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Preface

The typical user of a simulation package is someone who holds a PhD or an MSc,
has several years of experience in modeling and simulation, and underwent
thorough training to use the specific package. He or she typically works as a
scientist in the R&D department of a big organization or as an academic
researcher. Because the theory of simulation is complicated and the typical
simulation package presents many options, it is up to the user to employ his or her
expertise to validate the model and the simulation.

This means that a small group of simulation experts is serving a much larger group
of people working in product development, production, or as students studying
physics effects. Simulation models are oftentimes so complicated that the person
who implemented the model is the only one who can safely provide input data to
get useful output. Hence the use of computer modeling and simulation creates a
bottleneck in product development, production, and education.

In order to make it possible for this small group to service the much larger group,
the Application Builder offers a solution. It makes it possible for simulation experts
to create an intuitive and very specific user interface for his or her otherwise
general simulation model — a ready-to-use application. The general model can
serve as a starting point for several different applications, with each application
presenting the user with input and output options relevant only to the specific task
at hand. The application can include user documentation, checks for “inputs
within bounds”, and predefined reports at the click of a button.

Creating an application often requires a collaborative effort by experts within the
areas of physics, numerical analysis, programming, user-interface design, and
graphic design.

To a reasonable extent, COMSOL’s Technical Support team can recommend
physics and numerical analysis settings for your application. In addition, the
COMSOL documentation and online resources can be of great help. For
programming and design, the Technical Support team can provide very limited
help. These are areas where your own development efforts are critical.

The Application Builder makes it easy for a team to create well-crafted applications
that avoid accidental user input errors while keeping the focus on relevant output
details.

We at COMSOL are convinced that this is the way to spread the successtul use of
simulation in the world and we are fully committed to helping make this possible.



Introduction

A COMSOL® application is an intuitive and efficient way of interacting with a
COMSOL Multiphysics® model through a highly specialized user interface. This
book gives a quick overview of the Application Builder desktop environment with
examples that show you how to use the Form Editor, Main Window Editor, and
the Method Editor. Reference materials are also included in this book, featuring a
list of the built-in methods and functions that are available. For detailed
information on how to use the Model Builder, see the book Introduction to
COMSOL Multiphysics.

If you want to check out an example application before reading this book,
open and explore one of the applications from the Application Libraries in
one of the Applications folders. Keep it open while reading this book to
try things out. Only the Applications folders contain applications with user
interfaces. The other folders in the Application Libraries are tutorial
models with no user interfaces.

The Application Builder is included in the Windows® version of COMSOL

Multiphysics and is accessible from the COMSOL Desktop® environment.

COMSOL Multiphysics and its add-on products are used to develop applications.

A license for these add-ons is required to run the applications from the COMSOL

Multiphysics or COMSOL Server™ products.

Additional resources, including video tutorials, are available online at

https: / /www.comsol.com/videos.

RUNNING APPLICATIONS WITH COMSOL MULTIPHYSICS

With a COMSOL Multiphysics license, applications can be run from the
COMSOL Desktop in Windows®, macOS, and Linux®.

RUNNING COMPILED APPLICATIONS

By using COMSOL Compiler™ you can compile your application to an
executable file for Windows®, Linux®, and macOS. You can freely distribute the
executable and it can be run without any license file.

RUNNING APPLICATIONS WITH COMSOL SERVER

With a COMSOL Server license, a web implementation of an application can be
run in major web browsers on platforms such as Windows®, macOS, i0S, Linux®,
and Android™. In Windows®, you can also run COMSOL applications by
connecting to a COMSOL Server with an easy-to-install COMSOL Client,
available for download from https: / /www.comsol.com /client-download. COMSOL
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Server does not include the Application Builder, Physics Builder, or Model Builder
tools that come with the COMSOL Desktop environment. Any application
created with the Application Builder will automatically work with a web browser
or any client.

GUIDELINES FOR BUILDING APPLICATIONS

If you are not experienced in building a graphical user interface or programming,
you may want to read “Appendix F — Guidelines for Building Applications” on
page 388.

ADDITIONAL DOCUMENTATION

Additional documentation with information relevant to building applications can
be found in the books: Application Programming Guide, Application Builder
Reference Manual, and Programming Reference Manual.



The Application Builder Desktop Environment

COMSOL DESKTOP ENVIRONMENT —

The COMSOL Desktop environment provides access to the Ap-
plication Builder, including the Form, Main Window, and Method
Editors, as well as the Model Builder and the Model Manager.

MODEL BUILDER, APPLICATION BUILDER, and MODEL
MANAGER—Switch between the Model Builder, the Appli-
cation Builder, and the Model Manager.
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APPLICATION BUILDER WINDOW —
The Application Builder window with the
application tree.

SETTINGS and EDITOR TOOLS WINDOWS — Click any application
tree node or form object to see its associated Settings window.
The Editor Tools window is used to quickly create form objects.

The screenshot above is representative of what you will see when you are working
with the Application Builder. The main components of the Application Builder
desktop environment are:

» Application Builder window and ribbon tab
COMSOL Desktop environment

« Form Editor (sce page 57)

* Main Window Editor (see page 141)
Method Editor (see page 189)
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The Application Builder desktop environment is also sometimes referred to as the

Application Builder workspace.

THE APPLICATION TREE

The application tree consists of the
following nodes:

¢ Inputs

¢ Themes

¢ Main Window
* Forms

¢ Events

¢ Declarations
¢ Methods

e Libraries

The Inputs node contains subnodes that are
of the type Application Argument. These can
be used for input arguments to the
application when starting it from the
command line of the operating system.

The Themes node has a Settings window
with choices for the desktop color themes,
as well as font, text color, and other settings
that will affect the general appearance of an
application.

The Main Window node represents the main
window of an application and is also the
top-level node for the user interface. It
contains the window layout, the main
menu specification, and an optional ribbon
specification.

The Forms node contains subnodes that are
forms or folders containing local forms,
methods, and declarations. Each form may
contain a number of form objects such as
input fields, graphics objects, and buttons.

The Events node contains subnodes that are
global events. These include all events that
are triggered by changes to the various data

Application Builder

L et ELr B [0
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ﬁ Inputs
% Themes

v D Main Window
v E Menu Bar
v [Z] File ffile}
El Save {save}
El Save As {sgveds)
i Toolbar
~ [ Forms
D main
D selectllSize
D information
¥ D mainComputer
D toolbarComputer
¥ D mainTablet
D toolbarTablet
D notationsTablet
¥ D mainSmartphone
D toolbarSmartphone
Events
v = Declarations
= Boolean

123 Integer
25 Double
abe String

Material {materiall st}

2> Simulation Type List {simulationTypelist!
,@ Shortcuts

Methods

E initializeApplication

E resetToDefault

enableButtons

checkFindPrenglength

=| computeAndUpdateResults
runFrequencyStudy

v By

playSoundForFrequency
createReport
inputChanged
initGraphicsAndButtons
=| setMaterial
v [fifi Libraries
[#] Images
=i Sounds

fE3 Files
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entities, such as global parameters or string variables. Global events can also be
associated with the startup and shutdown of the application. Timer events can be
used to operate an app as a digital twin, enabling automated actions to be
performed at regular intervals.

The Declarations node is used to declare global variables, which are used in
addition to the global parameters and variables defined in the model.

The Methods node contains subnodes that are global methods. Methods contain
code for actions not included among the standard run commands of the model
tree nodes in the Model Builder. The methods may, for example, execute loops,
process inputs and outputs, and send messages and alerts to the user of the
application. Methods can modify the model object of a running application or the
model object represented by the Model Builder in the current session. The latter
being utilized when building an add-in.

The Libraries node contains images, sounds, and files to be embedded in an
MPH file so that you do not have to distribute them along with the application.
In addition, the Libraries node may contain Java® utility class nodes and nodes for
external ]ava® and C libraries.
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THE FORM EDITOR
FORM TAB — The Form tab in the ribbon

gives easy access to the Form Editor.

FORM EDITOR WINDOW — The tabbed Form
Editor window allows you to move objects around
by dragging. Click an object to edit its settings.
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FORM OBJECTS — Each form contains form objects
such as input fields, checkboxes, graphics, images,

SETTINGS and EDITOR TOOLS WINDOWS —
Click any application tree node or form object to see
its associated Settings window. The Editor Tools
window is used to quickly create form objects.

Use the Form Editor for user interface layout by creating forms with form objects
such as input fields, graphics, and buttons.

The main components of the Form Editor are:

e Form ribbon tab

» Application Builder window with the application tree

e Form window
« Editor Tools window

* Settings window

| 15



Creating a New Form

To create a new form, right-click the Forms node of the application tree and select
New Form. You can also click New Form in the ribbon. Creating a new form will
automatically open the Form Wizard with a number of layout templates.

If your application already has a form, for example forml, and you would like to
edit it, you can open the Form Editor in either of two ways:

 In the application tree, double-click the forml node.

 In the application tree, right-click the forml node and select Edit.

Note: Single-clicking a form node in the application tree displays a preview of the
form’s layout definition, whereas double-clicking allows you to edit the form.

You can also add forms that are local to other forms. When applicable, this option
is available as a menu option from the New Form button or the application tree.
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THE MAIN WINDOW EDITOR

MAIN WINDOW TAB — The Main MAIN WINDOW EDITOR — The Main Window Editor allows you to
Window tab in the ribbon gives easy ac- design menus, menu items, ribbon tabs, ribbon items, and subwindows.

cess to the Main Window Editor. You can move items around by dragging. Click an object to edit its set-
tings.
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x

Use the Main Window Editor for menu and ribbon layout by creating menus with
menu items and ribbon tabs with ribbon items. In addition, the Main Window
Editor, available directly from the Main Window node, is used for subwindow
layout.

The main components of the Main Window Editor are:
* Menu editor

+ File menu editor

» Ribbon tab editor

* Subwindow editor
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THE METHOD EDITOR

METHOD TAB — The Method

b in the ribbon gi METHOD WINDOW — The tabbed SETTINGS WINDOW — Click any
@b in the rll fon glves easdy ;C' Method Window allows you to switch application tree node to see its asso-
cess to tools for writing and de- between editing different methods. ciated Settings window.
bugging code.
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MODEL EXPRESSIONS, LANGUAGE ELEMENTS, and EDITOR TOOLS WINDOWS — These win-
dows display tools for writing code. The Model Expressions window shows all constants, parameters,
variables, and functions available in the model. The Language Elements window is used to insert template
code for built-in methods. The Editor Tools window is used to extract code for editing and running mod-
el tree nodes.

Use the Method Editor to write methods for actions not covered by the standard
use of the model tree nodes. A method is another name for what is known in other
programming languages as a subroutine, function, or procedure.

The main components of the Method Editor are:

¢ Method ribbon tab

+ Application Builder window with the application tree
¢ Method window

* Model Expressions, Language Elements, Editor Tools, and Settings
windows (these are stacked together in the figure above)
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Creating a New Method

To create a new global method, right-click the Methods node in the application
tree and select New Method. You can also click New Method in the ribbon Home tab.
In the New Method dialog you can change the name of the method.

3 Mew Method *

MName: method]
oK Cancel

Creating a new method will automatically open the Method Editor. Methods
created under the main Methods node in the application tree are global methods
and accessible from all methods, form objects, and from the Developer tab in the
Model Builder ribbon.

You can also add methods that are local to a form, also known as form methods.
When applicable, the option to create local form methods is available from the New
Method button's menu or by first clicking a form node in the application tree.

Furthermore, you can add methods that are local to individual form objects, also
known as local methods (see “Using Local Methods” on page 163 and “Local
Methods” on page 212).

A sequence of commands associated with, for example, a button or menu item can
be automatically converted to a new method by clicking Convert to Method. Open
the new method by clicking Go to Method. You can also create a method that is
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local to a form or form object by clicking Convert to Form Method or Convert to
Local Method, respectively. These options are shown in the figure below.

o 2 "
Choose Commands to Run B Command lcon | Arguments

method1

s, Solver Configurations

sults
erived Values
> B Tables
v il Electric Potential (ec) {pg1}
B velume 1{vell} =
> il Electric Field (ec) {pg2)
~ Wl Temperature (ht) {pg3} > Dialog Acti{ Go to Method
B Volume 1{voll} —
%5 Max/Min Volume 1 {mmv1}
> §il Current Density {pgd} > Appearance

> Position and Size

=/ EditNode » Run [ Plot 7 Set Value [ Show
Show as Dialog 1 Import File @ Enable () Disable

* Command lcon | Arguments

Compute Study 1 {std1}

Plot Temperature (ht) {pg3}
Plot Electric Potential (ec) {pg1}

form/graphics
form1/graphics2

Convert to Method

Convert to Form Method

> Position anc .
+5 Convert to Local Method

> Appearance

If a method already exists, say with the name method1, then you can open the
Method Editor in any of these ways:

+ In the application tree, double-click the methedl node.

 In the application tree, right-click the methodl node and select Edit.

* Below the command sequence in the Settings window of a form object, menu
item, ribbon item, or an event, click Go to Method.

 In the Events section of a form object, click Go to Source.
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APPLICATION BUILDER PREFERENCES

To access Preferences for the Application Builder, choose Preferences from the File
menu and sclect the Application Builder node.

@ Preferences

EE

Application Builder

~ Forms
Grid Mode
Sketch Mode

Application Builder

| [] Use separate desktop window for Application Builder

Maximum number of editors before closing: 15
Show editor preview

v Methods
Syntax Highlighting

Chatbot

Client-Server

Computing

Email

Files

Geometry

Graphics

Help

Libraries

LiveLink Connections

Mesh

Model Builder

Model Manager
Physics Builder
Results

Save

Security
Updates

User Interface

Factory Settings

Factory Settingsfor Al Import. Export. oKk Cancel

You can configure the COMSOL Desktop environment to display the Application
Builder in a separate desktop window. To do this, select the Use separate desktop
window for Application Builder checkbox. This configuration is particularly useful
if you are using multiple displays.

You can use the keyboard shortcuts Ctrl+Shift+M and Ctrl+Shift+A to switch
between the Model Builder and Application Builder, respectively.

You can set an upper limit to the number of open Form Editor or Method Editor
window tabs. Select the Maximum number of editors before closing checkbox and
edit the number (default 15). Keeping this number low can speed up the loading
of applications that contain a large number of forms.
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The Application Builder and the Model Builder

Use the Application Builder to create an application based on a model built with
the Model Builder. The Application Builder provides three important tools for
creating applications: Form Editor, Main Window Editor, and Method Editor.

e The Form Editor includes drag-and-drop capabilities for user interface
components such as input fields, graphics objects, and buttons.

* The Main Window Editor lets you design a menu bar or a ribbon, as well as
a desktop environment consisting of subwindows.

e The Method Editor is a programming environment that allows you to
modify the data structures that represent the different parts of a model or
application.

The figures below show the Model Builder and Application Builder windows.

Model Builder Application Builder
P R TR R - Etv Bl B~ 5
@
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Compenent 1 (comp 1)
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Geometry 1
22 Materials
=% Laminar Flow (spf)
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B Initial Values 1
5w Wall1
i Inlet 1
= Outlet 1
> 4&° Tiansport of Diluted Species (ids)
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[= Step 2: Stationary 2
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~ [ Results

Datasets

<
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>
>
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When creating an application, you typically start from an existing model.
However, you can just as well build an application user interface and the
underlying model simultaneously.

You can easily, at any time, switch between the Model Builder and Application
Builder. The model part of an application, as represented by the model tree, is
sometimes called an embedded model.

The tools in the Application Builder can access and manipulate the settings in the
embedded model in several ways; For example:

e If the model makes use of parameters and variables, you link these directly
to input fields in the application by using the Form Wizard or Editor Tools.
In this way, the user of an application can directly edit the values of the
parameters and variables that affect the model. For more information, see
pages 67 and 99.

* By using the Form Wizard or Editor Tools, you can include a button in your
application that runs a study node and thereby starts the solver. In addition,
you can use this wizard to include graphics, numerical outputs, checkboxes,
and combo boxes. For more information, see pages 49 and 67.

» The Data Access tool and the Editor Tools window can be used to directly
access low-level settings in the model for use with form objects or in
methods. For more information, see pages 67, 110, and 195.

* By using the Record Code and Record Method tools, you can record the
commands that are executed when you perform operations within the model
tree and its nodes. These will then be available in a method for further
editing. For more information, see page 199.
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Parameters, Variables, and Scope

The model tree may contain both parameters and variables that are used to control
the settings of a model. The figure below shows the model tree of an application
with nodes for both Parameters and Variables.
~ @ helical_static_mixer.mph (root)
v () Global Definitions
Fi Parameters 1
_I” Step 1(step1)
¥ _l Geometry Parts
4 Default Model Inputs
Materials
~ [l Component 1 {comp1)
~ = Definitions
2= Variables 1
» g Selections
[ Boundary System 1 (sys1)
> [ View1
Parameters are defined under the Global Definitions node in the model tree and are
user-defined constant scalars that are usable throughout the Model Builder. That

is to say, they are “global” in nature. Important uses are:
e Parameterizing geometric dimensions
e Specifying mesh element sizes

* Defining parametric sweeps

Variables can be defined in either the Global Definitions node or in the Definitions
subnode of any model Component node. A globally defined variable can be used
throughout a model, whereas a model component variable can only be used within
that component. Variables can be used for spatially or time-varying expressions,
including dependent field variables for which you are solving.

In the Model Builder, a parameter or variable is a string with the additional
restriction that its value is a valid model expression. For more information on the
use of parameters and variables in a model, see the book Introduction to
COMSOL Multiphysics.

An application may need additional global variables for use in the Form Editor and
the Method Editor. Such variables are declared in the Application Builder under
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the Declarations node in the application tree. The figure below shows the
application tree of an application with multiple declarations.

v [&] helical_static_mixer.mph (root)
ﬁ Inputs
% Themes

¥ D Main Window

> B Forms
Events

v = Declarations
abe String
25 Double
= Boolean
<> Mumber of Blades List {numberOfBladesChoicelist]
,@ Shortcuts

> [ Methods

» [ Libraries

You can also declare variables that are local to forms, also known as form
declarations. When applicable, the option to create local form declarations is
available by right-clicking a form node in the application tree.

The declared variables in the Application Builder are typed variables, including
scalars, arrays, Booleans, strings, integers, and doubles. Before using a variable,
you have to declare its type.

The fact that these variables are typed means that they can be used directly in
methods without first being converted using one of the built-in methods. This
makes it easier to write code with typed variables than with parameters and
variables representing model expressions. However, there are several tools
available in the Application Builder for converting between the different kinds of
variables. For more information, see pages 164 and 370. For more information on
typed variables, see the Application Programming Guide.
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Running Applications

With a COMSOL Multiphysics license, applications can be run from the
COMSOL Desktop environment. With a COMSOL Server license, applications
can be run in major web browsers on a variety of operating systems and hardware
platforms. In addition, you can run applications by connecting to COMSOL
Server with a dedicated client for Windows®.

By using COMSOL Compiler™, you can compile your application to an
executable file that can be run in the Windows®, Linux®, and macOS operating
systems.

The following two sections explain how to run applications in these different
settings. The third section, “Publishing COMSOL Applications” on page 47,
describes your rights to publish applications.

Running Applications in COMSOL Multiphysics

In COMSOL Multiphysics, you run an application using any of these ways:
* Click Test Application in the ribbon or in the Quick Access Toolbar.

+ Seclect Run Application in the File menu or in the Quick Access Toolbar.
« Double-click an MPH file icon on the Windows® Desktop.

» Seclect Test in Web Browser in the ribbon.

TESTING AN APPLICATION

Test Application is used for testing an application during development. It opens a
separate window with the application user interface while keeping the Application
Builder desktop environment running. The figure below shows the Test section as
it appears in the Form tab of the ribbon.

> B ®

Test Apply Preview  Testin Web

Application  Changes Form Browser ~
Test

While testing an application, you can apply changes to forms, methods, and the
embedded model at run time by clicking the Apply Changes button. Not all

changes can be applied at run time, and in such a case, you are prompted to close
the application and click Test Application again.

To preview the layout of a form without running the application, click Preview
Form in the ribbon.
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When Test Application is used, all methods are automatically compiled with the
built-in Java® compiler. Any syntax errors will generate error messages and the
process of testing the application will be stopped. To check for syntax errors before
testing an application, click the Check Syntax button in the Method tab.

e L El t: A = B+ n8=
anguage Elements [\/] Ej . B+C L

A T
El i
e oS ExpIs o Check Gote Record Use Create Local
E‘. Record Method Syntax Mode  Code  Shortcut Variable

Code

Check Syntax finds syntax errors by compiling the methods using the built-in Java®
compiler. Any syntax errors will, in this case, be displayed in the Method Errors and
Warnings window in the Method Editor. For more information, see “The Method
Editor” on page 189.

RUNNING AN APPLICATION

Run Application starts the application in the COMSOL Desktop environment.
Select Run Application to use an application for production purposes. For example,
you can run an application that was created by someone else that is password
protected from editing, but not from running.

e O % = > v
File Home  Form
MNew

Run Application

Open...

NN ar

Open From...

DOUBLE-CLICKING AN MPH FILE

When you double-click an MPH-file icon on the Windows® Desktop, the
application opens in COMSOL Multiphysics, provided the MPH-file extension is
associated with COMSOL Multiphysics. The application may either be opened for
editing or for running. You control this behavior from the root node of the
application tree. The Settings window for this node has a section titled Application
in which you can select either Edit application or Run application. A change in this
setting will be applied when you save the MPH file.

~ Application

[[] Ask to save application when closing

When starting with COMSOL Multiphysics:
Edit application -

|Edit application

Run application |
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If the MPH file was saved with the Edit application option, the application will
open in either the Application Builder or the Model Builder, depending on which
workspace was active at the time of saving.

If the MPH file was saved with the Run application option, the application will
open in runtime mode for production use. This option is similar to selecting Run
Application in the File menu with the difference that double-clicking an MPH file
will start a new COMSOL Multiphysics session.

If you have installed the COMSOL Client for Windows®, the MPH-file extension
may instead be associated with the COMSOL Client, and double-clicking an
MPH file will prompt you to log in to a COMSOL Server.

IGNORING LICENSE ERRORS

In the Settings window for the application tree root node, the Ignore license errors
during launch checkbox is used to control the behavior with respect to licensed
products when running applications.

~ Application

[[] Ask to save application when closing

When starting with COMSOL Multiphysics:
Run application =

Ignore license errors during launch

When this option is selected, an application can still be launched even if some
required licenses are unavailable. Although you cannot use the functionality
associated with missing licenses, you can write methods that dynamically adapt the
application’s features to the licenses that are available. For an example of how to
implement this, open the Installation Verification application from the Application
Libraries under COMSOL Multiphysics > Applications.

TESTING AN APPLICATION IN A WEB BROWSER

Test in Web Browser is used for testing the application in a web browser. This
functionality makes it easy to test the look and feel of the application when it is
accessed from a web browser connected to a COMSOL Server installation.

P

= ®
Main Test Apply Test in Web
Window Application  Changes = Browser
Main Window E-' Test in Chrome™ Browser
E-' Test in Firefox ® Browser

E-' Test in Microsoft Edge® Browser
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You can choose which of the installed web browsers you would like the application
to launch in. Test in Web Browser opens a separate browser window with the
application user interface while keeping the Application Builder desktop
environment running.

TEST APPLICATION VS. TEST IN WEB BROWSER

Test Application launches the application with a user interface based on Microsoft®.
NET Framework components, whereas Test in Web Browser launches the
application with a user interface based on HTML5 components. Test Application
will display the user interface as it would appear as a standalone app, compiled
using COMSOL Compiler, or when the application is run with COMSOL
Multiphysics or COMSOL Server, provided the COMSOL Client for Windows®
is used to connect with the COMSOL Server installation. Test in Web Browser will
display the user interface as it would appear when the application is run with
COMSOL Server, provided a web browser is used to connect with the COMSOL
Server installation.

For testing the appearance and function of an application user interface in web
browsers for macOS, i0S, Linux®, and Android™, a COMSOL Server installation
is required.

The table below summarizes the different options for running an application.

SERVER SOFTWARE CLIENT SOFTWARE TOOL OR COMPONENT
COMSOL Multiphysics Test Application

COMSOL Multiphysics Test in Web Browser

COMSOL Multiphysics Run Application

COMSOL Server COMSOL Client for Windows®
COMSOL Server Web Browser
COMSOL Runtime Executable file compiled with COMSOL Compiler

The Server column represents the software components that perform the
CPU-heavy computations. The Client column represents the software tool or
component used to present the application user interface. In the case of executable
files, all computations are done locally in the COMSOL Runtime™ environment.
For more information on compiled applications, see “Compiling and Running
Standalone Applications” on page 40.

SAVING A RUNNING APPLICATION

When you test an application, it is assigned the name Untitled.mph and is a copy
of the original MPH file. This is not the case when using the Run application
option.
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By default, when using the Run application option, the user of an application will
not be prompted to save changes when exiting the application. You control this
behavior from the root node of the application tree. The Settings window for this
node has a section titled Application in which you can select the Ask to save
application when closing checkbox, as shown in the figure below.

~ Application

7] Ask to save application when closing

As an alternative, you can add a button or menu item with a command to save the
application. For more information, see page 147.

APPLICATION LIBRARIES

From the File menu, select Application Libraries to run and explore the example
applications that are included in the COMSOL installation. Many of the
screenshots in this book are taken from these examples.

o O = ™ » v v
File

MNew Ctrl+M

Run Application

Open... Ctrl+0

NN aw

Open From... Ctrl+Shift+ 0
Recent >
Application Libraries

Save Ctrl+5

Save As..

Save To.. Ctrl+Shift+5

Revert to Saved Ctrl+Shift+R

(o i =

Compact History

COMSOL Multiphysics Server >
Help >
T Licensed and Used Products...

Preferences...

Exit
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You run an application, or open it for editing, by clicking the corresponding
buttons below the Application Libraries tree.

[l 2 ®H > ~ - S Untitled.mph - COMSOL Multiphysics = @

File

Helical Static Mixer

Application Libraries

(3 Refresh [F] Update COMSOL Application Libraries ) Application Gallery
Search

© 3 COMSOL Multiphysics M
v [l Applications Y
® cluster_setup_validation o=
O curve_digitizer Wy
O helical static_mixer

installation_verification

@ thermal_actuator_surrogate y
O transmission_line_calculator 377
O tubular_reactor ﬁ*

O tubular_reactor_surrogate

O tuning fork This app demonstrates the following:

5 [l Acoustics
> [l Chemical Engineering « Geometry parts and parameterized geometries
> [l Cluster and Batch Tuterials « Dark theme
> i Diffusion « Material appearance visualization with environment reflections
« Report generation for both Microsoft® Word and Microsoft® PowerPoint
> [l Electromagnetics y
- Options for setting different mesh sizes
> il Equation Based - Improved graphics visualization by showing/hiding different geometry objects
> il Fluid Dynamics « Enabling andl disabling ribbon items based on the solution state.
> [l Geometry Tutorials
> [l Geophysics Helical static mixers are often used to mix monomers and initiators which then react during 2 polymerization
process, The concentration field is included in the analysis in order to compute the extent of mixing between two
> [l Hest Transfer
streams injected into the static mixer through semicircle-shaped inlets.
5 [l Meshing Tutorials
> [l Muttiphysics The app can be used to estimate the degree of mixing in a system including one to five helical blades whese
> il Structural Mechanics dimensions can also be varied. The monomers' liquid properties and inlet velocity can also be varied

> % AC/DC Module
> 1)) Acoustics Medule

+ &3 Battery Design Module Name helical_static_mixer
> [= CAD Import Module Used products COMSOL Multiphysics
> ¥ CFD Module Physics interfaces  Laminar Flow
> £ Chemical Reaction Engineering Module Transport of Diluted Species
Al i} Created in COMSOL Multiphysics 6.3 (Build: 256)
B Run Application E Open Computation time 8 minutes
Author coMsoL
1] Open POF Document
Last medified Sep 30, 2024, 8:24:04 PM
Created Sep 30, 2024, 8:24:04 PM
Help g Close
911 MB | 980 MB

Applications that contain a model, but no additional forms or methods, cannot be
run and only opened for editing. Applications that contain forms and methods are
collected in folders named Applications.

The applications in the Application Libraries are continuously improved and
updated. You can update the Application Libraries by clicking Update COMSOL
Application Libraries.

Additional applications that are not part of the Application Libraries may be
available from the COMSOL website in the Application Gallery. To find these
applications, click the Application Gallery button. This will open a browser with
the web page for the Application Gallery.

Each application has an associated thumbnail image that is displayed in the
Application Libraries. In the COMSOL Server web interface, the thumbnail image
is displayed on the Application Library page.
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To set the thumbnail image, click the root node of the application tree. The
Settings window has two options for choosing the image: Set from Graphics
Window and Load from File. You can also Clear the image.

The Load from File option allows you to load images in the PNG or JPG file
formats. Choose an image size from 280-by-210 to 1024-by-768 pixels to ensure
that the image displays properly as a thumbnail in COMSOL Multiphysics and
COMSOL Server.

Settings
helical_static_mixer.mph
~ Protection

Editing not protected Set Password

Running not protected ~ Set Password
~ Used Products

COMSOL Multiphysics
~ Unit System

sl -

~ Presentation

Title: Helical Static Mixer

Description:  This app demenstrates the following:
» Geometry parts and parameterized geometries
= Dark theme

« Material appearance visualization with
environment reflections

Author: COMSOL
Cemputation time
Expected: 8 minutes
Last: Imindds

Thumbnail

Set from Graphics Window Load from File... Clear

The Set from Graphics Window option automatically creates two thumbnail images:

* An image of size 280-by-210 pixels shown in the Settings window of the
application tree root node and in the Application Libraries.

* Animage of size 1024-by-768 used as the default title page image in reports
and in the Application Libraries in COMSOL Server.
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PASSWORD PROTECTION

An application can be password protected to manage permissions. You assign
separate passwords for editing and running in the Settings window, accessible by
clicking the root node of the application tree in the Application Builder window.
You must have permission to edit an application in order to create passwords for
running it.

Settings

v Protection

Editing not protected Set Password

Running not protected Set Password

~ Used Products| |3

COMSOL Multiphysit o yprent password

~ Unit System Mew password: sasses

Retype new password: ssssss
sl
MNote: Lost passwords cannot be recovered.

~ Presentation OK Cancel

Title: Helical Static Mixer

When you open a password-protected MPH file, for editing or running, a dialog
prompts you for the password:

2

Enter password:

OK Cancel

To remove password protection, create an empty password.

The password protection is used to encrypt all model and application settings,
including methods. However, binary data, such as the finalized geometry
including embedded CAD files, mesh data, and solution data, is not encrypted.
Note that for add-ins the password is set in the Add-in Definition window. For more
information, see “Creating Add-ins” on page 234.

SECURITY SETTINGS

When creating an application with the Application Builder, it is important to
consider the security of the computer hosting the application. Both COMSOL
Multiphysics and COMSOL Server provide a very similar set of security settings
for controlling whether or not an application should be allowed to perform
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external function calls, contain links to C libraries, run MATLAB functions, access
external processes, and more.

The security settings in COMSOL Multiphysics can be found in the Security page
in the Preferences window accessed from the File menu. In COMSOL Server, they
are available in the Preferences page in the COMSOL Server web interface if you
are logged in as an administrator. If you are not sure what security settings to use,
contact your systems administrator.

Running Applications with COMSOL Server

COMSOL applications can be run by connecting to COMSOL Server from a web
browser or a COMSOL Client for Windows®. The COMSOL Client for
Windows® allows a user to run applications that require a LiveLink™ product for
CAD, as described in “Running Applications in the COMSOL Client” on page
37.

Running applications in a web browser does not require any installation or web
browser plug-ins. Running an application in a web browser supports interactive
graphics in 1D, 2D, and 3D. In a web browser, graphics rendering in 3D is based
on WebGL™ technology, which is included with all major web browsers.

RUNNING APPLICATIONS IN A WEB BROWSER

Using a web browser, you can point directly to the computer name and port
number of a COMSOL Server web interface — for example,
http://comsol-server-machine-url.com:2036, assuming that port number
2036 is used by your COMSOL Server installation. You need to provide a
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username and password to log in. If you are running COMSOL Server locally, the
address field will typically be localhost:2036.

O LgnwcousLsener x|

€ > C @D nhitpy/comsol-server-machine-urlcom2036 o 2 % 0O & ¢

COMSOL
SERVER

Username

paul

Password
wed

O Remember me (uses cookies)

Log in to COMSOL Server

Powered by COMSOL Muliphysics® About COMSOL Server™

When logged in, the Application Library page displays a list of applications to run.

v - o x
¥ Notify Widget X @ Application Library | COMSOLS: X 4

€ > C  ©® localhost2036/app-lio e % » 02 :
W COMSOL Notifications  Log Out

COMSOL Server / Application Library

paul
aaminisurator Library
_ kearch X Filter: Al SortBy:Name T 40/40 o=
[0R43 [OR43 [OR43 ®

0 upload B-H Curve Checker Beam Section Calculator Beam Section Calculator Bike Frame Analyzer
(Using LiveLink™ for

A Administration < [
i
1
LI
p Licensed and Used i)
Products, H
B )
Msetcfam A
@ Your Settings <
Run in browser - Run in browser - Run in browser - Runin browser <
[OR+4 [0+ ® [O+4
Charge Exchange Cell Cluster Setup Validation Concentric Tube Heat Corrugated Circular Horn
Simulator Exchanger Antenna

== 4
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Click Run in browser to run an application. Applications are run in separate tabs in
the browser.

© Application Library | COMSOLS< X | @ Cormugate

C  ® localhost2036/app/library_RF_Modul

@

Aperture
poiarization I

¢-®- e

@ Geometryview is pdted

Limitations When Running Applications in Web Browsers

When you create applications to run in a web browser, make sure you use the grid
layout mode in the Application Builder; See “Sketch and Grid Layout” on page
116. This will ensure that the user interface layout adapts to the size and aspect
ratio of the browser window. For low-resolution displays, make sure to test the
user interface layout in the target platform to check that all form objects are visible.
Applications that contain resizable graphics forms may not fit in low-resolution
displays. In such cases, use graphics with fixed width and height to make sure all
form objects fit in the target browser window. Depending on the type of web
browser and the graphics card, there may be restrictions on how many graphics
objects can be used in an application. You can get around such limitations by,
instead of using multiple graphics objects, reuse the same graphics object by
switching its source.

When running in a web browser, the LiveLink™ products for CAD software
packages are not supported.

When running COMSOL applications in web browsers for smartphones and
certain tablets, not all functionality is supported. Typical limitations include the
ability to play sounds or open documents. In addition, file upload and download
may not be supported.
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If the application allows the user to make selections, such as clicking on boundaries
to set boundary conditions, running in a web browser is different from running in
COMSOL Multiphysics or the COMSOL Client for Windows®. In a web
browser, boundaries are not automatically highlighted when hovering. Instead, it
is required to click once to highlight a boundary. A second click will make the
selection. A third click will highlight for deselection and a fourth click will deselect.
The process is similar for domains, edges, and points.

Note that file browsing functionality is slightly different depending on the web
browser and depending on the version of the web browser. This may impact the
user experience when running an application that has functionality for saving files
to the client computer. For example, the location of the downloads folder can be
changed in the settings of many web browsers. A web browser may also allow the
user to manually specify the download location for each file. Please refer to the
documentation of your target web browsers for details.

RUNNING APPLICATIONS IN THE COMSOL CLIENT

As an alternative to using a web browser for running applications, the COMSOL
Client for Windows® can be used to connect to COMSOL Server for running
applications natively in the Windows® operating system. This typically gives better
graphics performance and supports more sophisticated graphics rendering in 1D,
2D, and 3D. In addition, the COMSOL Client for Windows® allows running
applications that require a LiveLink™ product for CAD, provided that the
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COMSOL Server you connect to has the required licenses. You can open an
application with the COMSOL Client for Windows® in two different ways:

e The COMSOL Server web interface will allow
you to choose between running an application ® %
in a web browser or with the COMSOL
Client for Windows®.

If you try to run an application with the
COMSOL Client in this way, but it is not yet
installed, you will be prompted to download
and install it.

Biosensor Design

Run in browser hd
Run in browser

Run in COMSOL Client

* Ifyou have the COMSOL
Client fOI' Windows® 3 Connect to COMSOL Multiphysics Server X
already installed, a desktop | ™ veer
shortcut will be available.
You can double-click its
desktop icon and before
you can use the COMSOL ————
Client to run applications,
you will be prompted to log into a COMSOL Server with a valid username
and password. After login, the COMSOL Client displays a COMSOL Server
web interface identical to that seen when logging in from a web browser.

Server: | comsol-server-machine Username: | paul

Port: Default e Password:  sssssssssss

Remember username and password

Using the COMSOL Client, applications run as native Windows® applications in
separate windows. For example, applications run in the COMSOL Client may
have a Windows® ribbon with tabs. When run in a web browser, ribbons are
represented by a toolbar.
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In the figure below, the COMSOL Server web interface is shown (top) with an
application launched in the COMSOL Client for Windows® (bottom).

3 COMSOL Client

1 COMSOL

| paul
| qaminisator

3 uplosd

- Administration

p Licensedand Used
Products

@ Your settings

COMSOL Server / Appiication Library

Library

Search

[0R+¢

B-H Curve Checker

17

et ey

x

[0+

Beam Section Calculator

Filter: All Sort By: Name T 40140

[0+

Beam Section Calculator
(Using LiveLink™ for ...

o
[CR<4 e
Charge Excl

Simulator = S «

Report

o105
o155
05
Hom engt s
Waveguide ngth: '
Matching comugaion fengt 0zs
[E] Result Analysis
Output coss-polazation ati target: s %
Separamete 511 12376 4B
Input waveguide crose-polazaion atis 1762 %

Output aperture cross-polarzation raio:

> Torget crteion: passed.

@ information

defaul parameters excluding postprocessing.ltmay vary
based on the size o the geomelry and the frequency.

@ Lostcomputaton time: 17

@ Geometry view s updated.

0 be sround 9 < with the

Geometry

[0+

Bike Frame Analyzer

Cormugated Crcular Horn Antenna - o x

DFarfield 20 Gein
pattem

Patter (68 Polanzation  Polarzation

=

e tayout Help

Q@@ Lrizkznc- @NeBBO @8

RUNNING COMSOL SERVER ON MULTIPLE COMPUTERS OR A CLUSTER

COMSOL applications can be run on multiple computers or clusters in two main

ways:

* By installing COMSOL Server with primary and secondary instances.

* By configuring one of the study nodes in the Model Builder for a particular

cluster.
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Primary and Secondary Instances

Running COMSOL Server on multiple computers using primary and secondary
instances allows for more concurrent users and applications than a single computer
instance (or installation). The main COMSOL Server instance is called primary
and the other instances are called secondary. The primary server is used for all
incoming connections — for example, to show the web interface or to run
applications in a web browser or with COMSOL Client. The actual computations
are offloaded to the secondary server computers. This type of installation has a
major benefit: Applications do not need to be custom-built for a particular cluster.
Load balancing is managed automatically by the primary server, which distributes
the work load between the secondary servers. A COMSOL Server installation can
consist of multiple primary and secondary server installations without additional
license requirements. You can perform administrative tasks using the COMSOL
Server web interface without checking out license keys for users running
applications. License keys are only checked out when running applications.

Configuring a Study Node for Cluster Sweep or Cluster Computing

If you want to utilize a cluster for applications that require large parametric sweeps
or high-performance computing power, then you can configure the Model
Builder study nodes of an application using the Cluster Sweep and Cluster
Computing options. Note that for building such applications, you will need a
Floating Network License. You can find more information on configuring a study
node for clusters in the Introduction to COMSOL Multiphysics and COMSOL
Multiphysics Reference Manual books. For running such cluster-enabled
applications, you can use either COMSOL Server or a Floating Network License
of COMSOL Multiphysics. Cluster system configurations are available from the
COMSOL Server web interface.

For more information on COMSOL Server, see the COMSOL Server Manual
available with a COMSOL Server installation or from
https: / /www.comsol.com/documentation.

Compiling and Running Standalone Applications

If you have a license for COMSOL Compiler™, there will be a Compiler button in
the ribbon section Main, as shown below.

"5 Data Access
E'.Record Method
[ Compiler

Main
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Clicking this button will add a Compiler node to the application tree, shown in the
figure below.

Application Builder
- Etv Sl B~ [

v [&] tuning_fork.mph (root)
[EA Compiler
ﬁ Inputs

% Themes

The corresponding Settings window is shown below.

Settings
Compiler
= Compile Application

~ Qutput

Directory:  CACOMSOL & Browse

Runtime: Download =
Platforms

Windows

[ Linux

[] Linux, ARM

[] macOs, Intel

[] macOs, Apple silicon

~ Appearance

lcon for Windows: Default ~| |4
Splash: Default ~| |4
Preview

COMPILING APPLICATIONS

To compile an application, you need to make a few selections in this window.
Specify an output Directory, where the executable files will be saved after
compilation.

The Runtime option can be left at Download for most situations. COMSOL
Runtime contains all the COMSOL Multiphysics software components needed to
run the application as a standalone program. The Runtime setting specifies how the
COMSOL Runtime environment will be acquired from the compiled application.
If this setting is Download then the first time a user starts the compiled application
the COMSOL Runtime environment files will be downloaded (a service provided
by COMSOL). If the COMSOL Runtime environment already exists on the
computer, with a matching version number, then no download will be performed.
The option Embed will bundle the COMSOL Runtime files in the executable file.
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Note that with this option, the file size may be around 1GB even for smaller
applications.

You also have the option to preinstall COMSOL Runtime by downloading and
installing from: www.comsol.com /runtime-download

The Platforms settings determine which target-platform executables should be
generated at compilation. The extensions of the executables for the Windows®
and Linux® operating systems will be .exe and . sh, respectively. For macOS, a
.tar archive is created; unpack this archive on macOS to extract the app.

The lcon for Windows lets you specity the desktop icon. The Splash setting lets you
specify a BMP-image file to be displayed at startup.

After compilation, in the Windows® operating system, the executable file will be
available in the output directory, as shown in the figure below.

COMSOL X +
T c ) > ThisPC > Local Disk(C) > COMSOL

@ New T Sort O View

% Home
A Gallery
> @ OneDrive
tuning_fork.exe

As a next step, you can, for example, right-click the EXE file and create a shortcut
that you then place on the Windows® desktop. Note that the . exe file extension
might not be shown, depending on the operating system settings.

You can also compile an application from the operating system command line. For
more information, see the COMSOL Multiphysics Reference Manual.

RUNNING COMPILED APPLICATIONS

When running a compiled application, for example, by double-clicking the .exe
file in the Windows® operating system, a splash screen is shown and the
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application will start. If the application has the Splash option set to Default, then a
neutral-looking built-in splash screen will be shown.

It is recommended that you replace this with your own splash screen.

If this is the first time you are running an application on a particular computer,
then, in addition, an Initializing Installer progress window will be displayed. The
initialization progress window is shown below.

Initializing Installer
Starting COMSOL Runtime Installer

Downleading runtime components,

This may take a minute or two.
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After a short moment, the COMSOL Runtime Installer window is displayed, as
shown below.

3 COMSOL Runtime 6.3 Installer - X

COMSOL Runtime™ 6.3 Installer w coMsOoL
D

License Options Instal Finish

COMSOL Runtime License Agreement 6.3
YOU ARE USING COMSOL RUNTIME (THE "RUNTIME") LICENSED BY COMSOL.

If you or your organization obtained the Runtime as part of the COMSOL
Compiler, then the COMSOL Software License Agreement that was presented upon
installation of the OL Compiler add-on to COMSOL Multiphysics softwars
(www. comsol.com/sla) shall apply.

neither you nor your organization obtained the Runtime as part of the
L Compiler, then the following terms and conditions of this COMSOL
Runtime License Agreement ("CRLA™) shall apply.

IF YOU DO NOT ACCEPT THE APPLICABLE TERMS AND CONDITIONS, DO NOT USE THE
RUNTIME.

1. Definivions. The following words and phrases shall have the definitions
set forth below throughout this CRLE, regardless of whether or not such
words or phrases are capitalized:

a. The term "Application” shall mean (i) the output that is produced by
using the Application Builder feature of the COMSOL Multiphysics software
(with or without modification using the application programming interface
for such softwarsl or (ii) the outout that is produced by using the

© 1 accept the terms of the license agreement and understand and acknowledge that with this acceptance al other terms are rejected

() 1 do ot accept the terms of the license agreement

COMSOL Runtime information Cancel

The COMSOL Runtime Installer and its click-through agreement are only shown
once, and the next time you start the same application, it will not be shown. The
click-through agreement and initialization progress window will also not be
shown if you run another application on the same computer that was generated
with the same COMSOL Compiler version (having the same version of the
COMSOL Runtime).
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Click Next to proceed to the Options page, as shown in the figure below.

3 COMSOL Runtime 6.3 Installer - X

COMSOL Runtime™ 6.3 Installer wcoMsOoL
SO 00000

License Options Install Finish

Destination folder:

(C:\Program Files\COMSOL\COMSOLE3\Runtime Browse. ..
File system: c

Space required during installation: 3900 MB

Space required after installation: 3300 MB
Free disk space: 405298 MB

[ Register Livelink™ products
{8 Chedk for updates after installation

[ Ask to update the installed COMSOL Runtime for applications compiled with a newer version

CUDA
CUDA Directory: Browse...

COMSOL Runtime information < Back Install Cancel

On this page, you can set the destination folder for the COMSOL Runtime files,
choose to register LiveLink™ products (if included), and control how updates for
the COMSOL Runtime are handled. Click Install to continue. The installation
takes a few minutes and, when finished, the installer will prompt the user to start
the application.

If you selected the Ask to update the installed COMSOL Runtime for applications
compiled with a newer version checkbox while installing the COMSOL Runtime,
running an application compiled with a newer version of COMSOL Multiphysics
will give you the option to either run anyway or to download an update. An
example of this is shown in the figure below.

Tuning Fork

J

User interface sized for

@ COMSOL Update Available X

The COMSOL Runtime version is older than the version the app was compiled for,
App Version: 6.3.0.251
COMSOL Runtime version: £.3.0.250

[] Do not show this dialog again
Run Anyway Download
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An option for showing the COMSOL About dialog is always available in a
compiled application. The author of the application controls how this information
is available from the Settings of the Main Window; see “About Dialog” on page 143.
The figure below shows the About dialog.

About *

COMSOL Multiphysics .3 (Build: 251)

Products used:  COMSOL Multiphysics

COMSOL )
MULTIPHYSICS®

Acknowledgments v Show Information

»

By using this Application, you agree to be bound by version 6.3 of the COMSOL Application License, see
hittp /

This Application is run by tEchno\ngy supplied by COMSOL under version 6.3 of the COMSOL Software License Agreement,
see https://www.comsol.com/sla. © 1998-2024 COMSOLAB Protected by U.5., European (valid in DE, FR, and UK),
Chinese, Japanese, and Indian patents listed on https msol.comy/ p:tentf Patents pending. Certain technology
components are made available under terms found at http: ww.comsol.com/legal/about. Portions of this software are
owned by Siemens Product Lifecycle Management Software Inc. © 1986-2024. All Rights Reserved. Portions of this software
are owned by Spatial Corp. © 1985-2024. All Rights Reserved. COMS0OL, the COMSOL logo, COMSOL Compiler, COMSOL
Runtime, COMSOL Server, COMSOL Multiphysics, COMSOL Desktop, and Livelink are ther egistered trademarks or
trademarks of COMSOL AB. For 5 list of other trademarks and their owners, see htt .comsol.com/tm

COMSOL installation folder: Ci\Program Files\COMSOL\COMSOLS3 \Runtime

Preferences oK
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In the About dialog, the user of a compiled application can access the Preferences
by clicking the corresponding button. The Preferences window for a compiled
application is shown below.

Preferences X

Visualization

Rendering: OpenGL -

Optimize for  Quality =

Antialiasing: Medium +

Detail: Mormal =
Meouse

[] 3Dconnexion space mouse
Temporary files

Folder for temporary files (temp:///):  C\Users\username\AppDatatLocal\Ternph W& Browse
Recovery

Folder for recovery files:  Ch\Users\usernamel.comsol\wB3runtime\recow M@ Browse
Multicore

Number of cores: []
GPU acceleration

CUDA directory:
Livelink™ for MATLAB®

MATLAB® installation folder: W& Browse
Preduct updates

[] Ask te update the installed COMSOL Runtime for applications compiled with a newer version

Factory Settings Cancel

Here, the user can change settings for Visualization, Mouse, Temporary files,
Recovery, Multicore, GPU acceleration, LiveLink™ for MATLAB®, and Product updates.
These settings represent a subset of the Preferences available in COMSOL
Multiphysics and more information can be found in the COMSOL Multiphysics
Reference Manual.
If the compiled application detects that OpenGL® graphics hardware
acceleration is not supported, then the application will automatically
switch to software rendering and exit. The next time the application starts,
software rendering will be used.

Publishing COMSOL Applications

The COMSOL Software License Agreement (SLA) gives you permission to
publish your COMSOL applications for others to use, including commercially,
with certain restrictions spelled out in the SLA available at
https://www.comsol.com/sla. This permission enables you to share your
applications with others and to charge them for using your applications through
three different mechanisms.
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First, you can make an application available to others to be run by a COMSOL
Multiphysics installation. For using an application with COMSOL Multiphysics,
the user needs to belong to the same organization that purchased the COMSOL
Multiphysics license.

Second, you can make an application available to others to be run by a COMSOL
Server installation. This approach allows for greater flexibility, as it allows you to
set up a COMSOL Server installation and let users from around the world access
your Application. You just need to provide them with the address, a username, and
password to your COMSOL Server installation. Alternatively, users can purchase
their own COMSOL Server license. If you use COMSOL Server to host and run
applications, the SLA also gives you permission to make time on your COMSOL
Server License (CSL) available to persons outside your organization to host and
run applications that you are publishing to others, subject to certain restrictions.

Third, you can use COMSOL Compiler to compile your application into a
standalone program that contains all of the functionality required to make it run.
This approach gives you the greatest flexibility, as the end user of your application
will not need a license for COMSOL Multiphysics or COMSOL Server to run the
Application. The compiled application can then be run by that user and anyone
else to whom you allow the user to publish the compiled application, around the
world, inside or outside of your organization.

The COMSOL Application License, also available at https: / /www.comsol.com/sla,
further lets you modify applications available in the Application Libraries and
publish those modified applications for others to use, including commercially,
with certain restrictions spelled out in the Application License. This allows you to,
for example, use one of the applications in the Application Libraries as a starting
point for your own applications by adding or removing your own features.

If you wish to apply the Application License to applications that you create, the
Application License contains instructions on how to do so. The Application
License also addresses how you can use terms that you choose for modifications
you make to applications available in the Application Libraries, while the original
portions of those applications remain available under the Application License.

The results from a simulation software such as COMSOL Multiphysics can
shorten design times dramatically by, for example, reducing the number of
experiments or product tests. However, simulation software is not a substitute for
real-world testing. This is especially important if there are risks for physical or
environmental damage.
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Getting Started with the Application Builder

STARTING FROM A COMSOL MULTIPHYSICS MODEL

If you do not have a model already loaded to the COMSOL Desktop
environment, select File > Open to select an MPH file from your file system or
select a file from the Application Libraries. Note that, in the Application Libraries,
the files in the Applications folders are ready-to-use applications. All other files in
the Application Libraries contain a model and documentation, but not an
application user interface.

Once the model is loaded, click the Application Builder button on the ribbon Home
tab. This will take you to the Application Builder workspace.

o DB ER > v

File Home  Definitions Geometry  Materials P

A n >

Application Model Component Add
Builder Manager 1+ Component ~
Waorkspace Maodel
Model Builder
- S St~ Elv Siv v

CREATING A NEW FORM USING TEMPLATES AND THE FORM WIZARD

To start working on the user interface layout, click the New Form button in the
Home tab. This will launch the Form Wizard.

e O % = » v LI
File Home  Main Window
V. z =] " Data Access | Settings
® & [ -
B 4 i
Model Model New New G Record Method Editor Tools
Builder  Manager Form v Method v @3 Compiler
Waorkspace Main

The Form Wizard assists you with adding the most common user interface
components, so-called form objects, to the first draft of your application.
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In the Form Wizard, the first page is the Select Template page.

e D @H » o

File

Select Template

D Blank form
Single form
E Basic

E Subwindows, sections, and graphics

E Subwindows, tabs, and graphics
ﬁ Toolbar, sections, and graphics

ﬁ Buttons, sections, and graphics

ﬁ Compact layout for tablets

ﬁ Advanced compact layout for tablets
ﬁ Compact layout for smartphones

ﬁ Advanced compact layout for smartphones

Content

The different templates listed here will help you quickly create an organized
application with different levels of sophistication and user-interface layouts for
desktop, table, and smartphone use.

For this example, you can load the busbar.mph model from the Application
Libraries at COMSOL Multiphysics > Multiphysics. This is one of the models used in
the Introduction to COMSOL Multiphysics manual.

Select the Basic layout template and click Content. The Select Content page has four
tabs:

¢ Inputs

e Outputs
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¢ Graphics
¢ Ribbon buttons

Select Content

[] Labels on top
Inputs  Qutputs = Graphics = Ribbon buttons
Available: Selected:

~ < Model (root) —+
v () Global Definitions

~ P Parameters 1 Add Selected

25 Length (L)

8.5 Bolt radius (rad_1)

8.5 Thickness (tbb)

8.5 Width (wbhb)

8.5 Maximum element size (mh)
8.5 Heat transfer coefficient (htc)
e5 Applied voltage (Viot)

Double-click a node or click the Add Selected = button to move a node from the
Available area to the Selected area. The selected nodes will become form objects in
the application and a preview of the form will be shown in the Preview area to the
right.

The size as well as other settings for form objects can be edited after exiting the
wizard. You can also choose to exit the wizard at this stage by clicking Done, and
then manually add form objects.

The Inputs and Outputs Tabs

The Inputs and Outputs tab display the model tree nodes that can serve as an input
field, data display object, checkbox, or combo box. Input fields added by the
wizard will be accompanied by a text label and a unit, when applicable. You can
make other parts of the model available for input and output by using Data Access
(see page 110). Checkbox and combo-box objects are, for example, only available
in this way. For example, you can make the Predefined combo box for Element Size
under the Mesh node available in the wizard by enabling it with the Data Access
feature.
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In the figure below, three parameters, including Length, Width, and Applied
voltage, have been selected to serve as input fields.

Select Content Preview
[ Lsbelson top e
Inputs  Qutputs  Graphics  Ribbon buttons.
Available: Selected:
~ & Model (root) puts
~ () Global Definitions v @ Model (root)
v B Parameters | v (@ Global Definitions Main
== Bolt radius (rad_1) v Py Parameters 1 —_————
& Thickness (tbb) 55 Length (L) ! Inputs
2= Maximum clement size (mh) 2 Width (wbb) [ 5
5 Heat transfer coefficient (htc) &5 Applied voltage (Vtot) g S
| Width: 5 cm
| Applied voltage: 20 mV

+ Add Form i Edit Form — Remove Form

eTEmp\a(E
[ 2 B ecan:e\ [V pone

In the figure below, a Derived Values node for the maximum temperature has been
selected from the Outputs tab to serve as a data display object.

Select Content Preview
[] Labels on top o .
Inputs Outputs  Graphics = Ribbon buttons
Available:
v % Model (root)
v () Global Definitions ~ @ Model (root)
v P| Parameters | ~ B Resutts Main
s Length (L) ~ E% Derived Values —_——
=+ Bolt radius (rad_1) st Yolume Maximum 1 ! v Inputs
&= Thickness (tbb) i
2 Width (wbb) | Length: 2 cm
2 Maximum element size (mh) | Width s em
55 Heat transfer coefficient (htc) | Applied voltage: 20 mv
=+ Applied voltage (Viof) |
v [E Results I v Outputs
~ Ff Tobles i
5 Maximum and Minimum Values o (TR
Ff Teble 1

+ Add Form ¢ Edit Form — Remove Form

GTemplate
Help 0 Cancel [ Done

After exiting the wizard, you can edit the size and font color as well as other
settings for input fields and data display objects.

The Graphics Tab

The Graphics tab displays the model tree nodes that can serve as graphics objects:
Geometry, Selection, Mesh, and Results. In the figure below, a Temperature plot
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node has been selected. When using the Basic layout template, this selection
determines the default plot shown when the app is started.

e D EBR > O~ s

% busbarmph - COMSOL Muliphysics
File

Select Content Preview

[] Labels on top EE Home

Inputs  Outputs Graphics  Ribbon buttons

Available: Selected:

v £ Model (root) —+ v % Model (root)

v [ Component 1 (comp1) v [@ Results
~ = Definitions @ Temperature (ht) Main
© o Selecons
% Tibolts ~ Inputs Qa- v

Length s -
Wigdth: 3 m
Applied voltage: 20 mv

Bl Current Density

~ Outputs

Temperature: 0.001235 K

eTempme
relp € conca [ Done

The Ribbon Buttons Tab

The Ribbon buttons tab displays the model and application tree nodes that can be
run by clicking a button in the ribbon in the application user interface. Examples
of such tree nodes are Plot Geometry, Plot Mesh, Compute Study, and cach of the
different plot groups under Results. In addition, you can add buttons for GUI

Commands, Forms, and Methods. Note that in this example no Forms or Methods are
available yet.
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In the figure below, buttons have been added corresponding to the actions: Plot
Geometry, Plot Mesh, Compute Study, Plot Electric Potential, Plot Temperature, Plot
Current Density, and Reset Window Layout.

Select Content Preview

[ Labels on top e e

Inputs  Outputs  Graphics Ribbon buttons. TR T /U

Available: Selected b o = =} =) |

O 6UI Commands v @ GUI Commands | Geomety Meh Compute  Electic  Temperature
> [ File Commands ~ [ Main Window Commands { Euteniclie) (bt)
aphics Commands Reset Window Layout

ent 1 (comp1) ~ Inputs
2

nent cometry 1

Deinitions A PlotMesh 1 Lehote ] Gl

B Resuts ~ Compute Study 1 Width: H m
W Plot Electric Field (Ec) v [@ Results Applied voltage: | 20 mv

Wl Plot Electric Potential (Ec)

Tl Plot Temperature (H1) ~ Outputs

Wl Plot Current Densi
- By Temperature: 0.001235K

@ el
B e a[an:e\ [ pone

The Reset Window Layout option is available under GUI Commands > Main Window
Commands > Reset Window Layout. The application consists of two subwindows,

one for the inputs and outputs and one for the graphics. The Reset Window Layout
button will reset the two subwindows in the application to their original size. The
Subwindows templates are similar to the Basic template but additionally enable you
to detach, move around, and dock the subwindows. In this case, the Reset Window
Layout operation will rearrange all subwindows to their original position and size.

Using the Form Editor, you can add buttons that run your own custom command
sequences or methods.

For an example of using the Single form template, see the Introduction to
COMSOL Multiphysics manual.

EXITING THE WIZARD

Click Done to exit the wizard. This automatically takes you to the Form Editor.

TESTING THE APPLICATION

You can now click Test Application in the Test section of the ribbon.

> »)
Test App Test in Web
Application  Changes  Browser

Test
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The figure below shows the running application.

@ Untitled.mph - Electrical Heating in a Busbar - o X

File  Home

B =
e
Ly TR G CRi
~ Inputs Qa@- @ Lrzr ¢y < e BEO @6

Length: ] m
Width: 5

Volume: Temperature (K) Max/Min Volume: Temperature (K) L
Applied voltage: 20 m 324
~ outputs

Temperature: 330.4K

323

SAVING AN APPLICATION

To save an application, from the File menu, select File > Save As. Browse to a folder
where you have write permissions, and save the file in the MPH-file format. The
MPH file contains all of the information about the application, including
information about the embedded model created with the Model Builder.

| 55



Themes

The Settings window for Themes is displayed when you click the Themes node in
the application tree. It lets you change the overall appearance of the user interface
and forms with settings for Application theme, Image export theme, Text color,
Background color, Font, Font size, Bold, Italic, and Underline.

Application Builder

tv By B [E

v [&] tubular_reactor.mph (root)

ﬁ Inputs
% Themes
¥ D Main Window
~ [ Forms
D main
D input
D description
D information
¥ D simulationEvents
¥ D emailServer
> % Graphics
Events
» = Declarations
> [ Methods
» [ Libraries

Settings

Themes

~ Themes

Application theme: Default

Image export theme: Default

~ Appearance

Text color: Systemn
Background color: Systemn
Font: Systemn

Font size: Systemn

Applies to new form objects

] Bold

[] Italic
[] Underline

pt

The default is that all new forms and new form objects inherit these settings when

applicable.
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The Form Editor

Use the Form Editor to design user interfaces by creating forms with various form
objects, including input fields, graphics, buttons, and more. This section covers
the use of forms and form objects, along with related topics such as the objects
used in ribbons, menus, and toolbars.

The Individual Form Settings Windows

The figure below shows the application tree node and Settings window for a form.

Application Builder Settings
= L Etv Bl B~ Form
c MName:  main =
v [&] tubular_reactor.mph (root) Title: Main
ﬁ Inputs
2y Themes lcon: Default - | |+
> [T Main Window [ Show in Madel Builder
v [ Forms
[ main v Size
D input
D description Initial size:  Automatic -

D information
¥ D simulationEvents
¥ D emailServer
> % Graphics

~ Margins

Horizontal: 0

Events Vertical: 0
» = Declarations i :
> [ Methods ~ Dialog Settings
N I
m]] Libraries Store changes: On request -
[] Resizable

Vertically scrollable

> Grid Layout for Contained Form Objects

~ Appearance

Text color: Inherit -
Background color: Transparent :
Background image: MNeone ~| |+

~ Events

On load: initializeApplication = e

On close: MNeone - e
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Each form has its own Settings window with settings for:

* Name used to reference the form in other form objects and methods.
» Form Title that is used in applications with several forms.

¢ lecon shown in the upper-left corner of a dialog.

* Initial size of the form when used as a dialog or when the Main Window is set
to have its size determined by the form.

* Margins with respect to the upper-left corner (Horizontal and Vertical).

» Choices of when to store changes in dialogs (Store changes), sce also
“Showing a Form as a Dialog” on page 78.

» Choices of whether the form should be Resizable or not and Vertically
scrollable or not when used as a dialog.

» Table with the formatting of all columns and rows included in the form (Grid
Layout for Contained Form Objects).

» Appearance with settings for Text color, Background color, and Background
image.

* Events that are triggered when a form is loaded or closed. (On load and On
close.)

Double-click a form node to open its window in the Form Editor. Alternatively,
you can right-click a form node and select Edit. Right-click a form window tab to
see its context menu with options for closing, floating, and tiling form windows.

@ Preview D main X
¥ Close
> Close All but This
Input and C Float
————|
~ Input
Maximize

Activation er |
5 Tile Vertically

r_r_ Tile Horizontally |

1
1
1
1
1
: Thermal con
1
1
\

Heat of react

SKETCH AND GRID LAYOUT MODES

When adding a form using the Blank or Single form layout templates, the
Application Builder defaults to sketch layout mode, which lets you use fixed object
positions and size. The other layout templates use the grid layout mode. Sketch
layout mode is useful when you want control over the absolute positioning of form
objects, such as when creating dialogs. Many, but not all, of the instructions in the
“The Form Editor” on page 57 assume that the Form Editor is in sketch layout
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mode unless otherwise specified. For information on grid layout mode, see
“Sketch and Grid Layout” on page 116.

If you use the Single form template and follow the same steps as for the earlier
example using the Basic template, then the Form Editor will result in an form as
shown in the figure below, after dragging to reorganize the buttons.

[@ Preview  [Jform1 x
v

>
Length: ? moleaq@- L e
Width: 5 em

Applied voltage: 20 mv
Temperature:  0.001235K

ry

A

¥ A
\ A58,
Geometry Mesh
=

Compute TEmp[:;]ature

Current Electric
Density Potential eq)

In this case, no ribbon is created and you can freely position form objects, such as
buttons and edit fields, by dragging them. This is beneficial in some cases,
however, the size of the graphics object will be fixed when using the Single form
layout template. This is because for this template the sketch layout mode is used
and automatic resizing of an app is only supported with the grid layout mode. To
learn how to create resizable graphics objects, see “Automatic Resizing of
Graphics Objects” on page 127.

Note that any type of application that you create using templates can also be built
using manual steps by starting from a Blank form or Single form template, however,
using templates accelerates this process.

INITIAL SIZE OF A FORM
There are two options for the initial size of a form:
* Manual lets you enter the pixel size for the width and height.

* Automatic determines the size based on the form objects that the form
contains. If you are using grid layout mode and there are columns or rows
set to Grow, then the size is not defined by the form objects. In this case, the
size is estimated using the Form Editor grid size as a base point. (It will
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typically be slightly larger.) You can change the grid size by dragging the
right or bottom border of the grid. For more information on grid layout

mode, see “Grid Layout” on page 119.

Settings

Form

MName:  form1 E
Title: l:‘ main

lcon: Default ~| |4
Show in Model Builder

v Size

Initial size: Automatic
|Aut0matic |[
> Margin pganyal |

Local Forms

Forms can be local to other forms, which enables you to create a better structure
when developing your applications. For instance, a complicated global form made
up of many different subforms can have the auxiliary forms as local forms,
displayed as children in the application tree.

v [&] finned_pipe.mph (root)
ﬁ Inputs
% Themes
> D Main Window
~ [ Forms
D rain
~ D geometry
~ [ Forms

E] innerMone
E] innerStraightGrooves
E] outerMone
E] outerDiskStackedBlades
E] outerCircularGrooves
E] outerHelicalBlades
E] outerHelicalGrooves
D operatingConditions
D solverSettings
D information
> % Group 1
Events

You can add a local form by, for example, right-clicking a global form and
selecting Local Form. A global form always appears directly under the Forms node

in the application tree.

60 |



Form Editor Preferences

To access Preferences for the Form Editor, choose Preferences from the File menu

and select the Forms node in the tree.

| 1O Preferences
BBl Forms

v Application Builder

Default layout mode: Sketch =

Show COMSOL layout templates in the Form Wizard

| v Forms
| Grid Mode
| Sketch Mode
| > Methods
| Chatbot
| Client-Server
Computing
Email
Files
Geometry
Graphics
Help
Libraries
LiveLink Connections
Mesh
Model Builder
Model Manager
> Physics Builder
> Results

Save
> Security

>
>
>
>
>
>
>
>
>
>

The Forms node and its child nodes, Grid Mode and Sketch Mode, includes settings
for changing the defaults for layout mode, margins, sketch grid, and layout

templates.

Form Objects

POSITIONING FORM OBJECTS

You can easily change the positioning of form objects such as input fields, graphics
objects, and buttons in one of the following ways (which methods are applicable

depends on which layout mode you are using):

+ Click an object to select it. A selected object is highlighted with a blue

frame.

» To select multiple objects, use Ctrl+click. You
can also click and drag to create a selection >
box in the form window to select all objects
within it.

v

Length: =0 = cm
Width: =5 = cm
Applied voltage: 20 i
Temperature: 0.001235K
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* Hold and drag to move to the new position. In sketch layout mode, blue
guidelines will aid in the positioning relative to other objects.

 In sketch layout mode, you can also use the keyboard arrow keys to move
objects. Use Ctrl+arrow keys to fine tune the position.

In the figures below, a Plet button is being moved from its original position. Blue
guide lines show its alignment relative to the unit objects and the Compute button.

v
ot ° e aa@-@l - dr | e-BrBHO0 @8
Width: 5 om

Applied voltage: 20 mV
Temperature:  D.001235K

Compute

Temperature
(ht)

RESIZING FORM OBJECTS
In sketch layout mode, to resize an object:
 Click an object to select it.

* Hold and drag one of the handles, shown as blue dots, of the highlighted
blue frame. If there are no handles, this type of form object cannot be
resized.

Note that some form objects that cannot be resized in grid mode can be resized

in sketch mode.

COPYING, PASTING, DUPLICATING, AND DELETING AN OBJECT

To delete an object, click to select it and then press Delete on your keyboard. You
can also click the Delete button in the Quick Access Toolbar.
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You can copy-paste an object by pressing Ctrl+C and Ctrl+V. Alternatively, you
can right-click an object to get menu options for Copy, Duplicate, Delete, and more.

@ Preview D form1 X

v

[ 2
ength: E cm Qa@- Lov bz
Width: -5

. Create Local Method
Applied voltage: 20

Ternperature: 0.007235 K Copy as Code to Clipboard 3
SooCut Ctrl+X
E] Copy Ctrl+C
[F] Duplicate Ctrl+Shift+D
M Delete Del
Settings
B g
H Hep F1

To paste an already copied object, right-click an empty area in the form and
right-click again. Depending on the copied object, a Paste menu option will be
shown. In the figure below, an Input Field has previously been copied and as a
result, a Paste Input Field option is shown.

@ Local Form

New Method
Form Objects 3
Scalar 3
Array 1D r
Array 2D »

%> Choice List

E’ Preview Form

Zoom 100% 3
Copy as Code to Clipboard »
Wb Cut Ctrl+X
5] Copy Ctrl+C
% Paste Input Field Ctrl+V
E—E Duplicate Ctrl+5Shift+D
i Group Ctrl+G
M Delete Del
=[ Rename F2
B Ssettings
B Hep F1
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ADJUSTING POSITION AND SIZE BY THE NUMBER OF PIXELS

When in sketch layout mode, you can adjust the position and size of an object by

typing the number of pixels in the Position and Size section of its Settings window:

 Click an object to select it. Make sure its Settings window is shown. If not,
double-click the object or click the Settings button in the Form tab.

o Edit the numbers in the Position and Size section.

v Position and Size

Width: Manual -
20

Height: Manual -
20

Positionx: 180

Positiony: 240

The Position and Size section will have different options depending on the type of
form object. For grid layout mode, there are additional settings for the position of
the object with respect to rows and columns. For details, see “Sketch and Grid
Layout” on page 116.

CHANGING THE APPEARANCE OF DISPLAYED TEXT

For form objects that display text, the Appearance section in the Settings window
lets you change properties such as the text displayed, font, font color, and font
size. For some form objects, such as a button, the size of the object will adapt to
the length of the text string.
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In the figure below, the Settings window for a text label object is shown.

@ Preview D main X Se‘[‘[lﬂg 5
T Text Label
>
Input and Description Mame:  inputAndDescription ,%

[] Multiline text
= dnput Text: Input_and_description
Activation energy: 75362 Jimol

Thermal conductivity: 0,559 Wime k)

Heat of reaction: -B4666 Jimaol

» Position and Size
v Appearance

~ Reactor Description jfexticolor: TR s

Background color:  Transparent .
Font: Default font T

Font size: 12 - | pt
[ Bold
[ ltalic
[] Underline
State
Visible
Enabled

Inlet: A, B

By using grid layout mode (see “Sketch and Grid Layout” on page 116) you can
gain further control over the size of form objects, such as setting an arbitrary size
for a button.

SELECTING MULTIPLE FORM OBJECTS

If you select more than one form object, for example, by using Ctrl+click, then the
Settings window will contain a set of properties that can be shared between the
selected objects. Shared properties will always originate from the Appearance
section, the Position and Size section, or the Events section.

THE NAME OF A FORM OBJECT

A form object has a Name, which is a text string without spaces. The string can
contain letters, numbers, and underscore, but the reserved names root and
parent are not allowed. The Name string is used by other form objects and
methods to reference the object as part of its path. The object’s path is displayed
as a tooltip when hovering over the Name field in the Settings window.

INSERTING FORM OBJECTS

You can insert form objects in addition to those created by the Form Wizard. In
the Form ribbon tab, in the Form Objects section, you can quickly select some of
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the most common form objects: Input Field, Button, Checkbox, Text Label, Data
Display, and Graphics.

e DR » X EBEED N
File Home  Form
3 Input Field [T Text Label ] Grid
(2K Button Data Display More 1 Sketch Show Arrange
[ Checkbox [ Graphics Objects ~ Grid Lines v
Form Objects Layout Sketch

Additional form objects are available from the More Objects menu button.

3 Input Field Text Label @ Grid Row Settings ~

(5% Button Data Display More 1 Sketch Show Arrange :[l: Column Settings + o

[ Checkbox [ Graphics Objects ~ Grid Lines v v
Form Objects Input

Toggle Button Combo Box

Application Builder

T+ Elv A Labels

Type filter text Unit Equation — Line
~ tubular_reactormph (root) Display
ﬁ Inputs
% Themes [5=] Web Page La_ Image o) Video
> 7] Main Window
v B Forms == Progress Bar £ Gauge Log
D main [ Message Log Results Table
D input
D description Subforms
D information - =
Form Form Collection = Card Stack
> D simulationEvents E‘ )
> D email Server Composite
> Graphics X X
Events & File Import Information Card Stack El Array Input
> = Declarations 8 Radio Button & Selection Input
> [ Methods
» [ Libraries Miscellaneous
[T] Text S List Box EEE Table
=¥ Slider # Knob T Hyperlink
i Toolbar A% Form Toolbar Spacer

The remainder of this section, The Form Editor, only describes the types of form
objects that are added by the Form Wizard. The form objects and ribbon features
added by using the wizard may include:

* Button and Ribbon Button

¢ Graphics

¢ Input Field

* Text Label (typically associated with Input Field)

66 |



* Unit (typically associated with Input Field)
¢ Data Display

However, when using Data Access (see page 110), the additional form objects may
be added by the wizard, including;:

¢ Checkbox

¢ Combo box

For more information on the checkbox, combo box, and other form objects, see
“Appendix A — Form Objects, Ribbon, Menu, and Toolbar Items” on page 245.

EVENTS AND ACTIONS ASSOCIATED WITH FORMS AND FORM OBJECTS

You can associate objects such as buttons, menu items, ribbon buttons, forms, and
form objects with actions triggered by an event. An action can be a sequence of
commands including global methods, form methods, or local methods. Local
methods are not accessible or visible outside of the forms or objects where they
are defined. The events that can be associated with an object depend on the type
of object and include: button click, keyboard shortcut, load of a form (On load),
close of a form (On close), change of the value of a variable (On data change), and
focus gained.

Using Ctrl+Alt+click on a form object opens any associated method in the
Method Editor. If there is no method associated with the form object, a new local
method will be created, associated with the form object, and opened in the
Method Editor. If the form object has an associated command sequence, this
sequence is converted to code and inserted in the local method.

Editor Tools in the Form Editor

The Editor Tools window is an important complement to the Form Wizard and the
Insert Object menu for quickly creating composite form objects. To display the
Editor Tools window, click the corresponding button in the Main group in the
Home tab.

"5 Data Access = settings
Eﬁ Record Method Editor Tools
[EA Compiler

Main
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You can right-click the nodes in the editor tree to add the same set of form objects
available with the Form Wizard.

Editor Tools

= Edit Node =T = ¢

% Themes

D Main Window
¥ % Forms
» @ GUI Commands
» [ Libraries
~ < Model (root)
v () Global Definitions
~ P; Parameters 1
25 Length (L)
8.5 Bolt radius (rad_1)
5.5 Thickness “--*
2= Width (w Input

85 Maximur Output

2.5 Heat tran

e5 Appliedv ™
4 Default Model Inputs
=) Materials

» Edit Node

= Definitions
WA Geometry 1
22 Materials
> 3 Electric Currents (ec)
» |IE) Heat Transfer in Solids (ht)
> .y Multiphysics
¥ A Mesh 1
» ~db Study 1

> [El Results

~ [l Compenent 1 (comp1)
>
>
>

Input Output Graphics Button

When a node is selected, the toolbar below the editor tree shows the available
options for inserting an object. You can also right-click for a list of these options.

Depending on the node, the following options are available:
e Input
An Input Field, Checkbox, Combo Box, or File Import object is inserted as follows:

- Inserts an Input Field using the selected node as Source. It is accompanied by
a Text Label and a Unit object, when applicable.

- Inserts a Checkbox using the selected node as Source.

- Inserts a Combo Box using the selected node as Source. A choice list is
automatically created, corresponding to the list in the node. This option is
only available when used with Data Access (see page 110) to make the
corresponding node available in the editor tree.

- Inserts a File Import object using the selected node as File Destination.
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¢ Output

- Inserts a Data Display object accompanied by a Text Label when applicable.

- Inserts a Results Table object when the selected node is a Table.
* Button

- Inserts a Button object with a command sequence running the selected node.
¢ Graphics

- Inserts a Graphics object using the selected node as Source for Initial Graphics

Content.

* Edit Node

- Brings you to the Settings window for the corresponding model tree node.
The Editor Tools window is also an important tool when working with the
Method Editor. In the Method Editor, it is used to generate code associated with

the nodes of the editor tree. For more information, see “Editor Tools in the
Method Editor” on page 195.

Button and Item

Clicking on a Button, ribbon, menu, or toolbar Item is an event that triggers an
action defined by its command sequence. The main section of the Settings window
for a button or item allows you to:

+ Edit the form object Name of the button.

» Edit the Text displayed on the button.

» Use an lcon instead of the default rendering of a button.
e Set the button Size to Large or Small.

e Set the button Style to Flat, Raised, or Outlined.
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* Add a Tooltip with text that is shown when hovering over the button.

+ Add a Keyboard shortcut by clicking the input field and entering a
combination of the modifier keys Shift, Ctrl, and Alt together with another
keyboard key. Alt must be accompanied by at least one additional modifier.

Settings

MNarne: button1 =
Text: Compute

lcon: = compute 32 ~ + [=
Size: Large =
Style: Flat =
Tooltip: Run simulation

Keyboard shortcut:  CTRL+S

The settings for a ribbon button, defined as Item in a Ribbon Section, are very
similar to those of a button form object. However, in their respective settings
windows, the sections and settings for Dialog Actions, Position and Size, and
Appearance are available only for the button form object. Similarly, the settings
windows for menu and toolbar items are also closely aligned with those of a button
form object.
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CHOOSING COMMANDS TO RUN

The section Choose Commands to Run lets you control the action associated with a
button-click event. The figure below shows the Settings window for a button that
triggers a sequence of four commands.

~ Choose Commands to Run B

> [ Forms
B GUl Commands
~ % Methods

method1

method2
[fifi Libraries
v 4% Model (root)
7 Global Definitions
> [l Compenent 1 (comp1) {comp1}
w oo Study 1 {std1}

[= Stationary {stat}

w

w

Edit Node Run [aE| Plot Set Value Show
Show as Dialog Import File Enable Disable

" Command lcon | Arguments
Compute Study 1 {std1} =

Plot Electric Potential (ec) {pg1} form1/graphics1
Plot Temperature (ht) {pg3} form1/graphics2
method1 @

bg BE -

A menu, ribbon, or toolbar item will also provide a Choose Commands to Run
section in its Settings window, and the functionality described in this section
applies. For more information on using menu, ribbon, and toolbar items, see
“Graphics Toolbar” on page 88, “The Main Window Editor” on page 141,
“Table” on page 330, and “Toolbar and Form Toolbar” on page 342.

To define a sequence of commands, in the Choose Commands to Run section, select
anode in the editor tree. Then click one of the highlighted buttons under the tree.
Alternatively, right-click in the tree and select the command or double-click. In

the figure below, the Geometry node is selected and the available commands Run
and Plot are highlighted. Click Run to add a geometry-building command to the
command sequence. Click Plot to add a command that first builds and then plots
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the geometry. The option Edit Node will take you to the corresponding node in
the model tree or the application tree.

~ Choose Commands to Run "5

¥ % Forms

» @ GUI Commands

> g Methods

» [ Libraries

~ < Model (root)

() Global Definitions
Component 1 (compl)
= Definitions

A Geometry 1

22 Materials

&

»
w

v viviv il

A

Electric Currents (ec)

=g Edit Node » Run [Z3 Plot Set Value Show

Show as Dialog Import File Enable Disable

You do not need to precede a Plot Geometry command with a Build
Geometry command (that you get by clicking Run). The Plot Geometry
command will first build and then plot the geometry. In a similar way, the
Plot Mesh command will first build and then plot the mesh.

The command icons highlighted for selection are those applicable to the particular
tree node. This is a list of the command icons that may be available, depending
upon the node:

* Run

¢ Plot

¢ Set Value

e Show

¢ Show as Dialog
* Import File

¢ Enable

¢ Disable

Some commands, such as the various plot commands, require an argument. The
argument to a plot command, for example, defines which of the different graphics
objects the plot should be rendered in.
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The example below shows the Settings window and command sequence for a
Compute button as created by the Form Wizard. This button has a command
sequence with two commands: Compute Study | and Plot Temperature.

~ Choose Commands to Run =

3 Forms

B GUl Commands
EE Methods

[fifi Libraries

& Model (root)

» () Global Definitions

> [ Component 1 (compl)
v oo Study 1

[= Stationary
> [fre Solver Configurations

v {E| Results

Edit Mode Run [ca| Plot Set Value Show
Show as Dialog Import File Enable Disable

v v v v

L
Command lcon | Arguments

Compute Study 1 =
Plot Temperature (ht) form1/graphicsi

tLEEE-#

The Plot Temperature command has one argument, form1/graphicsi.
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To add or edit an input argument, click the Edit Argument button below the
command sequence, as shown in the figure below.

L i
Command lcon | Arguments O Edit Argument x
Compute Study 1 = v B Forms
Plot Temperature (ht) form1/graphicsi v [ form1
graphicsl

t L REEr

Edit Argument

i @_‘ Use as Argument
| selected argument:
[ graphics1
OK Cancel

[

To reference graphics objects in a specific form, the following syntax is used:
formi/graphics2, form3/graphicsi,and so on. Ifa specific form is not specified,
for example, graphicsi, then the form where the button is located is used.

To control the order and contents of the sequence of commands, use the Move Up,
Move Down, and Delete buttons located below the command sequence table.
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CONVERTING A COMMAND SEQUENCE TO A METHOD
A sequence of commands can be automatically converted to a new method, and

further edited in the Method Editor, by clicking Convert to Method.

~ Choose Commands to Run
> [Tre Solver Configurations

~ {E| Results
> 2% Derived Values

> B Tables
- I‘i Electric Potential (ec) {pg1}
B volume 1 {voll}
» I'i Electric Field (ec) {pg2}
w I'i Temperature (ht) {pg3}

B volume 1{voll}

25 Max/Min Volume 1 {mmv1}

> Nl Current Density {pgd}
=¢ Edit Node Run [Ea Plot Set Value Show
Import File (8) Enable () Disable

Show as Dialog
lcon | Arguments

" Command
Compute Study 1 {std1}

Plot Temperature (ht) {pg3}
Plot Electric Potential (ec) {pg1}

form1/graphics1
form1/graphics2

t 1 xgtE~- #
> Dialog Actio :. Convert to Method
Convert to Form Methed

> Position anc -
“E Convertto Local Methed

> Appearance

Open the new method by clicking Go to Method

L3
Command lcon | Arguments

method1

bl PR

> Dialog Acti{ Go to Method

> Position and Size

> Appearance
You can also create a method that is local to a form or form object by
clicking Convert to Form Method or Convert to Local Method, respectively
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The method contains calls to built-in methods corresponding to the commands in
the commend sequence, as shown in the figure below.

@ Preview Dform‘l method1 X
model.study("stdl").run();
useGrophics(model.result("pg3"

526!
3  useGraphics(model.result("p

In this example, the first line:
model.study("std1").run()
runs Study | corresponding to the model tree node containing the first study with

tag std1 (the first study node is called Study 1 unless changed by the user). The
second and third lines:

useGraphics(model.result("pg3"), "formi/graphicsi");
useGraphics(model.result("pg1"), "formi/graphics2");

use the built-in method useGraphics to display plots corresponding to plot
groups pg3 and pg1, respectively. In this example, the plots are displayed in two
different graphics objects, graphics1 and graphics2, respectively.

For more information on methods, see “The Method Editor” on page 189.

SETTING VALUES OF PARAMETERS AND VARIABLES

The Set Value command allows you to set values of parameters and variables that
are available in the Parameters, Variables, and Declarations nodes. In addition, Set
Value can be used to set the values of properties made accessible by Data Access (see
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page 110). The figure below shows a command sequence used to initialize a set of
model parameters and a string variable.

~ Choose Commands to Run “db

~ 4 Model (root)
7 Global Definitions
~ P Parameters 1 {default}

=5 Activation energy (E)

Frequency factor (A)

Thermal conductivity (ke)

Diffusion coefficient (Diff)

Overall heat-transfer coefficient (Uk)
Heat of reaction (dHrx)

=5 Inlet temperature (T0)

Edit Node Run [za] Plot Set Value Show

Show as Dialog Import File Enable Disable

* Command lcon | Arguments
Set E of Parameters 1 {default} =0 75352

Set ke of Parameters 1 {default} = 0559

Set dHrx of Parameters 1 {default} -84666

Set activePlot of String =7 | temperature

B~

To learn how to perform the same sequence of operations from a method, select
Convert to Method under the command table.

CHANGING WHICH FORM IS VISIBLE

A button on a form can also be used to display a new form. This can be done in
two ways. The first is to use the Show command, which will replace the original
form with the new form. The second is to use the Show as Dialog command. In this
case, the new form will pop up as a dialog over the current form, and will usually
request input from the user.
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In the section Choose Commands to Run, you can select the Show command. The
figure below shows the command sequence for a button with a command Show
form3.

[er

~ Choose Commands to Run

~ [ Forms
D form1
D form2
D form3

B GUl Commands
= Declarations
EE Methods

» [ Libraries

» < Model (root)

»
»
»

=y EditNode » Run [ Plot 57 SetValue [ Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Show form3 as dialog
=% . v

This command will leave the form associated with the button and make the
specified form visible to the user.

SHOWING A FORM AS A DIALOG

In order to use the Show as Dialog command, begin with the Choose Commands to
Run scction and select the form that you would like to show. The figure below
shows an example of the settings for a button with the command Show form2 as
dialog.

~ Choose Commands to Run =

~ [ Forms
D form1
D form2

B GUl Commands
= Declarations
EE Methods

[fifi Libraries

» < Model (root)

»
»
»
»

=y EditNode » Run [ Plot 57 SetValue [ Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Show forma2 as dialog
=% . v
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With these settings, clicking the button in the application will launch the following
dialog corresponding to form2:

3 Help X

You are running version 2.1
of this application. For help
please call 123-456-7890.

OK

The form2 window in this example contains a text label object and an OK button,
as shown in the figure below.

@ Preview chrm‘l chrmZ x Settings

= Button
i Name: button1 =
You are running version 2.1 | ame Hren =
of this application. For help | Text: QK
please call 123-456-7830. |
i lcon: Mone ~| |+
| Size: Small -
oK i
! Style: Raised -
Tooltip:

Keyboard shortcut:

> Choose Commands to Run "5
~ Dialog Actions

Close dialog
Store changes

In the Settings window, the Dialog Actions section has two checkboxes:

¢ Close dialog

¢ Store changes

In the example above, the Close dialog checkbox is selected, ensuring that the

form2 window closes when the OK button is clicked. Since form2 has no user
inputs, the Store changes checkbox does not have any effect.

Typical dialog buttons and their associated dialog actions are:

BUTTON DIALOG ACTIONS

oK Close dialog and Store changes
Cancel Close dialog

Apply Store changes
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A dialog blocks any other user interaction with the application until it is closed.
In order to control when data entered in a dialog is stored, there is a list in the
Dialog Settings scction of the Settings window of a form where you can select
whether to store data On request or Immediately when the change occurs, as shown
in the figure below.

Settings

Mame: form1 ,@

Title: Form 1

lcon: Default ~| &
Show in Maodel Builder

> Size

> Margins

~ Dialog Settings

Store changes: On request -

[] Resizable ~ On request
Vertically scr|| Immediately |

When the Store changes option On request is sclected, the variables that have been
changed by the user in the dialog will not be updated until the OK button (or
similar) in the dialog has been clicked. This requires that the Store changes
checkbox is selected, in the Settings window of the OK button. When the option
Immediately is sclected, variables changed by the user in the dialog is updated
immediately including while the dialog is still open.

When Vertically scrollable is cleared, the form will never get any vertical scrollbar.
Instead, the scrollbar will appear on the form objects inside the form, if possible.
To obtain a satisfactory result, the form has to be created in grid mode. The form
object which should get the scrollbar must be in a row with setting Grow Row and
its alignment set to Fill Vertically.
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APPEARANCE

In the Settings window for a button, the Appearance scction contains font settings
as well as settings that control the state of the button object.

~ Appearance

Text color: Inherit =
Background color: Default =
Font: Default font =
Font size: Default size > pt
[] Bold
] Kalic

State
Visible
Enabled

Changing the Enabled and Visible State of a Form Object
Whether or not the button object should be Visible or Enabled is controlled from
the checkboxes under the State subsection. The Appearance section for most form
objects has similar settings, but some have additional options; for example, input
field objects.
A button, or another form object, with the Visible checkbox cleared will not be
shown in the user interface of the running application. A form object with the
Enabled checkbox cleared will be disabled, or “grayed out”, but still visible. The
state of a form object can also be controlled using built-in methods. For example,
assume that a Boolean variable enabled is used to determine the enabled /disabled
state of a button with Name button3. In this case, you can control the state of the
button as follows:

setFormObjectEnabled("button3", enabled);

In a similar way, the call
setFormObjectVisible("button3", visible);

lets a Boolean variable visible control whether the button is shown to the user
or not.

For more information, see “GUI-Related Methods” on page 376 and the
Application Programming Guide.

Graphics

Each Graphics object gets a default name such as graphics1, graphics2, and so
on, when it is created. These names are used to reference graphics objects in
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command sequences for buttons, menu items, and in methods. To reference
graphics objects in a specific form, use the syntax: form1/graphics2,
form3/graphics1, and so on.

SELECTING THE SOURCE FOR INITIAL GRAPHICS CONTENT

In the Settings window for a graphics object, use the section Source for Initial
Graphics Content to set the plot group or animation to be displayed as default. To
select, click Use as Source or double-click a node in the tree. If a solution exists for
the displayed plot group, the corresponding solution will be visualized when the
application starts. The figure below shows the Settings window for a graphics
object with a Temperature plot selected as the source.

Settings
MName: graphicsl =5

Zoom to extents on first plot
~ Source for Initial Graphics Content

v & Model (root)
> [ Component 1 (compl)
v {E| Results
Nl Electric Potential (ec)
V@ Electric Field (ec)
Iﬁ Temperature (ht)
V@ Current Density

@_‘Use as Source %, Clear Source =# Edit Node

Selected source:

VB Temperature (ht)

In addition to Results plot nodes, you can also use Animation, Selection, Geometry,
and Mesh nodes as the Selected source.

Selecting the Zoom to extents on first plot checkbox ensures that the first plot that
appears in the graphics canvas shows the entire model (zoom extents). This action
is triggered once the first time that graphics content is sent to the graphics object.

In the section Data Picking, below Source for Initial Graphics Content, selecting the
Enable data picking checkbox makes the graphics object interactive so that you can,
for example, click on a plot at a particular point and retrieve a numerical value for
the temperature at that coordinate. For more information, see “Data Picking” on
page 97.
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APPEARANCE

For a graphics object, the Appearance section of the Settings window has the

following options:

* Include an leon, such as a logo image, in the upper-right corner.

» Set the background Color for 2D plots.

 Set a flat or graded background color for 3D plots by choosing a Top color
and Bottom color.
~ Appearance

lcon: o logo_graphics.png - + =
Background for 2D plots

Color: Use default -
Background for 3D plots

Top color: Use default -

Bottom color: Use default -
State

Visible

Enabled

In addition, the subsection State contains settings for the visible and enabled state
of the graphics object. For more information, see “Changing the Enabled and
Visible State of a Form Object” on page 81.
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The figure below shows an application where the background Top color is set to
white and the Bottom color to gray. In addition, the standard plot toolbar is not
included.

© Untitled.mph - Electrical Heating in a Busbar - O X « Appearance
Length: 0 n lcon: o logo_graphics.png - + B
Wit : om A = Background for 2D plots
Applied voltage: 120 my Geometry Compute
Temperature:  3304K Color: Use default -
o Background for 3D plots
Surface: Current density norm (Afm?)
Top color: White -
x10°
10
Bottom color: Gray -
9
State
8 -
Visible
’ Enabled
m 6
5 ~ Toolbar
4 Position: Above -
3 -
Icon size: Small -
2
z Background color: Default -

Standard toolbar

Include standard toolbar items: None bt

Custom toolbar items
About

GRAPHICS COMMANDS

In the editor tree used in a command sequence of, for example, a button, the
Graphics Commands folder contains commands to process or modity a graphics
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object. The figure below shows a command sequence with one command for
printing the contents of a graphics object.

~ Choose Commands to Run "5

> [ Forms
~ @ GUI Commands
¥ File Commands
v [‘u Graphics Commands
Zoom Extents
‘[ Zoom to Selection
[@ Reset Current View
= Scene Light
@ Environment Reflections
(& Show Skybox
[#2 Rotate Environment
[ Transparency
B0 Orthographic Projection
@ Print
Select All
Clear Selection

. Show Selection Colors

= Show Material Color and Texture
Edit Node P Run [za| Plot Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Print lgl form1/graphicsi

The available Graphics Commands include:
e Zoom Extents

- Makes the entire model visible.
¢ Reset Current View

- Resets the currently active view to the state it had when the application was
launched; also see “Views” on page 91.

¢ Scene Light
- Toggles the scene light (on or off).
¢ Transparency
- Toggles the transparency setting (on or off).
* Orthographic projection
- Enable orthographic projection (as opposed to perspective projection).
e Print
- Prints the contents of the graphics object.
e Select All

- Selects all objects.
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¢ Clear Selection
- Clear the selection of all objects.
¢ Show Selection Colors
- Enable visualization of selection colors.
¢ Show Material Color and Texture
- Enable visualization of material color and texture.

Note that the many of these commands have corresponding toolbar buttons in the
standard graphics toolbar. See the next section “Graphics Toolbar”.

Plot While Solving

To let the user monitor convergence, you can plot the results while solving. In this
example, assume that the Plot option is enabled for Results While Solving. This
option is available in the Settings window of a Study node in the model tree, as
shown in the figure below.

Settings
Time Dependent

= Compute
Label: Time Dependent =5

> Study Settings

~ Results While Solving

Plot

Plot group:  Velocity (spf) {pg1} A lE

Update at: Times stored in output -
Probes: All -
Update at: ~ Time steps taken by solver -

You can include a method that calls the built-in sleep method for briefly
displaying graphics information before switching to displaying other types of
graphics. Insert it in a command sequence after a plot command, as shown in the
figure below.

" Command lcon | Arguments
Plot Mesh 1 form1/graphics1
Plot Velocity (spf) form1/graphics1
sleepABit @

Compute Study 1 =

t{ SgiE- &
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In this example, the sleepABit method contains one line of code:
sleep(1000); // sleep for 1000 ms

For more information on the method sleep, see “sleep” on page 381.

In the command sequence above, the Plot Velocity command comes before the
Compute Study command. This ensures that the graphics object displays the
velocity plot while solving.

USING MULTIPLE GRAPHICS OBJECTS

Due to potential graphics hardware limitations on the platforms where your
application will be running, you should strive to minimize the number of graphics
objects used. This is to ensure maximum portability of your applications. In
addition, if you intend to run an application in a web browser, there may be
additional restrictions on how many graphics objects can be used. Different
combinations of hardware, operating systems, and web browsers have different
limitations.

In this context, two graphics objects with the same name but in different forms
count as two different graphics objects. For example, form1/graphics1 and
form2/graphics2 represent two different graphics objects. In addition, if a
graphics object is used in a subform (see “Form” on page 300), then each use of
that subform counts as a different graphics object.

To display many different plots in an application, you can, for example, create
buttons, toggle buttons, or radio buttons that simply plot to the same graphics
object in a form that does not use subforms.
If you need to use methods to change a plot, use the useGraphics method. For
more information on writing methods, see “The Method Editor” on page 189.
The example code below switches plot groups by reusing the same graphics object,
based on the value of a Boolean variable.

if (my_boolean) {

useGraphics(model.result("pg1"), "formi/graphicsi");
} else {
useGraphics(model.result("pg2"), "formi/graphicsi");

}

CLEARING THE CONTENTS OF A GRAPHICS OBJECT

You can clear the contents of a graphics object by a call to the useGraphics
method, such as:
useGraphics(null, "/formi/graphicsi");

which clears the contents of the graphics object graphics1 in the form form1.
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GRAPHICS TOOLBAR

The type of tree node used in the Source for Initial Graphics Content determines the
type of toolbar that is shown. The toolbar will be different depending on the space
dimension and whether the referenced source is a Geometry, Mesh, Selection, or
Plot Group node. For example, the Plot Group node displays an additional Show
Legends button.

In the Settings window of a graphics object, in the Toolbar section, you can control
whether or not to include the graphics toolbar, as well as its position (Below,
Above, Left, Right). In addition, you can choose between the options Small or Large
for lcon size, Background color, and whether to Include standard toolbar items or
not.

v Toolbar

Position: Above =
lcon size: Small =
Background color: White =

Standard toclbar
Include standard toolbar items: Default =
Place standard toclbar before custom items

Custom toolbar items

L
MName lcon | Text Tooltip

Graphics Toolbar for Geometry and Mesh

The figure below shows the standard graphics toolbar as it appears when the
Geometry or Mesh node, for a 3D model, is used as a Source for Initial Graphics
Content.

Qe @~ dmEn - (¢ BraEBRES

Graphics Toolbar for Selection

When the Source for Initial Graphics Content is set to a Selection, the graphics
toolbar will contain three additional items: Zoom to Selection, Select Box, and
Deselect Box. This is shown in the figure below.

QA B Ly wzEn/ ¢y &-@- -8B aEE @3

For more information on selections, see “Selections” on page 93.
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Graphics Toolbar for Plot Groups

The figure below shows the standard graphics toolbar as it appears when a 3D Plot
Group node is used as a Source for Initial Graphics Content.

Qa@~ B Lrerznm - o B BEO S

If the Source for Initial Graphics Content is set to an Animation node, then additional
buttons for playing the animation are added to the graphics toolbar, as shown in
the figure below.

HENEF @a@~- @ drriwm - || 8- BEO &S

Custom Graphics Toolbar Buttons

In the Toolbar section, you can also add custom buttons to the graphics toolbar.
Use the buttons under the table to add or remove custom toolbar buttons (items).
You can also move toolbar buttons up or down, add a Separator, and Edit a button.
The figure below shows a standard graphics toolbar for results with four additional
buttons to the right.

Qaf- rmErEr dr (¢ B-r R @8 Ad =S

| 89



The figure below shows the corresponding settings and table of graphics toolbar
items.

v Toolbar

Position: Above -
lcon size: Small -
Background color: Default -

Standard toclbar

Include standard toolbar items: Custom -
[*] Player: MNormal -
&, Zoom: MNormal -
<L~ Gotoview: MNormal ar
% Rotate: Normal -

Select box: MNormal -
€ Deselect box: Hidden -
View: Mormal -
& Image: Normal -

Place standard toolbar before custom items

Custom toolbar items

" MName lcon | Text Tooltip
geometry ‘)\ Geometry
optimize CJ Optimize
compute | = Compute
settings {‘:’} Settings

BEE
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To edit the command sequence for a toolbar item, click the Edit button to open
the Edit Custom Toolbar Item dialog.

3 Edit Custem Toolbar ltem

General ' Choose commands to run

Mame: outlet
Text: Qutlet
Icon: i select_boundaries.png
Tooltip: Outlet

Keyboard shorteut:  CTRL+C|
State

Visible

Enabled

0K

Cancel

3 Edit Custem Toolbar ltem

General Choose commands to run

B Forms
b @ GUI Commands
b [l Libraries
4 % Model (root)

b @ Global Definitions

4 [ Compenent 1 (compl)

4 = Definitions
4 "y, Selections

& Inlet
& Outlet
b el View 1
Run [ Plot 7 Set Value || Show || Show as Dialog | ImportFile () Enable
Disable
"
Command Icon | Arguments
Plot Outlet form1/graphics1
SafE-
oK Cancel

This dialog has settings that are similar to those of a button or a toolbar item with

the contents divided into two or three tabs depending on if the item is a toggle
item or not. For details, see “Button and Item” on page 69 and “Toolbar and

Form Toolbar” on page 342.

Views

In the graphics toolbar of an application, the Go to Default View button (for 3D

graphics only) will reset the current view to the default view. If you click the arrow

& [ [ by 1z b2 ke

Go to Default View
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next to this button, a menu will be displayed with all applicable views. The
currently active view is indicated with a check mark.

vzl S [
Go to View 1
Go to View 5

<

Go to View 6
Reset Current View

Go to VX View
Go to ZV View

FERF R

Go to ZX View

In addition to a list of all views, there is an option Reset Current View that will reset
the currently active view to the state it had when the application was launched.

ANIMATIONS

You can display animations in an application by using a Results > Animation node
as the Source for Initial Graphics Content.

Settings

Graphics

MName: graphicsl 5
Zoom to extents on first plot

~ Source for Initial Graphics Content

~ & Model (root)
> [ Component 1 (compl)
v {E| Results
Nl Electric Potential (ec)
V@ Electric Field (ec)
VB Temperature (ht)
V@ Current Density
Export
= Animation 1

@_‘Use as Source %, Clear Source =# Edit Node

Selected source:

[# Animation 1
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To run the animation, use the Form Wizard or the Editor Tools window to create
a command from, for example, a button that runs a Results > Animation node.

Settings

Button

MName: button3 =
Text: Play Animation

lcon: “LL animate_32.png - + =
Size: Large =
Style: Flat =
Tooltip:

Keyboard shortcut:
~ Choose Commands to Run ]

v {E| Results
> 2% Derived Values

EH Tables

W@ Electric Potential (ec)
Ii Electric Field (ec)

I'i Temperature (ht)

V@ Current Density

~ N& Export

[# Animation 1

oW W W v

= Edit Node Run Plot Set Value Show

Show as Dialeg Import File Enable Disable

L1
Command lcon | Arguments

Export Animation 1 = form‘l_."rahics‘l

- #

==

When using the Form Wizard or Editor Tools, the animation button will have the
following default appearance:

[LT

Play
Animation

SELECTIONS

Selections in the Model Builder

In the Model Builder, named selections let you group domains, boundaries,
edges, or points when assigning material properties, boundary conditions, and
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other model settings. You can create different types of selections, for example, by
adding subnodes under the Component > Definitions node, as shown in the figure
below. You can also create selections generated by geometry or mesh sequences.
These can be reused throughout a model component.

~ [l Component 1 {comp1)
v = Definitions

[.1;] Bounda 4= Variables
» View 1 Variable Utilities 4
> [ Geometry 1 Equation Contributions 4
> igs Materials X
> &3 Solid Mech;  "unetions '
> A Mesh 1 Selections b Explicit
LI =)
Study 1 Probes Y% Ball
> [ Results =
Physics Utilities * T8 Box
Monlocal Couplings 4 [& Cylinder
Pairs ' E Union
Coordinate Systems 4 'El: Intersection
[==  Infinite Elernent Domain o Difference
i Perfectly Matched Layer % Complement
Shared Properties [N Adjacent
Control Variables * o& Logical Expression
Surrogate Model Sarmpling 4 Selection List
Lo View )

Color Selections

@ Show More Options... Reset Colors from Theme

8 |+ @

o MNode Group Remove Selection Colors
== Group by Type
. Update Probes

H Hep F1

As an example of how selections can be used, consider selections for boundary
conditions. When you select which boundaries should be associated with a certain
boundary condition, you can click directly on those boundaries in the graphics
window of the COMSOL Desktop environment. This is the default option called
Manual selection (see below). These boundaries will then be added to a selection
that is local to that boundary condition. Named selections instead let you define
selections that can be reused for several different kinds of boundary conditions
within a Component by just selecting from a drop-down list. The figure below
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shows an Explicit selection given the name Inlet Boundaries with an associated

boundary (1).
Model Builder
- | = et Ao

v & micromixer.mph (root)
» () Global Definitions
~ [l Component 1 {comp1)
v = Definitions
2= Variables 1
_I” Step 1 (step?)
v g Selections
= Inlet Boundaries
% Outlet Boundaries
w All Fluid Domains
= All Fluid Boundaries
gy Fluid Walls
av Average 1 (aveop_inlet)
av Average 2 (aveop_outlet)
[ Boundary System 1 (sys1)
> [ View1

Geometry 1

> igi Materials

v =% Laminar Flow (spf]
s Fluid Properties 1
= Initial Values 1

Settings

Explicit
Label: Inlet Boundaries
~ Input Entities

Geometric entity level: Boundary

!

[] All boundaries
[] Group by continuous tangent

~ Qutput Entities
Selected boundaries =
v Color

Color: MNene

The figure below shows the Settings window for an Inlet boundary condition
where the Inlet Boundaries sclection is used. In this example, there are also
selections for Outlet Boundaries, All Fluid Boundaries, and Fluid Walls.

Settings
Inlet
Label: Inlet1

~ Boundary Selection

Selection: &= Inlet Boundaries {sell1}

1
m Manual
m All boundaries
v g Selections
= Inlet Boundaries {sell1}
% Outlet Boundaries {sel
% All Fluid Boundaries {s

. 5 Fluid Walls {dif1}
> Overrit =

2}
eld}

For convenience, in addition to the Manual option, there is also a shortcut for All
boundaries. The example above is available for download from this link:
www.comsol.com/model /app-with-cad-import-and-selections-86621. It
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demonstrates the use of ribbon buttons (items) for interactively selecting inlet and
outlet boundaries in a microfluidics model.

Selections in the Application Builder

The Explicit selections, created under Definitions, or by geometry or mesh
sequences, let you group domains, boundaries, edges, or points based on entity
number, and the example below illustrates how to work with this type of selection.
Explicit selections can be made interactive in an application, but other types of
selections, such as a coordinate-based Box selection, are shown in read-only mode.

You can allow the user of an application to interactively change which entities
belong to an Explicit selection with a Selection Input object or a Graphics object. In
the example below, the embedded model has a boundary condition defined with
an Explicit sclection. Both a Selection Input object and a Graphics object are used
to let the user select boundaries to be excited by an incoming wave.

0.1

-0.47]

-0.57]

-0.67]

-0.77]

T T T T
1.4 1.6 1.8 2 2.2
= B —
=3 .
7 &

The user can here select boundaries by clicking directly in the graphics window,
corresponding to the Graphics object, or by adding geometric entity numbers in a
list of boundary numbers corresponding to a Selection Input object.

To make it possible to directly select a boundary by clicking on it, you can link a
graphics object to an Explicit selection, as shown in the figure below. Select the
Explicit selection and click Use as Source. In the figure below, there are two Explicit
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selections, Excitation Boundary and Exit Boundary, and the graphics object
graphics2 is linked to the sclection Excitation Boundary.

Settings

Graphics
Mame: graphics2 =
Zoom to extents on first plot

~ Source for Initial Graphics Content

¥ Declarations
v & Model (root)
~ [l Compenent 1 (comp1)
v = Definitions
v g Selections
w Exit Boundary
5| Excitation Boundary

@_‘Use as Source %, Clear Source =# Edit Node

Selected source:

+ Excitation Boundary

When a graphics object is linked directly to a selection in this way, the graphics
object displays the geometry and the user can interact with it by clicking on the
boundaries. The boundaries will then be added (or removed) to the
corresponding selection.

To make it possible to select by number, you can link a Selection Input object to
an explicit selection. For more information, see “Selection Input” on page 321.

The Editor Tools window provides a quick way of adding a Graphics object or a
Selection Input object that is linked to an Explicit selection. To get these options,
right-click an Explicit selection node in the editor tree.

You can also let a global Event be triggered by an Explicit selection by selecting it
as the Source for Data Change Event. This allows a command sequence or method
to be run when the user clicks a geometry object, domain, face, edge, or point.
For more information on using global events, see “Events” on page 154 and
“Source For Data Change Event” on page 156.

For an example of how to use selections in an add-in, see the Application
Programming Guide.

DATA PICKING

In the Settings window for a graphics object, select the Data picking checkbox to
make the graphics object interactive so that you can, for example, click on a plot
at a particular point and retrieve a numerical value for the temperature at that
coordinate. In the figure below, in the section Target for Data Picking, a scalar
double variable Tvalue is selected. This variable is declared under the Declarations
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node. In the running application, the value of the temperature at the pointer
position will be stored in the variable Tvalue.

Settings

Graphics

MName: graphicsl 5
Zoom to extents on first plot

~ Source for Initial Graphics Content

v & Model (root)
> [ Component 1 (compl)

v {E| Results

Nl Electric Potential (ec)
V@ Electric Field (ec)

| Temperature (ht)

V@ Current Density

@_‘Use as Source %, Clear Source =# Edit Node

Selected source:

VB Temperature (ht)
~ Data Picking @+ "3
[] Enable data picking

Target for data picking

v = Declarations
v 25 Double
sl Tvalue

@_‘Use asTarget ', Clear Target Sp Edit Node
Selected target:

25 Double=TValue

If the Target for Data Picking is a 1D double array, then the stored value will instead
correspond to the x,y (2D) or x, ¥, and z coordinates at the clicked position.

The Target for Data Picking can be any one of the following:
* Scalar double variable

* 1D double array

e Domain Point Probe

* Boundary Point Probe

» Graphics Data declaration

For more information on Graphics Data declaration, see “Graphics Data” on page
185.
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Input Field

An Input Field allows a user to change the value of a parameter or variable. In the
Form Wizard, when a parameter or variable is selected, three form objects are
created:

+ A Text Label object for the parameter or variable description.

* An Input Field object for the value.

* A Unit object (if applicable) that carries the unit of measure.

By selecting a parameter or variable using the Editor Tools window, the same three
form objects are created.

Assuming you do not use the Editor Tools window: To insert an input field as a

separate form object, click the Input Field button in the Form Objects section of the
ribbon Form tab. In the Form Editor, you link an input field to a certain parameter
or variable by selecting it from the tree in the Source section and click Use as Source.
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In the Source section of the Settings window, you can also set an Initial value. The
figure below shows the Settings window for an input field.

Settings

nput Field

MName:  inputfieldl =
Editable

Tooltip:

v Source @+ "5

» = Declarations
~ < Model (root)
v () Global Definitions
~ P; Parameters 1
HE| Length (L)
8.5 Bolt radius (rad_1)

@_‘ Use as Source =g Edit Node
Selected source:
=5 Parameters 1=Length (L)
Initial value: From data source -

Value: 9
~ Data Validation

Unit dimension check: ~ Append unitto number
Unit expression: cm
Mumerical validation

Filter: Double -
[] Lower bound

Comparison type: Greater than or equal

Value: 0

[] Upper bound

Comparison type: Less than or equal

Value: 1000

Error message:

Invalid input

In addition to parameters and variables, input fields can use an Information node
variable as a source, provided the Editable checkbox for the input field is cleared.

The default setting for the Initial value is From data source. This means that if the
source is a parameter, then the initial value displayed in the input field is the same
as the value of the parameter as specified in the Parameters node in the Model

Builder. The other Initial value option is Custom value, which allows an initial value
different from that of the source. If the Editable checkbox is cleared, then the Initial
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value will be displayed by the application and cannot be changed. This makes it
possible to use an Input Field an alternative to, for example, a Text Label object for
displaying text or a Data Display object for displaying numerical values.

You can add a Tooltip with text that is shown when hovering the mouse pointer
over the input field.

The header of the Source section contains buttons for easy access to tools that are

used to make additional properties and variables available as sources to the input
field.

~ Source B + B

» = Declarat| Create New Declaration and Use It as Source

v & Model (root)  cource D+ =
» = De

— . 1= J Switch to Model Builder and Activate Data Access
~ Source @+ B ~ M

w

= D% Create New Form Declaration and Use It as Source
@ Model (root)

<

The Create New Declaration and Use It as Source button can be used to add new
variables under the Declarations node. For more information, see “Declarations”
on page 164. The Create New Form Declaration and Use It as Source button can be
used to add new variables under the Declarations nodes local to forms, as shown
below.

¥ D Main Window
~ [ Forms
v D form1

v = Declarations
abe String
Events

The Switch to Model Builder and Activate Data Access button can be used to access

low-level model properties as described in the next section. For more information
on Data Access, see “Data Access in the Form Editor” on page 110.
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DATA VALIDATION

The Data Validation section of the Settings window for an input field allows you to
validate user inputs with respect to units and values.

~ Data Validation

Unit dimension check: ~ Append unitto number
Unit expression: my
MNumerical validation
Filter: Double -
Lower bound
Comparison type: Greater than or equal -
Value: 0
Upper bound
Comparison type: Less than or equal -
Value: 1000

Error message:

Invalid input

When creating an input field in the Form Wizard, the setting Append unit to
number is used when applicable. This setting assumes that a user enters a number
into the input field, but it can also handle a number followed by a unit using the
COMSOL square bracket [] unit syntax. If the Unit expression is mm, then 1[mm]
is allowed, as well as any length unit, for example, 0.1[cm]. An incompatible unit
type will display the Error message. A parameter that has the expression 1.23[mm],
and that is used as a source, will get the appended unit mm and the initial value
displayed in the edit field will be 1.23.

The Unit dimension check list has the following options:

* None

¢ Compatible with physical quantity

¢ Compatible with unit expression

* Append unit to number (default)

¢ Append unit from unit set

A yellow squiggly underline indicates a warning when a user enters an
incompatible unit, which is a unit that cannot be converted to the units specified
in the Data Validation scttings. Enable this feature by selecting Compatible with
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physical quantity or Compatible with unit expression. In addition, the user will see
a tooltip explaining the unit mismatch, as shown in the figure below.

Length: 9lkal m
Width: 5lem] | Deduced unit is [kg], expected is [m] |
Applied voltage:  20[mV] v

Temperature: 3304 K

If there is a unit mismatch, and if no further error control is performed by the
application, the numeric value of the entered expression will be converted to the
default unit. In the above figure, 9[kg] will be converted to 9[m].

A button Add Unit Label is available to the right of the Unit dimension check list.

~ Data Validation

Unit dimension check: ~ Append unitto number v |-

Unit expression: m Add Unit Label

Clicking this button will add a unit label to the right of the input field if there is
not already a unit label placed there.

The None option does not provide unit validation.

Numerical Validation
The options Append unit to number, Append unit from unit set, and None allow you
to use a filter for numerical validation of the input numbers.

~ Data Validation

Unit dimension check: Mone -

MNumerical validation

Filter: Double -
Lower bound None
Double

Comparison type: (
Integer

Value: 0 Regular expression

The Filter list for the option None has the following options:
* None

¢ Double

* Integer

* Regular expression

The Filter list for the options Append unit to number and Append unit from unit set
only allows for the Double and Integer options.
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The Double and Integer options filter the input based on the Lower bound and
Upper bound values. If the input is outside of these values, the Error message is
displayed. You can use global parameters in these fields. If global parameters are
used, you can define such parameters with or without units. If you use global
parameters without a unit, then only the numerical value of these parameters is
considered. For example, consider data validation of an input field for a length
parameter L with unit cm. Further, assume that a global parameter Lmax is used as
the Upper bound value. If you would like the maximum value of L to be 15 cm,
then the following values for the parameter Lmax will work: 15 (with no unit),
15[cm],0.15[m], 150[mm], and so on. In the Lower bound and Upper bound ficlds,
you can use Ctrl+Space to browse available parameters and for autocompletion.

For the Append unit from unit set option, the Lower bound and Upper bound values
are always with respect to the Initial value for the unit set by the unit set. For more
information on unit sets, see “Unit Set” on page 177.

The Regular expression option, available when the Unit dimension check is set to
None, allows you to use a regular expression for matching the input string. For
more information on regular expressions, see the dynamic help. Click the help
icon in the upper-right corner of a window and search for “regular expression”.
For more advanced requirements, note that virtually any kind of validation of the
contents of an input field can be made by calling a method using the Events section
in the Settings window of an input field.

For additional information on how to use more advanced Data Validation features
and how to use method code to perform data validation, see the Application
Programming Guide.

Error Message

You can customize the text displayed by the Error message. During the
development and debugging of an application, it can sometimes be hard to deduce
from where such errors originate. Therefore, when using Test Application,
additional debugging information is displayed, as shown in the figure below.

& Error x

Prong length must be 10 to 2500 mm.

@ Details

- Form object: Input field
- Path: mainComputer/pronglengthlnput
Must be a number: 10 = x = 2500

The debugging information typically consists of the type of form object, the path
to the form object, and the reason for the failure; for example, 10<=x<=2500.
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No debugging information is added when launching an application by using the
Run Application option or COMSOL Server.

NUMBER FORMAT
The Number Format section contains a Use input display formatting checkbox. If
selected, it enables the same type of display formatting as a Data Display object.

~ MNumber Format

Use input display formatting

Precision: 4
MNotation: Automatic -

Exponent: Power of 10 -
For more information, see “Data Display” on page 107.

APPEARANCE

In addition to color and font settings, the Appearance section for an input field
contains a Text alignment setting that allows the text to be Left, Center, or Right
aligned.

~ Appearance

Text color: Inherit =
Background color:  White =
Text alignment: Left -
Font: Lt
Center

Font size: Right pt
[] Bold
[] Italic

State
Visible
Enabled

Whether the input field should be Visible or Enabled is controlled from the
checkboxes under the State subsection. For more information, see “Changing the
Enabled and Visible State of a Form Object” on page 81.
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Unit

In the Settings window for a Unit object, you can set the unit to a fixed string, or
link it to an source, such as an input field. The figure below shows the Settings
window for a unit object.

Settings

Unit

MName:  unitl =
Label: From reference -

[] LaTeX markup

~ Source for Label

~ [ Forms

v D mainComputer
[ targetFrequencylnput
1 frequencyTolerancelnput
prenglengthinput
3 radiuslnput
1 inputfieldl

¥ D mainSmartphone

& Model (root)

w

Use as Source Edit Mode

Selected source:

[ pronglengthlnput

When adding an input field using the Form Wizard, a unit object is automatically
added when applicable. By default, the unit is displayed using Unicode rendering.
As an alternative, you can use LaTeX rendering by selecting the LaTeX markup
checkbox. Then, the display of units will not depend upon the selected font.

For centralized handling of units, you can use a Unit Set. For more details, refer to
“Unit Set” on page 177.

Text Label

A Text Label object simply displays text in a form. When adding an input field using
the Form Wizard, a Text Label object is automatically added for the description
text of the associated parameter or variable. There is a checkbox allowing for
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Multiline text. If selected, the Wrap text checkbox is enabled. The figure below
shows the Settings window for a Text Label object.

Settings

Text Label

MName: textlabelPronglength 5
[] Multiline text

Text: Prong length:

~ Position and Size

Harizontal alignment: Left -
Vertical alignment: Middle -
Width: 23
Height: 20

Row:

6
Column: 1
Row span: 1

1

Column span:

Cell margin

Cell margin: From parent form -

~ Appearance

Text color: Inherit -
Background color:  Transparent =
Font: Default font -
Font size: 1l > pt
[] Bold

[] Italic

[] Underline

To insert an additional Text Label, click the Text Label button in the ribbon Form
tab, in the Form Objects section. The contents of the section Pesition and Size will
change depending on if you are working in sketch layout mode or grid layout
mode.

Data Display

A Data Display object is used to display the numerical values of scalars and arrays.
If there is an associated unit, it will be displayed as part of the Data Display object.
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The figure below shows an example with data display objects for the Derived Values
quantities Point Evaluation and Volume Maximum. A formatted unit label is
automatically displayed as part of the object if applicable.

D inputsResults: inputsResultsSection2 X

Settings
= - =
Displacementmagnitude:m Name:  datadisplayl =
Temperature: 0.001235K [] LaTeX markup

Tooltip:

v Source D+ B

» = Declarations

v 4% Model (root)

» (i) Information

» () Global Definitions
» ~db Study 1{std1}
~ {E| Results

» P; Parameters

B8.85

~ &2 Derived Values

2% Point Evaluation 1 {pevl}
max Yolume Maximum 1 {max1}

E‘l Use as Source =g Edit Node
Selected source:

2% Point Evaluation 1 {pevl}

~ Number Format
Precision: 4
Motation: Automatic =

Exponent: Power of 10 =
Append unit to number
Unit: Default -

In many cases, the Editor Tools window can be used to insert a Data Display object
accompanied by a Text Label. Right-click a node in the editor tree and select the
Output option, if available.

SOURCE

To add a Data Display object without using the Editor Tools window, open the
Settings window for a data display object. In the Source section, select a node from
the model tree. Then click the Use as Source button shown below. Valid
parameters, variables, and properties include:

e The output from a Derived Values node, such as a Global Evaluation, Point
Evaluation, or a Volume Maximum node

108 |



» Variables declared under the Declarations > Scalar, ID Array, and 2D Array
nodes

+ Properties made available by using the Data Access tool; See “Data Access in
the Form Editor” on page 110

* One of the following Information node variables, which are under the root
node and under each Study node:

- Expected Computation Time

Under the root node, this value is specified in the Expected ficld in the Settings
window of the root node.

- Last Computation Time

Under the root node: Displays the last measured computation time for the
most recently computed study.

Under a study node: Displays the last measured computation time specific to
that study.

- Computed in Version

Under the root node: Indicates the version of COMSOL Multiphysics used
for the last computed study (for example, COMSOL 6.3.0.271).

Under a study node: Indicates the version of COMSOL Multiphysics used for
the last computation of that particular study.

When you start an application for the first time, the last measured times are
reset, displaying Not available yet.

USING THE FORM WIZARD FOR GENERATING DATA DISPLAY OBJECTS

In the Form Wizard, nodes under Derived Values, as well as variables under
Declarations and constants made available through Data Access, will automatically
generate Data Display form objects to present their values and Text Label form
objects to display their descriptions.

The settings for these form objects can subsequently be edited. To insert
additional data display objects, use the Insert Object menu in the ribbon and select
Data Display.

NUMBER FORMAT

The Number Format section lets you set the Precision, Notation, Exponent, and Unit.

RENDERING METHOD

By default, the unit of a data display object is displayed using Unicode rendering.
As an alternative, you can use LaTeX rendering by selecting the LaTeX markup
checkbox. Then, the data display does not rely on the selected font.
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A formatted display of arrays and matrices is only supported with LaTeX
rendering. The figure below shows a 2D double array (see page 172) displayed
using a Data Display object with LaTeX markup selected.

0 0 08 08 07 1 1 1 1 1 1 1
0 1 05 07 15 08 06 03 02 01 01 01
0 0 08 08 07 1 1 1 1 1 1 1

You can add a Teeltip with text that is shown when hovering over the data display
object.

Data Access in the Form Editor

The Settings window of many types of form objects has a section that allows you
to select a node in a tree structure that includes the model tree, or parts of the
model tree, and parts of the application tree. Examples include the Source section
of'an input field or the Choose Commands to Run section of a button. There are
many properties in the model and application trees that are not made available by
default, because there may be hundreds or even thousands of properties, and the
full list would be unwieldy. However, these “hidden” properties may be made
available to your application by a technique called Data Access.

The remainder of this section gives an introduction to using Data Access, with
examples for input fields and buttons.

DATA ACCESS FOR INPUT FIELDS

By default, you can link input fields to parameters and variables defined in the
model tree under the Parameters or Variables nodes and to variables declared in
the application tree under the Declarations node. To access additional model tree
node properties, click the Switch to Model Builder and Activate Data Access button
in the header of the Source section of the input field Settings window, as shown in
the figure below.

~ Source @+ B

D ; : . -
MEJ Switch to Model Builder and Activate Data Access

en
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You can also access it from the Application group of the Developer tab in the Model

Builder workspace

A % Data Access

Application P Test Application

Builder

Application

or from the Home tab in the Application Builder workspace.

" Data Access

Ewl I'!w Eﬁ Record Method

Method v €8 Compiler
Main

Form ~

= settings
Editor Tools

Then, when you click on a model tree node, checkboxes appear next to the
individual settings. In the figure below, the checkbox for an Electric potential

boundary condition is selected:

File Home  Definitions Geometry Materials  Physics Mesh  Study Results  Developer
A % Data Access MNew Method Lb @
Application = apalieation E’ Eecodiiihed Method Run Run Stop |
Builder Call ~ Method ~+ Method Call ~
Application Create Methods Method Calls Run Code
Model Builder Settings
— L} FEtY Elr Ev B~ Electric Potential
ype Titertext ¢ Label:  Electric Potential 1 =
v & busbar.mph (root)
v () Global Definitions ~ Boundary Selection
Fi Parameters 1
45 Default Model Inputs Selection: i Manual v
=) Materials a3 i
~ [l Component 1 {comp1) B —
» = Definitions El
» Geometry 1 e

> igi Materials
~ +\_ Electric Currents {ec)
i Current Conservation 1
23 Electric Insulation 1
= Initial Values 1
mw Electric Potential 1
m Ground 1
» |IE) Heat Transfer in Solids (ht)
¥ .ﬁ} Multiphysics
> A Mesh 1
» ~db Study 1

> [El Results

> Override and Contribution
> Equation

~ Electric Potential

Electric potential:

Vg 0.5 v

> Constraint Settings



The figure below shows the Settings window for an input field. The list of possible
sources for this field now contains the Electric potential.

Settings

MName:  inputfield3 =5
[ ] VI Editable
Tooltip: l:‘

~ Source @+ "B

» = Declarations

& Model (root)

() Global Definitions

W Busbar (comp1)

~ +\_ Electric Currents (ec)

w

~ (m Electric Potential 1
iz Electric potential (VO]

@_‘ Use as Source =g Edit Node

Selected source:
abe Electric Potential 1=Electric potential (V0)

Initial value: From data source -

Value: Vot

In addition, as shown in the figure above, Data Access allows you to access the
Editable checkbox and the Tooltip text of the input field form object. This follows
a general pattern: Beyond the settings in the Model Builder, Data Access provides
access to certain properties within the Application Builder.

Data Access can be used for buttons to set the value of a parameter, variable, or a
model property. For example, you can create buttons for predefined mesh element
sizes. The settings shown in the figure below are available when, in the Settings
window of the Mesh node, the Sequence type is set to User-controlled mesh. In this
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example, the Predefined property for Element Size has been made available and then
selected.

Model Builder Settings
— =+ 1+ | & =t L A4 Size

Type filter text ¢ ¥ Build Selected [E§ Build All

~ @ busbar.mph (root) Label:  Size =
» () Global Definitions
~ [l Component 1 {comp1) Element Size

Definitions

Calibrate for:

> igs Materials l:‘ General physics hd
> *_ Electric Currents ec) _
il (®) Predefined -
> ) Heat Transfer in Solids (ht) * Fredenne Normal
¥ .{E Multiphysics O Custom
~ A Mesh 1 .
. > Element Size Parameters
Size
Free Tetrahedral 1
» ~db Study 1
> [El Results
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The figure below shows the Settings window for a button used to create a mesh
with Element Size > Predefined set to Fine.

Settings
Button
MName: button3 E
Text: l:‘ Fine
lcon: l:‘ /& mesh 32png + + =
* . 1 Size: Large =
_,f_\\ Style: Outlined -
. A .
Fine Tooltip: l:‘
= - - Keyboard shortcut:
v Choose Commands to Run A

» W Geometry 1

» g Materials

> % Electric Currents (ec)

» |IE) Heat Transfer in Solids (ht)
> .y Multiphysics

~ /M Mesh1

Size

8.5 Predefined size (hauto)
% Free Tetrahedral 1

» ~db Study 1

> [E Results

=y Edit Node Run [Z& Plot Z# Set Value Show
Show as Dialog Import File Enable Disable

<

L
Command lcon | Arguments
Set hauto of Size i |4
Plot Mesh 1 graphics1
u B

In the above example, a Set Value command is used to set the value of the
Predefined mesh size (hauto) property. The property Predefined mesh size (hauto)
corresponds to the following settings in the Size node shown earlier:

PREDEFINED MESH SIZE VALUE
Extremely fine 1
Extra fine - Extra coarse 2-8
Extremely coarse 9

The value of the hauto property is a double and can take any non-negative value.
For non-integer values, linear interpolation is used for the custom mesh
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parameters. You can, for example, let a slider object adjust the predefined mesh
size. For more information on the slider object, see “Slider” on page 336.

In general, for individual model tree properties, you can quickly learn about their
allowed values by recording code while changing their values and then reviewing
the automatically generated code. For more information, see “Recording Code”
on page 199.

You can also use a combo box object to give direct access to all of the options from
Extremely fine through Extremely coarse. For more information, see “Combo Box”
on page 253.

SUMMARY OF DATA ACCESS

The table below summarizes the availability of Data Access for form objects and
events, as well as menu, toolbar, and ribbon items.

FORM OBJECT, EVENT, OR ITEM SECTION IN SETTINGS WINDOW

Input Field Source
Button Choose Commands to Run

Toggle Button, Menu Toggle ltem,  Source and Choose Commands to Run
and Ribbon Toggle Item

Checkbox Source
Combo Box Source
Data Display Source

Graphics (Graphics Toolbar Item)  Choose Commands to Run

Form Collection

Card Stack

Information Card Stack
Radio Button

Text

List Box

Slider

Toolbar and Form Toolbar
(Toolbar Item)

Menu ltem
Ribbon Item
Event (Global)

Active Pane Selector
Tiled or Tabbed

Active Card Selector

Active Information Card Selector
Source

Source

Source

Source

Choose Commands to Run

Choose Commands to Run
Choose Commands to Run

Choose Commands to Run

Source for Data Change Event
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A global event, menu, ribbon, or toolbar item provides a Choose Commands to Run
section in its Settings window, to which the functionality described above in the
section on buttons also applies. Global events and many form objects provide a
Source section in its Settings window, and the functionality described above in the
section on input fields applies. For information on global events, menus, ribbons,
and toolbar items, see “Graphics Toolbar” on page 88, “The Main Window
Editor” on page 141, “Events” on page 154, “Table” on page 330, and “Toolbar
and Form Toolbar” on page 342.

Sketch and Grid Layout

The Form Editor provides two layout modes for positioning form objects: sketch
layout mode and grid layout mode:

+ Sketch layout mode allows you to define fixed positions and sizes for objects
in pixels. This mode is typically used for simpler layouts, such as dialog
windows.

* Grid layout mode positions and sizes objects based on a background grid
with cells. In this mode, a form is divided into intersecting rows and
columns, with at most one form object per intersection. This layout mode is
recommended for designing resizable user interfaces, especially for
applications intended to run in web browsers across multiple platforms.

SKETCH LAYOUT

Switch between sketch and grid layout mode by clicking Sketch or Grid in the
Layout group in the ribbon Form tab.
HH Grid

£ Sketch Show Arrange

Grid Lines v

Layout Sketch
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The Sketch section in the Form tab has two options: Show Grid Lines and Arrange.
The Arrange menu allows you to align groups of form objects relative to each

[o]a] Row Settings +

other.
s
on
Show Arrange
Grid Lines v

ket |7 Align Left
jform‘l |:[| Align Center
[1 align Right

O Align Top
i align Middle
| Align Bottom

Sketch Grid

Column Settings ~

The Show Grid Lines option displays a sketch grid to which objects are snapped.
Note that the grid used in sketch layout mode is different from the grid used in
grid layout mode. The default setting for sketch layout mode is to show no grid
lines. Without grid lines visible, a form object being dragged is snapped relative to

the position of the other form objects.

If the Show Grid Lines option is selected, the upper left corner of a form object
being dragged is snapped to the grid line intersection points.

[ Grid e [o[4]
&
St Show | Amange
GridLlines v

Layout Sketeh
Q) Preview  [Jforml x

v

>

Length: 9 e
Width: 5 em
Applied voltage: 20 mv
Temperature: 0001235 K

Compute

-
>
Show Test
Errors Application Chal

Preview
Form

Editor Errors Test

laa@a-@ -tk ¢ <-B- DED @8



In the Settings window of the form, you can change the settings for the sketch
grid:
¢ Column width
¢ Row height
* Align grid to margin
¢ Snap zone
- Aslider allows you to change the snap zone size from Small to Large
¢ Snap only to grid
- Clear this checkbox to snap both to the grid and the position of other form
objects

~ Sketch Grid

Column width: 100
Row height: 20
[] Align grid te margin

Snap zone:
o .

Small Large
Snap only to grid

Position and Size

The sketch layout mode is pixel based, and the positioning of form objects is
indicated as the coordinates of the top-left corner of the form object measured
from the top-left corner of the screen. The x-coordinate increases as the object
moves to the right, and the y-coordinate increases as the object moves from the
top of the screen to the bottom. You can set the absolute position of a form object
in the Position and Size scction of its Settings window.

v Position and Size

Width: Manual A
20

Height: Manual A
20

Positionx: 180

Positiony: 240

Form objects are allotted as much space as required or as specified by their Width

and Height values. Form objects are allowed to overlap, when working in sketch
layout mode.
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Button and toggle button form objects, with their Size setting set to Large, have
an Automatic and Manual option for the Width and Height values. The Manual
option allows for pixel-based input and the Automatic option adapts the size of the
button to the size of the Text string.

GRID LAYOUT
Switch to grid layout mode by clicking Grid in the Layout group in the ribbon.
] Grid

1 Sketch - N Column Settings ~ Remove ~

n@j Rows & Columns

Layout Sketch Grid

The buttons and menus in the ribbon Grid group give you easy access to
commands for:

+ Changing the row and column growth rules between Fit, Grow, and Fixed,
which determine the layout when the user interface is resized (Row Settings
and Column Settings).

 Inserting or removing rows and columns (Insert and Remove).
» Aligning form objects within grid cells (Align).
* Merging and splitting cells (Merge Cells and Split Cells).

» Extracting a rectangular array of cells as a subform and inserting it into a new
form (Extract Subform).

e Defining the number of rows and columns (Rows & Columns).
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The Form Settings Window and the Grid
After switching to grid layout mode, the form window shows blue grid lines.

[&] Preview [ mainComputer X
v -

= & ) Eg o [ 7] Ly

Geometry Compute Plot Sound Report Reset Help

Geometry & Material Qa@- Lr el G 4 B @ @e
Find prong lengtl

Target freguency: 440

Frequency tolerance: 01 Hz
Prang length: L, 75 mm
Radius: r 25 mm
Material: Steel b
[ S
s | S—
s
P e——
Tr
Sound
Play sound when computed
Sound duration: 1 s
Computed frequency: 0 Hz

To review the example shown here, open the Tuning Fork application from the
Application Libraries under COMSOL Multiphysics > Applications.

To define the number of rows and columns, click the Rows & Columns button in
the ribbon.
O3 Rows & Columns *

Rows: 15
Columns: &

oK Cancel
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The section Grid Layout for Contained Form Objects in the Settings window shows

column widths and row heights.

~ (Grid Layout for Contained Form Objects

L

1
2
3

3

Column | Width
Fit
Fit
Fit
Fit
Fixed
Fit
Grow

Row Height

Fit
Fit
Fit

-

-

-

Size
N/A
MN/A
N/A
N/A
96
N/A
N/A

Size
N/A
N/A
N/A

To interactively select a form, as displayed in the Form Editor, click the top-left

corner of the form, or select the form in the application tree.

Georr

A blue frame is now shown. To interactively change the overall size of a form, you
can drag its right and bottom border. The form does not need to be selected for
this to work.

Note that if you switch from sketch to grid layout mode, all rows and columns will
have the setting Fit and the handles for the frame will not be displayed. If any of
the rows and columns have the Height or Width sctting set to Grow, then the frame
will display handles for resizing in the vertical or horizontal direction, respectively.
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The size of the interactively resized frame will affect the initial size of the form only
if the Initial size setting is set to Automatic. The size of the frame will also affect the
initial size of the Main Window if its Initial size setting is set to Use main form’s size.

Settings

Form

form1
l:‘ main

Default =
Show in Model Builder

MName:
Title:

lcon:

~ Size

Initial size: Automatic

| Automatic

> Margin panyal

Rows and Columns

Settings
Main Window
~ General

Title:
[] Show filename in title
tuning_fork_main_%}l.png - 4+

Classic menu

Tuning Fork

lcon:
Menu type:
Main window type: Single window

Status bar: MNeone

~ Main Form

Form: main hd

Prefer inner scrollbars
v Size

Initial size: Maximized

=

[] Center 0| Maximized

Use main form's size
v About Manual

Click the leftmost cell of a row to select it. The leftmost cells are only used for

selecting rows; form objects cannot be inserted there. When a row is selected, the
Row Settings menu as well as the Insert and Remove commands are enabled in the
ribbon tab. The figure below shows the fourth row highlighted.

Geometry  Compute

Geometry & Material
Find prong Ieng
Target frequency:

Frequency tolerance:

Prong length: L

Radius: r
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Similarly, to select a column, click the cell at the top. This cell cannot contain any
form objects. The figure below shows the third column highlighted. In this case,
the Column Settings menu is enabled in the ribbon tab.

> Form T o
A = |@ m
i Geometry Compute Plot Sound
Geometry & Material
Find prong Ieng
Target frequency: 440 Hz
Frequency tolerance: 0.1 Hz
Prong length: L, |75 = mm

The Row Settings and the Column Settings have the same three options:

* Fit scts the row height or column width to the smallest possible value given
the size of the form objects in that row or column.

* Grow scts the row height or column width to grow proportionally to the
overall size of the form.

* Fixed sets a fixed value for the number of pixels for the row height or column

width.

EH Fit Row
% Grow Row
E Fixed Row

T =
i [| i Column Settings ~
L Ins

HB Fit Column
HE Grow Column

[D] Fixed Column

You can interactively change the row height and column width by dragging the

grid lines.

v

>£\

Geometry

In this case, the number of pixels will be displayed and the Row Settings or Column
Settings growth policy will be changed automatically to Fixed.
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As an alternative to changing the Row Settings or Column Settings from the ribbon,
you can right-click in a row or column (the light-blue area to the left or at the top
of the form) and select from a menu.

I_ E] Local Form -

New Method
Form Objects 3

Scalar 3
Array 1D 3
Array 2D 3
<z»  Choice List
EH Fit Row
% Grow Row
= Fixed Row
E Insert Above
a Insert Below
E. Remove Row
@ Extract Subform
Zoom 100% 3
Copy as Code to Clipboard 3
SooCut Ctrl+X
E] Copy Ctrl+C
[F] Duplicate Ctrl+Shift+D
= Group Ctrl+G
Delete Del
=[ Rename F2
Settings

B
H Hep F1

The menu shown when right-clicking a row or column also gives you options for
inserting, removing, copying, pasting, and duplicating rows or columns.

Cells

Click an individual cell to select it. A selected cell is shown with deeper blue grid
lines.

he 5 cm

You can select Merge Cells and Split Cells to adjust the cell size and layout of your
form objects.
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When in grid layout mode, you can specify the margins that are added between
the form object and the borders of its containing cell.

~ Position and Size

Harizontal alignment: Fill =

Vertical alignment: Middle =

Minimum width: Manual -
90

Height: 17

Row: 2

Column: 2

Row span: 1

Column span: 3

Cell margin

Cell margin: From parent form -
MNone

> Appearance From parent form

> Events Custar

In the Settings window of a form object, the Position and Size section has the
following options for Cell margin:
* None
- No cell margins
* From parent form (default)
- The margins specified in the Settings window of the form; See “Inherit
Columns and Cell Margins” on page 130
* Custom

- Custom margins applied only to this form object

If the Horizontal alignment or Vertical alignment is set to Fill and the growth policy
of the column or row allows the form object to be resized, then you can specify a
minimum width or height, respectively. The minimum size can be set to Manual
or Automatic. The Manual option lets you specify a pixel value for the minimum
size. The Automatic option allows for a minimum size of zero pixels, unless the
form object contents require a higher value. The minimum size setting is used at
runtime to ensure that scroll bars are shown before the form object shrinks below
its minimum size.

Depending on the type of form object contained in a cell, the Width and Height
values can be set to Automatic or Manual, as described in “Position and Size” on
page 118.

You can click and drag a rubber box to select multiple cells.
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Aligning Form Objects

The Align menu gives you options for aligning form objects within a cell. You can
also let a form object dynamically fill a cell horizontally or vertically.

||:| Merge Cells
(=}
Align HH split Cel
¥ @ Extract Subform

= Fill Horizentally

Align Left
Align Center
Align Right
Fill Vertically
Align Top
Align Middle

Align Bottom

As an alternative, you can right-click a form object and select from a context menu.

7| | @ =

Report Reset Help Home

=

Create Local Method
Edit Method

Align Fill Horizontally
Row Align Left
Column Align Center
5] Extract Subform Align Right
Copy as Code to Clipboard Fill Vertically
i cut Ctrl+X Align Top
[ Copy Ctrl+C Align Middle
|_:E| Duplicate Ctrl+Shift+D Align Bottom
M Delete Del
5 Settings
Help F1
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Drag and Drop Form Objects

You can drag and drop form objects to move them. Click a form object to select
it, and then drag it to another cell that is not already occupied with another form
object.

Thermal conductivity: 0,559 Wil K)
Heat of reaction: -84666 = Jimol
| Compute = |

If you drop the object in an already occupied cell, then the objects switch places.

Automatic Resizing of Graphics Objects

If you use one of the more sophisticated Form Wizard templates you will
automatically get a layout with a resizable graphics object.

If you do not use these templates, then, in order to make the graphics object of an
application resizable, follow these steps:

» Change the layout mode of the form containing the graphics object from
sketch to grid layout mode.

* Change the Height setting for any row covering the graphics object to Grow.
To change this, click the leftmost column of the row you would like to
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access. Then, change the Height setting in the Settings window of the form.
Alternatively, right-click and select Grow Row.

E] Local Form

New Method
Form Objects 3
Scalar r
Array 1D 3
Array 2D 3

<z»  Choice List

e

Fit Row
Grow Row

Fixed Row

Insert Above

W0 M (I ER

Insert Below

mm

.. Remove Row

Extract Subform

o

Zoom 100% 3
Copy as Code to Clipboard 3
5 Cut Ctrl+X
E] Copy Ctrl+C
[F] Duplicate Ctrl+Shift+D
= Group Ctrl+G
Delete Del
=[ Rename F2
5 Settings
H Hep F1
+ Change the Width for any column covering the graphics object to Grow. To

change this, right-click the uppermost row of the column you would like to
access and select Grow Column.

* Select the graphics object and change both the Horizontal alignment and
Vertical alignment to Fill. You can do this from the Settings window or by
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right-clicking the graphics object and selecting Align > Fill Horizontally and
Align > Fill Vertically.

Create Local Method

Align » = Fill Horizontally

Row 3 i Align Left
Column 4 Align Center
r5l Extract Subform Align Right
Copy as Code to Clipboard » Fill Vertically
g6 Cut Ctrl+X Align Top
[l Copy Ctrl+C Align Middle
[ Duplicate Ctrl+Shift+D : Align Bettom
M Delete Del
5 Settings
Help F1

Following the steps above, you may find it easier to make graphics objects
resizable by performing grid layout mode operations, such as adding empty rows
and columns as well as merging cells. If you are already in grid layout mode, then
a graphics object will default to Fill in both directions.

Extracting Subforms

You can select a rectangular array of cells in a form and move it to a new form.
First, select the cells by using Ctrl+click or Shift+click.

Sound

Play sound when computed

Sound duration: 1 5
Computed frequency: 1] Hz

Then, click the Extract Subform button in the ribbon.

Merge Cells B Rows & Col
|D|:| erge Ce mE ows & Columns
. Split Cell
Align e
¥ @ Extract Subform
Grid
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This operation creates a new form with the selected cells and replaces the original
cells with a form object of type Form. In the Settings window of the subform, the
Form reference points to the new form containing the original cells.

@ Preview D mainComputer X D mainComputer: form1 Sett| ngS
v
Form
o form . ToTTTTTmTmEmTmmEEmmmE

MName:  subform3

>‘5\ = &3 'l))) @ Form: E] form1

Geometry Compute Plot Sound Report [ Add bord
order
R
; ~ Position and Size
Geometry & Material aQ
Find prong Ieng Horizontal alignment:  Fill
Target frequency: 440 Hz Vertical alignment: Fill
Frequency tolerance: 0.1 Hz Minimum width: Automatic
Prong length: Lp g mm Minimum height: Automatic
Radius: r 25 i Row: 12
[ B Column: 1
Material: Steel v Row span: 3
\ “-p Column span: 4

| Cell margin

” T

| r ~ Appearance
Sonind Visible
@ Preview D mainComputer D mainComputer: form1 X Enabled
A
» I I
Sound duration: 1 5
Computed frequency: 1] Hz

Inherit Columns and Cell Margins

By using form collections, forms, and subforms, you can organize your user
interface, for example, by grouping sets of input forms. The figure below shows
part of a running application with a form collection using sections, forms, and
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subforms for Mixer properties, Blade properties, Operating Conditions, Results, and
Information.

v Geometry

Mixer properties

Radius: 5.0 rmm
Inlet length: 12 mm
Outlet length: 18 mm
Total length: 150 mm

Blade properties

Mumber of blades: 5 -
Length: 24 mm
Thickness: 1.0 mm

~ Operating Conditions

Average velocity: 5.0 cm/s
Liquid density: 1.0e3 kg/m?
Liquid viscosity: 1.0e-2 Pas
~ Results

Values after last blade

Average contact probability:

Maximum dimensionless concentration:
Minimum dimensionless concentration:

Pressure loss from the first blade's inlet side: MaM Pa

~ Information

Expected computation time with default settings

Coarse mesh size: 4 min
Mormal mesh size: 8 min
Fine mesh size: 16 min

For more information on adding subforms to a form, see the previous section and
“Form” on page 300.

To review the example shown here, open the Helical Static Mixer application from
the Application Libraries under COMSOL Multiphysics > Applications. In this
example, the Application theme sctting, available in the Themes node in the
application tree, is set to Default, whereas in the saved example it is set to Dark.

When aligning forms vertically, as in the example above, you may want to ensure
that all columns are of equal width. For this purpose, you can use the Inherit
columns option in the Settings window of a subform. The figure below shows part
of the Settings window for the Operating Conditions form (left) with Name
operatingConditions and for the Mixer properties form (right) with Name
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mixerProperties. The mixerProperties form has its Inherit columns set to the
form operatingConditions.

Settings Settings
Form Form
Name: operatingConditions = Mame:  mixerProperties =
Titlee  Operating Conditions Title:  Mixer properties
lcon: Default = lcon: Default |
Show in Model Build :
[] Show in Maodel Builder o
2 £ > Margins
> Margins s -
> Dialog Settings
2§ Dialog Settings ~ Grid Layout for Contained Form Objects
~ Grid Layout for Contained Form Objects "
Row Height Size
L3
Column | Width Size 1 Fit > |N/A
1 Fixed  ||200 2 Fit - |N/A
7 Grow * [N/A 3 Fit * N/A
3 Grow * |N/A 4 Fit ~ |N/A
4 Fit v ||N/A : : = B
Inherit columns: DoperatlngCondltlons > | (=4
L3 x
Row Height Size Cell margins
1 Fit - |N/A Haorizontal: 5
2 Fit - |[n/A Vertical: 3
3 Fit * [N/A
Inherit columns: MNone -
Cell margins
Horizontal: 5
Vertical: 3

In the subsection Cell margins, you can specify the Horizontal and Vertical margins
that are added between form objects and the borders of their containing cells.
These settings will affect all form objects contained in the form, with their
individual Cell margins sct to From parent form; See “Cells” on page 124.
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Show Errors

When using the Form Editor or Main Window Editor, there is a toggle button
Show Errors in the ribbon.

[l = Insert ~ i — (3) Apply Changes
m B 5 @ (S E >
@ [ « [2X] Ra ve v iEw
(o] More hu Show Arrange Remove v [ Show Test E] Preview Form
[+ [m Objects~ ES - |F=. Align ~ = Errors Application E Test in Web Browser
Form Objects Layout Sketch Grid Editor Errors Test
App' ication Bu | |der @ Preview D geometry: mixerProperties X
v
- - A _
i L =
L Radius: 5.0 ) EJ mm
w E] helical_static_mixer.rmph (root) Inlet length: 12 = mm
1=
ﬁ Inputs Outlet length: 18 = mm
B Themes Total length 150 i
> [ Main Window otal length: = mm
~ [ Forms
D settings
D graphics

D operatingConditions
~ ':j geometry

~ [ Forms

';j mixerProperties
E] bladeProperties

When enabled, any object that is in an error or warning state, for example, a
missing source for an input field object, will show an icon in the corner of that
object. In addition, a similar error or warning icon will be shown in the application
tree. This makes it easy to locate errors in a form or main window design. By
default, the Show Errors button is disabled.

Copying Between Applications

You can copy and paste forms and form objects between multiple COMSOL
Multiphysics sessions running simultaneously. You can also copy and paste within
one session from the current application to a newly loaded application.

In grid layout mode, a cell, multiple cells, entire rows, and entire columns may be
copied between sessions.

When you copy and paste forms and form objects between applications, the copied
objects may contain references to other forms and form objects. Such references
may or may not be meaningful in the application to which they are copied. For
more information on the set of rules applied when pasting objects, see “Appendix
B — Copying Between Applications” on page 346.
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When copying and pasting between applications, a message dialog will appear if a
potential compatibility issue is detected. In this case, you can choose to cancel the
paste operation.

Using Forms in the Model Builder

Forms without graphics form objects can be used in the Model Builder. You can
use this functionality to create customized Settings windows for, for example,
common or repetitive tasks.

To use a form, right-click Global Definitions and select the form under Settings

Forms.

Model Builder

— = Et -

~ & busbar.mph (root)
v (1) Global Definitions
Fi Parameters 1 {default}
4 Default Model Inputs {eminpt]
2 Materials
> [l Component 1 (comp 1) {comp 1}
» ~db Study 1{std 1}
v {E| Results
Datasets
% Derived Values
EH Tables
I'.’ Electric Potential (ec) {pg1}
I'.’ Electric Field (ec) {pg2}
VB Temperature (ht) {pg3}
W& Current Density {pgd

oW W W v
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Geometry Parts
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+  Default Model Inputs
Materials
Lead and Constraint Groups
Thermodynamics

Parameter Estimation

!'-: Cosimulation for Simulink
Settings Forms
S Show More Options...

Mode Group

D busbarControls



You can control whether a form should be visible or not in the Model Builder as
a Settings Form via the Show in Model Builder checkbox. This checkbox is available
in the Application Builder in the Settings window of the corresponding form.

Settings

Form
Mame:  busbarControls =
Title: Busbar Controls

lcon: Default ~| |4
Show in Madel Builder

Once added to the model tree, the form is shown as a Settings window, shown in
the figure below.

Model Builder Settings

= E Busbar Controls

+— = =t~
MocIeITreeNocIeText o] .

v & busbar.mph (root)

v () Global Definitions Length: 9 cm
Fi Parameters 1 Width: g i
45 Default Model Inputs ;
Materials Applied voltage: 20 my
™ Busbar Controls 1 Temperature: 3304 K

> [l Compenent 1 (comp1)

» ~db Study 1 >Z_\
A\

v Results

@' Geometry
>

> B Tables

> I'ﬁ Electric Potential (ec) —

> Ni@ Electric Field (ec) Compute
> Nl Ternperature (ht)

> Nl Current Density

Export
[# Reports

To show a Settings Form you can:

* Click the corresponding model tree node.
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» Sclect it from the Settings Form menu button in the Developer tab in the
ribbon.

» Show it as a dialog by selecting it from the Show Dialog menu button in the
Developer tab in the ribbon.

Developer
t’ Pt —
® =
Stop Break Java Settings  Update Show
- Shell Form « Forms  Dialog ~
“ode Farms

For reusing a Settings Form between sessions, you can create an Add-in. For more
information, see “Creating Add-ins” on page 234.
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Inputs

When starting an application from the operating system command line, you can

provide input arguments. In the application tree, you specify such input
arguments under the Inputs node.

Application Builder -
— Etv Elv ¥~ |:@

v [&] my_app_input.mph (root)
v ﬁ Inputs
freq
% Themes

¥ D Main Window

Command-line arguments are automatically written to the declarations you define
as Selected source, in the corresponding Settings window for an Application

Argument. They can be used, for example, to provide input data or configuration
settings.

Settings
MName: freq

~ Source

~ Declarations

» abc String
» E Boolean
v

5.5 Double
s fq
= targetfq
=5 fqtol
» 122 Integer

Use as Source Edit Node

Selected source:

=5 Double=targetfq

~ Help Text

The target frequency of the simulation.

Command-line arguments can be used when starting applications with COMSOL
Multiphysics, COMSOL Server, as well as when starting applications that have
been compiled with COMSOL Compiler. In the example below, for a compiled
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application in Windows®

value 400.

, an input argument freq is given that takes a (double)

BEX Administrator: Command Prompt — O »

For COMSOL Multiphysics, the corresponding command would be
comsol.exe -run myapp.mph -appargnames freq -appargvalues 400
When running this command, you need to be positioned in the COMSOL

Multiphysics installation directory where the executable comsol. exe is located, for
example

C:\Program Files\COMSOL\COMSOL63\Multiphysics\bin\win64
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Alternatively, you can copy and paste the COMSOL Multiphysics 6.3 Windows®
Desktop shortcuticon (in order to keep the original shortcut), right-click the icon,
and select Properties; as shown in the figure below.

= ~

12 COMSOL Multiphysics 6.3 Properties *
Security Details Previous Versions
General Shortcut Compatibility

}] COMSOL Muttiphysics 6.3

Target type: Application

Target location: wing4

Target: OMSOLEI Multiphysicsbinwinb4\comsol exe'|
Start in: "C:\Program Files\COMSOLNCOMSOLE3 \Multiph

Shortcut key:  [MNone

Run: Nomal window ~
Comment:
Open File Location Change Icon... Advanced...

. d

You can, for example, modify the Target text field to be:

"C:\Program Files\COMSOL\COMSOL63\Multiphysics\bin\win64\comsol.exe" -run
myapp.mph -appargnames freq -appargvalues 400

To provide input arguments with special characters, you need to use single quotes.

The following example of a compiled application shows how to provide a file path,
such as for a configuration file, as an input argument:

myapp.exe -appargnames configfile -appargvalues 'C:\\COMSOL\\my_conf.dat'

If you have multiple input arguments, they are separated by commas, for example:

myapp.exe -appargnames a,b,configfile -appargvalues
3.2,5.4,'C:\\COMSOL\\my_conf.dat"'

For COMSOL Server, you can provide the arguments directly in the address field
of your browser (URL); for example:

http://<host:port>/app/myapp_mph?appargnames=freq&appargvalues=400
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You can also use a file declaration as an input argument. This is useful, for example,
when you want to let users supply input files. For example:
comsol.exe -run file_arguments.mph -appargnames interpfile -appargvalues
'C:\data\functions\simpleinterp.txt'
This example uses an application argument interpfile, which is linked to a file
declaration to read the interpolation file simpleinterp.txt when launching the
application. This file is then used in an interpolation function in the application’s
embedded model.
Note that in order to use units, you need to use nested quotes. For example,
-appargvalues "'500[m]','500[s]"'".
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The Main Window Editor

In the application tree, the Main Window node represents the main window of an
application and is also the top-level node for the user interface. It contains the
window layout, the main menu specification, and optional ribbon, and
subwindow specifications. The Main Window Editor, visible whenever the Main
Window node is active, lets you design menu bars, ribbon tabs, and subwindows.

GENERAL

The Settings window contains a General section with the following settings:
o Title

¢ Show filename in title

* lcon

¢ Menu type

* Main window type

+ Status bar

Settings

vial

~ General

Title: Helical Static Mixer
Show filename in title

lcon: Default = &

Menu type: Ribbon >
Main window type: Single window -
Status bar: Progress .

The Title is the text at the top of the main window in an application, with the Icon
shown to the far left of this text. By default, the Title is the same as the title of the
model used to create the application. Keep the Show filename in title checkbox
selected if you wish to display the file name of the application to the left of the
Title.

In the leon list, select an image from the library or add an image (*.png) from the
local file system to the library and use it as an icon. If you add a new image, it will
be added to the image library and thereby embedded into the application. You can
also export an icon by clicking the Export button to the right of the Add Image to
Library and Use Here button.
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The Main Window node in the application tree has two child nodes, the names and
purposes of which depend on the Menu type setting. There are two available Menu
type options: Ribbon and Classic menu. By default, the menu type is set to Ribbon,
which includes the child nodes File Menu and Ribbon. When the Classic menu type
is selected, the child nodes arc Menu Bar and Toolbar.

The Main window type sctting lets you select the type of application layout:
Subwindows or Single window. The Subwindows option makes it possible to
organize forms into subwindows that, while the application is running, can be
detached and docked.

The Status bar list controls what is shown in the status bar. From the list, select
the Progress option to display a progress bar, otherwise, select None. Note that you
can also create custom progress bars by writing method code.

MAIN FORM
The Main Form section is visible if the Main window type is sct to Single window. It
contains a reference to the form that the main window displays.

v Main Form

Form:  settings | 3

Prefer inner scrollbars

This setting is important when using a form collection because it determines
which form is displayed as the main window when the application is opened for
the first time.

WINDOW LAYOUT

The Window Layout section is visible if the Main window type is sct to Subwindows.
¥ Window Layout

Column Width
1 50
2 130

Row Height
1 100
[] Allow dragging between subwindows

[] Show form header in subwindows with a single form

Subwindows can be defined in the lower part of the Main Window Editor. You
work with subwindows in a way that is similar to forms when in grid mode. For
more information, see “Subwindows” on page 150.
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SIZE

In the Size section, the Initial size setting determines the size of the main window
when the application is first started.

~ Size

Initial size: Maximized =

[] Center on screen

There are two or three Initial size options, depending on the Main window type

setting:

* Maximized results in the window being maximized when the application is
run.

» For the Single window option, Use main form's size uses the size of the main
form; See “The Individual Form Settings Windows” on page 57. The main
form is defined by the Main Form section. This option further adds the size
required by the main window itself, including: the window frame and title
bar, main menu, main toolbar, and ribbon. This size is computed
automatically.

* Manual lets you enter the pixel size for the width and height. In this case,
nothing is added to the width and height. When using this option, you need
to ensure that there is enough room for the window title, ribbon, and menu
bar.

In addition, there is a Center on screen checkbox that is applicable to any Size
setting that does not correspond to a maximized window.

When the Main window type is set to Subwindows, the Use main form's size option
is not applicable and is therefore removed. In this case, the Initial size is changed
to Maximized.

For more information on the Use main form’s size option, see “The Form Settings
Window and the Grid” on page 120.

ABOUT DIALOG

The About Dialog section contains settings for customizing parts of the About This
Application dialog, which contains legal information.
~ About Dialog

Placement: Automatic =
Show COMSOL information

Custom text:
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The Placement option lets you choose between Automatic, File menu, Ribbon,
Lower-right corner, or Lower-left corner. The Lower-right corner and Lower-left
corner options are available only when the Main window type is set to Single window
and will place a hyperlink referencing the About This Application dialog in the
corresponding corner of the application user interface. If selected, the Show
COMSOL information checkbox will display the COMSOL software version and
product information. Any text entered in the Custom text field will be displayed
above the legal text in the dialog. In the Custom text field, words containing https
or www will be interpreted as hyperlinks, if possible. For example,
https://www.comsol.com or www.comsol.com will be replaced with a hyperlink.

LANGUAGE LOCALIZATION

The Language Localization section contains settings for the localization of the
application.

~ Language Localization

Localization

Language: From preferences -
From preferences
tubular_reactor_en_US.properties (English)
tubular_reactor_de_DE.properties (German)
tubular_reactor_zh_CM.properties (Chinese, simplified)

The Localization setting determines whether the application should be localized
using language files or not and is disabled by default. The Language setting
specifies the language files that are used for localization. By default, the From
preferences option is selected and the language used when running the application
is determined by the language preference setting in COMSOL Multiphysics,
COMSOL Server, or a compiled application. For more information on
localization, see the Application Builder Reference Manual.
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Menu Bar and Toolbar

The Menu Bar node can have Menu child nodes that represent menus at the top
level of the Main Window.

v [&] Untitled.mph (root)
ﬁ Inputs
% Themes

v D Main Window
~ [Z] FileMenu
v [Z] File fmenu}
El Save {item 1}
El Save As {item2]
EI Menu 2 {menuZ}
EI Menu 3 {menu3}
[+ Ribbon
> B Forms
Events
= Declarations

> [ Methods

For the Menu Bar option, a Toolbar node is made available. The Toolbar node and
the Menu nodes have the same type of child nodes.

w

4 [&] Untitled.mph [root)
E Inputs
% Themes

- D Main Window
- E Menu Bar
4 [Z] File {menu}
El Save {item1}
El Save As {item2}
EI Menu 2 {menu2}
EI Menu 3 {menu3}
i Toolbar
b B Forms
Events
[ = Declarations
I [y Methods
b [ Libraries
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MENU, ITEM, AND SEPARATOR

The child nodes of the Menu and Toolbar nodes can be of type Menu, Item, Toggle
Item, or Separator, exemplified in the figure below:7

4 [&] Untitled.mph [root)
E Inputs
% Themes

- D Main Window
- E Menu Bar
4 [Z] File {menu}
El Save {item1}
El Save As {item2}

=]

El Report {item3}

[ Exit {itemd}
4 EI Menu 2 {menu2}
] ttem 1 fitem1}
Toggle ltem 1 {toggle_item1}
@ Menu 3 {menu3}
4 ¥u Toolbar

] ttem 1 fitem1}

4 EI Menu 1 {menul}
[ ttem 1 fitem1}
Toggle ltem 1 {toggle_item1}

[ % Forms
A Menu node has settings for Name and Title.

Settings
Menu
MName:  menul

Title: Menu 1

A Menu node can have child Menu nodes that represent submenus.

A Separator displays a horizontal line between groups of menus and items, and has
no settings.

The Settings window for an Item node is similar to that of a button and contains a
sequence of commands. Just like a button, an item can have associated text, an
icon, and a keyboard shortcut. For more information, see “Button and Item” on
page 69. In a similar way, the Settings window for a Toggle Item node is similar to
that of a toggle button.
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The figure below shows the Settings window for an Item associated with a method
for saving an application using the command Save Application As.

Settings
Item
Marme: savels =
Text: Save As
lcon: [4] save as.png - + B
Keyboard shortcut: CTRL+ALT+5
State
Visible
Enabled
~ Choose Commands to Run e

~ @ GUI Commands
v File Commands
Save Application
[ Save Application As
[ Save Application Copy As
Save Application on Server

Edit Node P Run [z Plot Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Save application as =
=% . ~ #

The figure below shows an example of an application with a File menu.

File
Save Ctrl+5
@ Save As Ctrl+ Alt+5 >Z—\
(i) About ometry

You can enable and disable ribbon, menu, and main toolbar items from methods.
For more information, see “Appendix E — Built-In Method Library” on page

370.
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Ribbon

The Ribbon node contains the specifications of a ribbon with toolbars placed on
one or several tabs. For the Ribbon option, a File menu is made available directly
under the Main Window node.

RiIBBON TAB AND RIBBON SECTION

Child nodes to the Ribbon node are of the Ribbon Tab type. Child nodes to a Ribbon
Tab are of the Ribbon Section type. Child nodes to a Ribbon Section can be of the
Item, Toggle Item, Menu, or Separator type.

The Item and Menu options provide the same functionality as described previously
for the Menu Bar and Toolbar. A Separator added as a child to a Ribbon Section is a
vertical line that separates groups of Items and Menus in the running application.
A Separator is displayed as a horizontal line in the application tree. The figure
below shows an example.

4 E] tubular_reactor.mph (root)
ﬁ Inputs
% Themes
4 D Main Window File Home
4 [F] FileMenu —
El Save {save) ‘:. — 5/
El Save As {sgveds] - -
4 EI Ribbon Reset Compute Report  Help
4 ™ Home {home}
el Input {input} Input Simulation Documentation
El Reset {reset}
4 Simulation {simulation}
El Compute {compute!
4 Documentation {documentation}
El Report {report!
5] Help {help)
b B Forms
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Interactive Editing of Menus and Ribbon Tabs

When creating menu and ribbon items, you can interactively position them in the

Main Window Editor by dragging.

App“ca’[ion Builder @ Preview D Main Window X
=+t | Bt~ Elv B~ 3 File Home
ype Titertext ¢ 000 A q
li_battery_pack_designer.mph (root) L —
ﬁ Inputs Battery  Battery Compute
% Themes Cell Pack Parameters
~ D Main Window Navigation
> [E File Menu
~ [+ Ribbon
= Home{f:omte]rab} o . Battery Cell Battery Pack
v MNavigation {navigationSection} —

Battery Cell {batteryCeliToogle} i

Battery Pack {batteryPackToogle} v Properties
v Battery Cell {batteryCellSection}

El Compute Parameters {computeParameters}

El Open Circuit Voltage {openCircuitVoltage}

El Experimental Data {experimentalData}

Battery capacity:

Reference temperature:

w Mnan Cirenit Valtana

You can right-click the Main Window Editor, for example, a ribbon section, and

add additional items from a context menu.

[@] Preview  [T] Main Window X

File Home

T o (1 Open Circuit Voltage [J] Cell Voltage ™
cce LB if

£ Experimental Data (JF Voltage Losses

Battery  Battery Compute Update Mesh
Cell Pack Parameters  [i] Cell State of Charge Design
Mavigation P
@ Menu
T El ltem
Battery Cell B Toggle ltem
X g Separator
~ Properties
Copy as Code to Clipboard >
Battery capacity: ¥ Cut Ctrle X
Reference tempera
[=] Copy Ctrl+C
~ Open Circuit \ [£] Duplicate Ctrl+Shift+D
e [ Delete Del
State of charge = age
Z = Rename F2 c=ll
E  Settings
Properties and Comments
Help F1
tiI+EWR

Compute
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Subwindows

You can organize your forms and form collections into subwindows that can be
resizable and detachable. In the Main Window node, if you change the Main window
type to Subwindows, the lower part of the Main Window Editor becomes a
workspace for the layout of subwindows.

s DB UR > 9 BN B S heal stasc micesmph - COMSOL Mtiphysics - o x

Application Settings
catem S

Seltonnatye sable

2016823768

Note that the New Form Wizard templates Basic, Subwindows, sections, and
graphics; and Subwindows, tabs, and graphics will create applications containing
subwindows.

The Main Window Editor has a window scale feature, available in the lower left
corner. Use this to get a better overview of the subwindow layout.

25%
508
75%
100%
150%
200%
300%
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The Window Layout section is visible if the Main window type is sct to Subwindows.

Settings
Main Window
~ General

Title: Helical Static Mixer
Show filename in title

lcon: Default ~ | |4

Menu type: Ribbon =
Main window type: Subwindows =
Status bar: Progress =

~ Window Layout

Column Width

1 50

2 150
Row Height
1 100

[] Allow dragging between subwindows

["] Show form header in subwindows with a single form

Working with subwindows is similar to working with forms in grid mode. You can
insert columns to the left and to the right of existing columns. Rows can also be
added above and below existing rows, and rows and columns can be deleted. Grid
cells can be merged and then split again. On the ribbon of the Main Window
Editor, there is a Rows & Columns button that enables you to quickly create a layout
with a specified number of rows and columns.

File Home  Main Window
Classic Menu Menu Bar [Z] File Menu —
= _
[ Ribbon Toolbar ™ Ribbon Tab T G S — — o= T
Ribbon Section Menu  Menu - Errors
Menu Type Classic Menu Ribbon Items Grid Editor Errors

The sizes of the rows and columns can be specified interactively by dragging. They
can also be specified manually in the Window Layout section, in the Settings
window of the Main Window.

The column width and row height settings are not interpreted as absolute width
and height, but rather summed together, and each individual row and column size
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is then interpreted as a fraction of the total size. A percentage value is displayed in
the column and row headers in the Subwindows layout area.

@ Preview D Main Window X
File Home
) A A — s N H‘ = .
S A A = S | i = & B
Reset Update Mesh  Compute Velocity Velocity Dimensionless Contact Report  Help
- Streamlines Slices Concentration »  Probability -
Input Geometry Simulation Visualization Documentation
v Geometry @

Mixer properties
Radius: 5.0 mm

The Allow dragging between subwindows setting controls whether forms can be
dragged and moved between the different parts of the subwindow area.

The Show form header in subwindows with a single form sctting controls whether
to the forms, which are alone in a subwindow, should have a header. This setting
is only available when dragging between subwindows is disabled.

Only one type of object can be placed in each of the grid cells used to define the
window layout. This is called a subwindow object and is automatically added to a
grid cell as soon as it is created. The Settings window for a subwindow object is

shown in the figure below.

Settings

Subwindow
Label: Subwindow 1

~ Forms

~ [ Forms

D operatingConditions
D geometry

D results

D information

Add to Subwindow Edit Node

Vertically
scrollable

D settings =4 O =4

Form Initially open | Closable

Default form: settings

This Settings window makes it possible to set which forms that are open in
different subwindows. In the table below the model tree in the Forms section, you
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can specify if the form is Initially open in the subwindow, if it is Closeable, and if it
is Vertically scrollable. A form that is Closeable will have a cross icon in the window
title for closing it.

Since a form can only be shown in one subwindow, the Forms section, containing
the available forms, is filtered to only show forms that have not yet been added to
a subwindow. Also, the Forms section only shows global forms and not local forms.
When starting an application, each form that has been added to the Forms section,
and where the checkbox in the Initially open column is selected, is shown in the
corresponding subwindow. The Title of the form is used as the title on the
corresponding tab.

The Default form setting specifies which form is initially active in the subwindow
when launching the application.
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Events

An event is any activity (for example, clicking a button, typing a keyboard
shortcut, loading a form, or changing the value of a variable) that signals a need
for the application to carry out one or more actions. Each action can be a
command sequence, a method, or mix of both. The methods themselves may be
local methods associated with particular forms or form objects, or global methods
that can be initiated from anywhere in the application. The global methods are
listed in the Methods node of the application tree. The form methods are listed
under the nodes of the respective form. The local methods are defined in the
Settings windows of the forms or form objects with which they are associated.
When a form object has an associated method, it may be opened for editing by
performing a Ctrl+Alt+click on the object. If the Ctrl+Alt+click is performed on a
form object that has no method, then a new local method, associated with the
object, will be created and opened for editing.

The events that initiate these actions may also be global or local. The global events
are listed in the Events node of the application tree and include all events that are
triggered by changes to the various data entities, such as global parameters or
string variables. Global events can also be associated with the startup and
shutdown of the application. In addition, Timer events can be used to periodically
trigger events based on a set time interval (delay). The local events, like local
objects, are defined in the Settings windows of the forms or form objects with
which they are associated.

Event nodes trigger whenever the source data changes, regardless of if it is changed
from a method, form object, or in any other way. Events associated with form
objects only trigger when the user changes the value in the form object.
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Events at Startup and Shutdown

Global or local methods, as well as command sequences, can be associated with
the events at startup (On startup) and shutdown (About to shut down) of an
application. To access these events, click the Events node in the application tree.

Application Builder Settings
Bt~ S~ $~- Events
o
E v Events
hd El tuning_fork.mph (root)
ﬁ Inputs On startup: runOnStartup - Ej + -
% Themes -
» D Main Window About to shut down: runOnShutdown * + -
> % Forms
Events
» = Declarations
> % Methods
» [ Libraries

A shutdown event is triggered when:

* The user of an application closes the application window by clicking the Close
icon in the upper-right corner of the application window

» The Exit Application command is issued by a form object

* A method is run using the command exit()

A method run at a shutdown event can, for example, automatically save critical
data or prompt the user to save data. In addition, a method run at a shutdown
event may cancel the shutdown by returning a Boolean true value.

LIMITATIONS WITH ON STARTUP EVENTS

Methods used for an On startup event cannot utilize Application Builder
functionality related to graphics or user interfaces. This is due to the fact that an
On startup cvent is run before the full application user interface is loaded. For
example, a method that is used for initializing graphics, such as Zoom Extents,
needs to be run as an On load event for a form and not as a global On startup event.
Another example is showing a dialog using a built-in method such as confirm. In
this case, no dialog will be shown and the operation will simply be ignored.

Global Events

Right-click the Events node and choose Event to add an event to an application.
An event listens for a change in a running application. If'a change occurs, it runs
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a sequence of commands. In the figure below, when the value of the Boolean
variable specserverdir is changed, a local method onEvent is run.

Application Builder Settings
L i L Etr Elv B~ Event
¢ MName: changeSpecserverdir =
v [&] cluster_setup_validation.mph (root) il
ﬁ Inputs
T Themes ~ Source for Data Change Event ® 3
> D Main Window
> [ Forms v = Declarations
v [E Events » 123 Integer
B changeSpecserverdir » abe String
B changeSpechatchdir v © Boolean
3 changeSpeccomsoldir & useQverride
B changeRunremote specserverdir
» = Declarations & spechatchdir
> % Methods & speccomsoldir
» [l Libraries E remote

<> Cluster type {clusterType}
<2» Remote Invoke command {remotelnvoke}

=4 Use as Source = Edit Node
Selected source:

E Boolean=specserverdir

~ Choose Commands to Run B

B Forms

B GUI Commands
= Declarations
% Methods

[fifi Libraries

>
>
>
>
>
» < Model (root)

= Edit Node Run [Z3 Plot Set Value Show

Show as Dialog Import File Enable Disable

L3
Command lcon | Arguments
onEvent @

by P~ @

Note that since this type of event has global scope and is not associated with a

particular form, the full path: /form1/graphics1 needs to be used if referencing
graphics objects.

The following two sections describe the options available in the Settings window
of an event.

SOURCE FOR DATA CHANGE EVENT

This section presents a filtered view of the tree from the Application Builder
window. The nodes shown represent data or have children that do.
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You can extend the list of available data nodes by clicking on the Switch to Model

Builder and Activate Data Access button in the header of the section Source For Data
Change Event.

~ Source for Data Change Event @ B

N Switch to Model Builder and Activate Data Access |

»

Dec
Model (root)

en

For more information, see “Data Access in the Method Editor” on page 197.

Note that Explicit selections are also allowed as Source for Data Change Event. This
allows a command sequence or a method to be run when the user clicks a
geometry object, domain, face, edge, or point. The figure below shows a dialog
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for a global event that opens a form panel as a dialog when the user changes the
contents of the Explicit selection named Outlet Boundaries.

Settings
Event

Mame: eventl ,E_'

Enabled

~ Source for Data Change Event

Declarations

~ @ Model (root)
» () Global Definitions
w Component 1 (comp1) {comp1}
~ = Definitions
» 2= Variables 1 {varl}
v g Selections

% Inlet Boundaries {sell}
[ Outlet Boundaries {sel2}
- All Fluid Domains {sel3}

E Use as Source =g Edit Node

Selected source:

% Outlet Boundaries {sel2}

~ Choose Commands to Run B

~ & Forms

D main
D cad

D mesh
D transport
D flow

D results
D panel

» @ GUI Commands

Sy EditNode » Run [ Plot 7 SetValue [ Show
Show as Dialog Import File Enable Disable

L3
Command lcon | Arguments
Show panel as dialog
SigHE- #

CHOOSE COMMANDS TO RUN

In the Settings window for an Event, the section Choose Commands to Run is similar
to that of a button and allows you to define a sequence of commands (which may
include methods). For more information, see “Button and Item” on page 69.
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Timer Events

Timer events adds a Timer that controls how often a command sequence is
triggered. This functionality can be used to operate an app as a digital twin. Each
time a delay has elapsed, a command sequence that you define is run. The
command sequence can include method calls, as shown in the figure below.

Settings

il

MName:  timerl

Delay: 10
[] Enabled

o&

~ Choose Commands to Run

initializeDataExport

checkLatestDataCompute
statusHealth

status50C
updateHistoryDataPlots

>|]]]] Libraries
» <@ Model (root)

Set Value Show

=g Edit Node P Run [Z3 Plot
Enable Disable

Show as Dialog Import File
M
lcon | Arguments

&

»
Command

runTimer
big BB~
You can use a Timer that accepts input from various external sources such as a
hardware sensor, an external database, or a web service. Subsequently, it updates

the app based on the acquired data.
In the Delay field, specify the delay time, in seconds, that the timer should wait
before executing the command. The default delay is set to 1 second, determining

the frequency at which the event is triggered.
The Timer is enabled by default. If you want to disable the triggering of timer

events, clear the Enabled box.
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Form and Form Object Events

Form and form object events are similar to global events, but are defined for forms
or individual form objects. These events can have an associated list of commands
in a command sequence, or refer directly to a global, form, or local method.

EVENTS TRIGGERED BY DATA CHANGE

For certain types of form objects, you can specify a method or command sequence
to run when data is changed. This setting is available in the Events section of the
Settings window of a form object, as shown in the figures below.

v Events
On data change: MNeone A P2
On focus gained: Create Global Method

Create Form Method

Create Local Method

reate Command Sequence

g c C d Seq
v Events
On data change: method1 ~ Bt
On focus gained: MNeone A P2

The drop-down list On data change contains None (the default), any available
methods under the Methods node of the application tree or under the Methods
node of the corresponding form, and a local method or command sequence
(optional).

The form objects supporting this type of event are:

¢ Input Field

¢ Checkbox

¢ Combo Box

¢ Graphics

¢ File Import

e Array Input

¢ Radio Button

e Text

¢ List Box
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¢ Table
* Slider

Buttons have associated events triggered by a click. Menu, ribbon, and toolbar
items have associated events triggered by selecting them. The corresponding
action is a command sequence defined in the Settings window of a button object
or item. Note, however, that such command sequences can also be used to run
methods. For more information on command sequences, see “Button and Item”
on page 69.

INPUT ARGUMENTS

Clicking Create Global Method or Create Form Method will open a dialog where you
can edit the name of the method to be created. Clicking Create Local Method will
create a local method with an automatically created name indicating the form and
type of event, see “Local Methods” on page 212. The method so created has a
first argument called newvalue which is based on the form object type. The
argument added to the method will contain the new value in the form object when
the event is triggered. The newly created method is also selected in the application
tree and opened in the editor area.

For example, assume that you create a method based on an input field that links
to a global parameter, as shown in the figure below.

@ Preview D flow X D panel D main Sett\ ngs
v -
nput Field
>
Mean velocity:

Mame:  inputfield3
Editable
Tooltip:

i

v Source @2+ 5

Declarations
Model (root)
P

(1)) Global Definitions
~ Pi Parameters 1{default}

-

cfm

8.5 Inlet concentration (c0)

&5 Diffusion coefficient (D)

=5 Mesh element size parameter (h_max)

= Mean velocity (U_mean)

25 |nlet width (a)

8.5 Laminar velocity profile normalization constz

@_-‘ Use as Source =g Edit Node

Selected source:

25 Parameters 1 {default}=Mean velocity (U_mean)
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The Settings window for the method created in this way is shown in the figure
below.

Settings

MName:  method1

Show in Model Builder

~ Inputs and Output
Inputs

L1
MName Type Default Description

newValue String >

The variable newvalue will then contain the new value of the Mean velocity entered
by the user of the app. In a similar way, if the method was created for an event
associated with a checkbox, the variable newvalue would be a Boolean variable
indicating the new status of the checkbox.

This functionality makes it possible to write method code for processing input data
and provides a general way of checking the input data in an app.

Selecting Multiple Form Objects

You can specify an On data change event for multiple form objects simultaneously
by using Ctrl+click and then selecting the method or command sequence to run.
In this way, you can, for example, quickly specify that a data change event initiated
by any of the selected form objects should run a method that informs the user that
plots and outputs are invalid. This functionality is not available for all
combinations of form objects.

EVENTS TRIGGERED BY LOADING OR CLOSING A FORM

Forms can run methods or command sequences when they are loaded (On load)
or closed (On close).

v Events
On load: method1 - Ej + -
On close: method2 - Bt~

This type of event is available in the Settings window of a form and is typically used
when a form is shown as a dialog, or to activate forms used as panes in a form
collection. Note that, as described earlier, a method that is used for initializing
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graphics, such as Zoom Extents, needs to be run as an On load event for a form and
not as a global On startup event.

EVENTS TRIGGERED BY FOCUS

Certain form objects can have an On focus gained event, which is similar to an On
data change event. This type of event is triggered when the user control associated
with a form object comes into focus, for example, when clicking an input field. In
general, a form object comes into focus when it becomes the target of keyboard
input by the action of a mouse click or when cycling focus using the Tab-key.

~ Events
On data change: MNeone - P2
On focus gained: checklnput ~ Bt

The form objects supporting this type of event are:
* Input Field

 File Import

e Text

Using Local Methods

Events can call local methods that are not displayed in the application tree. For
more information on local methods, see “Local Methods” on page 212.
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Declarations

The Declarations node in the application tree is used to declare global variables and
objects, which are used in addition to the global parameters and variables already
defined in the model. Variables defined under the Declarations node are used in
form objects and methods. In form objects, they store values to be used by other
form objects or methods. Variables that are not passed between form objects and
methods, but that are internal to methods, do not need to be declared in the
Declarations node. In methods, variables defined under the Declarations node have
global scope and can be used directly with their name. For information on how to
access global parameters defined in the model tree, see “Accessing a Global
Parameter” on page 225.

You can create a Declarations node that is local to a form. Such Declarations for a
form can only be used in that particular form, including form objects and methods
that are local to the form.

These are the different types of global Declarations:
¢ Scalar

e Array ID

¢ Array 2D

¢ Choice List

* File

¢ Unit Set

* File Type

¢ Shortcuts

¢ Graphics Data

Form Declarations can only be of the types:
* Scalar

e Array ID

e Array 2D

¢ Choice List
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Right-click a Declarations node to access the declaration types or use the ribbon.

> B Forms
¥ Events
» = Declarations
> B Methods Array 1D '
» [ Libraries Array 2D 3
<z» Choice List
3 File
Unit Set
[2) File Type
[*] Graphics Data
= MNode Group
H Hep F1

Note that Shortcuts are not created from this menu but by clicking the Create
Shortcut button next to the Name in the Settings window of a form object or by
using Ctrl+K for a selected form object.

To create Declarations that are local to a form, right-click the corresponding form
and select the variable type, as shown below.

¥ D Main Window

~ [ Forms
D form1
DformE EI Edit
D form3 Local Ferm
Events
v~ = Declaratior . New Method
123 Integer Scalar P abc String
abc
225 Array 1 Array 1D » @ Boolean
=5 Double
% Methods Array 2D » 123 Integer
» [ Libraries <> Choice List 85 Double

E] Preview Form
Copy as Code to Clipboard 3

Variables that are local to a form are organized under a Declarations node that is a
child node to the form, as shown below.

~ [ Forms
v D form1

v = Declarations
== Double

D form2
D form3

Events

The first three types of declarations, Scalar, Array 1D, and Array 2D, can be of the
following data types:

¢ String
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¢ Boolean
* Integer
¢ Double

In addition to right-clicking the Declarations node, you can click the Create New
Declaration and Use It as Source button in the Source section of many types of form
objects.

Settings

Input Field

MName:  pronglengthinput ,;'_::I
Editable
Tooltip:  10-2500 mm

~ Source @+ B

¥ Declarati

E1 Create New Declaration and Use It as Source
Model (rooty

-
\

w

This will open a dialog that lets you quickly declare scalar variables.

| @ Create and Use Declaration *
|
| Marme: var
Data type: String =
Initial value:
oK Cancel

USING DECLARATIONS AS INPUT ARGUMENTS TO COMMANDS

Certain commands used in the commands sequence of, for example, a button can
take an input argument. For more information, see “Button and Item” on page
69.
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The figure below shows a command sequence that includes a Plot Temperature
command with an input argument formi/graphics.

" Command lcon | Arguments 3 Edit Argument X
Compute Study 1 =
= - v [ Forms
form1/graphics1 - D form?
graphics1

t 1 SighE- [#

Edit Argument

E‘UseasArgument
| Selected argument:
[ graphicsl
oK Cancel

| -

You can use declarations as input arguments to commands.

To use a scalar variable, 1D array, or 2D array as input arguments, you use the
corresponding variable name. To access a single element of an array, or a row or
column of a 2D array, use indexes. For example, to access the first component in
a 1D array my_variable, you use my_variable(1). A 2D array element can be
retrieved as a scalar by using two indexes, for example, my_matrix(2,3). The
indexes can themselves be other declared variables, for example, my_variable(n).

For commands requiring a graphics object as an input argument, only string type
declarations are allowed with appropriate indexes, if necessary. If there is a
graphics object named graphics1 and also a string declaration named graphics1,
then the contents of the string declaration will be used. An exception is if single
quotes are used, such as 'graphics1', in which case the graphics object
graphics1 is used. This rule is also applied to other combinations of commands
and input arguments.

THE NAME OF A VARIABLE

The Name of a variable is a text string without spaces. The string can contain
letters, numbers, and underscores. The reserved names root and parent are not
allowed and Java® programming language keywords cannot be used.
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Scalar

Scalar declarations are used to define variables to be used as strings, Booleans,
integers, or doubles.

STRING

A scalar string variable is similar to a global parameter or variable in a model, but
there is a difference. A parameter or variable in a model has the restriction that its
value has to be a valid model expression, while a scalar string variable has no such
restrictions. You can use a string variable to represent a double, integer, or
Boolean by using conversion functions in a method. For more information, see
“Conversion Methods” on page 383. You can also use a string variable as a source
in many form objects, such as input fields, combo boxes, card stacks, and list
boxes.

The figure below shows the Settings window for the string variables
solutionState, device, and material.

Settings

List of Variables

L4 2 S
MName Initial value Description
solutionState nosolution Solution state
device computer Preferred device
material steel Material

String declarations, as well as other declarations, can be loaded and saved from or
to a file by using the Load from File and Save to File buttons below the List of
Variables table.

The Load from File and Save to File buttons are used to load and save from/to the
following file formats:

o Text File (.txt)
+ Microsoft® Excel Workbook (. x1sx)
- Requires LiveLink™ for Excel®

e CSV File (.csv)
» Data File (.dat)
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The drop-down list where these file formats can be selected is shown in the figure
below.

Text File (*txt) -

[ Text File (*tet) |
Microsoft Excel Workbook (*xlsx)
C5V File (*.csv)

Data File (*.dat)

All Files (*%)

To illustrate the use of declared strings, the figure below shows the Settings
window of an information card stack object where the string variable

statusInformationCharge is used as the source (Active Information Card
Selector).

Settings

Mame: infocard2

v Active Information Card Selector @ + "§

~ = Declarations

» E Boolean

~ abe String
abe statusinformationEOL
= statusinformationCharge
abc solutionstate
abc fileDataBase
abe serverlRL
abe serverDebugOutput
abc serverType
=be statusOhmic

f:‘ Use as Source = Edit Node
Selected source:

abe String=statusinformationCharge

For more information on using card stacks and information card stacks, see “Card
Stack” on page 305 and “Information Card Stack” on page 312.
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BOOLEAN

You can use a Boolean variable as a source in checkboxes, other form objects, and
methods. A Boolean variable can have two states: true or false. The default value
is false. The figure below shows the declaration of two Boolean variables.

Settings

Boolean

List of Variables

MName Initial value Description
validinput true Boolean
P T
geomlnitialization | false |Boolean
= o

Example Code

In the example code below, the Boolean variable bvar has its value controlled by
a checkbox. If bvar is true, then Plot Group 4 (pg4) is plotted in graphicsi.
Otherwise, Plot Group 1 (pgl) is plotted.
if (bvar) {
useGraphics(model.result("pg4"),"graphicsi1");
} else {
useGraphics(model.result("pg1"),"graphics1");

}

INTEGER AND DOUBLE

Integer and double variables are similar to strings, with the additional requirement
that the value is an integer or double, respectively.

Settings Settings
Integer Double
List of Variables List of variables
L3 L. P L] ciee
Mame Initial value | Description MName Initial value = Description
n_of_digits 3 MNumber of significant digits element_size_low 0.5 Walue for course mesh
n_steps 0 MNumber of iterations slement_size_mediu... 0.38 Walue for normal mesh
element_size_high 00.25 Walue for fine mesh
S22
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Array ID

The Array ID node declares one or more named arrays of strings, Booleans,
integers, or doubles that you can access from form objects and methods. The
number of elements in a 1D array is not restricted in any way, and you can, for
example, use a 1D array to store a column in a table with a variable number of
rows. The Settings window contains a single table, where you specify one variable
array per row. In the figure below, two double arrays are declared, xcoords and
ycoords.

Settings

Array

List of Variables

L]

MName Initial values | Mew element | Description
xcoords 10.2,-0.2,03,0... | 0.0 x-coordinates
ycoords 10.0,1.0,0.0,-1... | 0.0 y-coordinates

t == R +

The values in the column New element value are assigned to new elements of the
array when a row is added to a table form object. Arrays for strings, Booleans, and
integers are similar in function to arrays of doubles.

INITIAL VALUES

The Initial values can be a 1D array of arbitrary length. To edit the initial values,
click the Edit Initial Values button below the List of Variables. This opens a dialog
where the value of each component can be entered. See the figure below for an
example of a 1D array of doubles.

(]

Enter 1D array of doubles:
0.2

-0.2

03

0.1

0.96

-0.01

oK Cancel
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ARRAY SYNTAX

An array definition must start and end with curly braces ({ and }) and each
element must be separated with a comma. When you need special characters inside
an array element (spaces and commas, for example), surround the element with
single quotes ('). The table below shows a few examples of 1D arrays:

ARRAY SYNTAX RESULTING ARRAY

{1, 2, 3} A 3-element array with the elements |, 2,
and 3

{} An empty array

{'one, two', 'three by four'} A 2-element array with elements containing
special characters

{{1, 2, 3},{'one, two', 'three by A 2-element array containing a 3-element

four'}} array and a 2-element array

Array 2D

The Array 2D node declares one or more 2D arrays that you can access using form
objects and methods. In the figure below, the 2D double array xycoords is
declared.

Settings

Array 2D

List of Variables

L
MName MNumber of colu  Initial values MNew element value | Description
xycoords 2 - !{{0.3,0.2},{-0.2,0.4},... 0.0 xy-coordinates
% -
== - +

INITIAL VALUES

The default (or initial) value can be a 2D array of arbitrary size. To edit the initial
values, click the Edit Initial Values button below the List of Variables. This opens a
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dialog where the value of each component can be entered. See the figure below
for an example of a 2D array of doubles.

3 Edit Initial Values *

Enter 2D array of doubles:

0.3 0.2

-0.2 0.4

0.1 0.01

0.4 -0.1

0.004 0.3

-0.55 0.314
t ahll=

oK Cancel

ARRAY SYNTAX

The table below shows a few examples of 2D arrays:

ARRAY SYNTAX RESULTING ARRAY

{{}} An empty 3D array
{{'5",'6"},{'7",'8"}} A 2-by-2 matrix of strings
{{1, 2, 3}, {4, 5, 6}} A 2-by-3 matrix of doubles

For 2D arrays, rows correspond to the first index so that {{1,2,3},{4,5,6}} is
equivalent to the matrix:

123
456

Assuming that the above 2-by-3 matrix is stored in the 2D array variable arr, then
the element arr[1][0] equals 4.

To interactively define the Initial values of a 2D array, select the Undefined option
for the Number of columns. The Edit Initial Values button opens a dialog where the
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number of rows and columns can be interactively changed, as shown in the figure

below.

O Edit Initial Values

. Enter 2D array of doubles:
| 0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.0
0.0
0.0

0.0
0.0
0.0

Choice List

0.0
0.0
0.0

0.0
0.0
0.0

0.0
0.0
0.0

0.0
0.0
0.0

0.0
0.0
0.0

0.0
0.0
0.0

0K Cancel

The Choice List node contains lists that can be used by combo boxes, radio
buttons, or list boxes. The Settings window for a choice list contains a Label, a
Name, and a table with a Value column and a Display name column. Enter the
property value (Value) in the first column and the corresponding text to display to
the user (for example, in a combo box list) in the second column (Display name).
The Value is always interpreted as a string. In the example below, Dished bottom
will become the string dishedBottom when returned from the combo box.

Settings

Choice List

Label:  Tank Type List

Mame:  tankTypelist

List Content

L4

Value
dishedBottom
flatBottom

coneBottom
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Dished bottom
Flat bottom

Cone bottom
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As an alternative to creating a choice list by right-clicking the Declarations node,
you can click the Add New Choice List button in the Settings window for form
objects that use such a list, as shown in the figure below.

~ Choice List

e Selected: Add New Choice List

2> Available Impellers List {availablelm; 7> Tank Type List {tankTypersty
> Rotation Direction List {rotationDire:

7> Empty Impeller List {emptyEmpeller
> Impeller List {impellerList}

[] Allow other values

In addition you can click the adjacent Add New Form Choice List to create a choice
list local to the form.

ACTIVATION CONDITION

You can right-click the Choice List node to add an Activation Condition subnode.
Use an activation condition to switch between two or more choice lists contingent
on the value of a variable. For an example of using choice lists with activation
conditions, see “Using a Combo Box to Change Material” on page 267.

File

File declarations are primarily used for file import in method code when using the
built-in method importFile. For more information on the method importFile
and other methods for file handling, see “File Methods” on page 371. However,
an entry under the File declaration node can also be used by a File Import object.
The figure below shows the Settings window of a file declaration.

Settings

Label:  File1

MName: filel

File Location
Target directory:  Temporary =
Access using: upload:///filel

The file chosen by the user can be referenced in a form object or method using
the syntax upload:///file1, upload:///file2, and so on. The file name handle
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(filel, file2, and so on) can then be used to reference an actual file name picked
by the user at run time.

For more information on file declarations and file handling, see “Appendix C —
File Scheme Syntax” on page 348.

File Type

The File Type declaration lets you use a custom file type with a custom file
extension. The custom file declaration will then become available in the File Import
form object as well as in the dialogs shown when using the methods importFile
and fileSaveAs.

Settings

Label:  File Type 1
MName: filetypel

~ Definition
Description: My File Type

L - .
Filename extensions

*myfile
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Unit Set

The Unit Set node contains lists that can be used by combo boxes, radio buttons,
or list boxes for the purpose of changing units. The Settings window for a unit set
contains two sections: Unit Groups and Unit Lists.

Settings

Label:  Unit Set 1 =

MName:  unitset]

Unit Groups
L1
Value Display name
sl sl
imperial Imperial
T =3
Initial value: sl o,
~  Unit Lists
MName sl Imperial
length cm in
potential my my
T + =3

Each row in the Unit Groups table is a unit group that represents a collection of
units with a particular meaning in the context of the application user interface.
Each column represents a group of units labeled by a Value and a Display name.

Each row in the Unit Lists table is a unit list with columns containing units with
the same dimension, for example, mm, cm, dm, m, and km. The headings of the
Unit Lists table are Name and the Display names are defined in the Unit Groups
section. A unit list specifies the possible units that a form object that references the
Unit Set can switch between when running the application.

The figure above demonstrates the use of a Unit Set for an application that allows
for switching between metric and imperial units. In this example, two unit groups
arc defined: SI and Imperial.

The Value column contains string values that represent the current choice of unit
group. These string values can be manipulated from methods. The Display name
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column is the string displayed in the user interface. The Initial value list contains
the default unit group (SI in the example above).

In the example above, the Unit Lists table has three columns: Name, SI, and
Imperial. The Sl and Imperial columns are created dynamically based on the groups
in the Unit Groups section. Each row in the table corresponds to a physical quantity
such as, in this example, length and potential. Each column in the table
corresponds to the allowed units of 1length and units of potential, respectively.

The figure below shows an example application where a combo box form object
is used to choose between the SI and Imperial unit groups.

Length: 9 cm Length: 3.5433070866141 in
Width: 5 cm Width: 1.9685039370072 in
Applied voltage: 20 my Applied voltage: 20 my

Temperature: 3304 K Temperature: 3304 K

Compute

Compute

Unit system: sl - Unit systerm: Imperial =

sl

Imperial
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The figure below shows the Settings window of a combo box using the Unit Set of
the above example as the Source.

Settings

Combo Box

MName: combobox =
~ Source @+ "B
v = Declarations

Unit Set 1 {unitset1}
» < Model (root)

Use as Source Edit Mode

Selected source:

Unit Set 1 {unitset1}

Initial value: From data source -
~ Choice List @+
Available: Selected:

Unit Set 1 {unitset1}

[] Allow other values

In this way, a Unit Set can be used instead of a Choice List to create a combo box
for unit selection. Instead of a combo box, you can use a list box or a radio button
object in a similar way.
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The two figures below show the corresponding Settings windows for the two input
fields for Length and Applied voltage.

Settings Settings
nput Field Input Field
Name:  inputfield1 B Name:  inputfield3 B
Editable Editable
Tooltip: Tooltip:
~ Source @+ "F ~ Source @+ g
= Declarations = Declarations
v & Model (root) v & Model (root)
v (3 Global Definitions v (3 Global Definitions
v Pj Parameters 1 v Pj Parameters 1
sl Length (L) =5 Length (L)
=5 Bolt radius (rad_1) =5 Bolt radius (rad_1)
== Thickness (thb) == Thickness (thb)
=5 Width (whb) =5 Width (whb)
=5 Maximum element size (mh) =5 Maximum element size (mh)
=5 Heat transfer coefficient (htc) =5 Heat transfer coefficient (htc)
=5 Applied voltage (Vtot) =l Applied voltage (Vtot)
Use as Source S Edit Node Use as Source S Edit Node
Selected source: Selected source:
= Parameters 1=Length (L) = Parameters 1=Applied voltage (Vtot)
Initial value: ~ From data source - Initial value: ~ From data source -
Value: 9 Value: 20
~ Data Validation ~ Data Validation
Unit dimension check:  Append unit from unit set = Unit dimension check:  Append unit from unit set =
Unit set: Unit Set 1 {unitset1} - 3 Unit set: Unit Set 1 {unitset1} ~| 3]
Unit list: length (cm,in) - Unit list: potential (mV,mV) -

Numerical validation

Filter Double -
Lower bound

Comparison type:  Greater than or equal -

Value: 5

Upper bound

Comparison typei  Less than or equal -

Value: 15

Error message:

Invalid input

Numerical validation
Filter Double

Lower bound

Comparison type:  Greater than or equal
Value: 0

Upper bound

Comparison typei  Less than or equal
Value: 100

Error message:

Invalid input

The Unit dimension check is sct to Append unit from unit set. The Unit set is set to
Unit Set I{unitsetl} (the user-defined label for the Unit Set declaration used in this
example). The Unit list is set to length and potential, respectively. When using
Append unit from unit set, the Numerical validation section (under Data Validation)
refers to the Initial value of a Unit Set; in this case, em and mV, respectively. The
Lower bound and Upper bound values are scaled automatically when the application
is run and the unit is changed by the user of the application. For more information
on the settings for an input field object, see “Input Field” on page 99.
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The figures below illustrate the use of two Unit Set declarations for separately
setting the unit for length and potential, respectively.

v = Declarations
Length: 9 cm Length Units {unitset 1}
Width: 5 crm Potential Units {unitset2}
Applied voltage: 20 mV B Methods

» [ Libraries

Temperature: 3304 K

Compute
Length unit: cm =

Potential unit: my =

The figures below show the corresponding Settings window for the Unit Set
declarations.

Settings Settings
Unit Set Unit Set
Label:  Length Units = Label:  Potential Units =
MName:  unitset] MName:  unitset2
Unit Groups Unit Groups
L L

Value Display name Value Display name
cm cm W W
m m my my
inch inch
Initial value: cm - Initial value: my -
v Unit Lists v Unit Lists
k2 MName cm m inch " MName v my
length cm m in potential W my

+ +

Note that, in this example, by using additional Unit Set declarations, you can have
individual length unit settings for the Length and Width input fields. The figure
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below shows such an example, where three combo boxes have been used to
replace the unit labels and each combo box uses a separate Unit Set declaration as
its source.

Length: 9 cm -
Width: 1.9685039370078  inch =
Applied voltage: 20 my -

Temperature: 3304 K

Compute

When more flexibility is required, you can combine the use of a Choice List and a
Unit Set. For example, for a combo box, you can use the Unit Set as the Selected
source (string) and select a Choice List that is not a Unit Set.

Shortcuts

Form objects and other user interface components are referenced in methods by
using a certain syntax. For example, using the default naming scheme
form3/button5 refers to a button with the name button5 in form3 and
form2/graphics3 refers to a graphics object with the name graphics3 in form2.
You can change the names of forms and form objects. For example, if form1 is
your main form, then you can change its name to main.

To simplify referencing form objects as well as menu, ribbon, and toolbar items by
name, you can create shortcuts with a custom name. In the Settings window of an
object or item, click the button to the right of the Name field and type a name of
your choice.

Settiﬂgs 3 Create Shortcut *

Button
Mame: reportButton

Name: reportButton = [] Update methods

Tet Report m oK Cancel
lcon: # report_32.png - + =

Size: Large =

Style: Flat =

Tooltip: Create a simulation report.

Keyboard shortcut:

To create or edit a shortcut, you can also use the keyboard shortcut Ctrl+K.
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All shortcuts that you create are made available in a Shortcuts node under

Declarations in the application tree.

¥ Events

v = Declarations
= Boolean
123 Integer
25 Double
abe String

<Z» Material {materiall ist}

<Z» Simulation Type List {simulationTypeList}

=] Shortcuts
> [ Methods
» [ Libraries

In the Settings window for Shortcuts below, a number of shortcuts have been
created for a button, text labels, input fields, units, and toolbars.

Settings

Shortcuts
List of Shortcuts

L]
MName

reportButtonTablet

targetFrequencyTextSmart...
targetFrequencylnputSma...

frequencyToleranceTextS..,

frequencyTolerancelnputS..,
pronglengthinputSmartp...
targetFrequencyUnitSmart...

frequencyTolerancelnits...

plotButtonSmartphone

playSoundButtonSmartph...

reportButtonSmartphone

Target

toolbarTablet/reportButtonTablet
rainSmartphone/targetFrequencyTextSmartphone
mainSmartphone/targetFrequencylnputbmartphone
rainSmartphone/frequencyToleranceTextSmartphone
mainSmartphone/frequencyTolerancelnputSmartphone
rainSmartphone/pronglengthlnputSmartphone
mainSmartphone/targetFrequencyUnitSmartphone
mainSmartphone/frequencyTolerancelnitSmartphone
toolbarsmartphone/plotButtonSmartphone
toolbarsmartphone/playSoundButtonSmartphone
toolbarsmartphone/reportButtonSmartphone

Description
Shortcut to Button
Shortcut to Text label
Shortcut to Input field
Shortcut to Text label
Shortcut to Input field
Shortcut to Input field
Shortcut to Unit
Shortcut to Unit
Shortcut to Toolbar
Shortcut to Toolbar
Shortcut to Toolbar

The shortcuts can be referenced in other form objects or in code in the Method
Editor. The example below shows a shortcut, tempVis, used as an input argument
to a temperature plot.

L]
Command

Plot Temperature (ht)

lcon | Arguments
tempVis
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Shortcuts are automatically updated when objects are renamed, moved, copied,
and duplicated. They are available in methods as read-only Java® variables, just like
string, int, double, and Boolean declarations.

Using shortcuts is recommended because it avoids the need to adjust Method
Editor code when the structure of the application user interface changes.

Shortcuts are also available in the Model Builder, for use with the Application
Builder. In the Settings window of a model tree node, click the button to the right
of the Label field and type a name of your choice.

Settings Graphics

Block e a@- &

) Build Selected » [E8 Build All Objects B

Label: Block 1 =

v Object Type Create Shorteut (Ctrl+K)
Used in Application Builder

Type: Solid =

3 Create Shortcut *

Mame:  blkl

[] Update methods

oK Cancel

The custom name of a shortcut becomes available as a global variable in methods
and will automatically be used, for example, when recording code or new
methods, as shown in the figure below.

@ Preview methodl X

", new int[]{2,1,1});

", new int[]{2,3,1});
blkl.set("size", new int[]{2,3,5});

4  model.component("compl”).geom{"geoml").runf{"blkl™);
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Graphics Data

A Graphics Data declaration node is used to pick data at a specific coordinate from
a graphics object based on mouse clicks by the user. The figure below shows the
corresponding Settings window.

Settings

Gra cs Data

Label:  Graphics Data 1 =5

MName: graphicsdatal
v Initial Values

Coordinate: 0,00

Results evaluation: 0

~ Initial Values for 3D Geometry Source

Geometric entity level: Domain -

Domain settings

Line entry method: Point and surface normal =
Depth along line: 0
Point being modified: First point -

The Initial Values section contains default values for the extracted data properties
Coordinate and Results evaluation. The section Initial Values for 3D Geometry Source
contains settings for the selection methods available when the Source for Initial
Graphics Content of a graphics object is set to a geometry node.
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The different properties of a graphics data declaration are available from the Editor
Tools window as shown in the figure below.

Editor Tools
= Edit Node =1 ~

LIILLE
+
4

a_- Themes
Main Window

¢ v v o
[

Declarations
= Boolean

123 Integer

= Double

String

Choice Lists {grp3}

Graphics Data 1 {graphicsdatal}
5:2 Coordinate (coord)

Clv v v v v

ol

2.5 Results evaluation (eval)
=bc Geometric entity level (edim)
= Line entry method (method]

Depth along line (depth)
=bc Point being modified (twopoint)
> B Methods

To use a Graphics Data declaration node for data picking, select the Data picking
checkbox in the Settings window of a graphics object and select the Graphics Data
node as the Target for Data Picking, as shown in the figure below.

Settings

Graphics

MName: graphicsl =
Zoom to extents on first plot

> Source for Initial Graphics Content
~ Data Picking @+ "3
Enable data picking

Target for data picking

v = Declarations
» 85 Double
Graphics Data 1{graphicsdatal}

\

Use as Target %, Clear Target Edit Node

Selected target:
[=] Graphics Data 1{graphicsdatal}

GRAPHICS DATA FROM RESULTS

When the Source for Initial Graphics Content of a graphics object is set to a plot
group node, then the Results Evaluation value corresponds to the field value at the
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position determined by the mouse pointer. The Coordinate value corresponds to
the coordinate at that position. Note that in the Model Builder, this corresponds
to the data displayed in the Evaluation 2D or Evaluation 3D tables.

The figure below shows a data display object where the Coordinate property is used
as Source.

Settings

Data Display

MName:  datadisplay2 =5
LaTeX markup

Tooltip:

~ Source @+ "B

v = Declarations

» 85 Double

~ [=] Graphics Data 1{graphicsdatal}
25 Coordinate (coord)
8.5 Results evaluation (eval)
abe Geometric entity level (edim)
abe Line entry method (method)
=5 Depth along line (depth)
abc Point being modified (twopoint)

@_‘ Use as Source =g Edit Node

Selected source:

5.2 Graphics Data 1 {graphicsdatal}==Coordinate (coord)

You can also use the Coordinate property as the Source for an array input object.
The Results Evaluation property can be used as the Source for several form objects
including data display and input field objects.

To extract coordinate values into variables within a method, use one of the
following syntaxes:

» For a 1D double array declared under Declarations:

coords = app.declaration("graphicsdatal").getDoubleArray("coord");

e For a local Java variable within the method:

double[] coords = app.declaration("graphicsdatal").getDoubleArray("coord");

You can explore this syntax in the Editor Tools window. For example, right-click
Graphics Data | > Coordinate and sclect Get from the context menu.

GRAPHICS DATA FROM GEOMETRY

The settings Geometry Entity Level, Line Entry Method, Depth Along Line, and Point
Being Modified only apply when the Source for Initial Graphics Content of a graphics
object is set to a 3D geometry node. These settings provide the same point
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selection methods as a Domain Point Probe, when Geometry Entity Level is set to
Domain; and Boundary Point Probe, when Geometry Entity Level is set to Boundary.
The settings Line Entry Method, Depth Along Line, and Point Being Modified are only
applicable when Geometry Entity Level is set to Domain.
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The Method Editor

Use the Method Editor to write custom code for tasks that go beyond the
standard run commands available in the model tree nodes of the Model Builder.
These methods can perform operations such as executing loops, processing inputs
and outputs from various sources, and sending messages or alerts to the
application user.

The Java® programming language is used to write COMSOL methods, which
means that all Java® syntax and Java® libraries can be used. The Method Editor
supports Java 11 syntax. In addition to the Java® libraries, the Application Builder
has its own built-in library for building applications and modifying the model
object. The model object is the data structure that stores the state of the
underlying COMSOL Multiphysics model that is embedded in the application.
More information about these built-in methods can be found in “Appendix E —
Built-In Method Library” on page 370, in the Application Programming Guide,
and in the Programming Reference Manual.

The contents of the application tree in the Application Builder are accessed
through the application object, which is an important part of the model object.
You can record and write code using the Method Editor that directly accesses and
changes user interface aspects of the running application, such as button texts,
icons, colors, and fonts.

There are global methods, form methods, and local methods. Global methods are
displayed in the application tree and are accessible from all methods and form
objects. Form methods are displayed in the application tree as child nodes to the
form it belongs to. A local method is associated with a form object or event and
can be opened from the corresponding Settings window. For more information
about local methods, see “Local Methods” on page 212.

A number of tools and resources are available to help you create code for
methods. These are covered in the following sections and will make you
more productive by allowing you to copy-paste or autogenerate blocks of
code, for example.

Converting a Command Sequence to a Method

One of the quickest and easiest ways to generate code is to convert a command
sequence to a method. In the Form Editor, select Convert to Method from the
menu button displayed in the Settings window below an existing command
sequence. The command sequence is automatically replaced by an equivalent
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method. In the same way you can select Convert to Form Method and Convert to
Local Method.

Consider a case where you have created a compute button and you want to be
alerted by a sound when the computation has finished. Now, we will see how this
could be done using the Method Editor (this can also be done without writing
code, see later in this section).

You will also learn how to do this without using the Method Editor later in this
section. The figure below shows the Settings window of the Compute button.

Settings

Button

MNarne: button1 =
Text: Compute

lcon: = compute_32.png - + B
Size: Large *
Style: Outlined =
Tooltip: Compute and Plot Temperature and Current Density

Keyboard shortcut:  CTRL+T

~ Choose Commands to Run g

® Forms
B GUl Commands
= Declarations
EE Methods
[fifi Libraries
& Model (root)
» () Global Definitions
> [l Component 1 (compl)
v oo Study 1
[= Stationary
> [fre Solver Configurations

v {E| Results

> 2% Derived Values

v v v v v

=# Edit Node Run Plot Set Value Show
Show as Dialog Import File () Enable () Disable

" Command lcon | Arguments
Compute Study 1 =

Plot Temperature (ht) form1/graphics1
Plot Current Density form2/graphics2

tLEEE-#
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Select the Convert to Method option below the command sequence.

" Command lcon | Arguments
Compute Study 1 =

Plot Temperature (ht) form1/graphics1
Plot Current Density form2/graphics2

t L sigdE- @
5E Convert to Method

‘ Convert to Form Method
> Position ant ..
‘ Convert to Local Method

> Appearance

> Dialog Actio

The command sequence in this example is replaced by a method, method3.

Click the Go to Method button. The Method Editor opens with the tab for
method3 active.

L
Command lcon | Arguments
method3 B

bz P -

In the Method Editor, add a call to the built-in method playSound to play the
sound file success.wav, available in the COMSOL sound library, by using the
syntax shown in the figure below.

@ Preview method3 X
model.study("stdl”).run();
useGrophics{model.result("pg3"), "forml/
useGrophics{model.result("pg5"), "form2/

4  playSound("success.wav");

raphics2");

The newly added line is indicated by the green bar shown to the left.
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Note that in the example above, you do not have to use the Method Editor. In
the command sequence, select the file success.wav under Libraries > Sounds and
click the Run command button under the tree, as shown in the figure below.

Settings

Button

MName: button1 E
Text: Compute

lcon: = compute_32.png - + B
Size: Large =
Style: Outlined -
Tooltip: Compute and Plot Temperature and Current Density

Keyboard shortcut:  CTRL+T
~ Choose Commands to Run =

¥ [‘u Graphics Commands
¥ D Main Window Commands
> <& Model Commands
» = Declarations
v [fifi Libraries
v i) Sounds
133 SUCCESS.WaV
123 failwav
122 peutral.wav
~ & Model (root)
» () Global Definitions
> [l Component 1 (compl)
v o Study 1

=g Edit Node P Run [Z3] Plot Set Value Show
Show as Dialog Import File Enable Disable

" Command lcon | Arguments
Compute Study 1

Plot Temperature (ht)
Plot Current Density

Play 'success.wav'

L EEE

However, there are many built-in methods that do not have corresponding
command sequence nodes. For more information, see “Appendix E — Built-In
Method Library” on page 370.
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FORM OBJECT WITH ASSOCIATED METHOD

A form object that has an associated method is indicated with a special icon in the
Form Editor, as shown in the figure below. In this example, both the checkbox
called Find prong length and the Compute button have associated methods.

Compute

Pressing Ctrl+Alt+Click on a form object opens its associated method in the
Method Editor. If no method is currently linked to the form object, a new local
method will be automatically created, associated with the form object, and opened
in the Method Editor.

If the associated method has a compile error, then this is shown with a different
icon, as shown in the figure below.

Compute
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Language Elements Window

The Language Elements window in the Method Editor shows a list of various
language constructs. Double-click or right-click one of the items in the list to
insert template code into the selected method.

Language Elements

~ language constructs
> Array operations (for double, int, boolean, string)
v Block statements
Do-while
For-M
For-each
If
If-else
Instanceof expression
Multiline comment
Switch
Try-catch
While
With
Conversions
Server file handling utilities
External and utility libraries
Model Builder
User interface
Utility functions
Variables

oW W W W W

See also “Language Element Examples” on page 223.
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Editor Tools in the Method Editor

To display the Editor Tools window, click the corresponding button in the Main
group in the Home tab.

"5 Data Access = settings
Eﬁ Record Method Editor Tools
[EA Compiler

Main

When using the Editor Tools window in the Method Editor, you can right-click a
node in the editor tree to generate code associated with that node. Depending on
the node, up to eight different options are available:

e Get

e Set

e Set All

¢ Create

* Run

e Enable

 Disable

* Edit Node

Selecting one of the first seven options will add the corresponding code to the

currently selected method. The Edit Node option brings you to the Settings
window for the model tree node.
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The figure below shows an example of a node with six options.

Editor Tools
= Edit Node =T =

% Themes

D Main Window

> B Forms

» @ GUI Commands

1=

Declarations
Methods

[fifi Libraries
&
>

&P m

>
>
>
~ Model (root)

() Global Definitions
> [ Component 1 (compl)
v oo Study 1

[= Stationary

> [fre Solver Configurations Get

> [El Results Set All

Create
Enable
) Disable

Edit Mode

VvoeFT

Get Set gq Set All [ Create Run (&) Enable () Disable

When a node is selected, the toolbar below the editor tree also shows the available
options for generating code. The Edit Node option is located at the top left of the
window.

The Editor Tools window is also an important tool when working with the Form
Editor. For more information, see “Editor Tools in the Form Editor” on page 67.

KEYBOARD SHORTCUTS

Consider a method with a line of code that refers to a model object in the
following way:

model.result("pg3").feature("surfi1").create("hght1", "Height");
If you position the mouse pointer in "surf1" and press F11 on the keyboard,

right-click and select Go to Node, or click Go to Node in the ribbon, then the
corresponding Surface plot note is highlighted in the Editor Tools window.

Click Edit Node to open its Settings window. For more information on keyboard
shortcuts, see “Appendix D — Keyboard Shortcuts” on page 367.
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Data Access in the Method Editor

To access individual properties of a model tree node, click the Data Access button
cither in the Main section of the Home tab, in the Application Builder, or in the
Application section of the Developer tab in the Model Builder ribbon.

A " Data Access
Application P Test Application
Builder

Application

Alternatively, for certain form objects, for example, input fields, you can click the
Data Access button in the header of the Source section of the Settings window. See
also “Data Access in the Form Editor” on page 110.

Data Access needs to be enabled this way because a model typically contains
hundreds or even thousands of properties that could be accessed, and the list
would be too long to be practical.

When you click a model tree node, such as the Heat Flux node in the figure below,
checkboxes appear next to the individual properties. This example is based on the
busbar tutorial model described in Introduction to COMSOL Multiphysics.

In the figure below, the checkboxes for Heat transfer coefficient and External
temperature are selected:

"% Data A New Method b =
A o Data Access ew Metho _@ i
Application P Test Application Eﬁ Record Method Method Run
Builder Call ~ Method ~
Application Create Methods Method Calls Run Code
Model Builder Settings
- = St Elv E~ Heat Flux
.-~ =
- Label: Heat Flux 1 1=
e
v 4% busbar.mph (root) > Boundary Selection

v () Global Definitions

Fi Parameters 1

> Override and Contribution

4 Default Model Inputs > Equation
= Materials
~ [l Component 1 {comp1)
>

> Material Type

= Definitions
Heat Flux
> FA] Genmetru 1
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If you switch to the Editor Tools window, you will see additional nodes appear
under the Heat Flux node. Right-click and use Get or Set to generate code in an
active method window, as shown in the figure below.

Editor Tools

S EditNode =t v El ~

% Themes

D Main Window

¥ % Forms

» @ GUI Commands

= Declarations

EE Methods

[fifi Libraries

& Model (root)

» () Global Definitions

~ [l Compenent 1 (comp1)
» = Definitions

WA Geometry 1

22 Materials

»
»
»
w

¢ v v o

+\_ Electric Currents (ec)
) Heat Transfer in Solids (ht)
= Solid1
&= Initial Values 1
== Thermal Insulation 1
v (mw Heat Flux 1
abe External temperature (Text)
abc Heat transfer coefficient (h)

> iy Multiphysics Get
¥ A Mesh 1 A Set
> ~on Study 1 B .
> [ Results Z¢ EditNode

In the example above, Get and Set for the Heat transfer coefficient and the External
temperature properties will generate the following code:

model.component("comp1").physics("ht").feature("hf1").getString("Text");
model.component("comp1").physics("ht").feature("hf1").getString("h");

model.component("comp1").physics("ht").feature("hf1").set("Text",
"293.15[K]");
model.component("comp1").physics("ht").feature("hf1").set("h", "htc");
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Recording Code

Click the Record Code button in the Code section of the Method Editor ribbon to
record a sequence of operations that you perform using the model tree, as shown

in the figure below.

Language Elements  [sEC)
v

El i
11 Model Expressions Check

[Z® Record Method Syntax

o] e w

Go to
MNode

Create Local
Variable

Use
Shortcut

Record
Code

Code

Certain operations in the application tree can also be recorded, including methods
used to modify the user interface while the application is running such as changing

the color of a text label.

Clicking the Record Code button will add code to an existing method. To record
a new method, click the Record Method button. This button is also available in the
Main scction of the Home tab of the Form Editor or Method Editor ribbon.

"5 Data Access
New
Method v €8 Compiler

Main

= settings

Eﬁ Record Method Editor Tools

In addition, you can click the Record Method button in the Developer tab of the

Model Builder ribbon.
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While recording code, the COMSOL Desktop windows are surrounded by a red

frame:

e DB UR > o BT B 0 B S R S b coMOLMRBYSS - o ox
Fle  Home Defitons Geomeny Mk Plyic Mesh Sudy Resuts Deseloper a
A EDwesces 5 NewMethod g 5] =Rl Ics S \ a=

soptcton > Tethppicain | [BSODRIG] | oy | um Gk | Sengs Upsse  Show s o o

G| weod~ varascan- Sa | ame Toms ke Goie Ade Adons | Viewer

Model Builder Settings Graphics

e - s aa@- 0@ L- kK ¢ (@ 8- 6-a8

o i st @ B At =

~ % bustarmgh o) L s B
< o Ot

. poameter 1 Gement Szs
Ocout iadel et
& e o e~
) BusorCortro Gansal s .
@ Compe o) S
i
> B ceomeny 1 © o i
et ~ Hement Size Parameters K AN
B et Tartr e ) [r—— o8 :
L = o I N
1 HER i
s Mimum dement s s i
[pes— s n i Sy
~ o sty Macimum dement rowthise 5
1 Skpt:Sutonay = o
> Ty SoherConfiguratons | — &
2! o Congrions unaurefacon S
- & e s
> et Resottion ot arowegons: A
o S
(NP
o
Messages _ progress_Log _ Masimum and Miimum vlves
Bapse
- o

busbar.mph - COMSOL Multiphysics

e 0w R»o-c-8 B B o v
File Method
(. D 2 B % abc 5 Amay 1D~ Lol IIII D » Test Application ;l—; P DD
Model M, New New B2 B * Application Scalar B8 Amay 2D ¥ D More Main Apply Changes Compare  Compare  View
Builder Manager  Form « Method + [y ment - More Declartions [ BRI VINGOW (0t Brouser withSaved |~
Workspace Main Addin | mputs | Events Dectarations Uibraries Main Window Test Compare
Application Builder [Preview o Settings
P o Ml o [ 1 model.sEudy("<Edl") . createAutoSequences ("a11");
TiE-=-9 model. 501 ("s011") . runAL1() Vethod
Type filter tect a nodel. result("pl").run(); Name:  method1
model. result("pe2") . run();
busbar.mph (root) e e e Show in Model Builder
5 Inputs model. result("pea ") .run() ;
= Themes ~ Inputs and Output
> [7] Main Window Inputs
B Forms .
Events Name Type Default Description Unit
= Declarations
v B Methods
© method!
> [ Libraries
tE+
Output: | None -
100% ~
23268128668
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To stop recording code, click one of the Stop Recording buttons in the ribbon of
either the Model Builder or the Application Builder.

"9 Data Access Mew Method [ABC] = B+C - 3=
= = DT T
A o - v Ej u n T
Application P =L pphication E. SEpEELE Check  Goto Stop Use Create Local
Builder Syntax Mode | Recording Shortcut Variable
Application Create Methods Code

The previous section on Data Access demonstrated how to set the values for the

Heat transfer coefficient and External temperature properties in the busbar tutorial

model. Alternatively, you can achieve this using the Record Code feature. To

generate similar code using this method, follow these steps:

» Create a simple application based on the busbar model (MPH file) available
in the Application Libraries under COMSOL Multiphysics > Multiphysics.

e In the Model Builder window, click Record Method, or with the Method
Editor open, click Record Code.

+ Change the value of the Heat transfer coefficient to 5.
e Change the value of the External temperature to 300[K].
e Click Stop Recording.

» Ifitis not already open, open the method with the recorded code.

The resulting code is listed below:

model.component("comp1").physics("ht").feature("hf1").set("h", 5);
model.component("comp1").physics("ht").feature("hf1").set("Text",
"300[K]1");
Note that in File > Preferences you can enable the use of with() statements in
order to make the code more compact. For more information on the use of
with(), see “The With Statement” on page 225.

To generate code corresponding to changes to the application object, use Record
Code or Record Method, then go to the Form Editor and, for example, change the
appearance of a form object. The following code corresponds to changing the
color of a text label from the default Inherit to Blue:
app.form("formi1").formObject ("textlabell").set("foreground", "blue");
Recording code for operations in the Form Editor is useful for tasks such as
generating code to enable or disable various form objects. This allows for
controlling their status dynamically using a Boolean variable, for example, through
a checkbox.
For more information on modifying the model object and the application object,
sce the Application Programming Guide.

Use the tools for recording code to quickly learn how to interact with the model
object or the application object. The autogenerated code shows you the names of
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properties, parameters, and variables. Use strings and string-number conversions
to assign new parameter values in model properties. By using Data Access while
recording, you can, for example, extract a parameter value using get, process its
value in a method, and set it back into the model object using set. For more
information on Data Access, see “Data Access in the Method Editor” on page 197.

Checking Syntax

Click Check Syntax in the Method ribbon tab to see messages in the Method Errors
and Warnings window related to syntax errors or warnings about unused variables.

Language Elements  [2EC] =t B+C nd=

- _ v Z] @ Ur
eRiecelpisso Check Goto Record Use Create Local

E‘. Record Method Syntax Mode  Code  Shortcut Variable

Code

In addition to messages in the Method Errors and Warnings window, syntax errors
are indicated with a wavy red underline, as shown in the figure below.

@ Preview methodl X
model. study("stdl").runf);
useGraphics(model.result ("pg3"), "forml/graphics1l");
3  ploySound("s )

100% -

Method Errors and Warnings

@ 1Eror fA  0Wamings

Method Line Message
€ | method1 3 String literal is not properly closed by a double-quote
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Find and Replace

Click Find in the Quick Access Toolbar, or user the keyboard shortcut Ctrl+F, to
open the Find in Methods dialog used to find and replace strings in methods, as
shown in the figure below.

i W Untﬁnd:

=place with:

Fl n Ij |:|:tr| + F:I “ind in methods Direction
® Current ® Forward
O Al () Backward

[] Case sensitive

Find MNext Replace
Find All Replace All
Close

The Quick Access Toolbar is located above the ribbon to the left, in the
COMSOL Desktop user interface.

In the Form Editor and Main Window Editor, a different Find and Replace window
is used. This tool is identical to the Find and Replace functionality used in the
Model Builder.
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Model Expressions Window

The Model Expressions window in the Method Editor shows a list of predefined
expressions used as input and output arguments. Double-click or right-click one
of the items in the list to insert an expression:

Model Expressions

> Global definitions
> Mesh
v Compeonent 1 (compl)
> Definitions
> Frames
v Geometry
> Curvature (Spatial)
> Mormal
»  Tangent 1
» Tangent2
v~ Coordinate
¥ - x-coordinate
y - y-coordinate @j Insert Expression
z - z-coordinate
dom - Entity index
edgparal - Arc length parameter - m
edgparnal - Normalized arc length parameter - 1
> Mesh
> Electric Currents
> Heat Transfer in Solids
~ Builtin
> Mathematical constants
> Mathematical functions
> Operators
»  Physical constants
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Use Shortcut

If you look at the example below, you will notice several lines of code begins with
model.component ("comp1").mesh("mesh1").

B+C pe=
E &)

Check Goto Record Use Create Local Send to Continue 5t
=@ Record Method Syntax Mode  Code  Shortcut Variable Chatbot ~

T

e| Language Elements  [2BC] =1
v Z1 ©
[El1 Model Expressions

Code

@ Preview createMesh X

// Reset the mesh
38 model.component (“compl™).mesh(" 1'e|5|'.'_' J.automatic(true);

model.mesh(“meshl").autoMeshSize(meshNumber);
model. component (" 01"y meshi "meshl").feature().clear();
model. component (" .mesh{"mesh1l").automatic(false);
model. component (" .mesh("m }.create("ftril™, "FreeTri");
model. component (" .mesh{"meshl").feature( "Ftril").selection().remaining(};

H

The Use Shortcut button is used to simplify code by replacing these instances with
a variable name.

In the example above, the mouse pointer has been positioned at mesh1 at the first
occurrence of model.component("comp1").mesh("mesh1"). Click the Use
Shortcut button to open the Use Shortcut dialog as shown below.

3 Use Shertcut *

Mame:  meshl
[] Update all methods
oK Cancel

Click OK to transform the source code into what is shown in the figure below.

@ Preview createMesh X

// Reset the mesh
38 meshl.automatic(true);

meshl.autoMeshSize(meshNumber);
meshl.feature().clear();
meshl.automatic(false);
meshl.create("ftril”, "FreeTri™);
meshl.feature("Ftril").selection().remaining();

The code starting with the prefix model.component("comp1").mesh("mesh1")
has been replaced with the variable mesh1. This variable is stored as a shortcut in
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the Declarations node, as shown in the figure below together with the
corresponding Settings window.

» Forms -
Events Settings
~ = Declarations Shorteuts
abe String
55 Double List of Shortcuts
If! Boolean o
<z» Number of Blades List MName Target Description
E Shortcuts coarseButton mainwindow/home/simulationSection/cr... | Shortcut to ltem
’ % Meth?ds normalButton mainwindow/home/simulationSection/cr... | Shortcut to ltem
> [l Libraries fineButton mainwindow/home/simulationSection/cr... | Shortcut to ltem
visualizationSection rnainwindow/horme/visualizationSection Shortcut to Ribbon section
reportMenu rnainwindow/horme/documentationSecti... | Shortcut to Menu
mesh1 Mesh/mesh1 Shortcut to Mesh

If you instead position the mouse pointer at comp1, then the first part
model.component ("comp1") will be replaced with a variable comp1.

Syntax Highlighting, Code Folding, and Indentation

Different language elements in the code are displayed using different styles. Refer
to the figure below for an example:

= with(model.result("pzl”));
set("looplevel™, new String[1{"7"}); // The first real eigenfregquency always
endwith();
model.result().numerical( gevl").setResult();

/f Plot the solution in the graphics for the selected device
String graphics = "";
= if (device.equals(
graphics = “/main
H
-| else if (device.equals("tablet")) {
graphics = "/mainTablet/graphicsl";

mputer”)) {
mputer/graphicsl";

-l else if (device.equals("smartphone”}) {

graphics = "/mainSmartphone/graphics1";
H
useGraphics(model.result(“pgl”), graphics);
mExtents(graphics);

5e
ZO0

isGeometryfctive = false;
setProgress(188);
= if (isPlaySound) {

playSoundForFrequency();
H
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This example includes five styles:

» Keywords, such as if, else, for, while, double, and int are displayed in
bold blue font

 Built-in methods are displayed in italic blue font

« Strings are displayed in red font

» Comments are displayed in green font

¢ The remainder of the code is displayed in black font

You can customize the syntax highlighting theme in the Preferences window. See
the next section “Method Editor Preferences” on page 208.

You can expand and collapse parts of the code corresponding to code blocks that
are part of for, while, if, and else statements. This feature can be disabled, as
described in the next section “Method Editor Preferences”.

When writing code, use the Tab key on your keyboard to automatically indent a
line of code and insert white spaces where needed. As an alternative, you can
right-click in the Method Editor and select Indent and Format, as shown in the
figure below.

while (k < MAXITERATIONS && Math.abs(fl) > toleranceFrequency) {

£2 = f1;
computedFreqg[ _ T
F1 = compute = Go to Mode F11
carry = L1; | 24 Goto Method Ctrl+Alt+Double-click
L1 = L1-f1%(
L2 = carry; | O Undo Ctrl+Z
L1 = Math.ma I
ko= k+l; -
setProgress Zoom 100% r
H v
L1 = Math.roun| db Cut Ctrl+X 3 de
model.parami). |_—‘E| Copy Ctrl+C
/ifq = fa;
if (Math.abs(f ﬁ Paste Ctrl+V
error("Compu ﬁ Delete Del I5)+"
H
3 § Selectal Ctrl+A
else { // "Find —
setProgress(@, || Indent and Format Tab
setProgress(25) 15 Create Local Variable Ctrl+1
computedFreque Lp"
== Toggle Comment Ctrl+7

setProgress(75

Indentation and whitespace formatting also happen automatically when the
keyboard focus leaves the Method Editor. You can disable this behavior in
Preferences in the Method section by clearing the Indent and format automatically
checkbox.

Using the context menu shown above, when right-clicking, you can toggle
comments on and off for an entire block of code that you have selected. This is
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available by selecting Toggle Comment from the menu or the keyboard shortcut
Ctrl+7.

THE NAME OF A METHOD

The Name of a method is a text string without spaces. The string can contain
letters, numbers, and underscores. The reserved names root and parent are not
allowed and Java® programming language keywords cannot be used.

Method Editor Preferences

To access the Preferences for the methods, choose File > Preferences and sclect the
Methods node in the tree.

O Preferences x

4 Methods

~ Application Builder ] View all code
> Forms Close brackets automatically
v Methods [ Generate compact code using ‘with' statements
Syntax Highlighting
Chathot Enable cade folding
Client-Server Indent and format automatically
> Computing [¥] Generate cade using component syntax
> Emal Ask for confirmation before running methods
: Fﬁ‘:mﬁtnf Zoom level: | 100 -] %
> Graphics
> Help
> Libraries
> Livelink Cannections
> Mesh
> Model Builder
Model Manager
> Physics Builder
> Results
Save
> Security
Updates
> UserInterface
Factory Settings

Factory Settings for Al Import.. | Export.. ok Cancel

By default, the Method Editor only shows the most relevant code. To see all Java®
code in a method, including its object oriented structure and import declarations,
select the View all code checkbox.

The Close brackets automatically checkbox controls whether the Method Editor
should automatically add closing brackets, such as curly brackets {}, brackets [1],
and parentheses ().
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The Generate compact code using ‘with’ statements checkbox controls the
utilization of with statements in automatically generated code. For more
information, see “The With Statement” on page 225.

If the Enable code folding checkbox is selected, you can expand and collapse parts
of the code corresponding to code blocks associated with for,while, if and else
statements.

Selecting the Indent and format automatically checkbox will ensure that code is
consistently indented and formatted.

The Generate code using component syntax option will generate method syntax that
also includes the model component scope.

Clear the option Ask for confirmation before running methods in the Model Builder
if you do not want to confirm when running methods in this way.

Use the Zoom level sctting to increase the font size in the Method Editor.

Under the Syntax highlighting node, the Theme list contains a few predefined
themes. Choose User defined to define a syntax highlighting mode where the
colors can be assigned to individual language elements.

Ctrl+Space and Tab for Code Completion

While typing code in the Method Editor, the Application Builder offers
suggestions for code completion. A completion list appears as you type, displaying
possible options. In certain cases, selecting an entry from the list opens a separate
window with detailed information about the selected option. You can also
manually trigger code completion at any time using the Ctrl+Space keyboard
shortcut. When accessing parts of the model object, a list of available completions
is displayed, as shown in the figure below.

@ Preview methodl X
1 model.m

massProp() Returns all mass properties.
massProp(String tag)

material() Returns: ProbeFeaturelist
material(String tag) List of mass properties
mesh()

mesh(5tring tag)

methodCall()

methodCall{String tag)

e aee

model(])

Select a completion by using the arrow keys to choose an entry in the list and press
the Tab or Enter key to confirm the selection.

| 209



If the list is long, you can filter by typing the first few characters of the completion
you are looking for.

For example, if you enter he first few characters of a variable or method name and
press Ctrl+Space, the possible completions are shown:

@ Preview methodl X

int ival, iva2, iva3;
2 iy
M ival
& ival
& iva3

In the example above, only variables that match the string iv are shown. This
example shows that variables local to the method also appear in the completion
suggestions.

You can also use Ctrl+Space to learn about the syntax for the built-in methods that
are not directly related to the model object. Type the name of the command and
use Ctrl+Space to open a window with information on the various calling
signatures available.

@ Preview D form1
1 playSound

@ playSound(String name) Tries to play a sound file on the client. At least .wav files ar
@ playSound(double hz, int milliseconds)
Parameters:
name MName representing the sound file to play.

For a list of available built-in methods, you can use the Language Elements window
described on page 194 or see “Appendix E — Built-In Method Library” on page
370.

Similar information is displayed in a tooltip when hovering over the different parts
of a method call, property name, declaration, or shortcut.

model.result("pgl”).feature(" ptt|'a:' 1"y set("expr", new String[]{xexpr, vexprl});

model.result("pgl").run(); Create a point trajectories plot to visualize trajectories

of geometric points.
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The keyboard shortcut Ctrl+Space can also be used in the Model Builder. For
example, when typing in an Expression field in Results, use Ctrl+Space to see
matching variables, as shown in the figure below.

Settings Graphics

Volume & Q @A

| Q @~ ¥

[ Plot
Label: Volume1
v Data

Dataset: From parent =

Tl
Lt

~ Expression ehv =f-

Expression:
dif
~  Default
solid.disp - Displacement magnitude - m
~  Model
~ Thermal Actuator (comp1)
~ Solid Mechanics
~ Displacement
solid.disp - Displacement magnitude - m
~ Builtin
~ Operators
~ Integration and statistics
diskavgl(r, expr) - Average on the disk with radius r
diskavgl(r, expr, NJ - Average on the disk with radius r
diskint(r, expr] - Integral on the disk with radius r
diskint(r, expr, NJ - Integral on the disk with radius r

Creating Local Variables

You can automatically determine and set the type of a local variable. For example,
typing:
var1l = model.geom();

and then clicking the Create Local Variable button in the Code group on the
Method tab in the ribbon:

laec] = B+C pé=
4 Ej o ] T

Check Gote Record Use Create Local
Syntax Mode  Code  Shortcut Variable

Code

updates the code to
GeomList vari= model.geom();
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Here, GeomList is automatically identified as the data type of model.geom(). The
Create Local Variable functionality operates similarly to the Use Shortcut feature.
For example, if multiple instances of model.geom() exist, they will all be replaced
with the new variable name vari.

Local Methods

You can add local methods to form objects, including buttons, menu items, and
events. Local methods do not have nodes displayed under the Methods node in the
application tree. In the method window for a local method, its tab displays the
path to its associated user interface component, as shown in the figure below for
the case of a checkbox object.

=]

@ Preview rmainComputer: prongLengthlnput

* Enables and disables objects when the Find prong length check box is changed.
* All objects can be found as Shortcuts in the Declarations node.

6 // Objects for the mainComputer form
prongLengthInput.set(“edi ", lisFindLength);
targetFrequencyText.set(" ", isFindLength);
targetFrequencyInput.set( ", isFindLength);
targetFrequencyUnit.set(" ", isFindLength);
frequencyToleranceText.set( s isFindLength);
frequencyToleranceInput.set(” d", isFindLength);
frequencyTolerancelnit.set("en s isFindLength);

In the Form Editor, you can right-click a form object and select Create Local
Method from a menu, as shown in the figure below.

Length: g o cm

Width: 5 Create Local Method

Applied voltage: | 2 Align »
Row »
Column »

@ Extract Subform

Copy as Code to Clipboard 3
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LocAL METHODS FOR BUTTONS, MENU ITEMS, AND GLOBAL EVENTS

For buttons, ribbons, menus, toolbar items, and global events, you can add a local
method by selecting Convert to Local Method from the toolbar menu button under

the sequence of commands, as shown in the figure below.

~ Choose Commands to Run "5

> [ Forms

» @ GUI Commands

> g Methods

» [ Libraries

~ < Model (root)
» () Global Definitions
> [l Component 1 (compl)
» ~db Study 1

v {E| Results

> 2% Derived Values

=# Edit Node Run (@ Plot Set Value Show
Show as Dialog Import File Enable Disable

L

Command lcon | Arguments
Compute Study 1 =
Plot Temperature (ht)
tLEeE-#

> Dialog Actio 5E Convert to Method
5E Convert to Form Method

> Position ant ..
‘ Convert to Local Method

> Appearance

The function of this button is similar to the Convert to Method and Convert to Form
Method buttons, described in the section “Creating a New Method” on page 19.
The only difference is that it creates a local method not visible in the global
method list in the application tree. It also opens the new method in the Method
Editor after creating it. Ctrl+Alt+Click can be used as a shortcut for creating the
local method. Clicking the button Ge te Method will open the local method. The
figure below shows a call to a local method associated with a button.

L
Command lcon | Arguments

onClick H

b BB -

» Dialog Acti| Go to Method

To avoid any risk of corrupting code in a local method, you are unable to use
Convert to Method when there is a local method present in the command sequence.
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LoCAL METHODS FOR FORM AND FORM OBJECT EVENTS

To add a local method for a form or form object event, select the Create Local
Method option in the Events section of the Settings window. The selected On data
change method changes from None to Local method, as shown in the figure below,
and the Method Editor is opened.

~ Events

On data change: Local method >~ I+

To open an existing local method in the Method Editor, click the Go to Source
button. To delete the local method, select Remove Local Method from the menu.

As an alternative to Ctrl+Alt+Click, you can right-click a form object and select
Edit Method from its context menu.

Applied voltage: =20 = my
Edit Method
Copy as Code to Clipboard 3
SooCut Ctrl+X
[E] Copy Ctrl+C
[F] Duplicate Ctrl+Shift+D
W Delete Del
E  Settings
B Hep Fl

For more information, see “Events” on page 154.

Methods with Input and Output Arguments

A method is allowed to have several input arguments and one output argument.
You define input and output arguments in the Settings window of an active

method window. If the Settings window is not visible, click Settings in the Method
tab of the ribbon. The figure below shows a method with two input arguments,
var and coords; and one output, coordsout. The method adds random values to
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the array, coords. The degree of randomness is controlled by the input variable
var. The new values are stored in the array coordsout.

@ Preview methodl X Seﬁmqs
int len = coords.length; =
coordsout = new double[len];

= for (int k = 8; k < len; k++) { Mame:  method1

LT @ & (G =Es Show in Model Builder
5 coordsout[k] = coords[k]+var=ds;

Methad

¥ ~ Inputs and Output
Inputs

L]
MName Type Default Description Unit

var Double * |20 Variation

coords Array 1D d¢ ~ |{0.9,0.8,1.1,1.2} Coordinates

* + S #
Output:  Array 1D double -

Name:  coordsout

When you call another method from a method, Ctrl+Alt+double-click opens the
window for that method. A method is allowed to call itself for the purpose of
recursion. For more information, see the Application Programming Guide.

Standard methods in the Method Editor can only use input and output arguments
of the data types defined under the Declarations node. To use more general Java
types as method arguments, create a utility class with the desired methods, as
described in the next section.

Utility Classes and Methods

A Utility Class node contains a utility class with methods that can be called from
other methods in your application. Utility classes support standard Java syntax and
class structure.

Because a utility class can be made application-agnostic, it allows you to share Java
code across different methods and reuse algorithm implementations across
multiple applications. Methods defined in a utility class can be called from any
other method within the same application.
For example, consider the following method, which builds all geometries in the
model:

public static void runAllGeom() {
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model.geom().run();
}
The name of the utility class must match the tag of the Utility Class node. If the
Utility Class node is named util1, you can call the method above from another
method using:
utilt.runAllGeom();

When working with utility classes, it is often useful to enable the View all code
setting under Preferences > Application Builder > Methods. This setting allows you
to view the full class structure and add import statements for Java libraries.

3 Preferences X

ETE Methods
-~ Application Builder View all code
> Forms Close brackets sutomatically

;ham:ttmds [] Generate compact code using 'with' statements
Client-Server Enable code folding
> Computing Indent and format automatically
> Email Generate code using component syntax
> Files [7] Askfor confirmation before running methods
> Geometry
) Zoom level: | 100 - %
> Graphics
> Help
> Libraries
> Livelink Connections
> Mesh
> Model Builder

Model Manager

Physics Builder

Results

Save

Security
Updates

User Interface

Factory Settings

Factory Settings for Al Import.. | Export.. oK Cancel
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The figure below shows the default structure of a newly added Utility Class node
named utili1.

Application Builder

gu|
=)

~ By

>

~

Main Window
Forms

Declarations

Methods

5] initializeApplication
clearSolutions
resetToDefault
setlnputChanged
validateStudySettings
wvalidateFrequencySweep
compute
evaluateMumericalResults
addPipeDiameter
addWallThickness
playlndividualFrequencies
playCombinationOfFrequencies
createReport
provideErrorMessages

Libraries

2] Images

=) Sounds

[3) Files

utill

Utilities
ParameterValidationResult

[@] Preview

packag

import
import
import
import
import
import
import

public

utill X

Utilities

e builder;

com.comsol.api.*;
com.comsol.api.database. *;

) ParameterValidationResult

com.comsol.api.database.param. *;
com.comsol.api.database.result.*;

com. comsol.madel. *;
com.comsol.model.physics.*;

com. comsol.model.application.*;

class utill extends ApplicationLanguageBase {

/== Invoke this method from other code by typing:

=

utill.exampleMethod();

You can add method arguments,
and add more methods.

change the name, return type,

public static void exampleMethod() {

| 217



The figure below shows a (renamed) utility class Utilities from the Organ Pipe
Designer app, available in the Application Libraries under the Acoustics Module.

App\ ication Builder [@] Preview ‘ arameterValidationResult
- + O .y package builder;
o import com.comsol.api.®;
= import com.comsol.api.database.®;
v [2] ergan_pipe_designmph (roof) import com.comsol.apli.database.param.*;
5 Inputs import com.comsol.api.database.result.*;
T Themes import com.comsol.model.*;
> [ Main Window import com.comsol.model.physics.*;
> B Ferms import com.comsol.model.application.*;
Events
> = Declarations public class Utilities extends ApplicationLanguageBase {
~ B Methods
initializeApplication Get the highest numeric value from parameter string array.
clearSolutions .
resetToDefault 5 public static double getHighestNumericParameterValue(String[] array) {
setinputChanged double dbl = 8.8}
validateStudySettings 18 |
validateFrequencySweep int length = array.length;
compute = if (length == @) {
evaluateNumericalResults G LA

addPipeDiameter java.util.List<String> list - new java.util.Arraylist<Strings();
addWallThickness for (String param : array) {

playlndividualFrequencies int index = param.trim().index0F("[");
playCombinationOfFrequencies

= if (index 1= -1) {
createReport String value = param.substring(@, index).trim();
provideErrorMessages list.add(value);
~ [ Libraries B } else { )
Bl Images list.add(paran.trim());
<) Sounds b
(2 Files java.util.Collections.sort(list);
utill dbl = toDoubLe(list.get(length-1));
Utilities

return dbl;
) ParameterValidationResult

Validate the length parameter input

Returns a ParameterValidstionResult object containing validation result and error me:

public static ParameterValidationResult validateLengthParameter(String lengthParameter) {
boolean valid = false;

String testParamName - "test_param”j
String errorMessage = "Invalid input:

“+lengthParaneter;

This utility class defines several methods that are called from some of the standard
methods in the app. The figure below shows an example call from the method

addPipeDiameter to the utility class method getHighestNumericParametervalue,
using the following syntax:

double dbl = Utilities.getHighestNumericParameterValue (dSweepTableInputs);
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App\ication Builder [@ Preview (D) utill (3) Utilities (Z) ParameterValidationResult addPipeDiameter X

- PO package builder;

] import com.comsol.api.®;
import com.comsol.api.database.®;

4 ) . .
[£] ergan_pipe_design.mph (roo) import com.comsol.api.database.param.*;

[ Inputs import com.comsol.api.database.result.”;
2 Themes import com.comsol.model.*;
> [7] Main Window import com.comsol.model.physics.*;
> [ Forms import com.comsol.model.application.=;
Events
> = Declarations public class addPipeDiameter extends ApplicationMethod {
v s Methods 5 public void execute() {
[Z initializeApplication o
5] clearSolutions * Adds a new row to the pipe diameter input table.
[Z] resetToDefault +/
[Z setinputChanged
[ validateStudySettings double dbl = Utilities.getHighestNumericParameterValue(dSweepTableInputs);
[Z validateFrequencySweep 19 dbl = dbl+l;
& compute String[] newArray = oppend(dSueepTableInputs, String.valusOf(dbl)+"[cn]™);
[Z evaluateNumericalResults dSweepTablelnputs = newArray;
| addPipeDismeter validateStudySettings();
[Z] addwallThickness
[ playindividualFrequencies
[E playCombinationOfFrequencies 1
[Z createReport
[Z provideErorMessages
~ [l Libraries
[2] Images
=})) Sounds
[3) Files

utill
Utilities
ParameterValidationResult

Unlike standard methods, utility class methods are not restricted to the data types
defined in the Declarations node. They can accept and return general Java types,
including custom data types. Such custom data types are defined using class
definitions, where you specify the structure and behavior of your own Java objects.

Debugging

In the ribbon, the Debug and Breakpoint sections contain the tools available for
debugging methods.

\ E B

L bzt mE =\l o
3> b u =l b e OF
Continue  Step  Step  Step  Stop  Break Debug  Java Breakpoints Remove Disable
Into Out Log Shell All All

Debug Ereakpoints
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For debugging purposes, click in the gray column to the left of the code line
numbers to set breakpoints, as shown in the figure below.

[&] Preview computeAndUpdateResults runFrequencyStudy X Data Viewer
= Computes the frequency. Used in the method computeAndUpdateResults. MName Value
+ Uses the prong length as input and outputs the frequency. v Pi Parameters 1
= > aslp 0.08314678844203713 m
S if (isFindlength) { // The input is a double when Find prong length is ac RR= D QLD
model.param().set("Lp”, pronglength+"[mm]"); Ll 0.0025 m
3 > =5 Lh 004m
v = Declarations
/# Compute the freguency by running Study 1 -
® e e a5 computedFrequency  413.2570127504355
ab device "computer”
/ In case there was no solution i  isFindLength true
o / Need to set pointer to last e @ isGeometryActive true
15 model.result().numerical(“gevi). I
1]
model. result (). numerical ("geva”) . setTndex( "1 Elaitialzed true
@ isPlaySound true
double[][] d = model.result().numerical("gevi”).getReal(); abe material "steel"
outputfrequency = dlel[el; =i solutionState “neselution”
o 123 soundDuration 1
= targetFrequency 4400
CaH Stack == toleranceFrequency 0.1
[o= prongLength £3.14678044203713
= =5 outputFrequency 00
Method Line
runFrequencyStudy 15
computeAndUpdateResults 2

When you run the application, the method will stop at the breakpoints. Click the
Step button in the ribbon to go to the next line in the method. The figure above
shows a method currently stopped at the line highlighted in yellow. The Data
Viewer window, seen to the right in the figure above, opens when a method is
paused at a breakpoint. Using the Data Viewer window, you review and modify
local variables, declarations, and parameters, while debugging.

The Call Stack window, below the method window, as seen in the figure above,
also opens when a method is paused at a breakpoint. You can select a method in
the call stack see the corresponding variables in the Data Viewer window.

Click Continue to run the method up until the next breakpoint. Click Stop to stop
running the method and exit. You can also stop the execution of a method while
testing an application by using the keyboard shortcut Ctrl+Pause. A dialog
appears, as shown below.

€ Error e

Method stopped.

oK
Click Break to suspend method execution at the next reached line in method code,

as if there had been a breakpoint there. Click Step Into to step into the next
method, if possible. The option Step Out continues until the current method
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returns. Use Remove All to remove all breakpoints. Instead of removing, you can
disable all breakpoints by clicking Disable All.

To get an overview of all breakpoints, you can open the Breakpoints window, as
seen in the figure below. To open this window, click the corresponding button in
the Method tab, in the ribbon section Breakpoints.

Breakpoints Call stack
LR o
§ f

Enabled | Method Line
[+ | computeAndUpdateResults 19
[+ | computeAndUpdateResults 23
[ | runFrequencyStudy 1
[ | runFrequencyStudy 16

You can enable and disable individual breakpoints, either from the Breakpoints
window or by right-clicking a breakpoint in the gray column to the left of the code
line numbers, as shown below.

/f Compute the fregquency by running Study 1

. moadal studul Tet AT mand e
% Remove Breakpoint Ctrl+B
@) Disable Breakpoint CtrlaShiftep | L"Cluded in the application ile

eigenvalue in the results node in case th
(=] model.result().numerical("gevl").setIndex("looplevelinput™, "last", @);
model.result().numerical("gev2").setIndex("looplevelinput™, "last", @);

| 221



Click the Debug Log to display customized debugging messages in a separate Debug
Log window, as shown in the figure below.

E] Preview
setProgress(28);
double ¥1 = computedFrequency-targetFrequency;
L1 = L1-f1*((L1-L2)/(f1-f2)); // The Secant method
L2 = carry;
L1 = Math.max(L1l, le-3);
int k = 2;
27 = while (k < HAXﬁTERATIONS &% Math.abs(fl) > toleranceFrequency) {
debuglog("k:");
debuglog(k);
£2 = F1;
computedFrequency = runFrequencyStudy(Ll);
F1 = computedFrequency-targetFrequency;
carry = L1;
L1 = L1-F1#((L1-L2)/(F1-¥2));

nputeAndUpdateResults X

debuglog("L1:");
debuglog(L1);
L2 = carry;
L1 = Math.max(L1l, le-3);
k = k+1;
setProgress (k*188/MAXITERATIONS) ;
1008 ~
Debug Log Breakpoints Call Stack
&L=
k:
2
Ll:
82.080525679068842
k:
3
Ll:
82.13673164013234
k:
4
Ll:

82.1361690475009

The example above illustrate that, as an alternative to using the Data Viewer
window, you can use the debugLog command a to display the values of variables
in the Debug Log window. The code below uses the debugLog command to display
the values of strings and components of a 1D double array.

int len=xcoords.length;
if (selected==0) {
for (int i = 0; 1 < len; i++) {

double divid=double(i)/len;
xcoords[i] = Math.cos(2.0*Math.PI*divid);
ycoords[i] = Math.sin(2.0*Math.PI*divid);
debugLog("x:");
debugLog(xcoords[i]);
debugLog("y:");
debugLog(ycoords[i]);
debugLog("selected is 0");
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}

Note that you can also use the Java Shell and Chatbot windows while debugging.
For more information on these tools as well as built-in methods for debugging,
see “Debug Methods” on page 379 and the Application Programming Guide.

The Model Object

The model object provides a large number of methods, including methods for
setting up and running sequences of operations. The Convert to Method, Record
Code, Editor Tools, and Language Elements utilities of the Method Editor produce
statements using such model object methods. For more information and example
code related to the model object and its methods, see “Appendix C—Language
Elements and Reserved Names” in the book Introduction to COMSOL
Multiphysics, the Application Programming Guide, as well as the Programming
Reference Manual.

Language Element Examples

The Java® programming language is used to write COMSOL methods, which
means that Java® statements and syntax in general can be used. This section
contains simple examples of some of the most common language elements. For
more information and examples, see the Application Programming Guide and
the Programming Reference Manual.

UNARY AND BINARY OPERATORS IN THE MODEL OBJECT

The table below describes the unary and binary operators that can be used when
accessing a model object, such as when defining material properties and boundary
conditions, and in results, expressions used for postprocessing and visualization.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

| () {1} . grouping, lists, scope

2 ~ power

3 -+ unary: logical not, minus, plus
4 [] unit

5 * binary: multiplication, division
6 + - binary: addition, subtraction
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PRECEDENCE LEVEL SYMBOL DESCRIPTION

7 < <= > >= comparisons: less-than, less-than or equal,
greater-than, greater-than or equal

8 == I= comparisons: equal, not equal

9 && logical and

10 || logical or

[ , element separator in lists

UNARY AND BINARY OPERATORS IN METHODS (JAVA® SYNTAX)

The table below describes the most important unary and binary operators used in
]ava® code in methods.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

I ++ -- unary: postfix addition and subtraction

2 ++ -- + - unary: addition, subtraction, positive sign,
negative sign, logical not

3 * | % binary: multiplication, division, modulus

4 + - binary: addition, subtraction

5 ! Logical NOT

6 < <= > >= comparisons: less than, less than or equal,
greater than, greater than or equal

7 == I= comparisons: equal, not equal

8 && binary: logical AND

9 || binary: logical OR

10 ?: conditional ternary

[ += -= *= [=  assignments

12 , element separator in lists

ACCESSING A VARIABLE IN THE DECLARATIONS NODE

Variables defined in the Declarations node are available as global variables in a
method and need no further declarations.

BUILT-IN ELEMENTARY MATH FUNCTIONS

Elementary math functions used in methods rely on the Java® math library. Some
examples:
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Math.sin(double)
Math.cos(double)
Math.random()
Math.PI

THE IF STATEMENT

if(a<b) {
alert(toString(a));
} else {
alert(toString(b));
}

THE FOR STATEMENT

// Iterate i from 1 to N:

int N=10;

for (int i = 1; 1 <= N; i++) {
// Do something

}

THE WHILE STATEMENT

double t=0,h=0.1,tend=10;
while(t<tend) {
//do something with t
t=t+h;
}

THE WITH STATEMENT

// Set the global parameter L to a fixed value
with(model.param());
set("L", "10[cm]");
endwith();
The code above is equivalent to:

model.param().set("L", "10[cm]");
The with command is specific to the COMSOL API and not part of the standard

Java® programming language.

ACCESSING A GLOBAL PARAMETER

You would typically use the Editor Tools window for generating code for setting
the value of a global parameter. While in the Method Editor, right-click the
parameter and select Set.

To set the value of the global parameter L to 10 cm:
model.param().set("L", "10[cm]");

To get the global parameter L and store it in a double variable Length:
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double Length=model.param().evaluate("L");

The evaluation is in this case with respect to the base Unit System defined in the
model tree root node.

To return the unit of the parameter L, if any, use:
String Lunit=model.param().evaluateUnit("L");

To write the value of a double to a global parameter, you need to convert it to a
string. The reason is that global parameters are model expressions and may contain
units.

Multiply the value of the variable Length with 2 and write the result to the
parameter L including the unit of cm.

Length=2*Length;

model.param().set("L", toString(Length)+"[cm]");
To return the value of a parameter in a different unit than the base Unit System,
use:

double Length_real = model.param().evaluate("L","cm");

If the parameter is complex valued, the real and imaginary part can be returned as
a double vector of length 2:

double[] realImag = model.param().evaluateComplex("Ex","V/m");

COMPARING STRINGS

Comparing string values in Java® has to be done with .equals () and not with the
== operator. This is due to the fact that the == operator compares whether the
strings are the same objects and does not consider their values. The below code
demonstrates string comparisons:

boolean streg=false;

String a="string A";

String b="string B";
streq=a.equals(b);

// In this case streg==false

streq=(a==b);
// In this case streg==false

b="string A";
streq=a.equals(b);
// In this case streg==true

ALERTS AND MESSAGES

The methods alert, confirm, and request display a dialog with a text string and
optional user input. The following example uses confirm to ask the user if'a direct
or an iterative solver should be used in an application. Based on the answer, the
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alert function is then used to show the estimated memory requirement for the
selected solver type in a message dialog:

String answer = confirm("Which solver do you want to use?",

"Solver Selection","Direct", "Iterative");
if (answer.equals("Direct")) {

alert("Using the direct solver will require about 4GB of memory when solving.");
} else {

alert("Using the iterative solver will require about 2GB of memory when
solving.");
}

Running Methods in the Model Builder

Running methods in the Model Builder is similar to calling methods from
applications with the most important difference being that from the Model
Builder methods can directly modify the model object in the current session.
Running methods from the Model Builder can be used to automate modeling
tasks that consist of several manual steps. For example, in a model with multiple
studies, you can record code for the process of first computing Study 1; then
computing Study 2, which may be based on the solution from Study 1; and so on,
with customized code in between the calls to Study 1 and Study 2.

From the Model Builder you can call methods directly through Method Calls or
using the options available in the Developer tab in the ribbon, described later in
this section. You can call methods indirectly through Settings Forms, for example,
by calling a method at the click of a button. For more information on Settings
Forms, see “Using Forms in the Model Builder” on page 134.

In contrast to methods that are called from applications, methods called from the
Model Builder cannot use built-in graphics methods such as printGraphics,
useGraphics, and zoomExtents. This restriction is due to the fact that a Settings
Form cannot include a graphics object.

Methods called in the Model Builder may have input and output arguments. Input
arguments to such methods that are called directly, and not indirectly from a
Settings Form, are given by adding a Method Call node under Global Definitions, see
“Method Calls” on page 231.

CONTROLLING WHICH MODEL TREE NODE SHOULD BE ACTIVE

To control which model tree node should be active after running a method in the
Model Builder you can use the built-in method selectNode. For example, a
method modifying the geometry can have as its last line of code:

selectNode (model.component("comp1").geom("geom1"));
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which will display the geometry and select the Geometry node.
The method selectNode has no function when used in an application.

GENERATING A REPORT AUTOMATICALLY AFTER COMPUTING

As an example of using a method from the Model Builder, consider the process of
first computing the solution and then generating a report. This can be automated
by first recording the corresponding operations in the Model Builder and then
running a method.

Let us start from the busbar example described in the book Introduction to
COMSOL Multiphysics. You can load this example MPH file from the
Application Libraries, as shown in the figure below.

Application Libraries

(* Refresh Update COMSOL Application Libraries

v [@ COMSOL Multiphysics
» [ Applications
» [ Acoustics
» [ Chemical Engineering
» [ Cluster and Batch Tutorials
» [ Diffusion
> [ Electromagnetics
» [ Equation Based
» [ Fluid Dynamics
» [ Geometry Tutorials
» M Geophysics
» [ Heat Transfer
» [ Meshing Tutorials
v [fiil Multiphysics
® busbar
busbar_assembly
O busbar_box

e Open the model.
+ In the model tree, right-click the Reports node under Results.
» Seclect Brief Report.

« Change the Output format to Microsoft® Word (this example would also
work with the default HTML format).

* Click the Browse button and select a file name in a location on your system
that you have write permissions to, for example
C:\COMSOL\BusbarReport.docx
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 Click Write to generate and save the report to file.

Settings

R

Preview All

@z Generate E Preview Selected

il

Label: Report1

> Template
~ Format
Output format: Microsoft Word b
Filename: CACOMSOL\BusbarReport.docx M Browse = [ =

[] Always ask for filename
Open finished report
[] Disable cross-reference hyperlinks

« Close the Microsoft® Word document that was automatically opened. (This
functionality is controlled from the Open finished report checkbox.)

* Click the Developer tab in the ribbon (of the Model Builder) and click the
Record Method button. Click OK in the dialog that opens, to confirm the
method name method1.

File Home Definitions Geometry Materials Physics Mesh Study Results Developer Report 1

A "5 Data Access New Method L> @ D

P Test Application E. Record Method

Application Method Run Run Stop  Break Java Settings
Builder Call ~ Method ~  Method Call ~ Shell Form ~
Application Create Methods Method Calls Run Code

* In the model tree, right-click the Study | node and select Compute (or use the
ribbon option for Compute).

« Inthe model tree, right-click the Report | node and select Write (if prompted
to overwrite, answer Yes). Close the Microsoft® Word document that was
automatically opened.

 Click the Developer tab in the ribbon and click the Stop Recording button.

File Home Definitions Geometry Materials  Physics

A "5 Data Access MNew Method |+
P Test Application EI Stop Recording

Application Method
Builder Call ~
Application Create Methods Method Calls
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* You can now switch over to the Application Builder, by clicking on the
Application Builder button in the ribbon, and sce the recorded method in the
application tree and in the Method Editor.

File Home  Method

Utility Class (2] [e] Language Elements  [a5c] = B+C wd=
_ _ v =] @& 5 &
i=sBxiamallavalibiaty Revert E"Z Mol Check Gote Record Use Create Local
C External C Library to Saved E‘. Record Method Syntax  Node Code Shortcut Variable
Libraries Edit Code
Application Builder (G Preview L
tv Sl B model.stud};’( . J.createfutoSequences(“"all");
= T model.sol( J.runAll();
Type filter text o model.result("pgl”).runi);
. E] busbar.mph (o0t . model.result().report{"rptl”).run();
ﬁ Inputs
% Themes
¥ D Main Window
3 Forms
Events
= Declarations
~ % Methods
method1
» [ Libraries

For more information on code generated from the Study node, see the
Application Programming Guide.

* Here you can review and edit the generated code and also change the name
of the method to, for example, compute_and_report.

Settings

Method

MName: compute_and_report

Show in Model Builder

* Go back to the Model Builder by clicking on the Model Builder button in the
ribbon.
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 In Global Definitions > Parameters |, change the Length to 15[cm].

Model Builder

— = =t w

v 4@ busbar.mph (root)
v () Global Definitions
Fi Parameters 1
(¢ Default Model Inputs
=) Materials
> [l Component 1 (compl)
» ~do Study 1

~ @ Results

Datasets

> 2 Derived Values

> B Tables

» @ Electric Potential (ec)
> NB Electric Field (ec)

> Nl Temperature (ht)

» §@ Current Density
Export

v [# Reports

Settings
Para

Label: Parameters 1

~ Parameters

" Mame Expression
L 15[em]
rad_1 6[mm]

tbb 5[mm]

whb 5[cm]

mh 3[mm]

htc 5[W/m*2/K]
Vtot 20[mV]

Value
0.15m
0.006 m
0.005 m
0.05 m
0.003 m
5W/(m™K)
0.02V

Description
Length

Bolt radius
Thickness
Width

Maximum element size

]

Heat transfer coefficient

Applied voltage

* In the ribbon, click on the Developer tab and sclect compute_and_report from
the Run Method menu (if prompted to confirm, answer Yes).

Geometry  Materials  Physics
Mew Method b=
E Record Method Method

Call ~

Create Methods

Method Calls

Mesh

7]

Method ~

Results  Develop

Run Stop

Method Call ~

compute_and_report

Depending on your security settings, you may get an error message. To avoid this
error, open File > Preferences, go to the Security page, and change File system access
to All files. You can change this back to its default setting after running this

example.

Note that you can create multiple methods and call them from the Model Builder.

METHOD CALLS

A call, in the Model Builder, to a method for a specific set of input argument
values can be made by adding a Method Call node under Global Definitions. To add
a Method Call node, right-click Global Definitions and select one of the methods that

| 231



you have created. The figure below shows a Method Call to a method for creating
a geometric array.

Model Builder Settings
— — = =t R A4 Method Call
c B=B
~ @ createrray.mph (root) Label Createfrray 1
v (il Global Definitions Tag: ethodeall
Fi Parameters 1
%) Materials Method: createfrray
Createfrray 1 ~ Inputs
~ [l Component 1 {comp1)
» = Definitions X-position: 1
y
’ Geom.etry‘l ¥-position: 2.5
22 Materials
A Mesh 1 X-displacement: 15
> {8 Results ¥-displacement: 1.5
Rotation angle: 0
Scaling: 0.5
Mumber of objects X: &
Number of objects ¥:

The user interface layout of a Methed Call cannot be customized. Instead, for

customizing use a Settings Form, sce “Using Forms in the Model Builder” on page
134.

You can run, stop, or edit a Method Call by clicking the corresponding toolbar
button in the Settings window, as shown in the figure below.

Settings
Method Call
E|

Tag: methodcalll

Method: createfrray

This functionality is also available from the Developer tab in the ribbon of the
Model Builder, as shown in the figure below.

Physics Mesh  Study Results Developer

‘m | 5 =

Method Run Run Stop  Break
Call ~ Method ~  Method Call ~
Method Calls Create Array
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The figure below show the corresponding method’s Settings window in the
Application Builder with the definitions of the input arguments.

Settings

Method

Mame:  createfrray

Show in Madel Builder

~ Inputs and Output

Inputs
" MName Type Default Description Unit
xb Double > |0 X-position
yb Double > |0 ¥-position
dx Double =11 X-displacement
dy Double =11 ¥-displacement
ang Double > |0 Rotation angle
scl Double =11 Scaling
nobjects_k Integer =11 Mumber of objects X
nobjects_| Integer =11 Mumber of objects ¥

_l’_

Output: Mone -

You can add multiple Method Call nodes for the same method where each call can
contain a different set of input argument values.

There is no direct way of using output arguments from a method in the Model
Builder. However, you can use calls to the built-in method message to display
variables used in a method in the Messages window in the COMSOL Desktop
environment. The following example shows how to display the value of two
double variables width and depth in the Messages window:

message ("Width: "+toString(width));

message("Depth: "+toString(depth));
For debugging, you use the general techniques outlined in the section
“Debugging” on page 219.
For reusing a Settings Form between sessions, you can create an Add-in. For more
information, see “Creating Add-ins” on page 234.
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Creating Add-ins

To customize the workflow in the Model Builder, you can use a Method Call or a
Settings Form. However, these are associated with a specific MPH file, and you
may want to reuse them between sessions or share them with colleagues. To make
this possible, you can create an add-in based on a Method Call, Settings Form, or a
custom ribbon tab. Such add-ins can then be stored in a user-defined add-in
library. In addition, COMSOL Multiphysics comes with built-in add-in libraries.
For the add-ins in the built-in library, you can review their Application Builder
settings, including forms and methods, to quickly learn how to build your own
add-ins.

Creating an add-in is similar to creating an application, with a few differences.
Add-ins do not have their own graphics window, but instead use the main Graphics
window in the Model Builder. An add-in should preferably work, or give
controlled error messages, for any type of model.

To create an add-in, start from a form that you have created in the Application
Builder and click Add-in Definitions in the Home tab of the ribbon, as shown below.

| Settings &= Add-in Definition

il P . . Y =
Editor Tools Application
Create Add-ir Argument

Add-in Inputs

Right-click the Add-in Definitions node in the application tree and select Form
Definition.

v [&] Untitled.mph (root)
2= Add-in Definition

E Inputs 2%, Create Add-in Fg
% The.mes. D Form Definition
¥ D Main Window
B Forms Method Definition
Events ™1 Ribbon Tab Definition
= Declarations [ Ternplate Definition
EE Methods
» [ Libraries = MNode Group
[ Delete Del

The figure below shows the Settings window for the Form Definition. Here, you can
type a Label for the add-in form as well as select which form to use for the add-in.
The Label will be displayed in the user-defined add-in library. You can select

whether the form should be displayed as a Settings form in the model tree or as a
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dialog. The Allow multiple settings forms checkbox is used to allow for more than
one instance of the Settings form in the model tree. The Description is displayed in
the add-in library and as a tooltip when choosing among add-ins in the ribbon.

Settings

Form Definition

Label: Image to Curve
MName: formdefinition1
Form: main
Show as: Settings form
[] Allow multiple settings forms

~ Description

Use the contour plot of an imported image to create an
interpolation curve which can be included as part of a 2D
model or 3D work plane|
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Click the Add-in Definition node to sce its Settings window, as shown below.

Settings
Add-in Definition
£k, Create Add-in

v Add-in
Filename: image_to_curve.mph W& Browse
Label: Image to Curve

Unique identifier.  com.comsol.addins.mph.image_to_curve

~ Protection

Editing password:

~ Presentation

Description

This add-in lets you use an image as a starting point for an analysis. An
interpolation curve is created from a contour plot of an imported image.
This interpolation curve can then be used as part of a 2D model or 3D work
plane.

Preview image: | image_to_curve.png >~ + =

Preview (recommended size 440 = 215 px)

The Filename is the location of the add-in MPH file in the user-defined add-in
library. This location can be on a shared network drive if you wish to share the
add-in with your colleagues. The Label will be displayed in the Add-in Libraries
window. The Unique identifier is what identifies the add-in and is intended to be
unique for any COMSOL Multiphysics session. The unique identifier is
recommended to be in a format similar to <company name>.<Add-in name> ;for
example, my_company.my_add-in. The Editing password will be applied to the
created add-in and is different from the editing password that you can specify in
the root node Settings window of the MPH file used to create the add-in.
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To create the add-in, which is a special type of MPH file, click the Create Add-in

button.

Settings
Add-in Definition
Qh, Create Add-in

« Add-i| Create Add-in (F8)

As an alternative to a Form Definition you can use a Ribbon Tab Definition to create
one or more ribbon tabs with customized buttons (items) and menus. The figures
below show the settings for an add-in that defines a custom ribbon tab with menus

and buttons.

Application Builder
e B -

i)

~ E] colored_selections.mph (root)
v Eiz Add-in Definition
[™] Colored selections
ﬁ Inputs
% Themes

v D Main Window
[E] File Menu
~ [ Ribbon
~ [ Colored selections {ribbontab 1}
~ Selections {ribbonsection 1}
~ EI Select {menu}
Domains {toggle_item}
Boundaries {toggle_item2}
El Generate {item 1}
[ Clear fitema)}
~ Settings {ribbonsection2}
[+ settings fitem1}
[+] Reset {item2}
~ [ Forms
¥ D settings
Events
Declarations
v [ Methods
initialize

checkComponent

»E

updateGeometrySelection
componentDim
isDefinedByMesh
autoRandomColoredSelections
clearAutoColoredSelections

v
[
o
2z
oo

-1

Settings

Ribbon Tab Definition

Label: Colored selections

Ribbon tab: Colored selections {ribbontab1} - E:l

~ Description

The Colored Selections add-in lets you automatically color
all domains or boundaries for easier identification. Colors
are selected at random, and you can adjust the tint or
shade to your preference.
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The figure below shows this custom ribbon tab after it has been added from the
Add-in Libraries.

e e @ E » v " v

i % Untitled.mph - COMSOL Multiphysics

File Home Definitions Geometry Materials Physics  Mesh  Study Results Developer Colored Selections
G % (s —

'. if.ez': —

Select  Generate Clear Settings  Reset

+ | Domains Settings

Boundari = c

| = Poundaries Settings Graphics
— >t | $Ety Bl E~ B~ Untitled.mph QQ @~

Add-in Libraries

To use an add-in from the Add-in Libraries, you first need to enable it. In the
Developer tab in the Model Builder, click Add-in Libraries.

Developer
> M \
O ® e C
Stop Break Java Settings  Update Show Add-  Add-in Refresh Clear
Shell Form ~  Forms  Dialog ~ ins ~  Libraries  Add-ins  Add-ins
Forms Add-ins

In the list of add-ins, select the checkboxes of those add-ins that you want to
enable.

e e & & » v " v

File

Add-in Libraries

-+ Add Add-in (* Refresh F’%_: Update COMSOL Add-in Libraries

v [@ COMSOL Multiphysics
» E ] colored_selections
o image_to_curve
O ] mesh_partition_with_ball
O ESY particulate_composite_random
O & pid_controller
Ei ] planar_cut
O F state_space_controller
> % AC/DC Module
¥ 9 Plasma Module
¥ Porous Media Flow Mocule
> B2 Subsurface Flow Module

viN v v v v
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Once enabled, the corresponding add-ins will be displayed when clicking the

Add-ins button in the Developer tab.

g . C ) a= | ¢p

e oL <le
Add-  Add-in Refresh Clear Data Compare  Compare
ins » Libraries  Add-ins  Add-ins Viewer with Saved

Image to Curve Compare

D Image to Curve

Planar Cut Image to Curve

Use the contour plot of an imported
image to create an interpolation
curve, which can be included as part
of a 2D model or 30 work plane.

D Planar Cut

ﬂ Press F1 for more help.

The figure below shows the Settings Form for one of the built-in add-ins.

Filter %) Contour ' Curve *7 Reset

px
px

Browse...

Model Builder Settings
“— ® Etv Elv - B~ Image to Curve
e Browse |4 Plot G
v 4@ busbar.mph (root) v Image
~ -ﬁl Global Definitions X
Fi Parameters 1 xisze &
ol Image (i2m_im) y: size 750
4 Default Model Inputs Image width:  0.23
i) Materials . .
Filename: beam_cross_section.png
[ Image to Curve 1
v [l Component 1 (comp) Filter: Gaussian
» = Definitions Positive image
> \
» gi Materials v Contour
> 3 Electric Currents (ec) .
> I Heat Transfer in Solids (ht) Automatic contour threshold
» _{;} Multiphysics Contour threshold
> /A Mesh 1 R -
» ot Study 1 L
> [El Results

> Curve

If you want to review and edit the Application Builder settings for a built-in
add-in, you can open the corresponding MPH file. In a typical Windows®

installation, the built-in add-in library is located at:
C:\Program Files\COMSOL\COMSOL63\Multiphysics\addins

You can browse to a user-defined add-in library by clicking the Add User Add-in

Library button at the bottom of the Add-in Libraries window.
Al = 51
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The user-defined add-in library will be displayed alongside the built-in add-in
libraries, as shown below.

Add-in Libraries

+ Add Add-in (¥ Refresh ‘E&E Update COMSOL Add-in Libraries

v [fiii My Add-ins
b E busbar_controls
D Busbar Controls
> [@ COMSOL Multiphysics
> % AC/DC Module
> &) Plasma Module
¥ Porous Media Flow Module
> B2 Subsurface Flow Module

You can also click the Add Add-in button at the top of the Add in Libraries window
to browse to a user-defined add-in which will then be copied to a standard location
in the COMSOL Multiphysics installation folder (typically at
C:\Users\paul\.comsol\v63\addins or similar).

Workflow When Creating and Editing Add-ins

When creating and editing add-ins, you will find it useful to have two sessions of
COMSOL Multiphysics open at the same time: one session for the original add-in
MPH file where you work mostly in the Application Builder, and one session for
testing the add-in in the Model Builder. When testing an add-in using the Model
Builder, make sure to test for a great variety of models, including models of
different spatial dimensions as well as models with more than one model
component. Use the Refresh Add-ins button to make sure you always use an
updated version of the add-in you are editing.

= = O

— =
Add-  Add-in Refresh Clear
ins »  Libraries  Add-ins  Add-ins

Add-ins

240 |



Libraries

In the application tree, the Libraries node contains images, sounds, and files to be
embedded in an MPH file so that you do not have to distribute them along with
the application. In addition, the Libraries node may contain Java® utility class
nodes and nodes for external Java® (.jar) and C libraries (.d11 etc.), as well as
Add-ins. For more information on using utility classes and external libraries, see
the Application Builder Reference Manual.

Application Builder
— Etv Elv B~

v [&] Untitled.mph (root)
ﬁ Inputs
% Themes
» D Main Window
) Forms
Events
= Declarations
% Methods
v [fifi Libraries
[#] Images
=) Sounds
fE3 Files
) utill
) util2
) util3
Jzva External Java Library 1

C External C Library 1 {nativel}
25 Add-in1

Embedded files can, for example, be referenced in form objects or in methods by
using the syntax embedded:///file1, embedded:///file2, and so on. For
example, to reference the image file compute.png, use the syntax
embedded:///compute.png.

Note that you are not required to have the file extension as part of the file name;
instead, arbitrary names can be used. To minimize the size of your MPH file,
delete unused images, sounds, or other files.

To manage files loaded by the user of an application at run time, you have
several options, including using File declarations and File Import form
objects. For more information on files to be loaded at run time, “File” on
page 175, “File Import” on page 308, and “Appendix C — File Scheme
Syntax” on page 348.
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Images

The Images library contains a number of preloaded sample images in the PNG file
format to be used as icons in apps. If you wish to embed other image files, click
the Add File to Library button below the List of Images. A large selection of icons
is available in the COMSOL installation folder in the location data/icons.
Images can be referenced in image form objects, in methods, or, in the form of
icons, in various form objects. For images used as icons, two sizes are available:

16-by-16 pixels (small) and 32-by-32 pixels (large).

Settings

Images

List of Images

MName Description
animate_32.png COMSOL sample image
animate.png COMSOL sample image
clear_32.png COMSOL sample image
clear.png COMSOL sample image
compute_32.png COMSOL sample image
compute.png COMSOL sample image
comsol_32.png COMSOL sample image
comsol.png COMSOL sample image
delete_32.png COMSOL sample image
delete.png COMSOL sample image

S+ 0B
Preview
i3

Supported image formats are JPG, GIF, BMP, and PNG.

To preview an image, click the name of the image in the List of Images. The image
is displayed in the Preview section

To export a selected image, click the Export Selected Image File button to the right
of the Preview button.

Sounds

The Sounds library contains a few preloaded sounds in the WAV-file format. If you
wish to embed other sound files, click the Add File to Library button below the List
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of Sounds. A larger selection of sounds is available in the COMSOL installation
folder in the location data/sounds.

Settings

Sounds

List of Sounds

N
MName Description
fail.wav COMSOL sample sound
neutral.wav COMSOL sample sound
SUCCESS.Wav COMSOL sample sound
_l’_

To play a sound, click the name of the sound and then click the Preview button
below the List of Sounds.

Click the Export Selected Sound File button to the right of the Preview button to
export a selected sound.

To play a sound in an application, add a command in the Settings window of a
button, ribbon, menu, or toolbar item. In the Choose Commands to Run section,
select the sound and click the Run button below the tree. This adds a Play
command to the command sequence, as shown in the figure below.

~ Choose Commands to Run "5

> [ Forms

» @ GUI Commands
> [ Methods
v [fifi Libraries
v i) Sounds
123 suCcesswav
123 failwav
123 peutral.wav

Edit Node Run [a| Plot Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Play 'success.wav' >
=% . v

In methods, you can play sounds using the built-in method, playSound, such as:

playSound("success.wav");
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Files

The Files library is empty by default. Click the Add File to Library button to embed
files of any type in your application.

Settings

List of Files

" : -
MName Copied from Description

datal.txt CACOMSOL\datal bt File

datal.txt CACOMSOL\data2 bt File

data3.txt CACOMSOL\data3 bt File

mydata.cswv | CAVCOMSOL\mydata.csv | File

+

Use embedded:///filename to refer to a file with the name
filename in the application.

Click the Export Selected File button to the right of the Add File to Library button
to export a selected file.

+

Use embedded:///filena Export Selected File the name

filename in the applicati

The embedded files can be referenced in a method by using the syntax
embedded:///datal.txt, embedded:///data2.txt, and so on. For more
information, see “File” on page 175, “Appendix C — File Scheme Syntax” on
page 348, and “File Methods” on page 371.
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Appendix A— Form Objects, Ribbon, Menu, and Toolbar
ltems

This appendix provides information about forms, form objects, ribbon, menu, and
toolbar items and expands upon the sections “The Form Editor” on page 57 and
“The Main Window Editor” on page 141.

List of All Form Objects, Ribbon, Menu, and Toolbar
Items

The objects and items followed by a * in the following list have been covered
previously in a separate section. The remaining objects and items are discussed in
this appendix.

e Input
- Input Field*
- Button and Item*
- Checkbox
- Toggle Button and Toggle Item
- Combo Box
e Labels
- Text Label*
- Unit*
- Equation

- Line
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» Display
- Data Display*
- Graphics*
- Web Page
- Image
- Video
- Progress Bar
- Gauge
- Log
- Message Log
- Results Table
» Subforms
- Form
- Form Collection
- Card Stack
¢ Composite
- File Import
- Information Card Stack
- Array Input
- Radio Button
- Selection Input
* Miscellaneous
- Text
- List Box
- Table
- Slider
- Knob
- Hyperlink
- Toolbar and Form Toolbar

- Spacer
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Checkbox

A Checkbox has two values: on for selected and off for cleared. The state of a
checkbox is stored in a Boolean variable in the Declarations node.

USING A CHECKBOX TO CONTROL VISUALIZATION

The figure below is from an application where a deformation plot is disabled or
enabled, depending on whether the checkbox is selected.

Deformation DEfDrmatiDE‘L

Compute Compute

&

The screenshot on the left shows the running application. The screenshot on the
right shows the corresponding form objects in grid layout mode.

In the example below, the state of the checkbox is stored in a Boolean variable
deformation, whose Settings window is shown in the figure below.

Settings

Boolean

List of Variables

» i i
MName Initial value Description
deformation | true
=+ = - +
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The figure below shows the Settings window for the checkbox.

Settings

Mame:  checkbox1 ,@
Text: Deformation

Tooltip:

~ Source @+ "B

v = Declarations
~ E Boolean
deformation
Model (root)

w
)
¢

Use as Source Edit Mode

Selected source:

E Boolean=deformation
Initial value: Custom value =

Initial state: Selected =

Value for selected: on

Value for cleared:  off

> Position and Size
> Appearance

~ Events

On data change: Local method ~ 31 + 7

You associate a checkbox with a declared Boolean variable by selecting it from the
tree in the Source section and clicking Use as Source.

The text label for a checkbox gets its name, by default, from the Description ficld
of the Boolean variable with which it is associated.

The Initial value of the variable deformation is overwritten by the Value for
selected (on) or the Value for cleared (off) and does not need to be edited. When
used in methods, the values on and of f are aliases for true and false, respectively.
These values can be used as Booleans in if statements, for example.

The code statements below come from a local method that is run for an On data
change event when the value of the Boolean variable deformation changes.

model.result("pg1").feature("surfi1").feature("def").active(deformation);
useGraphics(model.result("pg1"), "graphicsi");
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USING A CHECKBOX TO ENABLE AND DISABLE FORM OBJECTS

The figure below shows a part of an application where certain input fields are
disabled or enabled, depending on if the checkbox is selected.

Geometry & Material
Find prong length
Target frequency: 440 Hz

The figure below shows the Settings window for a checkbox associated with a
Boolean variable isFindLength used to store the state of the checkbox.

Settings
Checkbox

Mame:  checkbox1 =
Text: Find prong length
Tooltip:

v Source @+ B

v = Declarations
~ @ Boolean
isFindLength
& isPlaySound
@ islnitialized
@ isGeometryActive
» abc String
& Root Model (root)

w

@_‘ Use as Source =g Edit Node

Selected source:

@ Boolean=isFindLength

Initial value: From data source -
Value for selected: on

Value for cleared:  off

The code statements below come from a method that is run for an On data change
event when the value of the Boolean variable isFindLength changes.

prongLengthInput.set("editable", !isFindLength);
targetFrequencyText.set("enabled", isFindLength);
targetFrequencyInput.set("enabled", isFindLength);
targetFrequencyUnit.set("enabled", isFindLength);
frequencyToleranceText.set("enabled", isFindLength);
frequencyToleranceInput.set("enabled", isFindLength);
frequencyToleranceUnit.set("enabled", isFindLength);
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Toggle Button and Toggle Item

A toggle button form object or toggle item is a button with two states: selected
and deselected. The figure below shows the ribbon toggle item Show Bus Bar from
the Lithium Battery Pack Designer app, available in the Application Libraries
under the Battery Design Module. In the left figure, the toggle item is in the
selected state, while in the right figure, it is in the deselected state.

D] {5 Slice H Show Bus Bar @ D] {5 Slice H Show Bus Bar @
1 1

- = i . 8 .
L Numerical Temperature L Numerical
[ Animate 888 Show Edges Results [ Animate 888 Show Edges Results
Battery Pack Battery Pack

Temperature

The information in this section applies to Toggle Button, Menu Toggle Item and
Ribbon Toggle Item.

USING A TOGGLE ITEM IN THE RIBBON TO ENABLE AND DISABLE PART OF A
MODEL

The two states of a toggle button are typically stored by linking it to a Boolean
variable. The figure below shows the Settings window of a button that enables and

250 |



disables the busbar part of a battery pack model depending on its state. The
Boolean variable isShowBusBar is selected in the Source section.

ettings

g w

MName: showBusBarToogle =
Text: Show Bus Bar

lcon: I show_busbarpng ~ —+ [=
Sizez Small v
Tooltip: Show the bus bar.

Keyboard shortcut:
State

Visible

Enabled

~ Source DB

~ Declarations

» abc String
~ B Boolean
= islnitialized
& isBatteryCell
@ isBatteryPack

B2l isShowBusBar
Use as Source Edit Node
Selected source:
= Boolean=isShowBusBar
Initial value: From data source =

Value for selected: on

Value for cleared:  off

Enabled corresponds to the Boolean variable isShowBusBar being true, which
indicates that the toggle button is selected. Disabled corresponds to the Boolean
variable isShowBusBar being false, which indicates that the toggle button is
deselected.

For a toggle button, the lcon is displayed when the button is not selected, while
the Selected icon is displayed when the button is selected.

For a toggle item, the Selected icon option is not available. Instead, the lcon will
appear highlighted when the toggle item is selected.

Below the Source section is the Choose Commands to Run section, with a choice for
Action that represents two different commands for Select and Deselect. The figure
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below shows the Settings window for Deselect with calls to the custom methods
showAndHide and updateGraphicsWindow.

~ Choose Commands to Run e

=
> [ Forms
» @ GUI Commands
» = Declarations
v % Methods
initializeApplication
setActiveMavigation
updateGraphicsWindow
showAndHide
toggleDynamicHelp
changeSolutionStatel
=| changeSolutionState2

Edit Node Run [Z3 Plot Set Value Show
Show as Dialog Import File Enable Disable

Action: Deselect -
L

Command lcon | Arguments
showAndHide [E |hide3, true

updateGraphicsWindow @ activeGraphics
g~ #

The next figure shows the command sequence for Select with calls to the same
methods but with different input arguments to the first method.

~ Choose Commands to Run e

> [ Forms

» @ GUI Commands

» = Declarations

v % Methods
initializeApplication
setActiveMavigation
updateGraphicsWindow
showAndHide
toggleDynamicHelp
=] changeSolutionStatel

=| changeSolutionState2

Edit Node Run [Z3 Plot Set Value Show
Show as Dialog Import File Enable Disable

Action: Select -
L

Command lcon | Arguments
showAndHide [F |hide3, false

updateGraphicsWindow @ activeGraphics

g~ #
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A toggle button is similar to a checkbox in that it can be linked to a Boolean
variable. For a toggle button, you define the action by using a command sequence,
whereas for a checkbox, you define the action by using an event (which can also
be a command sequence).

For simultaneous control of multiple toggle buttons you can link to a string
variable, instead of a Boolean variable. This enables you to group the behavior of
multiple toggle buttons similar to that of a radio button.

Combo Box

A Combo Box can function as either a combination of a drop-down list box and an
editable text field or as a drop-down list box without editing capabilities.

USING A COMBO BOX TO CHANGE RESULTS PARAMETERS

To illustrate the use of a combo box, consider an application where the user selects
one of six different mode shapes to be visualized in a structural vibration analysis.
This example uses a Solid Mechanics physics interface with an Eigenfrequency
study and is applicable to any such analysis.

This example is a modification of the Tuning Fork app available in the Application
Libraries, under COMSOL Multiphysics. The app is first used to determine a
prong length corresponding to 440 Hz. It is then saved as an MPH file and edited
further by adding forms and form objects.

The six mode shapes correspond to six different eigenfrequencies that the user
selects from a combo box:

Frequency: | Fundamental tone ~
Fundamental tone
Overtone 1
Overtone 2
Overtone 3
Overtone 4
Overtone 5
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In this example, the combo box is used to control the value of a string variable
mode. The figure below shows the Settings window for this variable.

Settings

String

List of Variables

L L. -
MName Initial value | Description
mode 7 Mode number

== - +

Selecting the Source

The figure below shows the Settings window for this combo box.

Settings
Combo Box
MName: combobox =
~ Source @+ "B

v = Declarations
w abe String
=5 mode
Use as Source Edit Node

Selected source:

abe String=mode

Initial value: From data source =
~ Choice List @+
Available: Selected:

<%» Choice List 1 {choicelist1}

[] Allow other values

In the Source section, you select a scalar variable that should have its value
controlled by the combo box and click Use as Source. In the Initial values list of the
Settings window of the combo box, choose a method to define a default value for
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the combo box. The options are First allowed value (the default) and Custom
default. For the Custom default option, enter a default value in the associated field.
The default value entered must be one of the allowed values.

Choice List

Vibrational modes 1-6 correspond to trivial rigid body modes and are not relevant
to this application; the first mode of interest is mode 7. A choice list allows you to
hide the actual mode values in the model from the user by only displaying the
strings in the Display name column; the first nonrigid body modes are named
Fundamental tone, Overtone 1, Overtone 2, and so on.

In the section for Cheice List, you can add choice lists that contribute allowed
values to the combo box. The Choice List declaration associated with this example
is shown in the figure below.

¥ Events

v = Declarations Seﬂlﬂgs
=bc String Chaoice List
<> Choice List 1 {choicelist1
& N};thozlsce st {ehoicelistl) Label:  Choice List 1 =

MName:  choicelist]

List Content

L
Value | Display name

7 Fundamental tone
8 Overtone 1
9 Overtone 2
10 Overtone 3
1l Overtone 4
12 Overtone 5

t 4R - g

The string variable mode is allowed to have one of these six values: 7, 8,9, 10, 11,
or 12. The text strings in the Display name column are shown in the combo box.

In the Settings window of the combo box, you can select the Allow other values
checkbox to get a combo box where you can type arbitrary values. These combo
boxes can accept any value and are not limited to those defined in the choice lists.
In this example, however, only six predefined values are allowed.

For more information on choice lists, see “Choice List” on page 174.

Events

In the Events section, specify a method to run when the value of the combo box,
and thereby the string variable used as the source, is changed by the user. In the
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present case, the value of the variable mode is changed, and a local method is run,
as shown below.

~ Events

On data change: Local method ~ 3t~

The code for the local method is listed below.

with(model.result("pgl1"));
set("looplevel”, new String[]{mode});

endwith();

model.result("pg1").run();
This code links the value of the string mode to the Eigenfrequency setting in the
Plot Group pg1. In this case, the string svar takes the values "7", "8", "9", "10",
|I11 II’ Or |I12II.
The code above can be generated automatically by using the recording facilities of
the Method Editor:

* Go to the Model Builder and, in the Developer tab, click Record Method.

* By default, an Eigenfrequency study for structural mechanical analysis creates
a Mode Shape plot group. In this plot group, change the Eigenfrequency from
mode 7 to mode 8. In the figure below, this corresponds to changing from
440 Hz to 633.52 Hz in the Settings window for the Mode Shape plot group.

Settings
3D Plot Group
[ Plot = 4= =» =]

Label:  Mode Shape (solid) =5
v Data
Dataset: Study 1/Solution 1 (sol1) - E
Eigenfrequency (Hz): 633.54 -
0.0049861i
» Selection 0.0088325i
v [CEer 0.021578i
0.025076i
Solution at angle (phas 0.010398
0.020046
> Title 440,05
633.54

~ Plot Settings
1163.1

View: Automatic 1166
[] Show hidden entiti 277

3105.9
[] Propagate hiding tu wewrermrrererere-

* Click Stop Recording.
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The resulting code is shown below.

with(model.result("pg1"));
set("looplevel", new String[]1{"8"});

endwith();

model.result("pg1").run();

Now change the string "8" with the variable mode to end up with the code listing
above. This will be stored in a method, say, method1. To create the local method
associated with the combo box, copy the code from method1. Then, delete
method1.

Using Data Access

A quicker, but less general way, of using a combo box is to use Data Access in
combination with Editor Tools. For the example used in this section, you start by
enabling Data Access and, in the Settings window of the Mode Shape plot group,
select the Eigenfrequency, as shown in the figure below.

Settings
3D Plot Group
Ea Plot M= 4= = =4

Label:  Mode Shape (solid) =

v Data

Dataset: l:‘ Study 1/Solution 1 (sol1) - F

Eigenfrequency (Hz): |+ 633.54 o
Select data source

> Selection
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In the Editor Tools window, the Eigenfrequency parameter is visible as
Eigenfrequency (looplevel). To create a combo box, right-click and select Input.

Editor Tools TAX
= Edit Node =T ~

% Themes
b [ Main Window
b B Forms
I @ GUI Commands
I = Declarations
I [y Methods
b [ Libraries
4 & Model (root)
I () Global Definitions
I @ Component 1 (compl)
[~ Study 1
4 [ Results
I Datasets
b 25 Derived Values
I E Tables
4 |8 Mode Shape (solid)
abe Eigenfrequencw (Hz) {lnonlevel i=11
b [ Surface 1 Input
I {El Eigenfrequencies| Output
Export —_—
I [# Reports =¢ Edit Node

The property name looplevel is used for a solution parameter. If a solution has two
or more parameters, then there are two or more loop levels to choose from.
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The figure below shows the Settings window of the corresponding combo box.

Settings

MName: combobox1

~ Source

= Declarations

v 4% Model (root)
» () Global Definitions
v

~ |l Mode Shape (solid)
2% Eigenfrequency (Hz) (looplevel, i=1)

E Use as Source = Edit Node

Selected source:
abe Mode Shape (solid)=Eigenfrequency (Hz) (looplevel, i=1)

Initial value: From data source

~ Choice List

Available: Selected:
3> Material {materialList}

=t Eigenfrequency (Hz) (looplevel, i=1)
7> Simulation Type List {simulationTypeList}

[] Allow other values

The choice list Eigenfrequency (looplevel) is automatically generated when inserting
a combo box using Editor Tools. Note that a choice list generated in this way is not
displayed under the Declarations node and cannot be modified by the user. For

greater flexibility, such as giving names to each parameter or eigenfrequency value,
you need to declare the choice list manually, as described in the previous section.

UsSING A CoMBO Box To CHANGE TIMES

The time parameter list specified in a Time Dependent study step can be used in
many places under the Results node. In an application, the individual time
parameters can be accessed in a similar way to what was described in the last
section for parameters, by using Data Access in combination with Editor Tools.

The example in this section is based on the model Axisymmetric Transient Heat
Transfer, available in the Application Libraries, under COMSOL Multiphysics.
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However, the techniques shown here are applicable to any model with a
time-dependent solution.

In the Settings window in the figure below, Data Access has been used to access the
Time parameter list in a temperature plot.

Settings
3D Plot Group
[ Plot = 4= =p =]

Label: Temperature 3D =
v Data
Dataset: l:‘ Revolution 2D 1 - I

Time (s): 70

4

In Editor Tools, a handle to the Time list is now available, as shown in the figure
below.

Editor Tools

= Edit Node =T =

% Themes
D Main Window
¥ % Forms
» [ GUI Commands
» [ Libraries
~ < Model (root)
» () Global Definitions
» &a Component 1 (compl)
» ~db Study 1
» ~db Study 2
v {E| Results
¥ {§} Configurations
Datasets
L~ Views

2% Derived Values

EH Tables

B Temperature (ht)

VB Temperature 3D
abe Time (=1 (lnanlevel =11
0 volu Input

B lsotherrr Output

B Tempera
~ Tempera ¢ Edit Node

v v v v v

o Temperature Difference, 10
Export
[# Reports
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By selecting Input, you can create a combo box using it as Source, as shown in the
figure below.

Settings
Combo Box
Mame: combobox1 E
~ Source @+ "B

= Declarations
v @ Model (root)

~ @ Results
v Nl Temperature 3D
a3 Time (s) (looplevel, i=1)

Use as Source Edit Node

Selected source:

abe Temperature 3D=Tirme (5) (looplevel, i=1)

Initial value: From data source -
~ Choice List @+
Available: Selected:

abe Time (s) (looplevel, i=1)

[] Allow ather values
In this case a built-in choice list Time (s) is used to defined the valid options for
the time parameters.

The combo box can be used for multiple purposes, for example, to update a plot
corresponding to a different time parameter. In order for a plot to automatically
update when a user uses the combo box to select a new time parameter, add an
event to the combo box at the bottom of its Settings window. In the figure below,
a method plotT is called for updating a temperature plot.

~ Events

On data change: plotT - E:l + -

The line of code below shows the contents of the method plotT:
model.result("pg1").run();
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The end result is a combo box in the application user interface, shown in the figure
below, which automatically updates a temperature plot when the user selects a new
value for the Time list.

Time (s): 70 -
0
10
20

30
40
50
60
70

80

90

100

110

120

130

140

150

160

170

180

180

Interpolation

You can replace the built-in choice list with a custom one, allowing users to select
from a specific subset of available parameters. This approach also applies to
parametric sweeps.

USING CONFIGURATIONS FOR CENTRALIZED CONTROL OF TIME AND
PARAMETER LISTS

Configurations arc available in the Model Builder by right-clicking the Results node
and choosing Configurations from the resulting context menu. Configurations
provide centralized control over plot groups, ensuring uniform style and dataset
values without adjusting each group individually. Each option applies to multiple
plot groups in the model tree and allows simultaneous updates.

* Single-Select Solution: Set solution parameters for 2D and 3D plots, such as
generating multiple plots with the same time data.

* Multiselect Solution: Manage 1D plots to show multiple solutions across a
parametric sweep or time steps.

* Graph Plot Style: Customize line width and styles for graph plots (xy-plots)
to create consistent visualizations.

In addition, the Preferred Units configuration option enables centralized control
of default units for a model.
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The figure below shows a Single-Select Solution | configuration node added to the
Axisymmetric Transient Heat Transfer model. The settings window includes the
time list which can be accessed via the Data Access functionality, just as in the
example in the previous section.

Model Builder Settings
“— + ® St i W Single-Select Solution
c Label:  Single-Select Solution 1 =
~ @ heat_transient_axi_configuration.mph (root)
v () Global Definitions v Solution
Fi Parameters 1
= Materials Solution: Solution 1 (sol1) > |
v & Component 1 (comp 1) Time (s): 250 -
» = Definitions
>
2 Materials
» IE) Heat Transfer in Solids (ht)
A5 Mesh 1
» ~db Study 1
» ~db Study 2
v {E| Results

~ {§} Cenfigurations

Preferred Units 1

e Single-Select Solution 1
¥ Datasets
> L~ Views

> 2% Derived Values

> E Tables

» [ Terperature (ht)

» N Terperature 3D

» n |sothermal Contours (ht)

» [ Termperature (ht) 1

» " Temperature, 10

» " Temperature Difference, 10

[# Reports

The figure below displays the settings for the Temperature 3D plot group,
referencing the Single-Select Solution | configuration. In this way, the time used by
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the plot group is not locally set but instead determined by the configuration
setting.

Model Builder Settings
— + l =t - W~ 3D Plot Group
Type filter text (&) Gl Plot 1= = =

v 4@ heat_transient_axi_configuration.mph (root) Label: Temperature 3D =
v () Global Definitions
Fi Parameters 1 ~ Data
i) Materials
v & Component 1 (comp 1) Dataset: Revalution 2D 1 - | |E
» = Definitions . X .
Solution parameters: From configuration -
¥ Geometry 1 ¢ Z
2 Materials Configuration: Single-Select Solution 1 ~| |
» IE) Heat Transfer in Solids (ht)
A5 Mesh 1 > Selection
» ~db Study 1 "
» ~db Study 2 b U=
v (Bl Results v Plot Settings
v {§} Configurations
Preferred Units 1 View:  Automatic ~| |
N5 Single-Select Solution 1 [ Show hidden entities
> Dataset
> Lo Viae::;E : [] Propagate hiding to lower dimensions
> 2% Derived Values Blordat e edos
> [ Tables Color: From theme =
» . Temperature (ht) X
| T an Frame: Material (R, PHI, Z) -
» . |sothermal Contours (ht)
» [ Termperature (ht) 1 v Color Legend
» " Temperature, 10
Show | d
» " Temperature Difference, 10 LSRN
Export [] Show maximum and minimum values
[# Reports [] Show titles

1 Chlmass vmide

The same reference to the Single-Select Solution | configuration can be made from
the other plot groups, for example, the Isothermal Contours plot group as shown
below.

Settings
2D Plot Group
Plot M= 4= = =4|

Label: lsothermal Contours (ht) E
~ Data

Dataset: Study 1/Solution 1 (sol1) - T

Solution parameters: From configuration -

Configuration: Single-5elect Solution 1 A
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Enabling the Data Access functionality makes the Single-Select Solution | time list
available from Editor Tools.

A "5 Data Access New Method L’ @

Application P Test Application Eﬁ Record Method

Method Run Run St
Builder Call ~ Method ~ Method Call ~
Application Create Methods Method Calls Run Code
Model Builder Settings
— + ‘s St~ i W Single-Select Solution
e ¢ Label:  Single-Select Solution 1 =
~ @ heat_transient_axi_configuration.mph (root)
v () Global Definitions ~ Solution
Fi Parameters 1
= Materials Solution: l:‘ Solution 1 (sol1) AR
v & Component 1 (comp 1) Time (): 250 -
» = Definitions
¥ Geometry 1
2 Materials
» IE) Heat Transfer in Solids (ht)
A5 Mesh 1
» ~db Study 1
» ~db Study 2
v {E| Results

v {§} Configurations

Preferred Units 1

\F; Single-Select Solution 1
Datasets
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The corresponding combo box (with text label) and settings window are shown
in the figures below.

Settings

Combo Box

Mame: combobox1 ,E_

~ Source .:+:. +

= Declarations
~ & Model (root)
~ @ Results
v 3% Configurations
~ I‘r‘; Single-Select Solution 1
23] Time (s) (looplevel, i=1)

= Use as Source =g Edit Node [@] Preview  [io:ioSection2 X

v

Selected source:
abe Single-Select Solution 1=Time (s) (looplevel, i=1)

Ti 3 -
Initial valuez ~ From data source "o e 0

~ Choice List @+
Available: Selected:

abe Time (s) (looplevel, i=1)

[] Allow other values

The Events section of the Combo Box window references a method updatePlots,
as shown in the figure below.

Settings

Combo Box

Mame: combobox1 E
> Source ® +

» Choice List @+
> Position and Size

> Appearance

~ Events

_|_.
4

On data change: updatePlots =
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The method loops through all plots group tags and updates each plot:

@Pre‘fiew Dio: ioSection2 updatePlots X
=] for (String tag : model.result().tags()) {
model.result(tag).runi);
NI

The complete code is listed below:

for (String tag : model.result().tags()) {
model.result(tag).run();

}
If only a subset of the plot groups need to be updated, then they can be updated
individually by the method, for example:

model.result(“pg2”).run();
model.result(“pg3”).run();

Automatic Update of Plot Groups
To automatically update plot groups when using configurations, you can use a
method with code similar to the following:

for (String tag : model.result().tags()) {
model.result(tag).run();
}
and run this method as a combobox event, when the value of a combobox is
changed.

USING A CoMBO Box To CHANGE MATERIAL

Consider an application where combo boxes are used to select the material. In this
case, an activation condition (see “Activation Condition” on page 175) can also
be used for greater flexibility in the user interface design.

The example in this section is based on the Busbar model, available in the
Application Libraries, under COMSOL Multiphysics. However, the techniques
shown here are applicable to any model with a time-dependent solution.

The figure below shows screenshots from an application where the user can choose
between two materials, Aluminum or Steel, using a combo box named Material. A
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second combo box called Alloy shows a list of Aluminum alloys or Steel alloys,

according to the choice made in the Material list.

~ Inputs

Length:
Width:

Applied voltage:

Material:

Alloy:

~ Results

Temperature: 3304 K

Material: Aluminum

Alloy: Aluminum 6063
Aluminum 3003

~ Results Aluminum 6063

Temperature: 330 Alurninum, generic
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cm
cm
my
Material: Steel
Alloy: Steel AlSI 4340
Steel AISI 4340
~ Results Structural steel, generic

Temperature: 3304 K



The material choice is implemented in the embedded model using global materials
and a material link, as shown below.

Model Builder Settings

— + | & Etw Material Link

.

- Label:  Material Link 1

]

v <@ busbar.mph [root)
v ® GIobaTDeﬁnitions Name: | matinkT
Fi Parameters 1
4% Default Model Inputs
v (52 Materials Geometric entity level: Domain -
=2 Aluminum 3003-H18 (mat 1)

Geometric Entity Selection

i iz Aluminum 6063-T83 (mat2) Selection: = All domains
> 2a Aluminum (mat3) 1 =
> 38 Steel AISI 4340 (matd) o B —
» iza Structural steel (mat5) 3 E I\"]
~ [l Component 1 {comp1) 2 TS
» = Definitions 5
» Geom.etry‘l 6
v e Materials
LA M.aterial Link 1 {matink1) D Overniie
» +\_ Electric Currents {ec)
» BB Heat Transfer in Solids (ht) v Link Settings
> gy Multiphysics _
> A Mesh1 Material: Aluminum 6063-T23 (mat2) - Tt
» ~db Study 1 MNone
> B Results v Mater Alyminum 3003-H18 (mat1)
" Aluminum 6063-T83 (mat2)
Pro aluminum (mat3) Unit Pr
[ |Elec Steel AISI 4340 (mat4) Sm  |Ba
[/ |Hea Structural steel (mat5) JikgK) Ba
[ |Relative permittivity epsilo... |1 1 Ba
[ | Density rho 2700[kg... kg/m® |Ba
[ | Thermal conductivity k_iso ;... | 2001[W/(... | W/(m....| Ba
Relative permeability mur_i.. |1 1 Ba
Coefficient of thermal expansi... | alpha_...| 23.4e-6[... | 1/K Ba
Young's modulus E 59[GPa] Pa Yo
Poisson's ratio nu 0.33 1 Yo

Each material is indexed with a string: mat1, mat2, ..., mat5. An event listens for
changes to the value of the global variable alloy, where the value is controlled by
a combo box. When the value is changed, a method switchAlloy is run, with one
line of code listed below.

model.component("comp1").material("matlnk1").set("1link", alloy);
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The figure below shows the declaration of two string variables, material and
alloy, which are controlled by the Material and Alloy combo boxes, respectively.

Settings

String

List of Variables

L L. -
MName Initial value  Description

material aluminum Material

alloy mat1 Alloy

T = % M o

The application utilizes three choice lists: Aluminum Alloys, Steel Alloys, and
Material.

Activation Condition

An activation condition is used for the Aluminum Alloys and Steel Alloys choice lists,
as shown in the figure below.

v Declarations

abe String
v <2 Aluminum Alloys {choicelist 1}
<> Activation Condition {actcond 1}
v 3> Steel Alloys {choicelist2}
&> Activation Condition {actcond 1)
&> Material {choicelist3)
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The Settings window for the Material combo box is shown below.

Settings
Combo Box
MName: combobox] =
~ Source @+ "B

v = Declarations
~ abe String
=i material
abe alloy
& Model (root)

w

Use as Source Edit Mode

Selected source:

abe String=material

Initial value: First allowed value >
~ Choice List @+
Available: Selected:

<z» Aluminum Alloys {choicelist1} <z» Material {choicelist3}

<> Steel Alloys {choicelist2}

[] Allow other values

Note that the Material combo box uses the material string variable as its source.
The Material choice list is used to define a discrete set of allowed values for the
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material string variable. The Settings window for the Material choice list is shown
below.

Settings
Choice List

Label:  Material E

MName: choicelist3

List Content

L] .

Value Display name
aluminum Aluminum
steel Steel
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The Settings window for the Alloy combo box is shown in the figure below.

Settings
Combo Box
Mame: combobox2 E
~ Source @ + B

v = Declarations
w abe String

abe material
= alloy
» 4 Model (root)

@_‘ Use as Source =g Edit Node

Selected source:

abe String=alloy

Initial value: From data source -
~ Choice List @ +
Available: Selected:

<z» Material {choicelist3} <7 Steel Alloys {choicelist2}

<Z» Aluminum Alloys {choicelist1}

[] Allow ather values

> Position and Size
> Appearance

~ Events

On data change: switchAlloy ~ Bt~

| 273



Note that the Alloy combo box uses both the Aluminum Alloys and the Steel Alloys
choice lists. The choice list for Aluminum Alloys is shown in the figure below.

Settings

il

Label:  Aluminum Alloys

Mame:  choicelist]
List Content

L4

Value Display name
mat1 Aluminum 3003
mat2 Aluminum 6063

mat3 Aluminum, generic

\ -

274 |



The activation condition for the Aluminum Alloys choice list is shown in the figure
below.

Settings
Activation Condition
Label:  Activation Cendition

MName: actcondl
v Source @~

v = Declarations
w abe String
=i material
abe alloy
& Model (root)

w

@_‘ Use as Source =g Edit Node
Selected source:

abe String=material
~ Condition

L A
Activating values

aluminum
=3
[ Invert condition

USING A CoMBO Box To CHANGE ELEMENT SIZE

When creating a combo box, you can use the Data Access functionality to
reproduce the features of a combo box that exists within the Model Builder. For

| 275



example, consider an application where a combo box is used to change the
element size in a mesh, as in the figure below.

Predefined size: Mormal -
Extremely fine
Extra fine
Finer
Fine
MNormal
Coarse
Coarser
Extra coarse

Extremely coarse

Switch to the Model Builder and select the Mesh node (we assume here that the
model has just a single mesh). In the Settings window of the Mesh node, select
User-controlled mesh (if not already selected). In the settings window for the Size
node, available directly under the Mesh node, select the option Predefined. Click
Data Access in the ribbon. This gives access to the combo box for a predefined
element size, as shown in the figure below.

Settings
Size
# Build Selected [E§ Build All

il

Label: Size

Element Size

Calibrate for:
l:‘ General physics =
@ Predefined Mormal =
) Custom

Select the green checkbox to the left of the list to make it available as a source for
a combo box in the Application Builder. Then, when you return to the Application
Builder, you will find that the choice list for mesh size is now revealed as a
potential Source in the Settings for a new combo box.
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To insert the combo box object, you have two alternatives:

Select Combo Box from the Insert Object menu in the ribbon. In the Settings
window for the combo box, select the node Predefined size (hauto) in the
Source section and then click the Use as Source button.

In the Editor Tools window, select the node Predefined size (hauto) under the
Mesh > Size node. Then right-click and select Input, as shown in the figure
below.

Settings Editor Tools X
Z¢ EditNode =T » =l =

% Themes

¥ D Main Window

> [ Forms

» @ GUI Commands

» = Declarations

¥ % Methods

» [ Libraries

v @ Model (root)

7 Global Definitions

i

far)

Component 1 (compl)
= Definitions
WA Geometry 1
2 Materials
+\_ Electric Currents (ec)
5] Heat Transfer in Solids (ht)
iy Multiphysics
A Mesh 1
v [ size
8.5 Predefined size (hauto)

4% Free Tetrahedral 1 Input

» ~db Study 1 Output

> [El Results

€
K v v v v v vl

=¢ EditNode
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The corresponding Settings window for the

below.

Settings
Combo Box

Mame: combobox3

~ Source

» = Declarations

v @ Model (root)

(1 Global Definitions

~ [ Component 1 {compl)
~ A Mesh 1

Size

55 Predefined size (hauto)

@_‘ Use as Source =g Edit Node

Selected source:

8.5 Size=Predefined size (hauto)

Initial value: From data source

~ Choice List

Available:

<2 Alurninurm Alloys {choicelist}
<> Steel Alloys {choicelist2}

<z» Material {choicelist3}

[] Allow ather values

Changing the Initial value to From data source ensures that the element size setting

Selected:
8.5 Predefined Size (Hauto)

combo box is shown in the figure

of the model, in this case Normal, is used as the default element size in the

application. The choice list, Predefined size (hauto), from the Model Builder is now

selected as the choice list for your combo box in the Application Builder. This
choice list does not appear as a choice list under the Declarations node of the

application tree because it is being referenced from the Model Builder. Therefore,

if you want a list with a more limited set of choices, you cannot edit it. Instead,

you have to remove the predefined list as the Source of your combo box and create

a new choice list of your own by declaring it under the Declarations node. For
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example, you can create a choice list with three entries, as shown in the figure
below.

Settings

Label:  Choice List 1 =5

MName:  choicelist]

List Content
L]
Value Display name
4 Fine
5 MNormal
6 Coarse

\ -

To learn which values are used by the Predefined Size list in the model, use Record
a New Method and change the value from Normal to Fine, then to Coarse, and then
back to Normal. Click Stop Recording and read the values in the autogenerated
code. The Predefined Size property name is hauto and the values for Fine, Normal,
and Coarse are 4, 5, and 6, respectively, as implied by the automatically generated
code shown in the lines below.

model.component("comp1").mesh("mesh1").feature("size").set("hauto", 4);
model.component("comp1").mesh("mesh1").feature("size").set("hauto", 6);
model.component("comp1").mesh("mesh1").feature("size").set("hauto", 5);

The hauto property can also take non-integer values. For more information on
mesh options, see “Data Access for Input Fields” on page 110.

USING A COMBO Box TO CHANGE A PHYSICS PROPERTY

The figure below shows part of the user interface of the Acoustic Treatment
Boundary Calculator app, available in the Application Libraries under the
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Acoustics Module. The Backing type setting is controlled by a combo box with the
options Rigid, Air cavity, and Cavity filled with porous.

~ Backing Condition

Backing type: | Air cavitiy -
Cavity depth: Rigid mm
Air cavitiy

Cavitiy filled with porous

Air domain

Porous sample

Air cavity

BAIIIEREREAEE AN

The figure below shows the corresponding combo box form object in the Form
Editor.

@ Preview D input: backingCommon X
v

Backing type: | Air cavitiy

b ]|
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The corresponding settings window is shown below.

Settings

MName: combobox1

~ Source

~ = Declarations
~ abe String

abe solutionState
abe frequencyMethod
abc sampleType
=bc porousModelSample
=2 backingCondition
abc porousModelCavity
abc geometrySketch
=bc asymTermMormal
=bc asymTermRandom

Use as Source =g Edit Node
Selected source:

abe String=backingCondition

Initial value: From data source =
~ Choice List D +
Available: Selected:

&> Choice Frequency Method {frequency_list 3> Choice Backing Condition {backing_list}

<%» Choice Frequency 150 Interval {frequency,
3> Choice Material Type {material_list}
<%» Choice Porous Model Sample {porous_sar

<z» Choice Porous Model Cavity {porous_cavi

[] Allow other values

> Position and Size
> Appearance

~ Events

On data change: inputChanged b

Here, the string variable backingCondition is defined under the Declarations
node in the application tree. The value of this string variable determines the
Backing type physics setting. A combo box allows the app user to modify the value
of the string variable, thereby changing the Backing type setting. The allowed
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values of the combo box is determined by the Choice List (under Declarations)
named Choice Backing Condition, as shown below.

Settings

Choice List

Label:  Choice Backing Condition

MName: backing_list

List Content

" Value Display name

rigid Rigid

aircav Air cavitiy

porouscav Cavitiy filled with porous

Additionally, the combo box is configured with an On data change event, which
runs the method inputChanged whenever the value of the combo box or its
associated string variable backingCondition is updated.

When the computation starts (triggered by the user clicking the Compute button
in the app), another method, updatePhysics, updates the model’s physics
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settings based on the value of the backingCondition variable, as shown in the
figure below.

@ Preview D input: backingCommon updatePh

JE*

* Sets up physics depending on the material

/
8.’

// Cases for solid material sample

if (sampleType.equals(
model.component (“com
model. component
model. component

id")) {

1"y.physics( lid").active(true);

1"y multiphysics(" 1"Y.active(true);
1"y multiphysics(" "Y.active(true);

sb2

if (backingCondition.equals("rigid”)) {

model. component (“c

model.component (“compl”).physics("acpr”).selection().set(3, 4);

H

else if

model.

model

model.

H

else if

model.
model.

model
¥
¥

(backingCondition.equals("ai v}y {
component(“compl”).physics({"solid").feature("fixl").active(false);
.component( 1"y.physics(" r*y.selection().set{l, 3, 4);

(backingCondition.equals({"porou
component(“compl”).physics(
component (
.component("c

component (

compl™).physics("ac

v

“YV.physics(" r*y.selection().set{l, 3, 4);

// Cases for porous material sample

else if (sampleType.equals("por

1A

The figure below shows the complete user interface of the app.

Air domain

Porous sample

A cavity

T
H
i

1").physics("solid").feature("fixl").active(true);

pr*).feature("pom2").active(false);

") .feature("Fixl").active(false);

1").physics("acpr").feature("pom2").active(true);

of the sample and the backing condi

gEgsgse

EEEEES
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USING A UNIT SET INSTEAD OF A CHOICE LIST

If the combo box will be used for the purpose of changing units, then a Unit Set
can be used instead of a Choice List (you still select it in the Choice List section of
the Settings window of the combo box).

Equation

An Equation object can display a LaTeX equation by entering the expression in the
Enter equation in LaTeX syntax ficld.

Settings

Equation

MName: equationl =
v Equation mhv =h~

Enter equation in LaTeX syntax:
-\nabla \cdot (k \nabla u) =
Equation preview

—V- (kVu)

~ Position and Size

Width: 73
Height: 20
Positionx: 644

Positiony: 368

~ Appearance

Text color: Inherit b

Fontsize:  Default size > | pt
State

Visible

Enabled

A preview is shown of the rendered LaTeX syntax after leaving the text field.
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Line

Use the Line form object to add a horizontal or vertical line to a form, which can
be used, for example, to separate groups of form objects. For the horizontal line
option, you can also add text that appears within the line.

Settings
Line
MName: linel =
~ Settings
Orientation:
Harizontal -

[ Include divider text
Text:

v Position and Size
Width: 200
Height: 1
Positionx: 303
Positiony: 268

v Appearance
Line thickness: 1
Line color: Default >
Text color: Inherit i
Font: Default font -

Font size: Default size * | pt

[] Bold
[] Italic
State
Visible
Enabled
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Web Page

A Web Page object can display the contents of a web page as part of the user
interface.

Settings

Web Page
MName: webpagel E
Mative browser on Windows: Chromium™ -
v Source

URL -
Page URL:

https:/fwww.comsol.com/products

Browser preview

8 COMSOL Q  MENU ;

LOG IN CONTACT 9

The COMSOL Product Suite -

~ Position and Size

Width: 240
Height: 100
Positionx: 813
Positiony: 425
~ Appearance

Visible

You can specify the page source in four different ways from the Source list:

* Use the default option Page to enter HTML code in a text area below the
list, enclosed by the <html> and </html> start and end tags.

+ Use the URL option to link to a web page on the Internet.

+ Use the File option to point to a local file resource containing HTML code.
Type the name of the file in the File field or click Browse to locate the file on
the local file system.

* Use the Report option to embed an HTML report. The Browser preview is
not active for this option.
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Use the setting Native browser on Windows to control which browser is used in the
Windows® version of COMSOL Multiphysics.

Image

Use an Image form object to add an image to a form. An image object is different
from a graphics object in that an image object is not interactive. Choose an image
file from one of the library images, accessible from a drop-down list, or by clicking
the Add Image to Library and Use Here button to select a file from the local file
system. The figure below shows the Settings window for an image object
referencing the image Image.png.

Settings

Image

MName:  imagel

il

Image: | Image.png - -}

~ Position and Size

[] Stretch image

Harizontal alignment: Left =
Vertical alignment: Top =
Width: 1192

Height: 2132

Row: 3

Column: 5

Row span: 2

Column span: 2

Cell margin
Cell margin: From parent form =

~ Appearance

Visible
Enabled

If you select an image file from your file system, this file will be embedded in the
application and added to the list of Images under the Libraries node.

While you can change the x- and y-position of the image, the width and height
settings are determined by the image file. However, if you use the grid layout
mode, then there is an additional setting Stretch image which, if activated, will
automatically scale the image to fill the available grid cell space.
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You can paste images from the clipboard to a form window by using
Ctrl+V. For example, you can copy and paste images from the
PowerPoint® slide presentation software. Such images will be added
automatically to the Images library and embedded in the application. The
names for pasted images are automatically set to: pasted_image_1.png,
pasted_image_2.png, and so on.

Video

A Video object embeds a video file in a form. The supported video file formats are
MP4 (.mp4), OGV (.ogv), and WebM (.webm). However, not all video file
formats are supported on all platforms. When running an application by
connecting to COMSOL Server from a web browser, which formats are supported
depend on the web browser and may vary with different versions of the same web
browser. When running an application with the COMSOL Client and with
COMSOL Multiphysics, the Internet Explorer version installed on your computer
is used as a software component for displaying the video object.

After added to a form, the Video object is represented, in the Form Editor by an
image, as shown in the figure below.
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The figure below shows the Settings window for the Video object.

Settings

Video

Mame:  videol =
Video: instructions.webm -+ =

Show video controls
[] Start automatically

[] Repeat
[ Initially muted

~ Position and Size

Width: 300
Height: 300
Positionx: 824
Positiony: 420

~ Appearance

Visible

The available settings are:
* Show video controls

e Start automatically

* Repeat

¢ Initially muted

The option Show video controls enables the video controls such as Play and Stop.

The option Initially muted is intended for the case where you want to play a video
with the sound initially turned off. For example, if the video is set to start
automatically, it can be useful to let the user choose whether the sound should be
on. The user can enable the sound either from the video controls, if the Show video
controls checkbox is selected, or by right-clicking in the video player.

Progress Bar

A Progress Bar object displays a customized progress bar, or set of progress bars,
based on a value that is updated by a method. Use a progress bar to provide
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feedback on the remaining run time for an application. The figure below shows
the Settings window of a progress bar object with one progress level.

Settings

Progress Bar

MName: progressharl 5
Include model progress

Progress levels: One -

Cancel button
Close dialog when canceled

~ Position and Size

Width: 375
Height: 59
Positionx: 20

Positiony: 20

~ Appearance

Visible
Enabled

Note that the built-in progress bar that is visible in the status bar of an application
is controlled by the Settings window of the Main Window node. By default, the
built-in progress bar shows the progress of the built-in COMSOL Multiphysics
core algorithms, such as geometry operations, meshing, and solving. By using the
setProgress method, you can customize the information shown in the built-in
progress bar. For more information, see “Progress Methods” on page 381 and the
Application Programming Guide.

The figure below shows the Settings window of a progress bar object with two
progress levels.

Settings

Progress Bar

MName: progressharl 5
Include model progress

Progress levels:  Two -

Cancel button
Close dialog when canceled

In this example, the progress bar object is part of a form progressform used to
present a two-level progress bar and a message log.
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The figure below shows the corresponding progress dialog in the running
application.

3 Progress X

Computing frequency.

Compute

Cancel

MNumber of degrees of freedom solved for: 24012,

The figure below shows the form progressform.

@ Preview D progressform X
v

>
Progress message

Progress message

Cancel

Messages:

The code segments below show typical built-in methods used to update the
progress bar and the message log.

/! show progress dialog:
dialog("progressform");
setProgressBar (" /progressform/progressi”, 0, "Computing prong length.");

// code for iterations goes here:
lastProgress = 20;
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Il

// update message log:

message("Iteration Number: " + k);
message("Frequency: " + Math.round(fq*100)/100.00);
message("Length: " + Math.round(L1*100)/100.00);

// update progress bar:

setProgressInterval("Computing frequency", lastProgress,
k*100/MAXITERATIONS) ;

// more code goes here:

/1

// finished iterating:
setProgressBar (" /progressform/progressi", 100);
closeDialog("progressform");
In the example above, the central functionality for updating the two levels of
progress bars lies in the call
setProgressInterval("Computing frequency", lastProgress,
k*100/MAXITERATIONS) .
For detailed information on the built-in methods and their syntax, see “Progress
Methods” on page 381 and the Application Programming Guide.

Gauge

Use a Gauge form object to add a radial gauge to a form. This object is similar to
the knob form object but is read-only and used to display a value by the position
of a needle or arrow of a gauge. Optional tick marks and labels are used to indicate
the range of values that the gauge can display. In addition to tick marks and labels,
you can optionally configure a color scale to indicate the values. The figure below
shows a gauge object together with a data display object, displaying the maximum
stress in a structural mechanics application.

100
80 , y , 120
Ay !

3745 MPa
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The Settings window for a gauge object is similar to that of a knob object.
However, there are some differences. For example, there is no Events section for a
gauge object. The figure below shows the Settings window for a gauge object.

Settings

Gauge

MName: gaugel E
Minimum value: 0

Maximum value: 200

MNumber of steps: 20

Tooltip:

~ Source @+ "B

» = Declarations
& Model (root)
» () Global Definitions
v {E| Results
v 2% Derived Values
k] Volume Maximum 1

<

@_‘ Use as Source =g Edit Node

Selected source:

max Volume Maximum 1

Initial value: From data source -

> Unit
> Number Format
> Position and Size

~ Appearance

Scale: Tick marks =
MNeedle color: Default =
Sweep angle: 270 deg

Color ranges

" Start valu | End value | Start color | End color
0 200 u

+

You can select any parameter, variable, or declared scalar variable as a source.
Select from the application tree and click Use as Source.
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You determine the range of values for the data source by defining the Minimum
value, Maximum value, and Number of steps for the gauge.

You can enter a Tooltip that is shown when hovering over the gauge. The settings
for units are similar to that of a slider or knob.

In the Initial value list, select From data source or Custom value for the initial value
for the gauge.

The figure below shows the Unit, Number Format, and Position and Size sections.

~  Unit

Method: Append unit to number ~| &=

Unit expression:  MPa

~ MNumber Format

[] Custom label formatting
Precision: 4
MNotation: Automatic

Exponent: Power of 10

~ Position and Size

Width: 128
Height: 128
Radius: Automatic -

Positionx: 711

Positiony: 823

The Unit section is similar to that of a slide or knob object.
In the Number Format section, you can specify a custom format for the tick labels.

The Position and Size section will have different contents depending on if the form
is using sketch mode or grid mode. You specify the Width and the Height is
automatically set to the same value as the Width (the Height edit field is disabled).
The Radius value specifies the radius for the tip of the gauge object's needle. By
default this is calculated automatically, but you can set it manually to make sure
that gauge objects placed next to each other have the same needle radius.

294 |



The figure below shows the Appearance section.

~ Appearance

Scale: Tick marks and all labels =
MNeedle color: Default =
Sweep angle: 270 deg

Color ranges

" Start valu | End value | Start color | End color
0 200 u

+

The Needle color takes its Default value from the current color theme.

You can specify a sequence of color ranges for the gauge. Click the Add button in
the table toolbar to add another color range, which opens a dialog.

3 Color Range X

Start value: O

End value: 200

Start color: Green =

End color: Red =
oK Cancel

In this dialog you give the start and end values for a color range as well as the start
and end color. To edit an existing color range, select its row in the table and click
the Edit button. The Move up and Move down buttons can be used to reorder the
color ranges and the Delete button deletes the color ranges in the selected rows.

The Start color and End color can take the value Transparent which means that they
get the same color as the current background color.

If the End value is less than the Start value, then the color range is rendered
backward.

Log

The Log form object adds a log window that displays messages from the built-in
COMSOL Multiphysics core algorithms, such as geometry operations, meshing,
and solving.
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The Include standard log toolbar checkbox is selected by default. When enabled, a
toolbar appears in the Log window, similar to the one in the COMSOL Desktop.

Settings
Log
MName: logl E

Include standard log toolbar

~ Position and Size

Harizontal alignment: Fill -
Vertical alignment: Fill -
Minimum width: Automatic -
Minimum height: Automatic -
Row: 12
Column: 8
Row span: 2
Column span: 6
Cell margin
Cell margin: From parent form -

The figure below shows a part of an application user interface containing a log
window.

b=

Scluticn errcr estimates for segregated groups

2.3e-016, 0.0008&

Residual errcr estimates for segregated groups

9.4e-009, 38

Statiocnary Selver 1 in Seluticn 1: Selution time: 1 3
Physical memory: 1.99 GB
Virtual memory: 2.12 GB

Message Log

The Message Log object adds a window where you can display messages to inform
the user about operations that the application carries out. Implement this feature
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using the built-in message method with syntax: message (String message). See
also “GUI-Related Methods” on page 376.

Settings

Mame: messages] =5
Include standard message log toolbar

Show COMSOL messages

[] Add timestamps to messages

~ Position and Size

Harizontal alignment: Fill -

Vertical alignment: Fill -

Minimum width: Manual -
350

Minimum height: Manual -
150

Row: 1

Column: 1

Row span: 1
1

Column span:

Cell margin

Cell margin: From parent form -

You can also display the value of a variable, including arrays, for example:
message (double xcoordinate).

The Include standard message log toolbar checkbox is selected by default. When
enabled, a toolbar appears in the Messages window, similar to the one in the
COMSOL Desktop.

The Show COMSOL messages checkbox is selected by default to enable messages
from the built-in COMSOL Multiphysics core algorithms, such as geometry
operations, meshing, and solving. Clear the checkbox to only allow messages from
the application itself. You can include time stamps to message by selecting the Add
timestamps to messages checkbox.
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The figure below shows a customized message window with convergence
information from a method (left) and the corresponding Message Log form object
(right).

Iteration Mumber: 1 !
Frequency: 406.04 :
Length: 82.6
Iteration Mumber: 2
Frequency: 427.82
Length: 81.26
Iteration Mumber: 3
Frequency: 440.78
Length: 81.35
Iteration Mumber: 4
Frequency: 439.98
Length: 81.34

Results Table

The Results Table object is used to display numerical results in a table.

= s [ @ RO
Time (s) = Temperature

0.0000 |5.3071E-5

10,000 |0.0024307

20.000 |0.056483

30,000 |0.65979
40.000 |3.1297
50000 |3.2717
60.000 1599
70.000 |25.803
80.000 |37.142
90.000 |49.540
10000 |62.635
11000  |76.166
12000 |39.943
130.00  |103.86
14000  |117.80
15000 |131.72

The source of the results table data is taken from Results and can be a child node
of Derived Values, a Table, or an Evaluation Group. In the figure below, a Table node

298 |



is used as the source (by selecting this option in the tree and then clicking Use as
Source.)

Settings
Results Table

Mame:  resultstablel =
Include standard results table toolbar
Show headers

~ Source

v @ Model (root)

v {E| Results

> 2% Derived Values
~ B Tables
FE Table 1{thl1}
Table 2 {thl2}

@_‘ Use as Source %, Clear Source =g Edit Node

Selected source:

FH Table 2 {thl2}

By clearing the Show headers checkbox, you can choose to hide the column
headers of the results table.

RESULTS TABLE TOOLBAR

The Include standard results table toolbar checkbox is selected by default. When
selected, a toolbar is included that provides the following buttons:

¢ Show Row Numbers

* Full Precision

¢ Automatic Notation

¢ Scientific Notation

¢ Engineering Notation

¢ Decimal Notation

¢ Rectangular Complex Numbers

* Polar Complex Numbers

¢ Copy Table and Headers to Clipboard
* Export

The Export button is used to export to the following file formats:
o Text File (.txt)
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« Microsoft® Excel Workbook (.x1sx)
- Requires LiveLink™ for Excel®

* CSV File (.csv)
+ Data File (.dat)

This is shown in the figure below.

Text File (*txt) -

[ Text File (*tet) |
Microsoft Excel Workbook (*xlsx)
C5V File (*.csv)

Data File (*.dat)

All Files (*%)

CONTROLLING RESULTS TABLES FROM METHODS

There is a built-in method useResultsTable() for changing which table is shown
in a particular results table form object. For more information on this built-in
method, see “GUI-Related Methods” on page 376.

By using the loadFile method you can import data into a table and then display
it using a results table form object or a table surface plot. For examples of this, see
the Application Programming Guide in the Results section.

Form

A form object of the type Form is used to organize a main form in one or more
subforms. To embed a subform, you create a link to it by selecting the form you
would like to link to from the Form reference of the Settings window for the
subform. The figure below shows an example where one of the cells of a form
emailServer has a link to the subform serverSettings. The Form object has the
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name emailSettingsForm. This example is taken from the application Tubular
Reactor. For more information, see “Tubular Reactor” on page 395:

@ Preview D emailServer X
v

[] Override preferenc =l

Connection security: MNone -
User:
Password:

From address:

arm oK Cancel |

Settings

Form
MName:  emailSettingsForm

Form: @ serverSettings
Add border

~ Position and Size

Horizontal alignment: Fill
Vertical alignment: Fill
Minimum width: Automatic
Minimum height: Automatic
Row: a
Column: 1
Row span: 1
Column span: 1
Cell margin
Cell margin: From parent form

~ Appearance

Visible
Enabled

fil

[l
Lt

The figure below shows the referenced form serverSettings, which is a local

form to the form emailServer.

App'ication Buildel‘ @ Preview D emailServer D emailServer: serverSettings X
v
— =+ 1+ | =t~
- N >
Host:
~ tubular_reactor.mph (root) Port 25
ﬁ Inputs :
% Thernes Connection security: MNene o
¥ D Main Window User:
v F
% tolrms . Password:
main
[ input From address:

D description
D information

¥ D simulationEvents
v D emailServer
~ [ Forms
E| serverSettings
E] okCancel
» = Declarations
¥ % Methods
Graphics {gro 1}
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If you are using grid layout mode, then you can quickly create subforms using the
Extract Subform button in the ribbon. See “Extracting Subforms” on page 129.

Form Collection

A Form Collection object consists of several forms, or panes, presented in a main
form. In this example, there are four forms that appear as tabs in a single main
window.

Settings

Results Name: | collection2

Type  Tiled ortabbed

Temperature  Conversion Temperature profiles  Conversion profiles

A Q- E Law o @ .g &I‘B ~ Tiled or Tabbed

v = Declarations
~ @ Boolean
@ isSendEmail
 isPlayTada
Use as Source Edit Node
Selected source:
@ Boolean=isPlotTiled
Tiled mode settings
[ Add borders in tiled mode
Tiling strategy: Columns first -

Number of columns: 2

~ Active Form Selector s

~ = Declarations

String
activePlot
abc solutionState

Useas Source Y%, Clear Source Edit Node

Selected source:

sbe String=activePlot

;
g
F

®

\

input
description

Add to Form Collection Edit Node

Form Visible ‘::]‘;:L?E
7 temperature = A
[ conversion = &
[ temperatureProfile &4 EA
™7 conversionProfile = =
Default form: | temperature -

There are four different layout options. From the Type list, choose between:

¢ Tabs, the default setting, which displays the forms using tabbed panes.
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« List, which displays a list to the left of the form panes, where you can select
the form to display.

* Sections, which displays each form in a separate section.

* Tiled or tabbed, which displays the forms in one of two ways depending on
the value of a Boolean variable. For more information, see the description
later in this section.

In the Forms section you can select which forms to display in the Form Collection.
These will be displayed in the app in the order they appear in the list. You can
change the order by clicking the Move Up and Move Down buttons.

input

-__ description

— -

|| information
simulationEvents

——
——

emailServer
Add to Form Collection Edit Node
Vertically
Form ety
scrollable

temperature
conversion

temperatureProfile

=
ArE &
m

LrCremee

conversionProfile

The Default form list specifies which form to be shown by default. This setting is
not available for the option Sections.

In the table below the tree in the Forms section, you can use checkboxes to select
which forms should be Visible, Collapsible, Vertically Scrollable, or Expanded. The
availability of these options depends on the Type, as shown in the following table:

TYPE VISIBLE COLLAPSIBLE V.SCROLLABLE  EXPANDED
Tabs Yes Yes

List Yes

Sections Yes Yes Yes

Tiled or tabbed Yes Yes

When Vertically scrollable is unchecked, the form will never have a vertical
scrollbar. Instead, scrollbars will appear on form objects inside the form, if
possible.
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You can control which tab (or list entry) is active by linking to a string variable in
the section Active Form Selector.

~ Active Form Selector

~ = Declarations
~ 2b= String

=3 activePlot
=be solutionState
=b= emailTo
b emailServerHost
b emaillUser
b emailSecurity
=b= emailFromAddress

Use as Source %, Clear Source Edit Node

Selected source:

=be String=activePlot

The string variable needs to be equal to one of the form names in the form
collection, such as temperature or conversion in the example above. Otherwise,
it will be ignored.

If you change the value of the form selector activePlot in the above example, in
a method that will be run at some point (a button method, for example), then the
form with the new value will be activated, as shown in the example below.

activePlot="conversion”; /* Activate the conversion form on completion of
this method */
For a form collection with the Type set to Sections, the Active Form Selector has no
effect. Using an Active Form Selector is optional and is only needed if you wish to
control which tab is active by some method other than clicking its tab. To remove
a string variable used as an Active Form Selector, click the Clear source toolbar
button under the tree.
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The Tiled or tabbed option displays the forms in one of two ways depending on
the value of a Boolean variable used as source in a Tiled or Tabbed section at the
top of the Settings window.

MName: | collection2

4

Type: Tiled or tabbed

~ Tiled or Tabbed

~ = Declarations
~ B Boolean
= isSendEmail
= isPlayTada
Use as Source Edit Node
Selected source:
= Boolean=isPlotTiled
Tiled mode settings
[¥/] Add borders in tiled mode

Tiling strategy: Columns first s

MNumber of columns: 2
The tabbed mode is identical to a form collection with the Type set to Tabs. In tiled

mode, all the forms are shown simultancously in a grid. The layout for the tiled
mode can be controlled by the settings in the subsection Tiled mode settings.

Card Stack

A Card Stack is a form object that contains cards. A Card is another type of form
object, one that is only used in the context of a card stack. Flip between cards in
a card stack to show one at a time. You associate a card stack with a data source
that controls which card to show. Each card specifies a value that is compared
against the data source of the card stack. The card stack shows the first card with
the matching value. If no cards match, nothing is shown.

USING A CARD STACK TO FLIP BETWEEN DIFFERENT SETS OF PARAMETERS

The example below is taken from the Lithium-Battery Designer application, see
also “Lithium Battery Designer” on page 403. It shows how a card stack can be
used to flip between two different sets of input parameters for a cylindrical and
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prismatic battery pack type, respectively. The settings of a radio button is used to
control which of the two cards are shown.

Input and Results

Canister  Cell Thermal Load  Simulation Info and Results

~ Pack Type

® Cylindrical 18650 =

O Prismatic/Pouch Diameter: 12 mm
Height 65 mm

v Active Material Volume Fraction

Relative jelly roll volume in battery: 0.95

Input and Results

Canister  Cell Thermal Load  Simulation Info and Results

~ Pack Type

O Cylindrical Length: 65 mm

(®) Prismatic/Pouch Width: 30 mm
Depth: 5 mm

v Active Material Volume Fraction

Relative jelly roll volume in battery: 0.95
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The figure below shows the corresponding card stack Settings window with two
cards and a string variable batteryPackType as its Active Card Selector.

Settings

Card Stack

Mame: cardstack]

~ Active Card Selector

~ = Declarations
~ 2b= String
=bc material
bc batteryType
= solutionState
=bc chargelnputMode

batteryPackType
bc simulationTimeMessage
Use as Source Edit Node
Selected source:

=bc String=batteryPackType
~ Cards

L
Card Activating value
—cylindricalType cylindrical

—prismaticType prismatic

Gl

By clicking a row in the table of cards in the Cards section, followed by clicking
one of the toolbar buttons below the table, you can perform the following
operations on cards:

¢ Delete
* Edit
¢ Add Card

¢ Duplicate

Each row in the table contains the name of the card in the Card column and their
associated activating values in the Activating value column. The stack decides
which cards to display based on their activating values. In this example, the
activating value is a string variable.
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Clicking the Add Card button displays the following dialog.

3 Add Card X

Card type: Local -

Name: Local
Existing form

Activating value:

oK Cancel

By default, the Card type is set to Local, which means that the card is defined locally
in its containing card stack object. If the Card type is set to Existing form, then you
can instead select one of the existing forms. The settings for an Existing form are

accessed directly from the Form Editor by clicking its node or by clicking the Edit
button in the Card section of the corresponding card stack Settings window.

When selected, the Adjust size to selected card checkbox makes it possible to have
the card stack adjust its size to the currently selected card. When not selected, the
card stack will be as large as the largest card, regardless of which card is selected.
When a card is empty, the card stack will disappear, which is a desirable feature in
many cases. Using it you can for example have a dynamic documentation card
stack appear and disappear depending on the user’s actions.

To access locally defined cards, right-click the card stack in a form window to get
a menu that allows selecting between the different cards in the card stack. To edit
cards, you can also use Alt+Click, which opens a dialog that lets you select multiple
cards at once.

File Import

A File Import object is used to display a file browser with an associated input field
for browsing to a file or entering its path and name. It is used to enable file import
by the user of an application at run time, when the file is not available in the
application beforehand.

Consider an application where a CAD file can be selected and imported at run
time, as shown in the figure below.

CAD file:  CACOMSOL\pipex_b Browse...
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The corresponding File Import object is shown in the figure below.

@ Preview D form1 X
v

>

CAD file:

Browse... =

The Settings window for the File Import object has a section File Destination. In this
section, you can select any tree node that allows a file name as input. This is shown
in the figure below, where the Filename for a geometry Import node is selected.

Settings

MName: fileimport1 =]
Style: Outlined =
lcon: MNone = Ll

Button text: Browse...

Dialog title:  File import

File types:
All 3D CAD Files (*.step; *.stp; *a_b; *x_t; ...)
AutoCAD File (*.dwg)
CATIA V5 File (*.CATPart; *.CATProduct)
DXF File (*.dxf)

Allow entering filename

~ File Destination w

= Declarations
& Model (root)
~ [l Component 1 (comp1) {comp1}

<

~ ' Geometry 1{geom1}
~ [& Import 1 (imp1) {imp1}
243 Filename (filename)
abc Filename (meshfilename)

E‘l Use as Source =g Edit Node
Selected source:
abe Import 1 (imp1) {imp1}=Filename (filename)

Access using:  upload:///geom1/imp1/filename

In this application, the File types table specifies that only CAD files are allowed.
You can further control which File types are allowed by clicking the Add and Delete
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buttons below the list of File types. Clicking the Add button displays the dialog
shown below:

D Add X

File types:
All Files (*.%)
All 2D CAD Files (*.dxf; *.mphtxt; “.mphbin; ...)
All 2D Importable Geometry Files (*.mphtxt; *.mphbin; ..}
All 2D Importable Mesh Files (*.mphtxt; *.mphbin; ...}
All 2D Mesh Files (*.mphtxt; *.mphbin; *fla; ...)
All 3D Importable Geometry Files (*.mphtxt; *.mphbin; ..}
All 3D Importable Mesh Files (*.mphtxt; *.mphbin; ..}
All 3D Mesh Files (*.mphtxt; *.mphbin; *fla; ...)
All COMSOL Files (*.mph; *.class)
All ECAD Files (*.zip; *.tar; *.tgz; *tar.gz; ..

oK Cancel

By clicking the Create New File Type and Use It you can use your own file format.
(This requires that you write method code for reading your own file format.)

The figure to the right shows a custom file

type. Adding a custom file type in this way @ Create and Use Dedlaration b
will also create a File Type declaration, as Label: My File Type
shown in the figure below. Name: filetype
v = Declarations Description: My File Type
E File 1 {file1} " Filename extensions
[2] My File Type {filetype} P
B Methods myfile
» [ Libraries

==

oK Cancel

ALTERNATIVES TO USING A FILE IMPORT OBJECT

If an input field for the file path and name is not needed, then there are other
methods for file import that allow a user to pick a file in a file browser. For
example, you can use a menu, ribbon, toolbar item, or a button to open a file
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browser. The figure below shows the Settings window of a ribbon button (ltem)
used to import a CAD file.

Settings

MName: import =
Text: Import

lcon: = import_32.png - + =
Size: Large =
Tooltip:

Keyboard shortcut:
State

Visible

Enabled

<

Choose Commands to Run b

= Forms

B GUI Commands

[iifi Libraries

& Model (root)

(&1l Global Definitions

~ [l Component 1 (comp1) {comp1}
» = Definitions

¢ v v o

~ A Geometry 1{geom1}
~ [& Import 1 (imp1) {imp1}
abe Source (type)
abe Filename (filename)
abe Filename (meshfilename)
Scale 1 (scal) {scal}

Edit Node Run [ Plot Set Value Show Show as Dialog
Import File Enable Disable

e Command lcon | Arguments
Set type of Import 1 (imp1) {imp1} = lcad
Impeort file to Import 1 (imp1) {imp1} :

Plot Geometry 1{geom1} B8 | main/graphics1
Zoom extents [ main/graphics1

A File Import object can also reference a File declaration. For more information, see
“File” on page 175. For more information on file handling in general, see
“Appendix C — File Scheme Syntax” on page 348.

The built-in method that corresponds to the command Import file is importFile.
For example, for importing an image you can use:

success=importFile("filel1",new
String[]1{"ALL_IMPORTABLE_IMAGES","PNG","JPEG","BMP","GIF"});
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Information Card Stack

An Information Card Stack object is a specialized type of Card Stack object used to
display information on the relationship between the inputs given by the user to an
application and the solution. The figure below, taken from the Tubular Reactor
app, shows a portion of a running application in which an information card stack
is used together with information on the expected computation time.

~ Information

Expected computation time: 5 seconds

I.f'_-“\.l Last computation time: 6 s

y,

The corresponding form objects are shown below:

@ Preview D main D input D information X

v

Expected computation time: 5 seconds

/o Solution not yet available.
.\/:.
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The figure below shows the Settings window where a string variable
solutionState is used as the source.

Settings

Information Card Stack

MName: infocardl

il

~ Active Information Card Selector

~ = Declarations
~ =bc String

activePlot
solutionState

[am}

emailTo

emailServerHost
Use as Source Edit Node

Selected source:

=be String=solutionState
~ Information Cards

L
Activatir | lcon | Text

nosolution Solution_not_yet_available
inputcha... A The_input_data_has_changed_since_previous._...
solutione... i | Last_computation_time:

+ 4

There are similarities with a Card Stack object, but for the Information Cards, each
card has an icon and text. In the figure above, the string variable values

nosolution, inputchanged, and solutionexists control which information
card is shown.
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In this example, the information card stack is accompanied by a data display object
where a model tree information node for the Expected Computation Time is used
as the source. The figure below shows its Settings window.

Settings
Data Display
Mame:  datadisplayl =

[] LaTeX markup
Tooltip:  #ntel Xeon E3-1650 v3 @3.50 GHz

v Source @+ "B

Declarations
v @ Model (root)
v (1) Information
<3 Expected Computation Time
Last Computation Time
Last Computation Date

Computed in Version
» () Global Definitions
» ~db Study 1{std1}

@_‘ Use as Source =g Edit Node

Selected source:

= Information=Expected Computation Time

Note that information nodes in the model tree are only shown when working with
the Application Builder. They are made available in the Source section in the
Settings window for form objects, when applicable.

You can also find information nodes with Last Computation Time under each study.

The information node Last Computation, found directly under the Model node, will
correspond to the computation time for the last computed study.

Information nodes can be used as a source for input field objects, text objects, and
data display objects. For input field objects and text objects, in order for the
information nodes to be accessible, the Editable checkbox has to be cleared.
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The Expected Computation Time take its data from the root node of the application
tree, as shown below.

Settings

tubular_reactor.mph
~ Protection

Editing not protected Set Password

Running not protected  Set Password
v Used Products

COMSOL Multiphysics

> Unit System
~ Presentation

Title: Tubular Reactor with Jacket

Description:  This app demonstrates the following:

» Emailing a report when the
computation is finished

» User-defined email server settings
» Playing a sound when the

R JE R (P |

Author: COMsOL
Computation time
Expected: 5 seconds

Last: 4s

If the computation time is predominantly spent in a method, such as when the
same study is called repeatedly, then you can manually measure the computation
time by using the built-in methods timeStamp and setLastComputationTime.
For more information, see “Date and Time Methods” on page 381.

Array Input

An Array Input object has an input table used to enter array or vector-valued input
data. An array input object supports arrays as data sources. You can add an
optional label, symbol, and unit.
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USING AN ARRAY INPUT OBJECT FOR 3D POINT COORDINATE INPUT

Consider an application where the user enters 3D coordinates for a point where
the stress is evaluated. The figure below shows a screenshot from an application
with an array input, button, text label, and data display object.

Point coordinate:
0.05
0.05
0.45

Evaluate Stress at Point

von Mises stress: 3992 MPa
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The figure below shows the Settings window of the array input object.

Settings

Array Input

Marme: arrayinputl =
Length: 3

Show vector as: Table -
~ Source @+ "B

Declarations
v 52 Array 1D Double
25 sampleCoords

€
1]

Use as Source Edit Node

Selected source:
Z:2 Array 10 Double=sampleCoords
Initial value: Custom value -
L]
Value
0.0

0.0
0.0

~ Layout Options

Label position: ~ Above -

Label text: Point coordinate:
[ Include symbol

Symbol (LaTeX encoded):  sampleCoords
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The Array Input form object uses a Source named sampleCoords, which isa ID
Array of type Double. This array is created prior to the creation of the Array Input
object by declaring an Array ID Double with the following Settings.

List of Variables

L oo e
MName Initial values | New element'  Description

sampleCoords |{0,0,0} 0.0 Point coordinate

== - +

In the Settings window of the array input object:

e In the Length ficld, enter the length of the array as a positive integer. The
default is 3.

* From the Show vector as list, choose Table (the default) to show the array
components as a table, or choose Components to show each array component
as a separate input field with a label.

* In the Value table, enter the initial values for the components in the array.

» The Layout Options section provides settings for adding optional labels and
units to the array input.

In this example, when the user clicks the button labeled Evaluate stress at point,
the following method is run for a Cut Point 3D dataset:
with(model.result().dataset("cpt1"));
set("pointx", sampleCoords[0]);
set("pointy", sampleCoords[1]);
set("pointz", sampleCoords[2]);
endwith();
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The stress value is displayed using a Data Display form object referencing a Derived
Values>Point Evaluation with the expression solid.misesGp, as shown in the figure

below.
Model Builder
- T St Elv v B

v @ stress_array_input.mph (root)
> () Global Definitions
v @ Component 1 {comp1) {comp 1}
» = Definitions
> Geometry 1{geom1}
» EE= Materials
> IJ-;J Solid Mechanics (solid) {solid}
A5 Mesh 1 {mesh 1}
» ~do Study 1{std 1}
v @ Results
~ Datasets
Study 1/Solution 1 (5ol 1) {dset 1}
=] Cut Point 3D 1 {cpt 1}
» 2% Derived Values
EH Tables
~ I‘.’ Stress (solid) {pg 1}
> B Volume 1 {vol1}

Radio Button

Settings
Volume

Plot

Label: Volume1

~ Data

Dataset: From parent

~ Expression
Expression:
solid.misesGp
Unit:

MPa
[] Description:

von Mises stress

Parameters
L3

MName Value Unit
solid.refpntx |0 m
solid.refpnty |0 m
solid.refpntz |0 m

-

=

x| =

—+eh- =R

Description
Reference point for moment...
Reference point for moment...

Reference point for moment...

A Radio Button object has a fixed number of options from which you can choose
one. It is most useful when you have just a handful of options.

USING RADIO BUTTONS TO SELECT A LOAD

Consider an application where the user can select one of three predefined loads,

as shown in the following figure.

Applied Force:

e High load (300 N)
Medium (150 N)
() Light load (50 N)
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The corresponding Settings window is shown below, where the global parameter
F is used as the source.

Settings

Mame: radicbutton ,@
Orientation: Vertical -
~ Source @+ "B
» = Declarations

v & Model (root)

v () Global Definitions
~ P Parameters 1
a3 Applied Force (F)

@_‘ Use as Source =g Edit Node

Selected source:

5.5 Parameters 1=Applied Force (F)

Initial value: From data source -
~ Choice List @ +
Available: Selected:

<> Choice List 1 {choicelist1}

The Orientation can be set to Vertical (default) or Horizontal.

In the Initial value list, choose the manner in which the initial selection of the radio
button should be made. The options are From data source, First allowed value (the
default), and Custom value. For the Custom value option, select from a list of the
allowed values given by the choice list.

In the Choice List section, you can add choice lists that contribute allowed values
to the radio button object, where each valid value represents one radio button.
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The radio button names are taken from the Display name column of their
associated choice list. The figure below shows the choice list used in this example.

Settings

Label:  Choice List 1 =5

Mame:  choicelist]

List Content
L

Value Display name
300 High load (300 M)
150 Medium load (150 M)
50 Light load (30 M)

td R > g

USING A UNIT SET INSTEAD OF A CHOICE LIST

If the radio button will be used for the purpose of changing units, then a Unit Set
can be used instead of a Choice List (You still select it in the Choice List section of
the Settings window of the radio button object).

Selection Input

In the Application Builder, you can allow the user of an application to interactively
change which entities belong to an Explicit selection with a Selection Input object
or a Graphics object. For more information on selections, see “Selections” on page
93.

You can choose to use a graphics object as the source of a selection without
having any selection input object. You can also link both a graphics object
and a selection input object to the same explicit selection.
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In the example below, the embedded model has a boundary condition defined
with an Explicit selection. Both a Selection Input object and a Graphics object are
used to let the user select boundaries to be excited by an incoming wave.

0.1

-0.47]
0.5
0.6 |
-0.77]
I I I T T
1.4 1.6 1.8 2 2.2
= B —
=3 = N
7 &

The user can select boundaries here by clicking directly in the graphics window
corresponding to the Graphics object or by adding geometric entity numbers in a
list of boundary numbers corresponding to a Selection Input object.

To make it possible to directly select a boundary by clicking on it, you can link a
graphics object to an explicit Selection used to group boundaries, as shown in the
figure below. Select the explicit selection and click Use as Source.
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In the figure below, there are two explicit selections, Excitation Boundary and Exit
Boundary, and the graphics object graphics2 is linked to the selection Excitation
Boundary.

Settings

Graphics

Mame: graphics2 =
Zoom to extents on first plot

~ Source for Initial Graphics Content

¥ Declarations
Model (root)

~ [l Compenent 1 (comp1)

en

w

v = Definitions
v g Selections
w Exit Boundary
5| Excitation Boundary

@_‘Use as Source %, Clear Source =# Edit Node

Selected source:

+ Excitation Boundary

When a graphics object is linked directly to an explicit selection in this way, the
graphics object displays the geometry and the user can interact with it by clicking
on the boundaries. The boundaries will then be added (or removed) to the
corresponding explicit selection.
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To make it possible to select by number, you can link a selection input object to
an explicit selection, as shown in the figure below.

Settings

Selection Input

MName: selectioninputl E

~ Source

v & Model (root)
~ [l Compenent 1 (comp1)
v = Definitions
v g Selections
w Exit Boundary
2 Excitation Boundary

Use as Source %, Clear Source Edit Node

Selected source:

+ Excitation Boundary

~ Graphics to Use When Active

~ [ Forms
v D form1
[ graphicsl
graphics2

@_‘ Use Graphics =g Edit Mode
Selected graphics:

[ graphics2

In a selection input object, you can copy, paste, remove, clear, and zoom into
selections.

You can have events associated with selections. The On data change cvent will be
triggered when the selection is changed. If you have a local method associated
with this event, you will get a method with an integer array argument. The
method is called with the new entities of the selection. The On activate event will
be triggered when the Activate Selection button is clicked.

v Events
On data change: meodifiedSelection ~ Bt
On activate: activatedSelection - Bt~
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Note that you can also use a global event triggered by a selection change, as

illustrated by the figure below, where the method runOnEvent is run each time a
selection is changed.

App“ca’[ion Builder B settings X runOnEvent

-ty E-

Mame:  eventl =

Type filte ¢ Enabled

v micromixer_app.mph (root)

%I Inputs ~ Source for Data Change Event @ B
% Thernes = Declarations
» D Main Window ~ <& Model (root)
v B Forms > () Global Definitions
D main ~ [l Component 1 (comp1) {comp1}
[ cad v = Definitions
[ mesh > 2= Variables 1{varl}
D transport v g Selections
D flow 2 Inlet Boundaries {sel1}
D results % Outlet Boundaries {sel2}
v ! Events % All Fluid Domains {sel3}
u e\.ren.t‘l = All Fluid Boundaries {seld}
. % Eﬂe;l:;a;;ons @_‘ Use as Source =g Edit Node
runOnEvent Selected source:
» [ Libraries % Inlet Boundaries {sel1}
~ Choose Commands to Run kS
¥ % Forms
» @ GUI Commands
~ % Methods
runOnEvent
» [ Libraries

» < Model (root)

=¢ Edit Node » Run [ Plot Set Value Show
Show as Dialog Import File Enable () Disable

L
Command lcon | Arguments

runOnEvent @

T l --><|"Eiv ,
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Text

A Text object is a text field with default text that is taken from a string variable or
an Information node. The Settings window for a text object is shown below.

Settings

Text

Mame:  textl ,@
[] Editable

[+] Wrap text

~ Source @+ "B

v = Declarations
w abe String

o svar

» < Model (root)

@_‘ Use as Source =g Edit Node

Selected source:

abe String=svar

Initial value: From data source -

Select a string variable or Information node from the tree in the Source section and
then click Use as Source. In the Value field, enter the initial text. By default, the
Initial value text is taken from this field. To instead use the string variable for the
Initial value text, change the Initial value setting to From data source.

The Editable checkbox is cleared by default. If selected, the text object can be used,
for example, to type comments in a running application. If the text is changed by
the user, it is stored in the string variable that is used as the data source, regardless
of the Initial value setting.

The Wrap text checkbox is selected by default. Clear this checkbox to disable
wrapping of the text. A scroll bar appears if the text does not fit.

For more information on Information nodes, see “Data Display” on page 107.

List Box

A List Box object is similar to a radio button object, except that it allows for the
simultaneous selection of multiple options.
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USING A LIST BOX TO SUPERIMPOSE VIBRATIONAL MODES

Consider an application where the first six vibrational modes of a mechanical part
can be superimposed and visualized by selecting them from a list box, as shown in
the figure below.

Superimposed modes: a |- ey RO R [O] B
o
Mode 1
Mode 2
Mode 3
Mode 4

Mede 5
Mode 6

| Plot Shape |

As an alternative, the following figure shows that a list can be displayed as a dialog.

aQa@~- & -

Superimposed modes:

Mode 1 @ add %
Mode 3
Mode 4 Allowed values:
Mode 2
Mode 5
Mode &
+

| Plot Shape |
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The Settings window for the list box of this example is shown in the figure below.

Settings

List Box

MName: listbox1 =
~ Source @+ "B

v = Declarations
w 255 Array 1D String
2 svar1D
» E Boolean
» 85 Double
» < Model (root)

@_‘ Use as Source =g Edit Node

Selected source:

255 Array 1D String=svar1D

Initial value: First allowed value -
v Choice List ® +
Available: Selected:

<%» Choice List 1 {choicelist1}

Select values in: List box -

The Select values in list allows you to choose between two alternatives, List box or
Dialog, for displaying the list.

You can use any scalar or array declaration as a source. Select from the tree and
click Use as Source. If you use a string array as the source, you can, in the running
application, select more than one item in the list using Shift+Click or Ctrl+click.
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For other sources, you can only select one value from the list. This example uses a
1D string array svariD. Its Settings window is shown below.

Settings

Array 10 5t

List of Variables

L
MName Initial values ~ MNew element | Description
svarlD 11,2,3,4,5,6} 1 Array 1D String
== - +

In the Choice List section, you can add choice lists that contribute allowed values
to the list box. The figure below shows the choice list used in this example.

Settings

Label:  Choice List 1 =5

MName:  choicelist]

List Content

" Value Display name
7 Mode 1

8 Mode 2

9 Mode 3

10 Mode 4

11 Mode 5

12 Mode &

\ -

The vibrational modes 1-6 correspond to trivial rigid body modes and are not of
interest in this application, hence the Value column starts at 7. The choice list
allows you to hide the actual mode values in the model from the user by only
displaying the strings in the Display name column. The first nonrigid body modes
are named Mode 1, Mode 2, and so on.

The method below uses the COMSOL Multiphysics operator with () to visualize
the superimposed modes. This example is somewhat simplified, since it ignores the
effects of amplitude and phase for the modes.

String withstru="0";
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String withstrv="0";

String withstrw="0";

for(int i=0j;i<svariD.length;i++){
withstru=withstru + "+" + "with(" + svariD[i] + ",u)";
withstrv=withstrv + "+" + "with(" + svariD[i] + ",v)";
withstrw=withstrw + "+" + "with(" + svariD[i] + ",w)";

}

with(model.result("pg7").feature("surfi1").feature("def"));
setIndex("expr", withstru, 0);
setIndex("expr", withstrv, 1);
setIndex("expr", withstrw, 2);
endwith();
useGraphics(model.result("pg7"),"/formi/graphics8");
zoomExtents("/form1/graphics8");

Assuming the user selected the modes 1, 3, and 5 by using the list box, the method
creates an expression with(1,u)+with(3,u)+with(5,u). This expression is then
used for the x-displacement (dependent variable u) in a displacement plot. In a
similar way, the method automatically creates expressions for the variables v and w
associated with the y- and z-displacement, respectively. Note that the command
with(), used in the results in the example above, is different from the built-in
with() command used to shorten syntax that is described in “With, Get, and Set
Methods” on page 385.

USING A UNIT SET INSTEAD OF A CHOICE LIST

If the list box will be used for the purpose of changing units, then a Unit Set can
be used instead of a Choice List (You still select it in the Choice List section of the
Settings window of the list box).

Table

A Table Object represents a structured grid of rows and columns used for defining
input, output, or displaying numerical data in tabular form. The figure below
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shows an example of a user interface of an app with a table object used to accept

input in three columns.

Flow rate and fluid properties:

L]
Flow rate (sccm)

100 0.032
200 0.023
300 0.146
1000 0.004
250 0.032
700 0.004
2000 0.04
600 0.023
+ PIRPINP N

Molecular weight (kg/mol)

Dynamic viscosity (Pa-s)
2E-5

1.78E-5

1.38E-5

1.9E-5

2E-5

1.9E-5

2.1E-5

1.78E-5

The figure below shows the corresponding form object and its Settings window.

Preview input X
P
v

>
Input
Pipe length:
Pipe diameter:
Temperature:
Process chamber pressure:
Spacing between pipes:

Flow rate and fluid properties:

B ]
Igjmm
K
1o

Opsten)

Settings

Table

MName:  tablel

m Show headers

= ] Automatically add new rows
X [ Sortable

Pa v Sources

m

~ Declarations
sbc

1D String

"
Flow rate (scem) | Molecular weight (kg/mol)

100 0.032
200 0.028
300 0.146
1000 0.004
250 0.032
700 0.004
2000 0.04

600 0.028

ti+EEEiadixcwn)

Dynamic viscosity (Pa-s)

2E-5
1.78E-5
1.38E-5
1.9E-5
2E-5
1.9E-5
2.1E-5
1.78E-5

3 flow_rate
3 molecular_weight
28 dynamic_viscosity

Add to Table Edit Node
o Header Width
Flow rate (sccm) 120

Molecular weight (k... 160

Dynamic viscosity (... | 160

~ Toolbar

Position: Below

lcon size: Small

"
Name lcon | Text

localiter 1

localitem?2

A

localitem3

localitemd =

X

localitem5
localitems

process]

B4/ 12 (60

process2

process3

5B

i

Grow | Editable | Alignment Data source
O| & | Len ~  Data flow_...
O| & | Lek + Data'mole...

O| & | Lei ~  Data'dyna..

Tooltip
Move up
Move down
Add

Delete

Load from file
Save to file
Process 1
Process 2

Process 3

In this example, the data source references three 1D string arrays. You can select
any type of array as the source and then click Add to Table.
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Three checkboxes control the overall appearance of the table:

* Show headers

¢ Automatically add new rows

* Sortable

The Automatically add new rows checkbox ensures that an additional empty row is
always available when a user is filling out a table. If all of the 1D string arrays,
which are used as a source to the table, have nonempty values for New element
value in their declaration Settings window, then this functionality is deactivated. In

this case, new rows can only be added by clicking the Add button in the associated
table toolbar, if such a button has been made available.

The Sortable checkbox makes it possible to sort the table with respect to a
particular column by clicking the corresponding column header.

The Sources section contains a table with five columns:

¢ Header

* Width

¢ Grow

¢ Editable

¢ Alignment

¢ Data source

Each row in this table defines a column in the table object. The option Grow allows

individual columns to grow when a form is resized. This option is only applicable
to grid mode and if the Horizontal alignment of the table is set to Fill.

In the example, the string arrays define the initial values for the rows
corresponding to the three columns, as shown in the figure below:

Settings

Array 1D String

List of Variables

L
MName Initial values MNew element value | Description
flow_rate {'100','200",'300",'1000",'250','700','2000",'600'} 100 Flow rate
molecular_weight | {'0.032','0.028",'0.146',0.004",'0.032",'0.004",'0.04",'0.028"} 0.032 Melecular weight
dynamic_viscosity |{'2E-5','1.78E-5','1.38E-5',"1.9E-5','2E-5','1.9E-5','2.1E-5','1.78BE-5'} | 1.78E-5 Dynamic viscosity
T
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You can control which source that determines the number of rows in the table. To
set this, right-click the corresponding array declaration in the Sources section and
select Set as Synchronizing Source.

~ Sources @+ "B

v = Declarations
v 255 Array 1D String
‘EE‘E' flow_rate
2 molecular_weight
20 dynamic_viscosity
=¢ EditNode

5 Addto Table

@ Setas Synchronizing Source

[ Add to Table = Edit Node

TOOLBAR

In this section, you can select which toolbar items (buttons) should be used to
control the contents of the table. The Pesition list defines the location of the
toolbar relative to the table and provides the following options:

* Below
e Above
e Left

¢ Right

The lcon size setting allows you to choose Small or Large icons.
To add an item to the toolbar, click the Add Toolbar Item button below the table.

v Toolbar
Position: Below >
lcon size: Small >
" Mame lcon | Text Tooltip

localitem5 Load from file

localitem® Save to file

process] & Process 1

process2 - Process 2

process3 PLN Process 3

=
> Position and § Aqd Toolbar ltem
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The following dialog is then shown.

[ @ Toolbar Items hed
v & Modify t Move Up
= Insert Above 1 Move Down
v File + Add
= Clear Table and Load from File = Delete

Load from File
Save to File
&, Process 1
Adds> %, Process 2
4. Process3
Purge
¢ Clean
Y. Clear Table

<<Remove

Custom ltem... Custom Toggle ltem...
OK Cancel

You can always add the following items:
¢ Move Up

* Move Down

¢ Add

¢ Insert Above

* Delete

¢ Clear Table

¢ Load from File

¢ Clear Table and Load from File

¢ Save to File

In addition, you can add customized items by clicking Custom Item or Custom
Toggle Item in the Toolbar Items dialog. The figure below shows the Edit Custom
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Toolbar Item dialog used to define a customized button. The dialog has two tabs
for a regular item and three tabs for a toggle item.

O Edit Custom Toolbar ltem s
General  Choose commands to run

Mame: purge

Text: Purge

Icon: = pipe_purge.png ~| [+ B
Tooltip: Purge

Keyboard shortcut:

State
Visible
Enabled
oK Cancel

O Edit Custom Toolbar tem

General - Choose commands to run

b & Forms

> [ GUI Commands
4 = Declarations
4 2ts Amray 1D String
22 flow_rate
285 molecular_weight
255 dynamic_viscosity
I sk String
b Ey Methods
b [l Libraries
b @ Model (roct)

Run Plot Set Value Show

Disable

Show as Diclog

"

Command
Set flow_rate of Array 1D String
Set molecular_weight of Array.

Icon | Arguments

7 | {'2000','2000','2000,
7 | ['0.028.'0.028",

7 ['1.78E-5,1.78E-5."

Set dynamic_viscosity of Array.

“

Import File Enable

2000, 2000','2000", 200...
g,'0.028''0.028, 0.028" .
1.78E-5,".78E-5, 1.78E-..

0K Cancel

The Choose commands to run tab is similar to that of menu, ribbon, and toolbar

items, as well as buttons.

The Load from File and Save to File buttons are used to load and save from/to the

following file formats:

o Text File (.txt)

+ Microsoft® Excel Workbook (. x1sx)
- Requires LiveLink™ for Excel®

* CSV File (.csv)
+ Data File (.dat)

This is shown in the figure below.

Text File (*txt) -

[ Text File (*tet) |
Microsoft Excel Workbook (*xlsx)
C5V File (*.csv)

Data File (*.dat)
All Files (*%)

The allowed separators are comma, semicolon, and tab for CSV files, and space

and tab for DAT and TXT files.
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Slider

A Slider is a form object for choosing numerical input using a slider control.

USING A SLIDER TO CHANGE THE PROPERTIES OF A TUBULAR REACTOR
The following example is from the Tubular Reactor Surrogate Model app,
available in the Application Libraries under COMSOL Multiphysics.

The figure below shows the user interface of the app where three slider objects are
used to control the Activation energy, Thermal conductivity, and Heat of reaction,
respectively, of the embedded tubular reactor model.

@ Untitled.mph - Tubular Reactor - a X
File Home
o — =
| = | B
Reset  Compute  Report Help
input | Simuiation | Documentation
Input and Description Results revecs: O
« Input Temperature | Conversion  Temperature profies | Conversion profiles
Active gy 75362 ymol QaR-@Lrrzxn ¢ e BEO @8
Surface: Conversion, species A (Preview)
1
0
/ 09
Plot:
O Computed results
@ Results pre 0.8
O Resuls preview and computed profies
+ Reactor Description 09
Outiet: A B,C
0H
06
ol Aveoc os
04
Py
Inlet:A, B
03
~ Information
Expected
%) 02
+ When Solved
01
Play sound
(] Email report to:
m )
=Ty

£ EmilSetings I
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The Settings window of the first slider is shown in the figure below.

MName: sliderl

i

Minimum value: 71518

Maximum value: 79205

MNumber of steps: 50

Orientation: Horizontal =

Tooltip:
v Source ®+ 2

» = Declarations
v < Model (root)
v () Global Definitions
~ P Parameters 1 {default}
=B Activation energy (E)
2.5 Frequency factor (A)
2.5 Thermal conductivity (ke)
8.5 Diffusion coefficient (Diff)
Use as Source Edit Node

Selected source:

2.5 Parameters 1 {default}=Activation energy (E)

Initial value: From data source =

In this example, the slider uses a global parameter E, representing the Activation
energy, as its source. You can select any parameter, variable, or declared scalar
variable as a source. Select from the application tree and click Use as Source.

You determine the range of values for the data source by defining the Minimum
value, Maximum value, and Number of steps for the slider. The Orientation can be
Horizontal or Vertical. You can also set a Tooltip that is shown when hovering over
the slider. The Append unit to number option lets you associate a unit with the
slider. This unit is appended to the number using the standard bracket notation,
such as [N], before being passed as a value to the source variable. As an alternative
to Append unit to number, you can choose Append unit from unit set. See “Unit
Set” on page 177 for more information.

In the Initial value list, sclect From data source or Custom value for the initial value
for the slider.

In the Events section, in addition to specifying which method to call for an On data
change event, you can select the Trigger while dragging checkbox. This setting
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determines if the event method should be called continuously while the slider is
being dragged or only upon its release.

~ Events

On data change: changelnputAndResultsPlot ~ I+~
Trigger while dragging

This checkbox can be cleared if the method that is called by the On data change
event is computationally heavy, so that there is a lag when dragging the slider.

Knob

A Knob is a form object for choosing numerical input using a control knob, similar
to a slider.

USING A KNOB TO CHANGE THE ANGLE OF A CRANE ARM

The following example is from the Truck Mounted Crane Analyzer app, available
in the Application Libraries under the Multibody Dynamics Module.

In this application, the angle of a truck mounted crane arm can be changed by
control knobs, such as in the figure below.

~ Orientation and Extension

\ i i

et / -~ ‘\.\ IJ ‘\.:‘\‘ IJ

s A s A ’/ \‘
a | 45 |- g - Al 15 m

In this example, the knobs are accompanied by input fields that are used to display
the selected value.
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The Settings window of one of the knobs is shown in the figure below.

Settings

Knot

MName: knob1 ,@
Minimum value: -13

Maximum value: 90

Mumber of steps: 33

Mouse movermnent: Distance -
Tooltip: -13<=value==90
v Source @+ 3

v = Declarations
w abe String

abe solutionState
=2 Anglel
abc RelAng
abe Extlen
abe Fel
abe Fe2
abe Fe3
abe results
abe cylCapl

Use as Source Edit Node

Selected source:

abe String=Anglel

Initial value: From data source -

In this example, the knob uses a string variable Angle1 as its source. You can select
any parameter, variable, or declared scalar variable as a source. Select from the
application tree and click Use as Source.

You determine the range of values for the data source by defining the Minimum
value, Maximum value, and Number of steps for the knob.

The Mouse movement can be Distance, Vertical, or Circular. Distance changes the
value with a linear mouse movement in any direction. Vertical changes the value
when you move the mouse vertically. Circular changes the value when you make a
circular mouse movement. A physical control knob is usually controlled with a
circular movement. However, when using a mouse this is usually not the most
convenient way. Instead, use a linear mouse movement by selecting Distance or
Vertical.

You can also set a Tooltip that is shown when hovering over the knob. The settings
for units are similar to that of a slider.

In the Initial value list, sclect From data source or Custom value for the initial value
for the knob.

| 339



In the Events section, in addition to specifying which method to call for an On data
change event, you can select the Trigger while dragging checkbox. This setting
determines if the event method should be called continuously while the knob is
being dragged or only upon its release.

~ Events

On data change: updateGeometryAndSolutionState 4~
[] Trigger while dragging

This setting can be useful if the method that is called by the On data change cvent
is computationally heavy, so that there is a lag when dragging the knob.

Hyperlink

A Hyperlink object embeds a hyperlink in a form. The figure below shows an
example of a hyperlink.

COMSOL Web Page
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The figure below show the corresponding Settings window.

Settings

Hyperlink

Mame:  hyperlinkl =
Text: COMSOL Web Page

URL: www.comsol.com

~ Position and Size

Width: 105
Height: 15

Positionx: 138
Positiony: 129

~ Appearance

Background color:  Transparent -
Font: Default font -

Font size: Default size > pt

[] Bold
[] Italic

State
Visible
Enabled

The Hyperlink object supports the types of URLs that you can use in a web
browser, including;:

» Web Page: When a user clicks the hyperlink for a web page, it opens in the
user’s default browser. The URL string needs to be on the form
protocol://address, where protocol is the transmission protocol; for
example, HTTP or HTTPS. The web address can be partial or complete, but
it is recommended to use a complete web address.

* Email: An email address is specified on the form mailto:emailaddress. This
will launch the user’s default email application program and prepare a new
message where the To field is set to the address specified. This way of
interactively sending an email from a COMSOL application is different from
using the built-in method. For more information on the built-in methods
for email, see “Email Methods” on page 373.
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Toolbar and Form Toolbar

A Toolbar or Form Toolbar object defines a toolbar and its buttons. The figure
below shows a toolbar with several buttons, from the Image to Curve add-in,
available in the Add-In Libraries under COMSOL Multiphysics.

Browse Plot Eifi Filter Contour Curve Reset

The Settings window for this toolbar (in this case a form toolbar) is shown in the
figure below.

Settings

Form Toolbar

MName: mainToolbar

Icon size: Small

4

~ Toolbar ltems

L3

MName lcon | Text Tooltip

browse Browse Load image file

plot Plot Plot imported image

process Filter Plot filtered image
plotContour Contour Plot image contours
generateCurve| /2 | Curve Generate curves from contours
factory 3 |Reset Reset to factory settings

(I

Each row in the Toolbar Items table contains either an Item or Toggle Item
corresponding to a toolbar button or toggle button, respectively, or a Separator.
Use the buttons below the table to add items or separators, change the row order,
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or delete a row. Click the Edit button to display the Settings window associated
with each row. The figure below shows the Settings window of the Browse item.

O Edit Custom Toolbar ltem

General  Choose commands to run
Name: browse
Text: Browse
lcon: open.png
Toottip: Load image file
Keyboard shortcut:

State
Visible
Encbled

Cancel

O Edit Custom Toalbar ltem

General Choose commands to run

> B Forms

> [@ GUI Commands

> = Declarations
= Form Declarstions

[ Methods
importimage
generateContour
generateCurve
createNodes
cleanup

[Z] measureContour

>

Run Plot Set Value Show

Disable

”»
Command
importimage

b B~

Show as Dialog * Import File

Icon | Arguments

5]

OK

Enable

Cancel

The text in the Tooltip ficld will be shown when hovering over the toolbar button.
The text in the Text field will be shown next to the icon, if any; otherwise just the
text is shown. Similarly you can choose to just have an icon and no text. The lcon
list, the Keyboard shortcut ficld, and the Choose commands to run tree represent the

same functionality as a button object. For more information, see “Button and
Item” on page 69.

A Toolbar form object can be placed anywhere in a form. A Form Toolbar is a variant

that can be added to a form’s header area and adapts intelligently based on the

form’s context. For instance, if the form is used in a subwindow or as a settings
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form, the toolbar will be fixed at the top, even when the content below scrolls out
of view. This ensures that the toolbar can always be easily accessible.

Model Builder Settings
“— ® Etv Elv - B~ Image to Curve
o Browse Plot Filter “# Contour Curve Reset
v 4 Untitled.mph (root) v Image
v () Global Definitions )
Fi Parameters 1 wose =
2 Materials y: size P
[ Image to Curve 1 Image width m
v Compo.n.er?t‘l fcomp1) Filename none Browse...
» = Definitions
> [A] Geometry 1 Filter. Gaussian
== Materials Positive image
£ Mesh 1
> [El Results v Contour

Automatic contour thresheld

Contour threshold

If the form is used in a section within a form collection, the toolbar appears in the
section header, offering a convenient location for section-specific commands.

Spacer

A Spacer object is invisible in the user interface and is only used when working in
grid layout mode. It defines a space of fixed size that you can use to ensure that
neighboring form objects have enough space to show their contents. Typically,

you would use a spacer next to a table or graphics object to ensure that they are
rendered properly. If the user resizes the window so that it becomes smaller than
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the size of the spacer, the effective size of the window is maintained by displaying

scroll bars. The figure below shows the Settings window of a spacer object.

Settings

il

MName: spacerl

~ Position and Size

Harizontal alignment: Left =
Vertical alignment: Top =
Width: 40

Height: 20

Row: 7

Column: 2

Row span: 1

Column span:

Cell margin

Cell margin: From parent form =
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Appendix B— Copying Between Applications

Many nodes in the application tree can be copied and pasted between applications,
including: forms, form objects, menu items, methods, Java® utility methods,
external libraries, file declarations, choice list declarations, menus, menu items,
ribbon sections, ribbon tabs, and ribbon items.

When you copy and paste forms, form objects, and items between applications, the
copied objects may contain references to other objects and items. Such references
may or may not be meaningful in the application to which it is copied. The
following set of rules apply when objects are pasted from the clipboard:

* A declaration referenced in a form object or menu item is included when
copying the object, but is not necessarily pasted. It is only pasted if there is
no compatible declaration present. If a compatible declaration exists, that is
used instead. A compatible declaration is defined as one having the same
name and type. For example, a string declaration is not compatible with an
integer declaration. An existing declaration may have an invalid default, but
no such check is done when pasting.

» A referenced global parameter may have a different unit, but will still be
considered compatible.

* A form or form object directly referenced from another form object is not
included automatically when copying objects. The direct reference will point
to an existing object if it has the same name. If the original reference is
among the copied objects, then that object will be used in the reference
instead of any existing objects having the same name. The name of the
copied reference will be changed to avoid name collisions.

* No objects in the model tree will be automatically copied, for example, a
graphics object referring to a geometry or an input field referring to a
low-level setting exposed by Data Access. If the reference points to an object
that exists in the model tree of the target application, then that reference will
be used.

» References to nonexistent objects will be attempted to be removed when
pasted. An exception is command sequences in buttons, where all commands
are kept and marked as invalid if they point to a nonexistent reference.

* Local methods are included in the copy-paste operation. However, no
attempt is made to update the code of the method. This also applies when
copying a global method.

* Arguments to commands in the command sequence of a button or a menu
item will be left as is.
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» Allimage references are automatically copied and added to the image library
when applicable. If there is an existing image with the same name, it will be
used instead of the copied version.

* No files, sounds, or methods are automatically copied if referenced to.
However, methods can be copied and pasted manually.

» All pasted objects that have a name that conflicts with that of an existing
object will be renamed. Any references to the renamed object from other
pasted objects will be updated.
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Appendix C — File Scheme Syntax

The handling of files may be an important feature of an application. For example,
the application may require a spreadsheet file with experimental data as input, a
CAD file to be imported, or a report to be generated and exported. The
Application Builder provides tools for reading and writing entire files or portions
ofa file. The way that this is done will vary depending on the system where the
application is running. The file system may be difterent on the computer running
COMSOL Multiphysics, where the application is developed, and on the computer
where COMSOL Server is installed and the application will run once it is
deployed. For more in-depth information on reading and writing various types of
data to file, see the Application Programming Guide.

File Handling in General and with COMSOL Server

In general, you cannot read and write files to local directories when running
applications with a web browser or the COMSOL Client for Windows®. The
application and its methods are run on the server and, mainly for cybersecurity
reasons, have no knowledge of the client file system (where the web browser or
COMSOL Client is run).

However, there are techniques for transferring files to and from the client file
system when running an application both with a web browser and the COMSOL
Client.

A File Import object can be used to ask the user for a file, for example. The user
then browses to a file on the client file system, which is then uploaded to the
COMSOL Server file system and becomes available to the application and its
methods. This can be used, for example, to provide a CAD file or an experimental
data file from the user at run time ands is covered in the section “File Import” on
page 354.

In a command sequence of, for example, a button, you can export data generated
by the embedded model by running a subnode of the Export or Report nodes. This
is covered in the section “File Export” on page 361.

SAVING AND OPENING FILES USING FILE COMMANDS

In the editor tree used in a command sequence, the GUI Commands>File Commands
folder contains commands to save and load applications and files, as well as exiting
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an application. The command Open File will pick any file from the server that was

Settings

Button

Mame: helpButton =
Text: Help

lcon: Bl help_32.png - + =
Size: Large -
Style: Flat *
Tooltip: Open the PDF documentation.

Keyboard shortcut: CTRL+0O

~ Choose Commands to Run B

> [ Forms

~ @ GUI Commands
v File Commands
Save Application
[ Save Application As
[ Save Application Copy As
Save Application on Server
[ Save Application on Server As
Open File
L SaveFile As
Exit Application
¥ [‘u Graphics Commands

Edit Node Run [aE| Plot Set Value Show Show as Dialog

Import File Enable Disable

L
Command lcon | Arguments

Open file embedded:///tuning_fork.pdf
u R

produced by a method or the model, or embedded with the application. The file
will be opened using the associated application on the client. This can be used, for
example, to open a PDF file in the client file system, or show a text file or an image
exported from the model on the client side. In the figure above, an Open File
command is used to open the PDF documentation for an application. The
corresponding PDF file is embedded in the application by being stored in the
Libraries > Files node. Files located there are referenced using the embedded:///
file scheme syntax described in the next section, “File Scheme Syntax” on page
351.

To open files from a method, use the built-in method fileOpen; see also
“Operating System Methods” on page 373.

To save a file, use the command Save File As, which is similar to Open File. When
using COMSOL Server, it will take any file from the server file system and display
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a Save As dialog to the user where the user can browse to a client location to save
the file. This is similar to downloading files from a link within a web browser. In
the figure below, a Save File As command is used to save a CAD model that is
stored in the Libraries > Files node.

~ Choose Commands to Run B

> [ Forms
~ @ GUI Commands
v File Commands
Save Application
[ Save Application As
[ Save Application Copy As
Save Application on Server
[ Save Application on Server As
Open File
L SaveFile As
Exit Application
¥ [‘u Graphics Commands

Edit Mode P Run Plot Set Value Show Show as Dialog

Import File Enable Disable

L
Command lcon | Arguments

Save file as 1 |embedded:///exhaust_manifold.x_t
S g bE~ @

To save files from a method, use the built-in method fileSaveAs; See also “GUI
Command Methods” on page 379. For more information on saving and exporting
files, see “File Export” on page 361.

The Save Application and Save Application As commands are available for use in the
command sequence for certain form objects. The Save Application As command
will display a Save As dialog where the user can specify a client path where the
entire application will be saved.

Similarly, the Save Application on Server and Save Application on Server As
commands are available to save the entire application on the server file system. For
information on the corresponding built-in methods, see “GUI Command
Methods” on page 379.

In summary, for COMSOL Server, both uploading and downloading files from
the client file system is supported, but, due to web browser and system security
settings, the application can never do it silently in the background without the user
browsing to the source or destination location of the file.

MoDEL COMMANDS

In the editor tree used in a command sequence, the Model Commands folder
contains two commands: Clear all solutions and Clear all meshes. Use these
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commands to make the MPH file size smaller before saving an application by
erasing solution and mesh data, respectively.

~ Choose Commands to Run A

> [ Forms

~ @ GUI Commands
¥ File Commands
¥ [‘u Graphics Commands
¥ D Main Window Commands
v & Model Commands
\ E Clear All Solutions
W Clear All Built Meshes
» [ Libraries

Edit Node Run [aE| Plot Set Value Show Show as Dialog

Import File Enable Disable

L
Command lcon | Arguments
Clear all solutions \ E
Clear all built meshes \ E
HE-

File Scheme Syntax

To make applications portable, the Application Builder allows you to use virtual

file locations using file schemes. A file scheme can be seen as a pointer to a file on

the file system, but the application does not need to know where the file is actually

stored (this is set in the Preferences window, see below.)

Different file schemes exist for different purposes:

o The user file scheme is for files that should be persistent between different
runs of an application by the same user.

* The common file scheme behaves in the same way, but is for files that should
be shared between all users.

e The temp file scheme is for files that should be removed as soon as the
application is closed.

e The dbfile file scheme is for file versions that are stored in a Model Manager
database.
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* The embedded file scheme is used to store files in the application itself, under

Libraries>Files. This can be useful if you want to make the application
self-contained and send it to someone else.

* The upload file scheme is for files that are uploaded to the application by the
user at runtime, such as a CAD file or an experimental data file to which the

user browses.

The table below summarizes all available file schemes.

SCHEME

REFERS TO

DEFAULT PATH

TYPICAL USAGE

embedded:///

upload:///

temp:///

user:///

common:///

dbfile:///

Files embedded in

the application under

Libraries > Files.

Files to be uploaded
by the user at run
time.

Files in a random
temporary directory,
which is unique for
each started
application instance.
These files are
deleted when the
application is closed.

Files in a directory
shared by all
applications for the
current user.

Files in a directory
shared by all users.

File versions stored in
a Model Manager
database.

N/A

Determined by the
Target directory in
the Settings window
of the File declaration

A random
subdirectory to the
folder for temporary
files, as determined
by the settings in
Preferences > Files

Determined by the
settings in
Preferences > Files

Determined by the
settings in
Preferences > Files

N/A

Experimental data,
CAD files, mesh files,
experimental data.

Experimental data,
CAD files, mesh files,
interpolation data.

Temporary files
produced by
command sequences
or methods, or data
export to a file saved
on the client (for use
with COMSOL
Server).

Output from
methods to be saved
between sessions.

Files shared between
many users or
applications.

Experimental data,
CAD files, mesh files,
interpolation data.

For more information on files in the Libraries node accessible by the
embedded:/// syntax, see “Libraries” on page 241.
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The table below summarizes the usage of the different file schemes. In the table,
a check mark means that this scheme is available and (r) means that it is the
recommended scheme. The dbfile file scheme is available for all usages.

USAGE EMBEDDED UPLOAD TEMP USER COMMON
File is used as input V (n S \

File is output \ @) \

Method reading a file V (n S S \ \
Method writing a file \ \ @) \

File is client-side N ol V() v N

You can set the preferences for the paths to temporary, user, and common files in
the Files page of the Preferences window, which is accessible from the File menu,
as shown in the figure below.

0 Preferences X
EE Files
v Application Builder

> Forms
> Methods Folder for user files (user///): C:\Users\paul.comsol\v83\applications\files\user P& Browse |

Folder for temporary files (temp:///):  C:\Users\paul\AppData\Local\Temp\, ¥ Browse

Chatbot Folder for common files (common:///): | C:\Users\paull.comsol\v63\applications\files\common V& Browse |
Client-Server

Libraries> Files bedded:///}: Use emt il to refer to a file with the name filename in the application.

Computing
Email

Declarations File (upload://): Use upload:/// 1o referto a file with the name filename in the application

v Files
Recent
Recovery
Geometry
Graphics
Help
Libraries
LiveLink Connections
Mesh
Model Builder
Model Manager
Physics Builder
Results
Save
Security
Updates
User Interface

Factory Settings

Factory Settingsfor Al Import. Export. oKk Cancel

For a COMSOL Multiphysics installation, a typical default location for the user
and common folders for a user named paul is:

C:\Users\paul\.comsol\v63\applications\files

For compiled applications, these folders are located within the corresponding
COMSOL Runtime folders, for example:

C:\Users\paul\.comsol\v63runtime\applications\files
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In the case of compiled apps, the application preferences, accessible from the About
dialog, only allow changing the location of the temporary folder temp. The user
and common folders are always located within the COMSOL Runtime folder and

cannot be relocated.

File Import

CAD IMPORT USING THE MODEL TREE AND A FILE IMPORT OBJECT

A File Import object is used to display a file browser with an associated input field
for browsing to a file or entering its path and name. It is used to enable file import
by the user of an application at run time, when the file is not available in the
application beforechand. You can directly link a File Import object to a file Import
node in the model tree; for example, a CAD Import node. Consider an application
where a CAD file can be selected and imported at run time, as shown by the figure
below.

CAD file:  CACOMSOL\pipex_b Browse...

The corresponding File Import object is shown in the figure below.

@ Preview D form1 X

v

CAD file: Browse... =
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The Settings window for the File Import object has a section File Destination. In this
section, you can select any tree node that allows a file name to be input. This is
shown in the figure below, where the Filename for the Import node is selected.

Settings

MName: fileimport1 =]
Style: Outlined -
lcon: MNone = Ll

Button text: Browse...

Dialog title:  File import

File types:
All 3D CAD Files (*.step; *.stp; *a_b; *x_t; ...)
AutoCAD File (*.dwg)
CATIA V5 File (*.CATPart; *.CATProduct)
DXF File (*.dxf)

Allow entering filename

~ File Destination

= Declarations
~ & Model (root)
~ [l Component 1 (comp1) {comp1}
~ ' Geometry 1{geom1}
~ [& Import 1 (imp1) {imp1}
243 Filename (filename)
abc Filename (meshfilename)
E Use as Source =g Edit Node
Selected source:
abe [mport 1 (imp1) {imp1}=Filename (filename)

Access using:  upload:///geom1/imp1/filename

CAD IMPORT USING A BUTTON AND COMMAND SEQUENCE

If you do not wish to use a File Import object, you can directly reference a Filename

from a button or an item in a menu, ribbon, or toolbar, or alternatively create a

method that calls the built-in method importFile as an event, for example
importFile("filel");

assuming there is a file declaration filei.
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The figures below shows a ribbon item used for geometry import together with
its Settings window.

File Home

= A

Import Plot
Geometry
CAD
1 1 H Settings X
Application Builder B setting
>t iE- Name: import B2
S Text: Import
~ .mph {roct)
%:Ir:;:l::rjpp mph (roof lcon: “import_32.png -~ + =
% Themes Size: Large -
v D Main Window
Tooltip:
> [E] FileMenu =
v [5] Ribbon Keyboard shortcut:
v [™] Home [homeTab} State
~ [E] CAD {CADSection] Visible
[ Import fimpart Enabled
E Plot Geometry {plotGeometry}
3 Selections {selectionsSection] + Choese Commands to Run &
» Simulation {simulationSection}
» Visualization {wisualizationSection] > @ Forms
> B Forms > @ GUI Commands
Events > [l Libraries
= Declarations v & Model (root)
2 Methods » () Global Definitions
> [ff] Libraries ~ [ Component 1 {comp1) {comp1}

» = Definitions
v YA\ Geornetry 1{geom1}
v [ Import 1 (imp1) {imp1}
abe Source (type)
abc Filename (filename)

=# Edit Node Run Plot Set Value Show Show as Dialog
Import File Enable () Disable

L
Command lcon | Arguments

Set type of Import 1 (imp1) {imp1}
Import file to Import 1 (imp1) {imp1}
Plot Geometry 1{geom1}

cad

main/graphicsl

1

Zoom extents main/graphics1

t V- @
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In the Settings window above, the command Import file to Import | will open a file
browser for the user to select a file, as shown in the figure below.

(e = | Applications - O *
“ Home Share View o
&« v A <« applications » CFD_Module » Applications v O Search Applications »

A

MName Date modified Type Size
7 Quick access

| | pipex_b X_B File 4KB
& Creative Cloud Files | | split_recombine_geom.x_b : ¥_B File 125 KB
& OneDirive | | star_chip_geom.x_b 2018-12-10 16:04 ¥_B File G KB
[ This PC
¥ Metwork

3 itemns =

The preceding command Set Type of Import allows you to filter the file extensions
displayed in the file browser. The available arguments are: file, mesh, native,
cad, and ecad.

The subsequent commands build and plot the geometry and zoom out using
zoom extents.

For more information on the File Import object, see “File Import” on page 308.

FILE IMPORT IN METHODS

Continuing the example of the previous section, assume that we click Convert to
New Method in the Settings window. The corresponding lines of code show how
CAD import can be accomplished from a method:

importFile (model.geom("geomi1").feature("imp1"), "filename");
useGraphics(model.geom("geom1"), "main/graphicsi");
zoomExtents("main/graphics1");

The first line illustrates using the built-in method importFile. For more
information on the method importFile and other methods for file handling, see
“File Methods” on page 371 and the Application Programming Guide.

FILE ACCESS AND FILE DECLARATIONS

At the bottom of the Settings window of a File Import object, you can see which
file scheme syntax to use to access an imported file from a method (next to Access
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using:). The figure below shows an example where a File Destination and Filename
are used.

Selected source:

123 Import 1 (imp1)=Filename (filename)

Access using:  upload:///geoml/imp1/filename

The file scheme syntax, upload:///geomi/imp1/filename, needs to be used
whenever accessing this file.

As an alternative, you can use a File declaration under the Declarations node.
(However, File declarations are primarily used for file import from method code.)
In this case, the file chosen by the user can be referenced in a form object or
method using the syntax upload:///file1, upload:///file2, and so on. The
file name handle (file1, file2, and so on.) can then be used to reference an
actual file name picked by the user at run time. See also “File” on page 175.

This syntax can also be used in any file browser text fields within the Model
Builder nodes. The figure below shows a file reference used in the Filename field
of the Import model tree node for a model using geometry import.

Settings Settings

) Build Selected » [E8 Build All Objects B ) Build Selected » [E8 Build All Objects B

il
il

Label: Import1 Label: Import1

v Source v Source
Source: Source:

Any importable file = Any importable file =
Filename: Filename:
upload:///filel o~ filel x Lo~
i Browse ¥ [ Import i Browse ¥ [ Import

When you enter upload: ///filel, it is automatically replaced with a reference to
the file location as filel. If you use the upload file scheme, the text field converts
the entry into a link. You can access the underlying source by selecting Show
Location in the Auxiliary Data window.

However, a quicker way is to link a file import object directly to the Filename field,
as described previously in the section “CAD Import using the Model Tree and a
File Import Object” on page 354.

IMPORTING EXPERIMENTAL DATA IN GENERAL

The Application Builder offers multiple ways to import experimental data. The
following sections highlight a few easy-to-implement methods. For additional file
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handling options, refer to “File Methods” on page 371 and the Application
Programming Guide. The guide also includes examples of how Java methods can
be used to import arbitrary files, whether in binary or text format.

IMPORTING EXPERIMENTAL DATA USING A FILE IMPORT OBJECT

The following example is from the Response Spectrum Generator app, available in
the Application Libraries under the Structural Mechanics Module. The figure
below shows the user interface of the app with a file import object used to browse
to a file with experimental data.

Input and Settings
~ Signal Parameters

Signal duration: T1e-3 [5]
Sampling interval:  5e-5 [s]

Signal source: Import tabular data -
Filename: CACOMSOL\data txt Browse...
Unit for signal: m/s* =

Acceleration signal

50 —
% 40 e
E e
= 30
s
B 20 AN
El 7 \\
g 10 /

0

0 0.005 0.01 0.015 0.02
Time [5]

The figure below shows the settings window of the corresponding File Import
object. The object links to the Filename property of an interpolation function,
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defined in the embedded model. In general, each interpolation function added to
a model will have the Filename property available for use in an app.

D inputSettings: cardimportTabular X @ Preview

Settings
v — i
: ] =
Filename: Browse... '3 Mame: fileimport1 =
Style: Raised v
lcon: None ~ 5

Button text:  Browse...
Dialog title: ~ File import
File types:

Text File (“bet)

C5V File (*.csv)

Data File (*.dat)

WAVE Audio File (*wav)

Allow entering filename
~ File Destination &

Declarations
Model (root)
& Global Definitions
v [, Base Acceleration Input (int1) {int1}
= Filename (filename)
> . Relative displacement spectrum (int2) {int2}
> . Relative velocity spectrum (int3) {int3}
> . Relative acceleration spectrum (int4) {intd}
b4
>

<
cem

Jl. Absolute acceleration spectrum (int5) {int3}
%) Positive and negative spectra {grp1}
> JE Results

Use as Source Edit Node
Selected source:
abc Base Acceleration Input (int1) {int1}=Filename (filename)

Access using:  upload:///int1/filename

In this application, the File types table specifies that only certain file types are
allowed.

More information on file import can be found in the Application Programming
Guide. There you will, for example, find information on customized parsing of
arbitrary file types.

IMPORTING EXPERIMENTAL DATA TO A TABLE

Using a table object provides another way to import experimental, or other
tabulated, data. The following example is from the Li-Ion Battery Impedance app,
available in the Application Libraries under the Battery Design Module. The figure
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below shows part of the app’s user interface featuring a table object used to import
and export the data.

~ Experimental Data

L
Frequency | Real Impedance | Imaginary Impedance | Impedance

1000 7.98E-4 T.09E-5 8.01257E-4
820 8.18E-4 T.91E-5 8.21552E-4
640 8.36E-4 9.09E-5 8.40778E-4
460 8.63E-4 1.02E-4 8.69037E-4
200 2 0564 1 1RE.A QNIRIAE.A

ate %
~ Parameter Estimatiq 02d from File

The Load from File button in the toolbar below the table can be used to load data
from file. The figure below shows the corresponding Table settings window. The
imported data is here stored in a set of 1D double arrays, one per column.

@ Pré-:éw [*7 experimental x Settin gs

>

" Frequency | Resllmpedance | Imaginary Impedance  Impedance Name: tablel
Show headers
[ Autematically add new rows
Sortable

~ Sources D -

SN =l v = Declarations

maginarylmpedance
25 impedance

Addto Table S Edit Node
»
* Header Width | Grow  Editable | Alignment | Data source

Frequency 20 % Left

.

Data ‘frequency’ from "Array 1D Dou...

Left

“«

Real Impedance 100 Data 'reallmpedance’ from ‘Array 1D...

Left

‘

Imaginary Impedance | 130 Data ‘imaginarylmpedance' from ‘Arr..

[E|E |

Left

.

Impedance % Data ‘impedance’ from ‘Aray 1D Do...

File Export

FILE EXPORT USING THE MODEL TREE

In a command sequence of, for example, a button, you can export data generated
by the embedded model by running a subnode of the Export or Report nodes.
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In the model tree, the Export node may contain several types of subnodes for file
export, including:

e Data

* Plot

e Mesh

e Table

¢ 3D Image

¢ 2D Image

* ID Image

e Animation

The Settings window for each of these nodes contains an Output section with a

field for Filename. The figure below shows the Settings window for an Export > Plot
node.

Model Builder Settings
— = Et - iy @~ Plot
(™ Refresh [S Export
~ @ busbar.mph (root) Label: Plot1 5
» () Global Definitions
> [l Component 1 (comp 1) {comp 1} ~ Plot
» ~db Study 1{std 1}
v {E| Results Plot group: 1D Plot Group 5 {pg53} -
» Hi Datasets
Plot: Line Graph 1{Ingr1 >
» &2 Derived Values ° ine Graphil (ngel}
> Tabl
% : Es. . v Output
> W@ Electric Potential (ec) {pg1}
» I'.’ Electric Field (ec) {pg2} File type: = G
> N Temperature (ht) {pg3} )
5 .-.« Current Density {pg4} Filename: W& Browse « E -
v 7w 1D Plot Group 5 {pg5} [] Always ask for filename
= b Line Graph 1 {ingr1} Data format: Spreadsheet b d
v Export
~[m3 Plot 1 {plot1} i Ifmultiple curves:  Append as rows -

E Reports
> Advanced

You can leave the Filename field blank, as shown in the figure above. In the
command sequence of, for example, a button, you can run the corresponding
Export > Plot node and, at run time, it will open a file browser window for the user
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to select a location and file name. A command of this type is shown in the figure
below.

"
Command lcon  Arguments

Export Plot 1 {plotl} =

While developing an application, you may need to use the Model Builder
repeatedly to check the exported data. In this case, you can use the Filename field
for a file used for testing purposes and, by selecting the Always ask for filename
checkbox, a file browser will still be opened at run time.

In a similar way to the Export subnodes, each Report subnode has a Format section
with a Filename field, as seen in the figure below.

Model Builder Settings
Report
e, 77| Generate E Preview Selected Preview All & Write =

:

- ‘® Etv El~

v & busbar.mph (root) Label: Report1 =
» () Global Definitions
> [l Component 1 (comp 1) {comp 1} > Template
» ~db Study 1{std 1}
v {E Results paghornal

Datasets

> 2% Derived Values Quiputiotmat STERENENATE =
> [ Tables Filename: B Browse v [~
> Wi Electric Potential (ec) {pg 1} [] Always ask for filename
ey . i
> Wi Electric Field (ec) {pg2} Open finished report
> il T t ht) {pg3}
.... S ure.( P93} [] Disable cross-reference hyperlinks
> N Current Density {pg4}
~ ~w 1D Plot Group 5 {pg5} Microsoft Word template: Default -
4 Li Ingri} .
Chn e Gy nd) Start new page at section level: Level 1 -
Export
[E3 Plot 1 {plat1} Enumerate sections to level: Level 3 -
v [# Reports
> Report 1{rpt1} v Images

By running a Report subnode, a file browser window is opened for the user to
select a location and file name for the report.

For more detailed control over file import and export, you can instead use a file
scheme.
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FILE EXPORT USING A TEMPORARY FILE

Some applications may need to produce temporary files, and this is accomplished
by using the temp:/// file scheme. The temporary files are stored in a random
temporary directory, which is unique for each started application instance. These
files are deleted when the application is closed. Temporary files can be produced
by command sequences or methods, or output to be saved on the client when used
with COMSOL Server.

The example below shows the Settings window of an Export > Plot node that is
used to export plot data as numerical values.

tings

(* Refresh [[= Export »

Label: Plot 1 =
v Plot

Plot group: 1D Plot Group 5 {pg5} = =
Plot: Line Graph 1 {Ingr1} ~| |3
~ Qutput

File type: Text -
Filename: temp:///lineplot.bect K& Browse v [~

[C] Always ask for filename

Data format: Spreadsheet =
If multiple curves:  Append as rows =
> Advanced

The Filename in its Output scction is set to temp:///lineplot.txt.

To make it possible to save the plot in this example, a button is created. In the
Settings window for the button, in the section Choose Commands to Run, first create
the output graph file by choosing the Export > Plot node created above and
clicking Run. Second, choose GUI Commands > File Commands > Save File As and
click Run again.
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In the Output section of the button Settings, sct the filename to the name of the
temporary file created by the Export Plot command, in this case,
temp:///lineplot.txt.

Settings

Button

Marme: button1 =
Text: Save Line Plot]

lcon: Mone ~| |+

Size: Small -
Style: Outlined -
Tooltip:

Keyboard shortcut:

3
&

~ Choose Commands to Run =

> [ Forms

~ @ GUI Commands
v File Commands
Save Application
[ Save Application As
[ Save Application Copy As
Save Application on Server
[ Save Application on Server As
Open File
L SaveFile As
Exit Application

Edit Node P Run [z Plot Set Value Show

Show as Dialog Import File Enable Disable

L1
Command lcon | Arguments
Export Plot 1{plot1} =
Save file as 1 |temp:///lineplottxt

tlEEE-#
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The Save File As command provides a dedicated Edit Argument dialog with
easy access to all embedded files as well as shortcuts for all file schemes.

v Choose Commands to Run "& @ Edit Argument X
’ % (FSDUrIrE; d File scheme: embedded:/// -
~ ommands
v File Commands Choose an application file resource:  @mbedded:/fy
Save Application animate.png upload:///
= SaveAppI?cat?on As animate_32.png common://{
[ Save Application Copy As user///

clear.png

Save Application on Server tempe/ff
[ Save Application on Server As clear 32png Custom
Open File compute.png
L SaveFile As compute_32.png
Exit Application comsol.png
Edit Node P Run [Z3 Plot Set Value Show comsol_32.png
Show as Dialog Import File Enable Disable delete.png
" delete_32.png
Command lcon | Arguments
Export Plot 1{plot1} = oK Cancel
Save file as +

t i EwelE-#

v Dialog Actions Edit Argument

The corresponding method code is as follows:

model.result().export("plot1").run();
fileSaveAs("temp:///lineplot.txt");

The Use of Temporary Files for File Export

Note that as a first step, in the example above, the file is written to a temporary
file, using the call to model.result().export("plot1").run(). This step is
done automatically by the application. In the second step, the method
fileSaveAs opens a file browser and lets the user of the application choose the file
location, for example, a folder on the computer’s local file system or to a network
folder. This extra step is needed in order for the application to function in a web
browser. Due to the security settings of a typical web browser, the application is
not permitted to automatically save a file to an arbitrary location. Instead, the
application is allowed to save to a few specific locations including the temp folder,
whose location is specified in the Preferences window settings. The other locations
are the user and common folders, also specified in the Preferences settings.

For more examples of file export, see the Application Programming Guide.
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Appendix D — Keyboard Shortcuts

The table below lists the keyboard shortcuts available in the Application Builder.
For a list of additional keyboard and mouse shortcuts, see the book Introduction
to COMSOL Multiphysics.

SHORTCUT ACTION APPLICATION ~ FORM METHOD
BUILDER EDITOR  EDITOR

Ctri+A Select all v ol ol

Ctrl+D Deselect all \

Ctr+C Copy \ \ \

Ctrl+V Paste \ \

Ctrl+X Cut v V Yl

Del Delete V \ \

Ctrl+N Create a new application \ \ \

Ctri+S Save an application \ \ \

Ctrl+F8 Test an application \ \ \

Alt+Click Edit certain form objects \

Pause Break or suspend a running method \
as soon as possible

Ctrl+Pause Stop a method \

Ctrl+Shift+F8 Apply changes \ \ \

Ctrl+R Record code \

FII Go to node \

Ctrl+K Create shortcut V \ \

FI Display help \ \ \

F2 Rename applicable nodes \

F3 Disable applicable nodes \

F4 Enable applicable nodes \

Ctrl+Up arrow Move applicable nodes up \

Ctrl+Down arrow Move applicable nodes down \

Ctri+Z Undo v ol ol

Ctri+Y Redo (Control+Shift+Z on Mac) v \ \

F5 Continue (in debugger) \

F6 Step (in debugger) \
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SHORTCUT ACTION APPLICATION ~ FORM METHOD
BUILDER EDITOR  EDITOR
F7 Step into (in debugger) \/
Shift+F7 Step out of a method (in debugger) \
F8 Run a method or method call. \
Create an executable or an add-in.
Fo Check syntax \
Ctri+F Find and replace text in methods \
Ctrl+Space, Ctrl+/, Autocomplete method code \/
or Ctrl+OEM2
Ctri+U Make selected code lowercase \
Ctrl+Shift+U Make selected code uppercase \
Ctr+B Toggle breakpoint on selected line \
Ctrl+M Toggle between matching \
parentheses, square brackets, or
curly braces
Ctrl+Shift+M Select all characters between \
matching parentheses, square
brackets, or curly braces
Ctri++ Ctrl key and plus key: Zoom in, in \ \ \
form editors, method editors, and
the Main Window editing window.
Ctri+- Ctrl key and minus key: Zoom in, in \ \ \
form editors, method editors, and
the Main Window editing window.
Ctrl+0 Reset zoom to 100% in form V \ v
editors, method editors, and the
Main Window editing window.
Ctrl+Alt+0 Zoom to fit the available space in V \

Ctrl+Scroll wheel
up

Ctrl+Scroll wheel
down

Ctri+All arrow keys

All arrow keys

form editors and the Main Window
editing window.

Zoom in, in method code window

Zoom out, in method code window

Fine-tune position of selected form
objects

Fine-tune position of selected form
objects
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SHORTCUT ACTION APPLICATION  FORM  METHOD
BUILDER EDITOR  EDITOR
Ctrl+Shift+A Switch to the Application Builder
workspace.
Ctrl+Shift+] Switch to the Model Manager \ \ \
workspace.
Ctrl+Shift+M Switch to the Model Builder v V Yl
workspace.
Ctri+Alt+Left-click  Create a local method or open a S
method associated with a form
object
Ctri+Alt+ Open a method from Method \
Double-click Editor code
Alt+F4 Close window v \/ l
Ctrl+F4 Close document S \
Ctrl+Shift+F4 Close all documents V l
Ctr+7 Toggle comment on and off \
Press Ctrl and Copy form object \
left-click. While

holding down the
key and button, drag
the mouse.
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Appendix E— Built-In Method Library

This appendix lists all of the built-in methods available in the Method Editor,
except for methods that operate on the model object and the application object.
For detailed information on using the built-in methods and for full information
on the syntax used, see the Application Programming Guide and the
Programming Reference Manual.

As an alternative method of learning the syntax of these methods, you can use
code completion by typing the name of the method and then use Ctrl+Space. A
window will open with information on the syntax and method signature.

@ Preview D form1 E

1 playSound

@ playSound(String name) Tries to play a sound file on the client. At least .wav files are supported.

@ playSound(double hz, int milliseconds)
Parameters:
name MName representing the sound file to play.

Model Utility Methods

The model utility methods make it possible to load the model object part of an
MPH file into a method for further processing.

NAME DESCRIPTION

clearModel Clears the model object contents.

createModel Creates a new model with a given tag.

removeModel Removes a model. The embedded model cannot be removed.

modelTags Returns an array of model tags for all loaded models, including the
embedded model.

uniqueModeltag Returns a model tag that is not in use.

getModel Returns a model with a specified tag.

loadModel Loads a model with a specified tag from a file or, using a model
location URI, from a Model Manager database.

loadProtectedModel Loads a password protected model with a specified tag from a file.

loadRecoveryModel Loads a model from a recovery directory/folder structure.

saveModel Saves a model to a file. The filename can be a file scheme path or,
if allowed by security settings, a server file path.

getComsolVersion Returns the current software version as a string.
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File Methods

The file methods support, in addition to reading and writing to data files on the
file system, reading and writing of data files stored in a Model Manager database

by accepting a file location URI.

NAME DESCRIPTION
readFile Returns the contents in a given file as a string.
openFileStreamReader Returns a CsReader object that can be used to read

openBinaryFileStreamReader

readMatrixFromFile

readStringMatrixFromFile

readCSVFile

writeFile

openFileStreamWriter

openBinaryFileStreamWriter

writeCSVFile

exists

deleteFile

copyFile

line-by-line or character-by-character from a given file
name.

Returns a CsBinaryReader object that can be used to
read from a given file byte-by-byte.

Reads the contents of the given file into a double matrix.
The file has the same spreadsheet-type format as available
in the model tree Export node.

Reads the contents of the given file into a string matrix.
The file has the same spreadsheet-type format as available
in the model tree Export node.

Reads a file with comma-separated values (CSV file) into
a string matrix. By default, it expects the file to use the
RFC 4180 format for CSV. However, by providing an
additional input argument a user-defined delimiter can be
used.

Writes array data to a given file. If the spreadsheet
format is used, then the data can be read by
readMatrixFromFile or
readStringMatrixFromFile.

Returns a CsWriter object that can write to a given file.

Returns a CsBinaryWriter object that can be used to
write to a given file byte-by-byte.

Writes a given double or string array to a CSV file. The
RFC 4180 format is used for the CSV.

Tests whether a file with a given name exists.

Deletes a file with a given name if it exists. The file is
deleted on the server.

Copies a file on the server. Both the source and target
names can use file scheme paths.
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NAME

DESCRIPTION

importFile

writeExcelFile

readExcelFile

getFilePath

getClientFileName

getClientFilePath

Displays a file browser dialog and uploads the selected file
to the file declaration with the given name. Afternatively, it
uploads the selected file to the Filename text field in a
given model object entity.

Writes the given string array data starting from a
specified cell in a specified sheet of an Excel file.

Reads a specified sheet of an Excel file, starting from a
specified cell, into a 2D string array.

Returns the absolute server file path of the server proxy
file corresponding to a certain file scheme path, or null if
the server proxy file for the given path does not exist.

This method can be used to pass the path to, for
example, a file using the temp:/// scheme to extemal
code or an application.

Returns the original name of an uploaded file on the client
file system (or null if there is no uploaded file matching
the given file scheme path).

This method is only useful for providing user interface
feedback; for example, to get information on which
uploaded file is being used. There is no guarantee that the
original file would still exist on the client or even that the
current client would be the same as the original client.

Returns the original path of an uploaded file on the client
file system (or null if there is no uploaded file matching
the given file scheme path).

This method is only useful for providing user interface
feedback; for example, to get information on which
uploaded file is being used. There is no guarantee that the
original file would still exist on the client or even that the
current client would be the same as the original client.
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Operating System Methods

NAME DESCRIPTION

executeO0SCommand Executes the OS command with a given command (full path) and
parameters. When applicable, the command is run server side.

fileOpen Opens a file with the associated program on the client. See also
the section “File Methods”.

getUser Returns the usermame of the user that is running the application. If
the application is not run from COMSOL Server, then the value
of the preference setting General > Username > Name is

returned.
openURL Opens a URL in the default browser on the client.
playSound Plays a sounds on the client.
Email Methods
NAME DESCRIPTION
emailFromAddress Returns the email from address from the COMSOL Server or

preferences setting.

sendEmail Sends an email to the specified recipient(s) with the specified
subject, body text, and zero or more attachments created from
Report, Export, and Table nodes in the embedded model.

userEmailAddress Returns the user email address(es) corresponding to the currently
logged in user, or an empty string if the user has not configured an
email address.

Email Class Methods

The class EmailMessage can be used to create custom email messages.

NAME DESCRIPTION
EmailMessage Creates a new EmailMessage object.
EmailMessage.setServer Sets the email (SMTP) server host and port to

use for this email message.

EmailMessage.setUser Sets the username and password to use for email
(SMTP) server authentication. This method must
be called after the setServer method.

EmailMessage.setSecurity Sets the connection security type for email
(SMTP) server communication.

EmailMessage.setFrom Sets the from address.
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NAME

DESCRIPTION

EmailMessage.
EmailMessage.
EmailMessage.

EmailMessage.

EmailMessage.

EmailMessage.

EmailMessage.

EmailMessage.

EmailMessage.

EmailMessage.

EmailMessage.

EmailMessage.

setTo
setCc
setBcc

setSubject

setBodyText

setBodyHtml

attachFile

attachFile

attachFromModel

attachText

attachBinary

send

Sets the to addresses.
Sets the cc addresses.
Sets the bcc addresses.

Sets the email subject line. Note that newline
characters are not allowed.

Sets the email body as plain text. An email can
contain both a text and an HTML body.

Sets the email body as HTML text. An email can
contain both a text and an HTML body.

Adds an attachment from a file. The attachment
MIME type is determined by the file name
extension.

Adds an attachment from a file with a specified
MIME type.

Adds an attachment created from a report,
export, or table feature in the model.

Adds a text attachment with a specified
sub-MIME type, such as plain or HTML.

Adds an attachment from a byte array with a
specified MIME type.

Sends the email to the email (SMTP) server. An
email object can only be sent once.
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EMAIL PREFERENCES

To set preferences for an outgoing email (SMTP) server, open the Email page of

the Preferences window, as shown in the figure below.

O Preferences

=t

Outgoing Server (SMTP)
Application Builder Host:
Chatbot

Client-Server

servermyorganization.com

Port: 25

Computing Connection security: |~ None -

<

Email
Outgoing Server (SMTP)
Files Password:

User: paul@myorganization.com

Geometry
Graphics

Help

Libraries

LiveLink Connections
Mesh

Model Builder
Model Manager
Physics Builder
Results

Save

Security

Updates

User Interface

Factory Settingsfor Al Import. Export.

COMSOL Server provides a similar set of email preferences.

Factory Settings

oK Cancel
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GUI-Related Methods

NAME

DESCRIPTION

Call a method directly

callMethod

useGraphics

openForm

closeForm

closeDialog

dialog

alert

alert

confirm

error

request

message

clearLog

clearMessagelog

Call a method from the Methods list by using its name; for
example, method1 (), method2()

Alternate way to call a method from the Methods list;
used internally and in cases of name collisions.

Plots a given entity (Plot Group, Geometry, Mesh, or
Explicit Selection) in the graphics form object given by a
name or name path in the second argument.

Shows the form with the given name in the current main
window. In a single window application, the form replaces
the current one. In an application with subwindows, the
form must exist in the main window layout. If not, it will
not be opened. Showing a form that is already open will
only activate the form.

Closes the form with the given name. Closing forms is
only possible in applications using subwindows. This
method is not applicable for single window applications.

Closes the form, shown as a dialog, with a given name.

Shows the form with a given name as a dialog. Equivalent
to the dialog method of a Form object; see below.

Stops execution and displays an alert message with a
given text.

Stops execution and displays an alert message with a
given text and title.

Stops execution and displays a confirmation dialog with a
given text and title. It also displays two or three buttons,
such as “Yes”, “No", and “Cancel".

Stops execution and opens an error dialog with a given
message.

Stops execution and displays a dialog with a text field,
requesting input from the user.

Sends a message to the message log.
Clears the log window.

Clears the message log window.
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NAME

DESCRIPTION

evaluateToResultsTable

evaluateToDoubleArray2D

evaluateToIntegerArray2D

evaluateToStringArray2D

useResultsTable

getChoicelist

setFormObjectEnabled

setFormObjectVisible

setFormObjectText

setFormObjectEditable

Evaluates a given entity, a Derived Value, in the table
object given by the name or name path in the second
argument, which will then be the default target for the
evaluations of the Derived Value. If the third argument is
true, the table is cleared before adding the new data.
Otherwise, the data is appended.

Evaluates the given entity, a Derived Value, and returns
the nonparameter column part of the real table that is
produced as a double matrix. All settings in the numerical
feature are respected but those in the current table
connected to the numerical feature are ignored.

Evaluates the given entity, a Derived Value, and returns
the nonparameter column part of the real table that is
produced as an integer matrix. All settings in the
numerical feature are respected, but those in the current
table connected to the numerical feature are ignored.

Evaluates the given entity, a Derived Value, and returns
the nonparameter column part of the potentially complex
valued table that is produced as a string matrix. All
settings in the numerical feature are respected, but those
in the current table connected to the numerical feature
are ignored.

Shows the values from the tableFeature in the
resultsTable form object.

Returns an object of the type Choicelist, representing
a choice list node under the declarations branch. The type
Choicelist has associated methods that make it easy
to change values and display names, see the Application
Programming Guide.

Sets the enable state for the form object specified by the
name or name path.

Sets the visible state for the form object specified by the
name or name path.

Sets the text for the form object specified by the name or
name path in the second argument. This method throws
an error if it is impossible to set a text for the specified
form object.

Sets the editable state for the form object specified by the
name or name path. This functionality is only available for
text field objects.
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NAME

DESCRIPTION

setMenuBarItemEnabled

setMainToolbarItemEnabled

setFileMenulItemEnabled

setRibbonItemEnabled

setToolbarItemEnabled

useView

resetView

getView

goToView

setWebPageSource

getScreenHeight

getScreenWidth

Sets the enable state for the menu bar item specified by
the name or name path (from the menu bar) in the first
argument.

Sets the enable state for the main toolbar item specified
by the name or name path (from the main toolbar) in the
first argument.

Sets the enable state for the file menu item specified by
the name or name path (from the file menu) in the first
argument.

Sets the enable state for the ribbon item specified by the
name or name path (from the main window) in the first
argument.

Sets the enable state for the toolbar form object item
specified by the name or name path in the first argument.

Applies a view to the graphics contents given by the name
or name path in the second argument.

Resets the view to its initial state in the graphics contents
given by the name or name path in the second argument.

Returns the view currently used by the graphics contents
given by the name or name path in the second argument.

TR TR TR TR TR TR T}

Goes to one of the “xy”, “"xz", "yx", “yz", "zx", or "zy"”
views in the main graphics window or in the graphics
window of a form object.

Sets the source for the form object specified by the name
or name path in the first argument.

Returns the height in pixels of the primary screen on the
client system, or of the browser window if Web Client is
used.

Returns the width in pixels of the primary screen on the
client system, or of the browser window if Web Client is
used.
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GUI Command Methods

NAME DESCRIPTION

clearAllMeshes Clears all meshes.

clearAllSolutions Clears all solutions.

clearSelection Clears the selection in the given graphics object.

environmentReflections
exit

fileOpen

fileSaveAs
printGraphics
rotateEnvironment
saveApplication
saveApplicationAs

saveApplicationCopyAs

Adds environment reflections to graphics

Exits the application.

Opens a file with the associated program on the client.
Downloads a file to the client. See also the section “File Methods".
Prints the given graphics object.

Rotate the environment used for reflections

Saves the application.

Saves the application under a different name (or as an MPH file).

Saves a copy of the application.

scenelight Toggles scene light in the given graphics object.
selectAll Selects all objects in the given graphics object.
skyBox Shows skybox in graphics
transparency Toggles transparency in the given graphics object.
zoomExtents Makes the entire model visible in the given graphics object.
zoomToSelection Zooms to the current selection.
Debug Methods

NAME DESCRIPTION

clearDebuglLog Clears the Debug Log window.

debuglog Prints the value of an input argument to the Debug Log window.

The input argument can be a scalar, 1D array, or 2D array of the
types string, double, integer, or Boolean.

Methods for External C Libraries
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EXTERNAL METHOD

NAME

DESCRIPTION

external

Returns an interface to an external C (native) library given by the
name of the library feature. The External class uses the Java
Native Interface (JNI) framework. For more information, see the
Application Programming Guide.

METHODS RETURNED BY THE EXTERNAL METHOD

The external method returns an object of type External with the following

methods:
NAME DESCRIPTION
invoke Invokes a named native method in the library with the supplied
arguments.
invokeWideString Invokes the named native method in the library with the supplied
arguments.
close Releases the library and frees resources. If you do not call this

method, it is automatically invoked when the external library is no
longer needed.
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Progress Methods

NAME DESCRIPTION

setProgressInterval  Setsa progress interval to use for the top-level progress and
display message at that level.
Calling this method implicitly resets any manual progress
previously set by calls to setProgress().

setProgress Sets a value for the user-controlled progress level.

resetProgress Removes all progress levels and resets progress to 0 and the
message to an empty string.

showIndeterminatePr  Shows a progress dialog with an indeterminate progress bar, given

ogress message, and an optional cancel button.

showProgress Shows a progress dialog with an optional cancel button, optional
model progress, and one or two levels of progress information.

closeProgress Closes the currently shown progress dialog.

startProgress Resets the value of a given progress bar form object name to 0.

setProgressBar Sets the value of a given progress bar form object name in the

range 0 —100 and the associated progress message.

Date and Time Methods

NAME DESCRIPTION

currentDate Returns the current date as a string (formatted according to the
server's defaults) for the current date.

currentTime Returns the current time as a string (not including date and formatted
according to the server's defaults).

formattedDateTime Returns a formatted time given in milliseconds since the epoch to a
readable date and time.

formattedTime Returns a formatted time using the given format. The format can
either be a time unit or text describing a longer format.

sleep Sleep for a specified number of milliseconds.

timeStamp Current time in milliseconds since midnight, January I, 1970 UTC.

getExpectedComputatio
nTime

Returns a string describing the approximate computation time of the
application. The string can be altered by the method
setExpectedComputationTime.
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NAME

DESCRIPTION

setLastComputationTim
e

getLastComputationTim
e

Set the last computation time, overwriting the automatically
generated time.

You can use the timeStamp method to record time differences and
then set the measured time in ms (a long integer).

Returns the last computation time in the given format. The format can
either be a time unit or text describing a longer format. This format is
localized and the output is translated to the current language setting.
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License Methods

NAME DESCRIPTION

checkoutLicense Checks out one license for each specified product.

checkoutLicenseForFil  Checks out one license for each product required to open an
e MPH file.

checkoutLicenseForFil  Checks out one license for each product required to open an
eOnServer MPH file.

getLicenseNumber Returns a string with the license number for the current
session. Example: 1icensenumber=getLicenseNumber ()

hasProduct Returns true if the COMSOL installation contains the
software components required for running the specified
products.

hasProductForFile Retumns true if the COMSOL installation contains the
software components required for running the specified
MPH file.

hasProductForFileOnSe  Retumns true if the COMSOL installation contains the

rver software components required for running the specified
MPH file.

Conversion Methods

NAME DESCRIPTION

toBoolean Converts strings and string arrays to Booleans. (' true' retums true, all
other strings return false).

toDouble Converts floats, float arrays, strings, and string arrays to doubles.

toInt Converts strings and string arrays to integers.

toString Converts Booleans, integers, and doubles, including arrays, to strings.

Array Methods

NAME DESCRIPTION

getColumn Returns a string, double, integer, or Boolean array for a specified column
in a 2D array (matrix). This is, for example, useful when values have been
read from a file and only certain columns should be shown in a table.

getSubMatrix Retumns a rectangular submatrix of an input matrix. Available for string,
double, integer, or Boolean 2D arrays.

insert Inserts one or more elements in an array and returns the expanded array.
Auvailable for string, double, integer, or Boolean arrays.
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NAME

DESCRIPTION

append

remove

insertRow

appendRow

removeRow

replaceRow

insertColumn

appendColumn

removeColumn

replaceColumn

matrixSize

Adds one or more elements to the end of an array and returns the
expanded array. Available for string, double, integer, or Boolean arrays.

Removes one or more elements from an array and returns the shortened
array. Available for string, double, integer, or Boolean arrays.

Inserts one or more rows into a rectangular 2D array and returns the
expanded array. Available for string, double, integer, or Boolean arrays.

Adds one or more rows to the end of a rectangular 2D array and returns
the expanded array. Available for string, double, integer, or Boolean arrays.

Removes one or more rows from a 2D array and returns the reduced
array. Available for string, double, integer, or Boolean arrays.

Replaces one or more rows in a rectangular 2D array and retums the
array. Available for string, double, integer, or Boolean arrays.

Adds one or more columns into a rectangular 2D array and returns the
expanded array. Available for string, double, integer, or Boolean arrays.

Adds one or more columns at the end of a rectangular 2D array and
retumns the expanded array. Available for string, double, integer, or
Boolean arrays.

Removes one or more columns from a rectangular 2D array and returns
the smaller array. Available for string, double, integer, or Boolean arrays.

Replaces one or more columns in a rectangular 2D array and returns the
array. Available for string, double, integer, or Boolean arrays.

Returns the number of rows and columns of a matrix as an integer array
of length 2. Available for string, double, integer, or Boolean arrays.
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String Methods

NAME DESCRIPTION

concat Concatenates a given array or matrix of strings into a single string using
the given separators.

contains Returns true if a given string array contains a given string.

find Returns an array with the indices to all occurrences of a string in a string
array.

findIn Returns the index to the first occurrence of a string in a string array or the
first occurrence of a substring in a string.

length Returns the length of a string.

replace Returns a string where a string has been replaced with another string.

split Returns an array of strings by splitting the given string at a given separator.

substring Returns a substring with the given length starting at the given position.

unique Returns an array of strings with the unique values in the given array of

strings.

Collection Methods

NAME DESCRIPTION

copy Returns a copy of the given array or matrix. Available for string, double,
integer, or Boolean arrays.

equals Returns true if all elements in the given array are equal and they have the
same number of elements. Available for string, double, integer, or Boolean
arrays. For doubles, comparisons are made using a relative tolerance.

sort Sorts the given array. Note: The array is sorted in place. Available for
string, double, or integer arrays. If the array is two-dimensional (a matrix),
the columns are sorted by their row values from top to bottom.

merge Returns an array with all of the elements merged from the given arrays.

Available for string, double, or integer arrays.

With, Get, and

Set Methods

NAME DESCRIPTION

with Used to make code more compact.

endwith The ending of a with statement.

set Sets a Boolean, integer, double, or string property value. Allows

for a scalar, array, or matrix property.
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NAME

DESCRIPTION

setIndex

getIntArray
getIntMatrix
getBoolean
getBooleanArray
getBooleanMatrix
getDouble
getString
getDoubleArray
getDoubleMatrix
getStringArray
getStringMatrix
getDblStringArray
getInt

get

descr

Sets a string, double, or integer property value for a matrix or
vector at a given index.

Gets an integer vector property.

Gets an integer matrix property.

Gets a Boolean property.

Gets a Boolean vector property.

Gets a Boolean matrix property.

Gets a double property.

Gets a string scalar, vector, or matrix property.
Gets a double vector property or parameter.
Gets a double matrix property or parameter.
Gets a string vector property or parameter.
Gets a string matrix property or parameter.
Returns the value as a matrix of strings.

Gets an integer property.

Returns a variable expression.

Returns a variable description.

Model Builder Methods for Use in Add-ins

For writing add-in method code that operates on the current component, current
mesh, current physics, and so on, use the methods in the table below.

NAME DESCRIPTION

getCurrentComponent Retumns an object of the type ModelNode for the current
component.

getCurrentPhysics Returns an object of the type Physics for the current physics
interface.

getCurrentMesh Returns an object of the type MeshSequence for the current
mesh.

getCurrentStudy Retumns an object of the type Study for the current
component.

getCurrentPlotGroup Returns an object of the type ResultFeature for the current

component.
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NAME DESCRIPTION

getCurrentNode Returns an object of the type ModelEntity for the current
component.
selectNode Select a particular model tree node.

These methods return the corresponding entity such that the method code in an
add-in can operate on it. When called from an application a method in this
category returns null. Also, null is returned if no entity of the corresponding type

exists such that nothing is current.
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Appendix F — Guidelines for Building Applications

General Tips

Include reports to files with input data and corresponding output data.
Make it intuitive. Provide help, hints, and documentation as necessary.
Make it foolproof: “Safe I/0”, “Reset to default data”; and so on.

Save a thumbnail image with the model.

Include a description text (It will be visible in the COMSOL Server library).
Test the application on the computer platforms for which it is intended.

Be minimalistic. From the developer’s point of view, it is much easier to
make sure logic works, organize, debug, maintain, and further develop the
app. From a user’s point of view, it is easier to use the application. The
minimalistic approach requires more care while developing but much less
maintenance later on and much higher adoption among users.

Embed libraries in the model if they are of manageable size.

Display the expected computation time and, after the computation, the
actual computation time.

When a computation is canceled, output data from the previous
computation should be cleared.

Password protect as needed. (Remember: No one can help you if you forget
the password.)

Naming Conventions

In the demo applications in the Application Libraries, all forms, events,
declarations, and methods use camelCase. You can adopt this convention also in
your own applications. Following this convention, a name should be composed of
a number of words joined without spaces, with each word’s initial letter in capitals
except the first letter that should be lowercase. Use a descriptive name and long
names are better than hard-to-understand short names.

Examples of names for forms:

main
inputParameters

geometryTab
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Examples of names for events:

updatePlot
moveToVelocityTab

Examples of names for declarations:

Strings — state, waveguideType
Boolean — isError, didChange, hasBeenlInitialized
Integer — year, nextYear

Double — speed, heatTransferCoefticient

Examples of names for methods:

compute();
computeStudyl();
computeStudyAndPlot();
getDataForPostProcessing|( );
setPlotType();

Methods

Do not create more methods than necessary.

Fewer methods give you a shorter list of methods to browse through when
looking for something. Fewer methods usually mean fewer lines of code to
worry about.

- If'several methods you wrote do essentially the same thing, consider merging
them into one method and dealing with the different cases by input
arguments.

- Do not create a method if it is only called from one place. Insert the code
right into that place instead.

Create a local method if it is only used in a form, or triggered by a form
event or a form object event.

Give methods descriptive names and name them so that similar methods are
grouped together when sorted alphabetically. You will have less to
remember and you will find what you are looking for easier. Long names are
better than hard-to-understand short names.

The points above apply to method code as well: be minimalistic, use as few
lines of code and variables as possible, use descriptive names for variables,
use long names instead of hard-to-understand short names, and optimize
code to run efficiently.
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» The above points apply to declarations as well: use good names, don't use
more than necessary, and declare variables where they are used (in forms and
methods or in the model).

Forms

» Do not create more forms than necessary.

* Use the Form Wizard templates to get started with creating forms.
» Consider using subwindows instead of form collections.

* Give forms descriptive names. Same reasoning as for methods.

* Make good use of the many different types of form objects. Some are good
for some things, while some are good for others.

* Do notinsert more form objects than necessary. Too many options for input
data may make the application hard to use. Too much output data makes it
hard to find important information.

 Insert a text field for the user to leave comments to save with the user’s set
of input and output data when saving the application.

» Consider inserting a button with a method to reset to default data.

» Apply “Safe 1/0”:

- For input fields, alert the user about input data that is out of bounds. You can
do that cither by an alert triggered by an On Data Change event for an input
field, or by setting limits in the form objects settings window, which then sets
hard limits. In a method generating the alert, you can just warn the user and
then allow the input data if the user chooses to go ahead anyway.

- On output fields, give the precision that makes sense. If current results are
not based on current input data, show it. If the computation failed, show it.

* Include tooltips, help, documentation, hints, and comprehensive reports.

* Provide the user with information about how long it takes to run the
simulation with default input data on a typical computer. It could be
seconds, hours, or even days depending on the application, so that is
something the user would like to know before hitting the compute button.
Consider playing a sound to alert the user when the computation has
finished. The user may be doing something else while waiting for results.
(Sending an email message with a report to the user or some other place
when the computation is done may be a better alternative if the computation
is really long.)

* Spend some time on the layout of a form. A good-looking form makes it
easier and more fun to use the application.

Consider setting keyboard shortcuts for buttons and menu items.
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Appendix G — The Application Library Examples

In the Application Libraries, you can find example applications that showcase the
capabilities of the Application Builder. They are collected in folders with the name
Applications and are available for many of the add-on products. You can edit these
applications and use them as a starting point or inspiration for your own
application designs. Each application contains documentation (PDF) describing
the application and an option for generating a report.

Below is a partial list of the available application examples organized as they appear
in the Application Libraries tree. Note that some applications may require

additional products to run.

NAME

APPLICATION LIBRARY

Cluster Setup Validation

Curve Digitizer

Helical Static Mixer

Transmission Line Calculator

Tubular Reactor

Tubular Reactor Surrogate Model Application
Thermal Actuator Surrogate Model Application
Tuning Fork

B-H Curve Checker

Induction Heating of a Billet

Effective Nonlinear Magnetic Curves

Organ Pipe Design

Lithium Battery Designer

Lithium Battery Pack Designer

Lithium-lon Battery Impedance

Water Treatment Basin

Reaction Equilibrium - Gas Phase Conversion of
Ethylene to Ethanol

Cathodic Protection Designer

COMSOL Multiphysics
COMSOL Multiphysics
COMSOL Muttiphysics
COMSOL Multiphysics
COMSOL Multiphysics
COMSOL Multiphysics
COMSOL Multiphysics
COMSOL Multiphysics
AC/DC Module

AC/DC Module

AC/DC Module

Acoustics Module, Pipe Flow Module

Battery Design Module
Battery Design Module
Battery Design Module
CFD Module

Chemical Reaction Engineering Module

Corrosion Module

Cyclic Voltammetry Electrochemistry Module

Electrochemical Impedance Spectroscopy Electrochemistry Module

Concentric Tube Heat Exchanger Heat Transfer Module
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NAME APPLICATION LIBRARY

Equivalent Properties of Periodic Microstructures Heat Transfer Module

Finned Pipe Heat Transfer Module

Forced Air Cooling with Heat Sink Heat Transfer Module

Inline Induction Heater Heat Transfer Module

Thermoelectric Cooler Heat Transfer Module

Mixer Mixer Module

Charge Exchange Cell Simulator Molecular Flow Module, Particle Tracing
Module

Truck Mounted Crane Analyzer Multibody Dynamics Module

General Parameter Estimation Optimization Module

Heat Recovery for System for Geothermal Heat Pipe Flow Module

Pump

Solar Dish Receiver Designer Ray Optics Module

Corrugated Circular Horn Antenna RF Module

Frequency Selective Surface Simulator RF Module

Slot-Coupled Microstrip Patch Antenna Array RF Module

Synthesizer

Rotor Bearing System Simulator Rotordynamics Module

Si Solar Cell with Ray Optics Semiconductor Module

Beam Section Calculator (Using LiveLink™ for Structural Mechanics Module, LivelLink™

Excel®) for Excel®

Beam Section Calculator Structural Mechanics Module

Bike Frame Analyzer Structural Mechanics Module, Livelink™
for SOLIDWORKS®

Homogenized Material Properties of Periodic Structural Mechanics Module

Microstructures

Fiber Simulator Wave Optics Module

Plasmonic Wire Grating Analyzer Wave Optics Module

Polarizing Beam Splitter Wave Optics Module

The following sections highlight some of the applications listed in the table above.

The highlighted applications exemplify a variety of important Application Builder
features, including the use of animations, email, optimization, parameter
estimation, tables, and the import of experimental data.
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Helical Static Mixer
This app demonstrates the following:

Geometry parts and parametric geometries

Dark theme

Use of subwindows

Material appearance visualization with environment reflections

Report generation for both Microsoft® Word and Microsoft® PowerPoint
Options for setting different mesh sizes

Improved graphics visualization when showing and hiding different
geometry objects

Enabling and disabling ribbon items based on the solution state.

Helical static mixers are often used to mix monomers and initiators which then
react during a polymerization process. The concentration field is included in the
analysis in order to compute the extent of mixing between two streams injected
into the static mixer through semicircle-shaped inlets.

The app can be used to estimate the degree of mixing in a system including one
to five helical blades whose dimensions can also be varied. The monomers' liquid
properties and inlet velocity can also be varied.

This application does not require any add-on products.
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Transmission Line Calculator

This app demonstrates the following:

» Creating apps for small screens such as smartphones

» User-interface navigation with a top menu typically used on websites

e Dynamically hiding forms using card stacks to minimize the space required
by the app

+ Changing appearance by using different background colors.

Transmission line theory is a cornerstone in the teaching of RF and microwave
engineering. Transmission lines are used to guide waves of electromagnetic fields
at radio frequencies. They exist in a variety of forms, many of which are adapted
for easy fabrication and employment in printed circuit board (PCB) designs.
Often, they are used to carry information, with minimal loss and distortion, within
a device and between devices.

Electromagnetic fields propagate along transmission lines as transverse
electromagnetic (TEM) waves. The Transmission Line Parameter Calculator app
computes resistance (R), inductance (L), conductance (G), and capacitance (C) as
well as the characteristic impedance and propagation constant for some common
transmission lines types: coaxial line, twin lead, microstrip line, and coplanar
waveguide (CPW).
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This application does not require any add-on products.

® Transmission Line Calculator = O *

Twin-lead Microstrip CcPW
® =

Geometry Ph);.sics Simulation  Results/Help

Compute
Expected computation time: 4 seconds

Last computation time: 3s

I/’_-“\I Coaxial Line simulation is solved.
L

Electric potential. Lines: Electric Field, Magnetic Flux Density

About

Tubular Reactor

This app demonstrates the following:

* Sending an email with a report when the computation is finished
» User-defined email server settings

+ Playing a sound when the computation is completed

» Language localization

» Options to visualize plots tiled or tabbed.

The app exemplifies how students in chemical engineering can model nonideal
tubular reactors (radial and axial variations) and investigate the impact of different
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operating conditions. It is also a great example of how teachers can build tailored
interfaces for problems that challenge the students’ imaginations.

The model describes a tubular reactor where propylene oxide (A) reacts with water
(B) to form propylene glycol (C):

A+B->C

Since water is the solvent and present in abundance, the reaction kinetics may be
described as first order with respect to propylene oxide

R=k*C_A

Alternatively, a second-order reaction can also be implemented according to
R=kt*C_A*C_B - kr*C_C

The reaction is exothermic and a cooling jacket is used to cool the reactor. The
reactor is modeled in 2D axisymmetry and the simulation results yield
composition and temperature variations in both the radial and axial directions.

This application does not require any add-on products.

b Untitled.mph - Tubular Reactor - o X
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Tubular Reactor Surrogate Model Application

This alternative version of the Tubular Reactor app demonstrates how
computational speed can be significantly increased by using a surrogate model
instead of a full finite element model. A surrogate model is a simplified,
computationally efficient approximation of a more complex and
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resource-intensive model. By enabling faster evaluations, the surrogate model

enhances interactivity.

This app demonstrates the following:

» Adjusting input parameters via sliders, with near-instantaneous updates to
the solution retrieved from the surrogate model

+ Comparing the surrogate model solution with the full finite element
solution

+ Efficient geometry sampling for data generation to be used for surrogate
model training.

In this case, the surrogate model is a Deep Neural Network (DNN). The surrogate
model has 5 input parameters in total: 3 for the activation energy, thermal
conductivity, and heat of reaction, and 2 for the spatial coordinates.

This application does not require any add-on products.

@ Untitledmph - Tubular Reactor - o X
File  Home
“— _ B
pn} = Ed
Reset  Compute  Report Help
Input | Simulation | Documentation
Input and Description Results umPIvSIeS: @
~ Input Temperature  Conversion | Temperature profiles = Conversion profiles
Activation energy: 75362 ymol Qa@- rrEEzn S [-a- O @a &

Surface: Conversion, species A (Preview)

Plot
O Computed results

@ Results preview

O Results preview and computed profiles

~ Reactor Description

Cooling jacket

Inlet: A, B

~ Information

Thermal Actuator Surrogate Model Application
The Thermal Actuator Surrogate Model Application demonstrates how the
computational speed can be increased with the use of a surrogate model.
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This app demonstrates the following;:

+ Adjusting input parameters via sliders, with near-instantaneous updates to
the solution retrieved from the surrogate model

» Comparing the surrogate model solution with the full finite element
solution

« Efficient geometry sampling for data generation to be used for surrogate
model training.

The 3D surrogate model has 8 input parameters: 5 input parameters, that include
geometry dimension and applied voltage, and 3 input parameters for the x,y, and
z coordinates.

This application does not require any add-on products.
For more information on this app and surrogate models in general, see the
COMSOL Learning Center course on surrogate modeling;:

https: / /www.comsol.com /support/learning-center /article /94521 /261.

© Thermal Microactuator Surrogate Model App - o X
File  Home

W = B a a &
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Tuning Fork
This app demonstrates the following;:

* Playing a sound at a specific computed frequency
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* Selecting different materials from a combo box
* Visualizing material appearance, color, and texture

» Choice of three different user interface layouts for computer, tablet, or
smartphone

¢ Custom implementation of the secant method

e Custom window icon.

When a tuning fork is struck, it vibrates in a complex motion pattern that can be
described mathematically as the superposition of resonant modes, also known as
eigenmodes. Each mode is associated with a particular eigenfrequency. The tuning
fork produces its characteristic sound from the specific timbre that is created by
the combination of all of the eigenfrequencies.

The app computes the fundamental resonant frequency of a tuning fork where you
can change the prong length. Alternatively, you can provide a user-defined target
frequency and the application will find the corresponding prong length using an
algorithm based on a secant method.

This application does not require any add-on products.

B Tuning Fork - o X

File

BWooo= 8 W B o )

Geometry Compute  Plot Sound  Report Reset Help Home

Geometry & Material
[ Find prong length

Target frequency: 440 Hz °
Frequency tolerance 01 Hz
Prong length: L, 8214 mm
Radius ro2s mm

Material Steel -

Lp
———

e ——
J—T—,—_%

Q@@ Lrzhk ¢ |l BMO @8

Sound
Play sound when computed
Sound duration: 1 s

Computed frequency: 440 Hz

B-H Curve Checker

This app demonstrates the following:

» Importing measured data from a text file
* Handling measured data using methods

» Exporting the results to a text file.
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The app can be used to verify and optimize B-H curves using experimental data.
It also generates curve data in the over-fluxed region, where measurement are
difficult to perform. It removes the unphysical ripples of the slope of the B-H
curve that might cause numerical instability.

The original B-H curve is evaluated from two aspects. Firstly, to verify that the
extrapolation of the curve is reasonable from the physical point of view. Secondly,
to check if the slope of the curve is smooth. The optimization algorithms are
mainly based on the simultaneous exponential extrapolation method and the
linear interpolation method, respectively.

The app requires the original curve data defined in a text input file. Once the curve
is imported, the application checks if optimization is required. By clicking the
Optimize Curve button, the user can generate the optimized curve data, which can
be exported to a text file.

This application does not require any add-on products.

@ B-H Curve Checker - a X
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Induction Heating of a Steel Billet

This app demonstrates the following;:

* Geometry parts and parameterized geometries

» Using tables for user input parameters

* Visualization on a 2D cross-section of a 3D geometry

» Improved visualization and user experience when a geometry object (the air
object) is hidden.
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Induction heating is a method used to heat metals for forging and other
applications. Compared with more traditional heating methods, such as gas or
electric furnaces, induction heating delivers heating power directly to the piece in
a more controlled way and allows for a faster processing time.

The app is used to design a simple induction heating system for a steel billet,
consisting of one or more electromagnetic coils through which the billet is moved
at a constant velocity. The coils are energized with alternating currents and induce
eddy currents in the metallic billet, generating heat due to Joule heating. The
billet cross section; the coil number, placement, and size; as well as the initial and
ambient temperature and the individual coil currents can all be specified as inputs
in the app.

This application requires the AC/DC Module.

© Untitled.mph - Induction Heating of a Steel illt - o X
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Effective Nonlinear Magnetic Curves Calculator

This app demonstrates the following:

« Importing measured data from a text file

+ Handling measured data using methods

» Exporting the results to a text file

» Exporting the results as COMSOL Material Library file.

The app is a companion to the Effective Nonlinear Constitutive Relations
functionality. Magnetic-based interfaces in the AC/DC Module support the
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Effective HB/BH Curve material model that can be used to approximate the
behavior of a nonlinear magnetic material in a frequency domain simulation
without the additional computational cost of a full transient simulation.

The Effective HB/BH Curve material model requires the effective Heff (B) or
Beff (H) relations defined as interpolation functions. This utility app can be used
to compute the interpolation data starting from the material’s H(B) or B(H)
relations.

The interpolation data for the H(B) or B(H) relations can be imported from a text
file or entered in a table. The app then computes the interpolation data for the
Heff (B) or Beff (H) relations using two different energy methods. The resulting
effective material properties can be exported as a COMSOL Material Library file
and be further used in a model with the Magnetic Fields interface.

This application does not require any add-on products.

Organ Pipe Design
This app demonstrates the following:

« Using a Java® utility class for combining several waveforms and for playing
sound

» Using tables for presenting results.
The app allows you to study the design of an organ pipe and then play the sound

and pitch of the changed design. The pipe sound includes the effects of different
harmonics with different amplitudes.

The organ pipe is modeled using the Pipe Acoustics, Frequency Domain interface.
The app allows you to analyze how the first fundamental resonance frequency
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varies with the pipe radius and wall thickness, as well as with the ambient pressure
and temperature.

Using the app, you can find the full frequency response, including the
fundamental frequency and the harmonics. With a method written in Java®code,
the app detects the location and amplitude of all harmonics in the response, thus
extending the analysis beyond the built-in functionality of the COMSOL
Multiphysics user interface.

This application requires the Acoustics Module.

@ Organ Pipe Design
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Lithium Battery Designer

This app can be used as a design tool to develop an optimized battery
configuration for a specific application. The application computes the capacity,
energy efficiency, heat generation, and capacity losses due to parasitic reactions of
a battery for a specific load cycle.

Various battery-design parameters consist of: geometrical dimensions of the
battery canister, the thicknesses of the different components (separator, current
collectors and electrodes), the positive electrode material, and the volume
fractions of the different phases of the porous materials can be changed. The load
cycle is a charge-discharge cycle using a constant current load, which may be
different for the charge and discharge stages.

The app also computes the battery temperature (assuming an uniform internal
battery temperature), based on the generated heat and the thermal mass. Cooling
is defined using an ambient temperature parameter and a heat transfer coefficient.

| 403



This application requires the Battery Design Module.
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Li-lon Battery Pack Designer
This app demonstrates the following:

* Dynamic help system using card stacks
¢ Multiple components (1D and 3D) in a single app

» Toggle buttons in the ribbon for showing different input, hiding/showing
geometry selections, and for dynamic help

* Geometry parts and parameterized geometries

» Importing experimental data

+ Options for creating different mesh sizes

» Resetting a portion of the input parameters or all
* Generating a results table during the app session

« Exporting results to a text file or to Microsoft® Excel if a license of
LiveLink™ for Excel® is available

« Sliders and buttons to control the time step to plot
* Visualizing results with animations

e Custom window icons.
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It is a tool for investigating the dynamic voltage and thermal behavior of a battery
pack, using load cycle and SOC vs OCV dependence experimental data.

Parameter estimation of various parameters such as the ohmic overpotential, the
diffusion time constant, and the dimensionless exchange current can be performed
by the app. The app may then be used to compute a battery pack temperature
profile based on the thermal mass and generated heat associated with the voltage
losses of the battery.

Various battery pack design parameters (packing type, number of batteries,
configuration, geometry), battery material properties, and operating conditions
can be varied.

This application requires the Battery Design Module.
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Li-lon Battery Impedance

The goal with this app is to explain experimental electrochemical impedance
spectroscopy (EIS) measurements and to show how you can use a simulation app,
along with measurements, to estimate the properties of lithium-ion batteries.
The app takes measurements from an EIS experiment and uses them as inputs. It
then simulates these measurements and runs a parameter estimation based on the
experimental data.
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The control parameters are: the exchange current density, the resistivity of the
solid electrolyte interface on the particles, the double-layer capacitance of NCA,
the double-layer capacitance of the carbon support in the positive electrode, and
the diffusivity of the lithium ion in the positive electrode. Fitting is done to the
measured impedance of the positive electrode at frequencies ranging from

10 mHz to 1 kHz.

The application requires the Battery Design Module.

@ Livlon Battery Impedance - o X

File  Parameter Estimatio

© = 7@

Resst  Run  Report Help

Input  Simulation  Documentation

Input & Results Graphics ENEALS
+ Cell Properties Nyquist Plet | Bode Plot
NCA dlctrode thickness: 35 um = = _—
eaaa- @ WER @8 §o
LT0 electrode thickness: s um
x10%
Separator thickness: 0 m
Current collctor aea: 2 e s o
NCA, initial tate o charge: 059 8
170, intil state of charge: 033
75 y
+ Experimental Data
. 7
»
Frequency | Real Impedance | Imaginary Impedance | Impedance 65
1000 79864 70885 8012574
820 81864 791E-5 8.21552-4 6
) 83664 9055 8407756 4 ss
0 634 10264 85903764
20 aose.n 160 o morose.n s
+ =\ [=c]

~ Parameter Estimation

Imaginary Impedance [Qm?]
-

] Exchange current density, NCA: 4365 At
(9] Film resistvity, NCA particles: 0005 Qm? >
7] Double layer capacitance, NCA: 1 F/m? 3 o /
] Volumetric double layer capacitance, carbon in NCA: 741610 F/m’
] Diffusion coeffcient in NCA: 11807 s 22
b
« Information
Expected computation time: 52 seconds s
Status 1 }))/
(7) Lt computationtime 46 050 b
00008 00008 0001 o001l o001z oools  ooois 00015 00016

Real Impedance [Qm?]

Water Treatment Basin
This app demonstrates the following:

e Parametric geometry containing a geometry sequence with if-statements to
produce different types of designs

* Options to set the mesh size

e Light Theme

+ A graphical user interface that includes different windows that can be shown
or hidden.

Water treatment basins are used in industrial-scale processes in order to remove
bacteria or other contaminants.

The app exemplifies modeling turbulent flow and material balances subject to
chemical reactions. You can specify the dimensions and orientation of the basin,
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mixing baffles, and inlet and outlet channels. You can also set the inlet velocity,
species concentration, and reaction rate constant in the first-order reaction.

The app solves for the turbulent flow through the basin and presents the resulting
flow and concentration fields as well as the space-time, half-life, and pressure drop.

The application requires the CFD Module.
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Reaction Equilibrium—Gas Phase Conversion of Ethylene to Ethanol
This app demonstrates the following:

* How an app can be used as a teaching tool

* An 8 question multiple choice quiz where the answers can be sent to the

grader by email

This app calculates the equilibrium compositions in gas phase conversion of
ethylene to ethanol. It allows you to study how the initial conditions and the
operating conditions affect the ethanol production.

The app is designed to teach you how to compute quantitative results for the
equilibrium composition and provide an understanding for the dynamics of a
chemical equilibrium.
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The application requires the Chemical Reaction Engineering Module.

© Untitled.mph - Reaction Equilibrium - Gas Phase Conversion of Ethylene to Ethanol
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Cyclic Voltammetry

The purpose of the app is to demonstrate and simulate the use of cyclic
voltammetry. You can vary the bulk concentration of both species, transport
properties, kinetic parameters, as well as the cycling voltage window and scan rate.

Cyclic voltammetry is a common analytical technique for investigating
clectrochemical systems. In this method, the potential difference between a
working electrode and a reference electrode is swept linearly in time from a start
potential to a vertex potential, and back again. The current-voltage waveform,
called a voltammogram, provides information about the reactivity and mass
transport properties of an electrolyte.
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The application requires one of the Battery Design Module, Electrochemistry
Module, Electrodeposition Module, Corrosion Module, or Fuel Cell &

Electrolyzer Module.
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Electrochemical Impedance Spectroscopy
The purpose of this app is to understand EIS, Nyquist, and Bode plots. The app
lets you vary the bulk concentration, diffusion coefficient, exchange current
density, double layer capacitance, and the maximum and minimum frequency.

0.1 0 01
Electric potential (V)

Electrochemical impedance spectroscopy (EIS) is a common technique in
electroanalysis used to study the harmonic response of an electrochemical system.
A small, sinusoidal variation is applied to the potential at the working electrode,
and the resulting current is analyzed in the frequency domain.

The real and imaginary components of the impedance give information about the
kinetic and mass transport properties of the cell, as well as the surface properties
through the double layer capacitance.
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The application requires one of the Battery Design Module, Electrochemistry
Module, Electrodeposition Module, Corrosion Module, or Fuel Cell &
Electrolyzer Module.

© Untitled.mph - Electrochemical Impedance Spectroscopy. - o X
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Concentric Tube Heat Exchanger

This app demonstrates the following;:

 Selecting predefined or user-defined materials

» User option to switch between laminar flow or turbulent flow

+ Changing boundary conditions using methods

¢ Visualizing temperature dependent material properties as graph plots

» User option to set the solver tolerance.

Finding the right dimensions for a heat exchanger is imperative to ensure its
effectiveness. Other properties must also be considered in order to design a heat

exchanger that is both of the right size and provides heated or cooled fluid of the
right temperature.

The app computes these quantities for a heat exchanger made of two concentric
tubes. The fluids can flow either in parallel or in counter current flow.

The fluid properties, heat transfer characteristics, and dimensions of the heat
exchanger can all be varied. The Nonisothermal Flow multiphysics interface is
used to model the heat transfer.
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This application requires the Heat Transfer Module.

@ Concentrc Tube Heat Exchanger Dimensioning Tool - o X
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Equivalent Properties of Periodic Microstructures
This app demonstrates the following:

¢ Visualization of a periodic structure from a unit cell
» Resetting some or all input parameters

« Export the resulting material properties as an MPH file or an XML file that
can be imported to a COMSOL Multiphysics session.

Periodic microstructures are frequently found in composite materials, such as
carbon fibers and honeycomb structures. They can be represented by a unit cell
repeated along three directions of propagation.

To reduce computational costs, simulations may replace all of the microscopic
details of a composite material with a homogeneous domain with equivalent
properties. This app computes the equivalent properties for a geometrical
configuration and the material properties of a unit cell to be used in a macroscopic
model that uses these composite materials.

Nine different microstructures are given, with dimensional characteristics that are
modifiable by the user, as well as thirteen predefined materials. The app calculates
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the equivalent density, heat capacity, and thermal conductivity or diffusivity of the
composite materials.

This application does not require any add-on products.
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Finned Pipe
This app demonstrates the following:
* Geometry parts and parameterized geometry

A results table form object containing outputs.

Finned pipes are used for coolers, heaters, or heat exchangers to increase heat

transfer. They come in different sizes and designs depending on the application
and requirements.

When the fins are placed outside the pipe, they increase the heat exchange surface
of the pipe so that a cooling or heating external fluid can exchange heat more
efficiently. When placed inside the pipe, it is the inner fluid that benefits from an
increased heat exchange surface. Instead of fins, grooves can also increase the heat
exchange surface, particularly inside the pipe where space is limited.

With this app, you can customize a long cylindrical pipe with predefined inner and
outer fins or grooves to observe and evaluate their cooling effects. The app
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calculates the thermal performance of a pipe that is filled with water and then
cooled or heated by surrounding air with forced convection.

Various geometric configurations are available for the outer structure
(disk-stacked blades, circular grooves, helical blades, helical grooves, or none) and
for the inner structure (straight grooves or none).

The app computes the dissipated power and the pressure drop as functions of the
geometry and air velocity.

This application requires the Heat Transfer Module.
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Forced Air Cooling with Heat Sink

This app demonstrates the following;:

» Geometry parts and parameterized geometries

+ Sending an email with a report when the computation is finished

» User-defined email server settings which is useful when running compiled
standalone applications

« Options for setting different mesh sizes
 Error control of input parameters using methods.
Heat sinks are usually benchmarked with respect to their ability to dissipate heat

for a given fan curve. One possible way to carry out this type of experiment is to
place the heat sink in a rectangular channel with insulated walls.
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The temperature and pressure at the channel’s inlet and outlet, as well as the
power required to keep the heat sink base at a given temperature, is then
measured. Under these conditions, it is possible to estimate the amount of heat
dissipated by the heat sink and the pressure loss over the channel.

The purpose of the app is to carry out investigations of such benchmarking
experiments. You can vary the type of heat sink as well as the number of fins or
pins and their dimensions to find the optimal design for a given pressure loss over
the channel.

Air velocities and heat source rates can be varied and the app solves for
nonisothermal flow, assuming turbulence as described by the algebraic yPlus
model.

This application requires the Heat Transfer Module.
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Inline Induction Heater

This app demonstrates the following;:

* A model using symmetry while the results are visualized in full 3D
» Provides info if the results are above or below certain critical values

* Seclecting predefined or user-defined materials
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* Error control of geometry parameters using methods and presentation of
possible errors using card stacks

+ Sliders and buttons to control the position of the slice when visualizing the
results with a slice plot.

The app computes the efficiency of a magnetic induction apparatus for the heating
of liquid food flowing in a set of ferritic stainless steel pipes.

Ferritic stainless steels become more and more used in food processing due to their
relatively low and stable price, and their magnetic properties that allow using new
heating techniques.

A circular electromagnetic coil is wound around a set of pipes in which a fluid
flows. The alternating current passing through the coil generates an alternating
magnetic field that penetrates the pipes, generates eddy currents inside them, and
heats them up. Then heat is transferred to the fluid essentially by conduction.

Various configurations are available for the set of pipes (number, length, thickness,
material) and for the coil (number of turns, wire radius, current density, and
excitation frequency) to optimize the heat exchange with the fluid, while ensuring
homogeneous temperatures within it for a given flow rate.

This application requires the Heat Transfer Module and the AC/DC Module.
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Thermoelectric Cooler
This app demonstrates the following:
* Visualizing material appearance, color, and texture

* Showing info below the graphics about geometry parameters, results, and
performance depending on the selected plot action

Thermoelectric coolers are widely used for electronics cooling in various
application areas, ranging from consumer products to spacecraft design. A
thermoelectric module is a common type of component used in thermoelectricity
applications. A typical module consists of several thermoelectric legs sandwiched
between two thermally conductive plates, one cold and one hot. The device that
needs to be cooled down must be attached to the cold face.

Due to the variety of applications, there can be many different thermoelectric
cooler configurations. This app covers the basic design of a single-stage
thermoelectric cooler of different sizes with different thermocouple sizes and
distributions. It also serves as a starting point for more detailed calculations with
additional input options and can be extended to multistage thermoelectric
coolers.

This application requires the Heat Transter Module, AC/DC Module, and
Optimization Module. Instead of the AC/DC Module you could alternatively use
the MEMS Module or the Plasma Module.
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Mixer

This app demonstrates the following:

* Multiple tabs in the ribbon

* Geometry parts and parameterized geometries

 Parts and cumulative selections can be used to automatically set domain and
boundary settings in the embedded model

+ Adding or removing geometry parts with different geometrical
configuration

» Options for creating different mesh sizes

e Sending an email with a report when the computation is finished

» User-defined email server settings which is useful when running compiled
standalone applications

« Sliders to control the visualization of a slice plot.

The app provides a user-friendly interface where scientists and process engineers
can investigate the influence that vessels, impellers, baffles, and operating
conditions have on the mixing efficiency and on the power that is required to drive
the impellers. You can use this application to understand and optimize the design
and operation of a mixer for a given fluid.

You can specify the dimensions of the vessel from a list of three types and the
dimensions and configuration of the impellers from a list of eleven types. The
vessels can also be equipped with baffles. You can further specify the impeller
speed and the properties of the fluid that is being mixed.
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The application requires either the CFD Module or the Polymer Flow Module.

o Ui - o x

Charge Exchange Cell Simulator

A charge exchange cell consists of a region of gas at an elevated pressure within a
vacuum chamber. When an ion beam interacts with the higher-density gas, the
ions undergo charge exchange reactions with the gas which then create energetic
neutral particles. It is likely that only a fraction of the beam ions will undergo
charge exchange reactions. Therefore, in order to neutralize the beam, a pair of
charged deflecting plates are positioned outside the cell. In this way, an energetic
neutral source can be produced.

This app simulates the interaction of a proton beam with a charge exchange cell

containing neutral argon. User input includes several geometric parameters for the
gas cell and vacuum chamber, beam properties, and the properties of the charged
plates that are used to deflect the remaining ions.

The simulation app computes the efficiency of the charge exchange cell, measured
as the fraction of'ions that are neutralized, and records statistics about the different
types of collisions that occur.
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This application requires the Particle Tracing Module and the Molecular Flow
Module.

@ Untitled.mph - Charge Exchange Cell Simulator - o x
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Truck Mounted Crane Analyzer

This app demonstrates the following;:

+ Using the knob form object

» Updating the geometry by rotating a knob

e Provides info if the results are above or below certain critical values

Many trucks are equipped with cranes for handling loads and such cranes have a
number of hydraulic cylinders that control the motion of the crane. These
cylinders and other components that make up the crane are subjected to large
forces when handling heavy loads. In order to determine the load-carrying
capacity of the crane, these forces must be computed.

In the app, a rigid-body analysis of a crane is performed in order to find the
payload capacity for the specified orientation and extension of the crane.

Inputs include the angle between the booms, the total extension length, the
capacity of the inner and outer boom cylinders, and the capacity extension
cylinders. Results from the app include the payload capacity and hydraulic cylinder
usage.
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The application requires the Multibody Dynamics Module.

© Untitled.mph - Truck Mounted Crane Analyzer - o X
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General Parameter Estimation
This app demonstrates the following;:

* Importing measured data from a text file or use built-in functionality for
data generation

» Automatically change solver options based on the input
* Dynamically update the equation display.
The app can be used to estimate parameters in models without any physics. Data

can be imported from a file or the built-in functionality for data generation can be
utilized.

The models include linear, quadratic, sigmoid, sloped Gaussian, and a custom
model with up to 5 parameters.

The Levenberg—Marquardt solver computes confidence intervals for the estimated
parameters, while the other solvers (MMA, SNOPT, and BOBYQA) allow for
specification of parameter bounds. MMA and BOBYQA allow for minimization
of the maximum square instead of the sum.

420 |



The application requires the Optimization Module.
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Geothermal Heat Pump

This app demonstrates the following;:

+ Changing the design by using a combo box with predefined options

* Options for creating different mesh sizes

« Editing and plotting monthly data input

o Setting the end time and the time steps size of a time-dependent simulation
 Visualizing the initial values for a time dependent simulation

e Includes a simple control system to manage the temperature.

Geothermal heating is an environmentally friendly and energy-efficient method to
supply modern and well insulated houses with heat. Heat exchangers placed at a

sufficient depth in the ground below the house utilize subsurface heat, where
temperatures are almost constant throughout the year.

The app studies different pipe configurations of a ground heat exchanger. It
provides information on the performance of ground-coupled heat exchangers for
different specifications (depth, pattern, pipes configuration, and heating
conditions), temperature conditions, soil thermal conductivity, and temperature
gradient.
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The heater can also be turned off if the daily heat demand is achieved, and then
turned on again after 24 hours. The temperature at the pipe’s outlet can be
controlled and compared to the minimum temperature required in the heat
exchanger specifications.

This application requires the Pipe Flow Module.

@ Heat Recovery System for a Geothermal Heat Pump
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Solar Dish Receiver Designer

Solar concentrator/cavity receiver systems can be used to focus incident solar
radiation into a small region, generating intense heat which can then be converted
to electrical or chemical energy. A common figure of merit in solar thermal power
systems is the concentration ratio, or the ratio of the solar flux on the surface of
the receiver or in the focal plane to the ambient solar flux.

This app is an application based on the Solar Dish Receiver tutorial model. In this
app, incident solar radiation is reflected by a parabolic dish, while the concentrated
solar radiation is collected in a small cavity. A total of six different parameterized
cavity geometries are available for investigation: Cylindrical, Dome,
Heteroconical, Elliptical, Spherical, and Conical. It is also possible to take several
different types of perturbation into account, including solar limb darkening and
surface roughness. For each cavity geometry, built-in plots show the flux
distribution and concentration ratio in the focal plane as well as the incident flux
on the interior surfaces of the cavity.
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You can learn more about this example in a related blog post: “Efficiently
Optimizing Solar Dish Receiver Designs”:
https: / /www.comsol.com/blogs /efficiently-optimizing-solar-dish-receiver-designs.

This application requires the Ray Optics Module.

@ Unfitied.mph - Solar Dish Receiver Designer
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Corrugated Circular Horn Antenna

This app demonstrates the following:

» A toolbar with large buttons for the navigation instead of a ribbon

* Subforms used as sections and the sections' headings include an image

» Provides info if the results are within a certain range

* Visualizes a 2D axisymmetric model in full 3D

The excited TE mode from a circular waveguide passes along the corrugated inner
surface of a circular horn antenna where a TM mode is also generated. When
combined, these two modes give lower cross-polarization at the antenna aperture.
By using this app, the antenna radiation characteristics, as well as aperture

cross-polarization ratio can be improved by modifying the geometry of the
antenna.
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This application requires the RF Module.

8 Comugued [EE——— - o x

Frequency Selective Surface Simulator

This app demonstrates the following:

* Designing an app for small screens such as smartphones

¢ User-interface navigation with a top menu typically used on websites

* Geometry parts and parameterized geometries

* Visualizing periodicity of a geometry with material rendering

» Warning messages on icons when properties are not updated

* Sending an email with a report attached when the computation is finished

Frequency selective surfaces (ESS) are periodic structures that generate a bandpass
or a bandstop frequency response. They are used to filter or block RF, microwave,
or, in fact, any electromagnetic wave frequency. For example, you see these

selective surfaces on the doors of microwave ovens, which allow you to view the
food being heated without being heated yourself in the process.

The app simulates a user-specified periodic structure chosen from the built-in unit
cell types. It provides five unit cell types popularly used in FSS simulations along
with two predefined polarizations in one fixed direction of propagation that has
normal incidence on the FSS. The analysis includes the reflection and transmission
spectra, the electric field norm on the top surface of the unit cell, and the
dB-scaled electric field norm shown on a vertical cut plane in the unit cell domain.
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You can change the polarization, center frequency, bandwidth, number of
frequencies, substrate thickness and its material properties, and unit cell type
(circle, ring, split ring, and so on) as well as their geometry parameters, including
periodicity (cell size).

This application requires the RF Module.

Microstrip Patch Antenna Array Synthesizer

This app demonstrates the following:

o Parameterized geometries

* Visualizing material appearance, color, and texture

* Multiple plots in the same window to visualize the results

+ Options to visualize the results with different views using checkboxes
Microstrip patch antenna arrays are used in a number of industries as transceivers

of radar and RF signals. This is a prime candidate for the 5G mobile network
system.

The app simulates a single slot-coupled microstrip patch antenna, fabricated on a
multilayered low-temperature cofired ceramic (LTCC) substrate. When using this
app, you will be able to simulate the far-field radiation pattern of the antenna array
and its directivity. The far-field radiation pattern is approximated by multiplying
the array factor and the single antenna radiation pattern to perform an efficient
far-field analysis without simulating a complicated full-array model.
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You can also evaluate phased antenna array prototypes for 5G mobile networks
with a default input frequency of 30 GHz. You can do this by varying antenna
properties such as the geometric dimension and substrate material.

This application requires the RF Module.
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Rotor Bearing System Simulator
This app demonstrates the following:

» Navigation system using toggle buttons in the ribbon and Back/Forward
buttons in the settings window

* Seclecting predefined or user-defined materials
» Using a table for input of geometry objects
The app simulates a rotor bearing system consisting of disks and bearings mounted

on a rotating shaft. An eigenfrequency analysis is performed for a range of angular
speeds, to identify critical speeds of the system.

An app of this kind is useful at an early design stage where design modifications
can be made to move critical speeds away from the operating speed of the system.

Results include whirl modes, a Campbell plot, and a list of critical speeds.
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This application requires the Structural Mechanics Module and the
Rotordynamics Module.

@ Untitled mph - Rotor Bearing System Simulator - o x
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Si Solar Cell with Ray Optics

This app demonstrates the following:

e Multiple components (1D and 3D) in a single app

» Using the same choice list in the app as in the model using Data Access
functionality

¢ Output numerical results for a specific time step using a combo box

The app combines the Ray Optics Module and the Semiconductor Module to
illustrate the operation of a silicon solar cell at a location specified by the user. The
Ray Optics Module computes the average illumination over a day of the year. The
Semiconductor Module computes the normalized output characteristics of a solar
cell with design parameters specified by the user. The normalized output
characteristics is then multiplied by the computed average illumination to obtain
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the output characteristics of the cell at the specified date and location, assuming
simple linear relationship between the output and the illumination.

@ Si Solar Cell with Ray Optics
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This app demonstrates the following:

« Reading and importing data from an Microsoft® Excel file
« Exporting data to an Microsoft® Excel file

The app computes the beam section properties and true stress distribution in a
designated steel beam section. A broad range of American and European beam

standards are available. It uses LiveLink™ for Excel® to read and store the beam
data in Excel® worksheets.
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This %Jplication requires the Structural Mechanics Module and LiveLink™ for
Excel®. A version of this app is also provided without Microsoft® Excel
functionality.

© Beam Section Calculator - o x

Fle  Home

0O = E@= #ZAa

Recet  Recet | Compute | Updse Fxpor | Repat  Help
Al Foreec Pl
nput Simuation Resute Documentation
Designation Graphics  Section Properties
ot [0S o = Bending Moment M1 - w3
s
Shape | I-heam = . e
L ao012
oo w = |s 2 :
o 10
it imperil =
10
Dimensions s
Depth (e 46 in
Flange
Width (o) 405 in 1b
Thickness (t): 0345 in
Location (o) 000 in s
et racus (12 0w n osh
Sope: 00 %
e
Thickness tw): 0280 in
Fillet radlius (r1): 0250 in or
3
Forces
Aol force N 0sf
Moment around 1-axis T hm
Shese force along 7-nec TN
Moment around 2-axis T Nm at s
Shear force slong 1 axs TN
Tuisting moment T Nm
Masimun alowabis suess 35 MPa st
Information
a0
ixpected computation time: 5 seconds Al
(7 Last computation time: 2¢
) v 0.0112
2 15 1 05 0 05 1 15 2 m

About

Bike Frame Analyzer

This app demonstrates the following:

» Connecting an app to a SOLIDWORKS® session

e Setting a maximum allowed value which the solution is compared to

* Selecting predefined or user-defined materials

» Changing boundary conditions with a combo box using methods

The app computes the stress distribution and the deformation of a bike frame
based on user configurable loads and constraints. It leverages LiveLink™ for

SOLIDWORKS® to load the geometry, and to update the frame dimensions for
studying their effect on the results.
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This application requires the Structural Mechanics Module
SOLIDWORKS®.

and LiveLink™ for

@ Bike Frame Analyzer

e vome
&4 &4 -
T e o A = A
foe | Upimc  Upioe | Meh Compie e Seeen
Jliirog s
wot | ceonay sottor | ooameriation
~ Design Geometry | Mesh | Effective stress | Displacement | Maximurm stress | Maximum stress range.
g | Spediettoeumt <] || Gk Ol
e womny || Oyopors D oxds ] dmumuaue e [ Dformaion
Configuration: 7 aaR-@Bi Ly wzkn d- |« Oes
i <Dt gy St
s @agEY fem Von Mises stress (MPa) ~ Crank angle = 0°
 oetons

Dimensions  Material | Loads & Constaints

Headangle®): 73 o
Seat angle B s °
Top tube length (C): 568 mm
88 crop (O): & mm
Chainstay (€ s mm
Wheelbase (F): 1032 mm
Stock (6): o8 mm
Weight 16 kg

~ Computation

Usesymmetr: | Off B

Mesh size: Finer

Mesh scale factor: 1
~ Verification
Maximum allowable stress factor: 0.5

‘The resulting maximum effective stress is
elow the allowable value.

~ Information
Expected computation time: 1 min 305

@) \## eutaontine 1 min8s
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Fiber Simulator

For almost all commercial optical fiber types, the design consists of a concentric
layer structure with the inner layer(s) forming the core and the outer layer(s)
forming the cladding. Since the core has a higher refractive index than the
cladding, guided modes can propagate along the fiber.

This application performs mode analyses on concentric circular dielectric layer
structures. Each layer is described by an outer diameter and the real and imaginary
parts of the refractive index. The refractive index expressions can include a
dependence on both wavelength and radial distance. Thus, the simulator can be
used for analyzing both step-index fibers and graded-index fibers. These fibers can
have an arbitrary number of concentric circular layers. Computed results include
group delay and dispersion coefficient.

This application requires the Wave Optics Module.

© Untitled.mph - Fiber Simulator - o X
File Home
O O smdmdTansngletoderbs (A = X T . - B
5 A = nowh £ W | F B
Reset | (@ Steprindex Multi-Mode Fiber Show Mesh Compute  Mode ModeField Group Dispersion  Aftenuation Refractive  Report  Help
(© Grodec-indox MultiModeiber SE0MEEY Field  Diameter Delay Index
nput Design Simuition Resuts Documentation
~ Fiber Design Table Wavelength: | 1200 v KM  Mode | 1:Effectivemodeindexis 14484 v ATENECE B
»
Label Diameter (um) | v aa@~ @ - @8
Core 8.2[um] 0.0052+mat3.rfi.... | (0.63+2.06"0.14).
Cladding T25ium] et et | 0.63-2060.18) Surface: Electric field norm (v/m) Arrow Surface: Electric field Contour: Electric field, zcomponent (V/m)
60
[ CUE =N s0
~ Available Materials 40
»
Neme Tag 30
Si02 (Silicon dioxide, Silica, Quartz) (Malitson 1965 F... | mat3
Ge02 (Germanium dioxide, Germania) (Fleming 1984:... mat4. 20
Si02 (Silicon dioxide, Silica, Quartz) (Gao et al. 2013: T... | mat5.
Si02 (Silicon dioxide, Silica, Quartz) (Ghosh 1999: a-Q...  mat6. 10
Si02 (Silicon dioxide, Silica, Quartz) (Ghosh 1999: a-Q... | mat7. £
SI02 (Silicon dioxide, Slica, Quartz) (Kischkat et al. 20.. | mate el o
S
B Hep 10
+ Simulation Parameters 20
Minimum wavelength: 12 um
Maximum wavelength: 16 um =30
Number of wavelengths: gl w0
Number of modes 3
~ Information 0
Expected computation time with default settings: 60 seconds 60
(7 Last computation time: 465

U
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Plasmonic Wire Grating
This app demonstrates the following:

» Choice of different user interface layouts for computer/tablet or
smartphone

+ Custom background image and color
» Graphics appearance with custom top color and bottom color

» Custom position of the graphics toolbar

This application computes diffraction efficiencies for the transmitted and reflected
waves (m = 0) and the first and second diffraction orders (m = +1 and +2) as
functions of the angle of incidence for a wire grating on a dielectric substrate. The
incident angle of a plane wave is swept from normal incidence to grazing
incidence. The application also shows the electric field norm plot for multiple

grating periods for a selected angle of incidence.
This application requires the Wave Optics Module.
BA Plasmonic Wire Grating Analyzer - o X
=R AUNERE e L S
© Geomety Pamees

Periodicity: 200 nm
£

Wire radius:

it Material Properties

Substrate refractive index: 12

41 nm

02 E-1 Mo @1 02

Polarizing Beam Splitter

A Gaussian beam is incident on a 45-degree thin-film stack embedded in glass
material prisms. The thin-film stack is designed from alternating high and low
refractive index materials. The wave will be refracted at the Brewster angle at each
internal interface. Thus, mainly p-polarized waves (polarization in the plane of
incidence) will be transmitted, whereas mainly s-polarized waves (polarization
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orthogonal to the plane of incidence) will be reflected. Changing the spot radius
for the Gaussian beam modifies the polarization discrimination.

The reflectance and transmittance spectra are calculated for different Gaussian

beam spot radii.

The app automatically calculates the phase expressions necessary for the

Electromagnetic Waves, Beam Envelopes interface, when the user changes the

design parameters.

This application requires the Wave Optics Module.

@ Untitied.mph - Polarizing Beam Splitter

File  Home
Reset  Geometry ~ Mesh Compute
Input Design Simulation

~ Design

Prism refractive index (nPrism)
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ID array 171
2D array 172
3D coordinates 316

About dialog 46
About to shut down event /55
action 67, 71, 154
activation condition 175, 267, 275
active card selector 307
Add New Choice List 175
Add New Form Choice List 175
add-in 14, 136, 233, 234
selections 97
Add-in Libraries 238
add-on products 391
alert 226, 376
aligning form objects 117, 126
animation 82, 89, 92
appearance
button object 8/
forms 56, 58
graphics object 83
input field object 105
multiple form objects 65
table 332
text 64
append unit from unit set /80
append unit to number 102, 337
application
saving 350
Application Argument /3, 137
Application Builder
desktop environment /2, 21
window 12, 15, 18
Application Builder Reference Manual

I'1, 241

application example

Beam Section Calculator 428

B-H Curve Checker 399

Bike Frame Analyzer 429

Charge Exchange Cell Simulator 418

Concentric Tube Heat Exchanger
410

Corrugated Circular Horn Antenna
423

Cyclic Voltammetry 408

Effective Nonlinear Magnetic Curves
Calculator 401

Electrochemical Impedance Spec-
troscopy 409

Equivalent Properties of Periodic Mi-
crostructures 4/ |

Fiber Simulator 43/

Finned Pipe 412

Forced Air Cooling with Heat Sink
413

Frequency Selective Surface Simula-
tor 424

General Parameter Estimation 420

Geothermal Heat Pump 421/

Helical Static Mixer 393

Induction Heating of a Steel Billet 400

Inline Induction Heater 4/4

Li-lon Battery Impedance 405

Li-lon Battery Pack Designer 404

Lithium Battery Designer 403

Microstrip Patch Antenna Array Syn-
thesizer 425

Mixer 417

Organ Pipe Design 402

Plasmonic Wire Grating 432

Polarizing Beam Splitter 432
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Reaction Equilibrium—Gas Phase
Conversion of Ethylene to Etha-
nol 407
Rotor Bearing System Simulator 426
Si Solar Cell with Ray Optics 427
Solar Dish Receiver Designer 422
Thermal Actuator Surrogate Model
Application 397
Thermoelectric Cooler 416
Transmission Line Calculator 394
Truck Mounted Crane Analyzer 419
Tubular Reactor 395
Tubular Reactor Surrogate Model
Application 396
Tuning Fork 398
Wiater Treatment Basin 406
Application Gallery 3/
Application Libraries 10, 30, 31, 49, 391
Application Library
COMSOL Server 35
application object 189
Application Programming Guide [/,
189, 223
application tree 12, 15, 18
applications
publishing 47
applications folder 10, 31, 391
apply changes 26
arguments
input and output 2/4
arranging form objects /17
array 171
ID 171
2D 172
2D, interactively defining 173
syntax |72
array input object 160, 163, 315
auto complete 209

Automatic Notation 299

automatically update plot groups 267

background color 58
background image 58
Blank form template 59
BMP file 242
Boolean variable 168, 170, 171, 247
conversion 383
Boundary Point Probe 98, 188
Break 220
breakpoint 220
browser
web 34, 139
built-in method library 370
button 69,82, 115,212
command sequence 7/
icon 69
keyboard shortcut 70
on click event 69, 71
size 69, 119
style 69
text 119
tooltip 70

C libraries
external 379
CAD-file import 308, 352, 354
Call Stack window 220
cancel shutdown 155
card 305
card stack object |15, 168, 169, 305,
312
cell margins 125, 132

cells
merging |24
splitting 124
Chatbot window 223
check box object 115, 160, 163, 170,

193,212, 247
check syntax 202



choice list 68, 164, 174, 175, 255, 259,
270, 278, 284, 320, 321, 329, 330,
377
classic menu 142
clear selection
graphics 86
click-through agreement 44
clipboard 288, 299, 346
close application icon 155
Close brackets automatically 208
code completion 209
tooltip 210
code folding 209
color
material 86
selection 86
column settings 123, 130
combo box object 115, 160, 168, 174,
177,253
command line 137

command sequence 19, 53, 54, 71, 74,

75,82, 91, 146, 154, 158, 160, 189,

213,243, 335, 343
comments
toggle on and off 207
common, file scheme 352
compatible with physical quantity, unit
dimension check 102
compatible with unit expression, unit
dimension check 102
Compiler
button 40
node 4/
compiler 10, 26, 29, 40
complex numbers 299
component syntax 209
computation time 315
expected 109, 312, 314
last 109, 314, 382

computed in version 109
COMSOL Client 10, 28, 29, 34, 37
file handing 348
running applications in 37, 348
COMSOL Compiler 10, 26, 29, 40
COMSOL Desktop environment |2,
21
COMSOL Multiphysics 10, 26, 27, 32,
33,37, 133,189, 223, 290, 295, 297
COMSOL Runtime 41
COMSOL Server 10, 26, 28,29, 31, 33,
34, 37, 38, 352
manual 40
COMSOL Software License Agree-
ment 47
confirm 226, 376
Continue 220
Convert to Form Method 20, 75, 190,
213
Convert to Local Method 20, 75, 190,
213
Convertto Method 19, 75,77, 189, 191,
213,357
Coordinate 185, 187
Copy Table and Headers to Clipboard
299
copying
forms and form objects 133, 346
objects 62
rows or columns |24
Create Local Method 212
Create Local Variable 21/
Create New Declaration and Use It as
Source 101
Create New Form Declaration and Use
It as Source 101
creating
forms 16, 49
methods 9
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CSV file 168, 300, 335
curly brackets 208
custom file type 176
custom ribbon tab 234

custom settings window |34

DAT file 168, 300, 335
Data Access 12, 197, 201
data change 67, 160, 214, 248, 249, 390
data display object 105, 107, 15
information node 314
tooltip /10
data file 168, 300, 335
Data picking 186
data picking 97, 186
data validation 102, 180
Data Viewer window 220
date 381
dbfile, file scheme 352
Debug Log 222
debug log window 222, 379
debugging 219, 220, 379
Decimal Notation 299
Declaration and Use it as Source 166
Declarations 14, 164, 166
form 101, 164, 165
global 101
local 101
declarations node 247
delete button 62, 74, 309
deleting an object 62
Depth Along Line 187
derived values 108, 298
description text
Boolean variable 248
derived value 106
desktop icon 27, 42, 139
desktop shortcut 27, 139
Developertab 19, 11, 136, 199, 229
dialog 376

digital twin /4, 159
disable
form object 201
Disable All 221
disable form object 377
display name, for choice list 174, 177,
255,321, 329,377
displayed text 64
Domain Point Probe 188
domain point probe 98
double variable 168, 170, 171
conversion 383
double, data validation 103
download
option for compiling 41
drag and drop, form objects 62
duplicating
rows or columns 24

duplicating an object 62

edit local method 214
edit node 72, 195, 196
Editor Tools 195
editor tools 67, 198, 257, 259
window [8
editor tree 68, 71, 84, 195, 348, 350
element size | 14
change 276
email 341
class 373
methods 373
email attachment
export 373
report 373
table 373
embed
option for compiling 41
embedded, file scheme 241, 244, 352
enable

form object 201



Enable code folding 209 external C libraries 379

enable form object 377 extracting subform 119
enabled state, for form objects 8/ E File 164
Engineering Notation 299 fle

equation object 284 commands 348
error message, data validation 102, 104
Evaluation 2D 187

Evaluation 3D 187

declaration 175
destination 309, 355
download 36, 350

evaluation tables /87 import 72, 160, 163, 175, 241

event 67, 154, 160, 212, 214, 261

menu 47
About to shut down 155 methods 37/
button on click 71 opening 349
for multiple form objects 65, 162 saving 349
form 160 types 309

form object 160
global I3, 115, 154
keyboard shortcut 70

upload 36, 350
file browser 366

file custom 176

knob 340 file import object 160, 163, 175, 241,
local 154 308, 348, 354
node 155 File menu editor |7
on close 162
file open
on data change 67, 160, 214, 248, system method 373
249, 390
file scheme
on load 67, 162 common 352
on startup 155 dbfile 352
slider 337 embedded 241, 244, 352
Events 13 syntax 241
Excel® file 168, 300, 335 temp 352
executable 10, 26, 40 upload 175, 352, 358
expected computation time 109 user 352
explicit selection 93, 96 File Type 164
exponent, number format 109 file type

export declaration 176

filename 309, 355, 372
files library 244
Find 203

email attachment 373
export button, results table 299
export node 348 361

Export Selected Image File 242 Find and Replace window 203

Find in Methods 203

fit, row and column setting 119, 123
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fixed, row and column setting 119, 123

for statement 225
form 15, 58
Declarations /64
local 60
form collection 115, 142, 302
Form Editor
desktop location |2
overview 5
preferences 21/, 61
using 57
form event 160
form method 20, 67, 154, 160, 189
form object 15, 61, 67, 245
event [60
with associated methods 193
form object path 65
form reference 302
Form tab, in ribbon 15
form toolbar 342, 343
item 115
form window 15
Form wizard 67, 68, 106
Forms 13
Full Precision 299

function 18

gauge object 292
parameter 293
scalar variable 293
variable 293

geometry 33, 52, 71, 82, 88, 97, 323,

346, 356, 358, 376

import 308, 352, 354
operations 290, 295, 297

Geometry Entity Level 187

geometry node 71

get 386

GIF file 242

global evaluation 108

global event 13, 154

global form 67

global method 19, 67, 160, 189

global parameter 225

go to method 19, 75, 191

graphics 76
clearing contents 87
commands 84
hardware acceleration 47
hardware limitations 87
object 51, 52, 81, 82, 160, 376
plot group 87

Source for Initial Graphics Content

185

source for initial graphics content 82

tab, New Form wizard 52
toolbar 88, 115
using multiple objects 87
view 85, 92, 378
graphics data 98, 164, 185
grid layout mode 36, 59, 107, 116

grid lines, sketch layout mode /17

grow, row and column setting /19, 123

growth rules [ 19

Home tab, in ribbon 49
HTML
code 286
report 286
HTTP and HTTPS protocols 341
hyperlink object 340

icon 242, 343
button 69
close application 155
command 72
desktop 27, 42, 139
graphics 83
help 104

main window 14/



menu item 46
method 193
ribbon item 146
toolbar 343
if statement 225
ignore license errors 28
image
background 58
formats 242
object 287
Preview 242
scaling 287
thumbnail 3/
Images library 242
Immediately
Store changes 80
import
file 72, 160, 163, 175, 241, 309, 355
import data, to table 300
Indent and Format 207
Indent and format automatically 209
information card stack object 115, 312
information node 314
information node variables 109
inherit columns 130
initial size, of main window 143
initial values, of array 71
initialize
parameter 77
variable 77
Initializing Installer progress window 43
input arguments 37, 214
input arguments, to commands 67
input field object 99, 115, 160, 163, 168,
180
adding 99
information node 314
text object 106
tooltip 101

unit object 106
Inputs 13, 137
inputs tab, outputs tab, New Form wiz-
ard 5/
inserting
form objects 65, 67
rows and columns |19, 122
rows or columns |24
integer
data validation 103
variable 168, 170, 171
variable conversion 383
interactive editing

menus and ribbon items 49

item
menu 146, 212
ribbon 148

toolbar 70, 342

Java Shell window 223
Java utility class 241
Java® programming language 189, 223
JPG file 32, 242
keyboard shortcut 21, 67, 154, 196, 209,
211,220, 367
event 70, 46, 343
knob object 338
parameter 339
scalar variable 339

variable 339

Language 144

language elements window 18, 194, 223
language localization |44

last computation time 109

LaTeX 106, 109, 284

layout mode 58, 116

layout options, form collection 302
layout template 16, 50, 61

Libraries /4
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libraries node 241, 287
license agreement 47
license errors

ignoring 28
Line Entry Method 187
line object 285

list box object 115, 160, 163, 168, 174,

177,326
LiveLink™ for Excel® 168, 300, 335
LiveLink™ products 37
local event 154

local form 60

local method 20, 67, 75, 154, 160, 163,

189, 193,212,214, 248, 256, 346
local variable 21|
Localization 144
log object 295
logo image 83

low-resolution displays 36

Main Form 42

Main Window 13, 17, 142, 290
node 141, 150

Main Window Editor 149
desktop location /2
overview |7

Main window type 142

margins
cell 125,132

material 267

material color and texture 86

math functions 224

menu (46, 148
bar 145
classic 142
item 82, 115, 146,212
toggle item 146, 250

Menu editor |7

menu toggle item |15

merging cells [ 19, 124

mesh 52, 82,88, | 14
change element size 276
size |14
meshing 290, 295, 297
message log object 296, 376
method 14, 18,65,75,82, 164, 189, 190,
370
event /55, 160
form 20, 67, 154, 160, 189
form object 193
global 19, 160, 189
local 20, 67, 75, 154, 160, 163, 189,
193,212, 248, 256, 346
Model Builder 227
window /8
Method Call 227, 234
Method Editor 370
desktop location 12
overview |8
Preferences 208
using 189
Method Errors and Warmnings window
202
Method tab, in ribbon 18
method, called from the Model Builder
227
Methods /4
minimum size
form objects 125
Model Builder
method 209, 227
model commands 350
model data access / /5, 157, 346
Model Expressions 204
model expressions window |8
model object 189, 223, 370
model tree node, controlling if active
227
model utility methods 370



move down
command sequence 74
move up
command sequence 74
MP4 file 288
MPH file 14, 26, 27, 29, 33, 49, 55, 241,
351,379
multiline text 107
multiple form objects

selecting 65, 162

name
button 69
check box 248
choice list 174
form 58
form object 65
graphics object 8/
menu [46
method 208
shortcut 182
variable 167
named selection 93
new element value /71
new form 16
New Form wizard 66, 106
graphics tab 52
inputs and outputs tabs 5/
ribbon buttons tab 53
new method /9
notation
data display number format 109
unit 109
number format 105, 109
number of rows and columns [ /9

numerical validation 103, 180

OGV file 288
on click event, button 69

on close event 162

on data change event 67, 160, 214, 248,
249, 390
on load event 67, 162
On request
Store changes 80
on startup event 55
open file 349
OpenGL graphics hardware accelera-
tion 47
operating system command line /37
operators 223, 224
orthographic projection 85
OS commands 373
output arguments 214
Output directory
for compiled applications 41

overlapping form objects | /8

panes 302, 303
parameter 18, 52, 76, 100, 102, 168,
225, 346, 386
combo box object 253
declarations 14, 64
events /4, 154
input field object 99
method 202, 225
slider object 337
text label object 106
parametric sweep 262
parentheses 208
password protected application 33
pasting
form objects 62
forms and form objects |34
image 288
rows or columns |24
path
form object 65
pixels 64, 116
play sound 36, 243, 373
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plot52,53,71,72,82,88 170, 247, 256,
330, 357, 365, 376
plot geometry command 72
plot group 76, 170
plot groups
automatically update 267
PNG file 32, 242
Point Being Modified 187
point evaluation 108
Polar Complex Numbers 299
position and size 64, 116, 118
multiple form objects 65
positioning form objects 61
precedence, of operators 224
precision 299
precision, number format 109
preferences 21/, 61, 208, 352, 353
for compiled applications 47
security 33
Preview
image 242
preview form 26
preview form'’s layout definition /6
printing
graphics 85, 379
Probe 188
procedure 8
Programming Reference Manual I/,
189
progress 289, 381
progress bar [42
progress bar object 289, 381
progress bar, built in 290
progress dialog 291, 381
publishing applications 47

Quick Access Toolbar 26
Find 203

radio button object 115, 160, 174, 177,

319

Record Code 199
recording code 199
Rectangular Complex Numbers 299
recursion 215
regular expression |04
Remove All 221
removing

password protection 33

rows and columns |19, 122

rows or columns 24
report 388, 391

creating 348, 361

creating automatically 228

email attachment 373

embedding 286

HTML 286

image 32

node 348, 361
request 226, 376
reset current view 85, 92
Reset Window Layout 54
resizable graphics 36
resizing form objects 62
Results Evaluation 185, 186
results table object 298, 377
ribbon /42, 148

item 115, 148

section 148

tab 148

toggle item 115, 148, 250
Ribbon button 70
ribbon buttons tab, New Form wizard

53

ribbon tab

custom 234
Ribbon tab editor 17
row numbers, in table 299

row settings 122



run application 26, 28
running applications
compiled 40
in a web browser 34, 348
in the COMSOL Client 37

runtime 4/

save
application 55
running application 29
save application command 350
save as 379
save file 349
Scalar 168
scalar variable 168, 254, 337
scene light 85, 379
Scientific Notation 299
security settings 33
select all
graphics 85
selection 52, 82, 88
explicit 96
selection colors 86
selection input object 96, 322
selections 93
add-in 97
selectNode method 227
separator
menu |46
ribbon 148
toolbar 146, 342
separators
CSV, DAT, and TXT files 335
set value command /4
Settings Form 136, 227, 234
Settings Forms 134
settings window
customized /34
Form editor 12, 15
Method editor 18

shortcut
desktop 27, 139
shortcuts 164, 182
use 205
Show as Dialog command 77
Show Dialog 136
Show Errors 133
show form command 78
Show in Model Builder |35
shutdown
cancel 155
Single form template 59
Single window 42
sketch grid 117
sketch layout mode 58, 107, 116
slider object 115, 161, 336
smartphones
running applications on 36
software rendering 47
solving 290, 295, 297
sound
play 243
Sounds library 242
Source for Initial Graphics Content /85,
186
spacer object 344
special characters 39
splash screen 42, 43
splitting cells 119, 124
state
enabled, for form objects 81
visible, for form objects 81
Status bar 142
status bar 290
Step 220
Step Into 220
Step Out 220
Stop 220
Stop Recording 201
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stopping a method 220
Store changes 80
Stretch image 287

string variable 14,77, 154, 168,171, 254,

255,270, 304, 313, 326
conversion 383
methods 385
subroutine 18
Subwindow editor |7
subwindow layout |7
subwindows 142, 150

Switch to Model Builder and Activate

Data Access 101
syntax errors 202
syntax highlighting 207, 209
system methods 373
OS commands 373

table
email attachment 373
table object 161, 171, 330, 377
add to table 33/
source 331
tables, model tree 298
tablets
running applications on 36
Target for Data Picking 97, 186
temp, file scheme 352
template 16, 50, 61
templates /50
temporary file 366
test application 26, 28
test in web browser 26
text 146
text color 58
text file 168, 299, 335
text label object 99, 106
text object 115, 160, 163, 326
information node 3/4
Theme 209

Themes 13
Themes node 56
thumbnail image 3/, 32
time 38/
time parameter
combo box object 259
Timer events 14, 159
timestamps 297
title
form 58
main window 4]
menu /46

toggle button /15, 250

size 119
text 19
toggle item

menu |15, 146, 250
ribbon 115, 148 250
toolbar 342
toolbar 145, 299, 342
button, table object 334
graphics 88, 115
item 115, 342
separator /46, 342
toolbar item 70
tooltip
button 70
data display object I 10
input field object 10/
knob object 339
method editor 210
slider object 294, 337
toolbar button 343
unit mismatch 103
transparency 85, 379
TXT file 168, 299, 335

Unicode 106, 109
unrt

changing using unit set 177



data display 109 utility class 215

dimension check 102, 103, 180 vV Value 174, 177

expression 02 variable 14, 164, 202

groups 177 accessing from method 224
lists 177 activation condition 175
object 99, 106 Boolean 170, 171, 247
Unit Groups 177 declaration 14, 164
Unit Lists 177 double 170, 171
Unit Set 177 events |4, 154
unit set 104, 164, 284, 321, 330 input field object 99
Untitled.mph 29 integer 170, 171

upload
file scheme 175, 352, 358
URL 139, 286, 341

name completion 210

scalar 254, 337

slider object 337

string 168, 171, 254, 255, 304, 313,
326

text label object 106

use as source
array input object 317
card stack object 307
check box object 248
combo box object 254

version

of the software 109

data display object 108 video

declaration 166 controls 289

explicit selection 96, 322 player 289

gauge object 293 video object 288

graphics object 82 view

go to default 3D 91
graphics 85, 92, 378

information card stack object 313
input field object 99

knob object 339

list box object 328

radio button object 320

results table object 299

selection input object 96, 322
slider object 337

text object 326

reset current 85, 92
View all code 208
visible state, for form objects 8/

volume maximum /08

W WAV file 242
web browser 10, 29, 34, 139
file handling 348
web page

hyperlink 341

Use component syntax 209
use shortcuts 205
user

file scheme 352 web page object 286

WebGL 34
WebM file 288

user interface layout /5

username 373
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while statement 225
Window Layout 54, 142, 151
with statement 209, 225, 385
with statements 209
with() command 330
wrap text

text label object 107

Z zoom extents 82, 85, 330, 357, 379
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